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Introduction

Welcome to COMSOL Multiphysics®! This book details features and techniques
that help you throughout all of your COMSOL modeling in Version 4.4 using the
COMSOL Dcsktop® environment. For example, detailed information about how
to build model geometries in COMSOL, how to create a mesh for the finite
elements, how to create parameters and variables used within a model, how to add
the physics and material properties, and how to solve and display the results, are all
explained. The full set of documentation shows you, step by step, how to tap into
many functions and capabilities available in the COMSOL environment.

This introductory chapter provides an overview of COMSOL Multiphysics and its

product family, documentation set, and other resources.

Version 4.4 brings all-new COMSOL desktop environments for Windows® and as
a cross-platform version for Linux® and Mac with user interface components such
as ribbon toolbars in Windows for easy, single-click access to most functionality and
new, easier-to-use ways to select geometric entities and add, for example, boundary
conditions, materials, and physics to the picked entities. See About This Release of
COMSOL Multiphysics for information about the changes. This release also
includes an extended and improved Physics Builder for creating your own

specialized physics interfaces.
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COMSOL Multiphysics is a powerful interactive environment used to model and solve all kinds of scientific and
engineering problems. The software provides a powerful integrated desktop environment with a Model Builder
that gives you a full overview of the model and access to all functionality. With COMSOL Multiphysics you can
casily extend conventional models for one type of physics into multiphysics models that solve coupled physics
phenomena—and do so simultaneously. Accessing this power does not require an in-depth knowledge of

mathematics or numerical analysis.

Using the built-in physics interfaces and the advanced support for material properties, you can build models by
defining the relevant physical quantities—such as material properties, loads, constraints, sources, and fluxes—rather
than by defining the underlying equations. You can always apply these variables, expressions, or numbers directly
to solid and fluid domains, boundaries, edges, and points independently of the computational mesh. COMSOL
then internally compiles a set of equations representing the entire model.

You access the power of COMSOL as a standalone product through a flexible graphical user interface (GUTI) or by
script programming in ]ava® or the MATLAB® language (this requires a LiveLink™ for MATLAB® license).

Using these physics interfaces, you can perform various types of studies including:

* Stationary and time-dependent (transient) studies
* Linear and nonlinear studies

¢ Eigenfrequency, modal, and frequency response studies

When solving the models, COMSOL assembles and solves the problem using a set of advanced numerical analysis
tools. The software runs the analysis together with adaptive meshing (if selected) and error control using a variety
of numerical solvers. The studies can make use of multiprocessor systems and cluster computing, and you can run

batch jobs and parametric sweeps.

COMSOL creates sequences to record all steps that create the geometry, mesh, studies and solver settings, and
visualization and results presentation. This makes it easy to parameterize any part of the model; simply change a
node in the model tree and re-run the sequences. The program remembers and reapplies all other information and

data in the model.
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REAL-WORLD APPLICATIONS
Partial differential equations (PDEs) form the basis for the laws of science and provide the foundation for modeling

a wide range of scientific and engineering phenomena. You can use COMSOL in many application areas, including:

* Acoustics ¢ Microwave engineering
* Bioscience * Multibody dynamics

¢ Chemical reactions * Optics

* Corrosion and corrosion protection * Particle tracing
 Ditffusion * Photonics

¢ Electrochemistry ¢ Plasma physics

¢ Electromagnetics * Porous media flow

» Fatigue analysis * Quantum mechanics

¢ Fluid dynamics * Radio-frequency components
* Fuel cells and electrochemistry * Semiconductor devices
* Geophysics and geomechanics * Structural mechanics

¢ Heat transfer ¢ Transport phenomena

* Microelectromechanical systems (MEMS)  » Wave propagation

¢ Microfluidics

Many real-world applications involve simultaneous couplings in a system of PDEs—multiphysics. For instance, the
electric resistance of a conductor often varies with temperature, and a model of a conductor carrying current should
include resistive-heating effects. The Multiphysics Modeling Approaches section discusses multiphysics modeling
techniques. Many predefined physics interfaces provide easy-to-use entry points for common multiphysics

applications.

In its base configuration, COMSOL offers modeling and analysis power for many application areas. For several of
the key application areas there are also optional modules. These application-specific modules use terminology and
solution methods specific to the particular discipline, which simplifies creating and analyzing models. The modules
also include comprehensive model libraries with example models that show the use of the product within its

application areas.

About This Release of COMSOL Multiphysics

For use on the Windows® platform, the COMSOL 4.4 release introduces a ribbon layout, a style familiar to
Microsoft® Office users and integrated into many other software designs. The ribbon-style layout is intuitive and
makes it easy to locate similar and frequently used features. For the Linux® and Mac platforms, COMSOL 4.4

includes extended toolbars that provide almost identical single-click access to most functionality in the software.

For experienced COMSOL users, the basic functionality has not changed but access to some menus and physics
features have been moved. Many changes are related to different menu paths and icons. The COMSOL Desktop
has the same flexibility but in addition to the ribbon toolbars, the fonts and icons have changed.

The ribbon layout is only available with Windows operating systems. For
Mac and Linux users there is a similar approach to how the toolbars are
n displayed and used, including new icons and contextual menus, but it

does not look the same, nor it referred to as a ribbon.
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For all users, the new layout highlights the most used functionality; menu items are grouped with similar tasks and
actions. The features are still also available when you right-click a node in the model tree to open the context

menu—there are often several ways to complete the same task. As before, the available options in any context menu
or ribbon toolbar are based on where you are in the model, at what stage of the process of solving, or whether it is

relevant to the model being built. In other words, it is contextual.

Also see the COMSOL Multiphysics Release Notes for more information
'El about this release.

DIFFERENT INSTRUCTIONS FOR DIFFERENT OPERATING SYSTEMS
The addition of the ribbon for Windows users means that there are slightly different instructions about how to
access some features compared to Mac or Linux users. When specific instructions are included about where to find

a particular feature, the instructions distinguish between the operating systems using different icons.

¢ Where there are no differences, the icons are not used.

e Where there are minor differences in appearance or accessibility, but the functionality is the same, no icons are
used.

* In general, instructions for all platform imply that the feature is available from a named toolbar. For example,
the Physics toolbar, Mesh toolbar, or Geometry toolbar. See Toolbars and Keyboard Shortcuts for information
about each toolbar.

A ribbon tab, ribbon group, or modal ribbon tab, are available in the
Windows version. See Figure 2-1 for an example of the Windows Home

ribbon.

cross-platform version, primarily for Mac and Linux users. See Figure 2-9

for an example of these toolbars.
Linux

The Model Toolbar and Contextual Toolbar are available in the

ABOUT THE SCREEN SHOTS USED IN THIS MANUAL
The screen shots used throughout this reference manual are captured using the Windows platform except where

there are clear differences other than fonts or cosmetic appearance.

NEW APPROACH TO MULTIPHYSICS MODELING

In previous versions of COMSOL Multiphysics, specific multiphysics interfaces, such as The Joule Heating
Interface, were added to the Model Builder. Now, a predefined multiphysics coupling approach is used, improving
the flexibility and design options for your modeling. However, this is not yet available for all multiphysics interfaces
for all modules. In the future all multiphysics interfaces will use this approach but for this release, only interfaces
with a Heat Transfer interface have changed. For specific details, see Multiphysics Modeling Approaches.

The COMSOL Modules and Interfacing Options

The optional modules, including interfacing options such as the CAD Import Module and bidirectional interfaces

such as the LiveLink™ products, are optimized for specific application areas and offer discipline-standard
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terminology and physics interfaces. For some modules, additional material libraries, specialized solvers, element

types, and visualization tools are also available.

For up-to-date module availability, product descriptions, and a

g specification chart, go to www.comsol.com/products.
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About the Documentation Set

The full documentation set that ships with COMSOL Multiphysics consists of the following titles:

o Introduction to COMSOL Multiphysics—information about version 4.4 and how to build models using the

desktop environment, including quick references to keyboard shortcuts and common commands and functions.
* COMSOL License Agreement.

e COMSOL Installation Guide—Dbesides covering various installation options, it describes system requirements
and how to configure and run the COMSOL software on different platforms, including client/server
architectures as well as shared-memory and distributed (cluster) parallel versions.

e COMSOL Multiphysics Reference Manual—this book, which covers the functionality of COMSOL
Multiphysics across its entire range from geometry modeling to results evaluation and visualization, including
the physics interfaces for physics and equation-based modeling. It serves as a tutorial and a reference guide to
use COMSOL Multiphysics. This book reviews geometry, mesh, solver, and results functionality and provides
detailed information about the settings and options. Additionally, it describes some advanced functionality and

settings in COMSOL Multiphysics and provides background material and references.

e COMSOL API for use with ]mm® Reference Manual—this book provides details about features and techniques
that help you control COMSOL Multiphysics using its application programming interface (API). The COMSOL
API can be used from a standalone Java application as well as from MATLAB® using the LiveLink™ for MATLAB®
interface.

e The Physics Builder Manual provides documentation related to the Physics Builder.

In addition, each of the optional modules includes a manual as described in The COMSOL Modules and
Interfacing Options. The documentation for the optional CAD Import Module and LiveLinks to CAD packages
is available in separate manuals, and the documentation for the optional Material Library in the Material Library
User’s Guide.

The COMSOL LiveLink™ for MATLAB® User’s Guide shows how to access the capabilities of COMSOL from the
MATLAB programming environment.

A number of Internet resources provide more information about COMSOL, including licensing and technical
information. The electronic documentation, topic-based (or context-based) help, and the Model Libraries are all
accessed through the COMSOL Desktop.

If you are reading the documentation as a PDF file on your computer, the
blue links do not work to open a model or content referenced in a

n different guide. However, if you are using the Help system in COMSOL
Multiphysics, these links work to other modules (as long as you have a

license), model examples, and documentation sets.

CONTACTING COMSOL BY EMAIL

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please contact your local COMSOL
representative or send your questions to support@comsol.com. An automatic notification and case number is sent

to you by email.
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COMSOL WEBSITES

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com /contact

Support Center www.comsol.com/support

Product Download www.comsol.com/support,/download
Product Updates www.comsol.com/support,/updates
COMSOL Community www.comsol.com,/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase

The Help Window and Topic-Based Help

The Help window is useful as it is connected to many of the features on the COMSOL Desktop. This concept is

called topic-based help or context belp. You can also search all the HTLM documentation content from this

window.
The Help system automatically starts a web server using port 8090 on the
computer where COMSOL is installed. Depending on the security
settings, you might get a question to allow that port to be used the first
n time the help system is started.

The operating system might also issue a firewall security warning. To use
Help, allow COMSOL access through the firewall.

To learn more about a node in the Model Builder, or a window on the Desktop, click to highlight a node or

window, then press F1. The Help window opens and displays the topic information about the selected feature.

OPENING THE HELP WINDOW AND THE TOPIC-BASED HELP

To open the Help window:

e Press F1.
* On the main toolbar, click Help ( 3 ).
¢ From the main menu, select File>Help (Windows) Help>Help (Linux and Mac)

¢ Right-click any node in the Model Builder and select Help.

ABOUT USING THE FI KEY TO ACCESS CONTEXT HELP
To display topic-based (context) information in the Help window, on the COMSOL Desktop:

* Click to highlight a node in the Model Builder tree. For example, the Component or Geometry node.

COMSOL DOCUMENTATION AND HELP |
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¢ Click a window tab, for example, Model Builder, Add Study, or Messages.

» For Windows users, hover over toolbar buttons to display a too/tip. At the same time you can press F1 to display

more detail. This is only applicable to buttons, not submenus.

In some cases you need to refocus the context help on its target before
pressing F1. Try clicking to highlight a node, a window, or the button or
n click to focus on the Help window, hover over a toolbar button (Windows

only) and press F1.

TABLE I-1: THE HELP AND DOCUMENTATION TOOLBARS

BUTTON NAME DESCRIPTION

(% Home Returns to the COMSOL Documentation window home
page. Only available for The Documentation Window.

Contents  Open a tree-based menu of the COMSOL documentation. It
is the HTML version of the documentation that is also
accessed from the Documentation window. Only available
for the Help window. When you select a node in the table of
contents tree the corresponding topic is shown on the Topic
page.

@ Search On the Help window, click to open the search engine to
look for contents in the COMSOL documentation. Search
results are shown sorted by product.

On the Documentation window, enter Search terms in the
field and choose the Search scope—All documents, Selected
only, or Model library.

See Searching Help and Documentation Content for
more information about search terms you can use.

Topic On the Help window, jump directly to the information about
a node or window that you have clicked in the COMSOL
Desktop. This is an interactive environment. Click a node to
update the contents instantly.

[ Sticky On the Help window, click the Sticky Help button to lock
Help the current help window (the icon is highlighted & ), which
can be useful to keep some help topic or model instruction
active, or to release the window and view topic-based
(context) help when a node or window is clicked.

(€] Back Navigates backward to the topics previously selected.

For the Help window, move back or forward in the browser
history on the Search or Topic pages.

e Forward Navigates forward within a topic, but only to the end of the
current list.
> Next Navigates forward to the next topic in the order displayed.
< Previous Navigates backward to the previous contents topic.

CHANGING THE DEFAULT HELP SETTINGS

To edit the following settings, open The Preferences Dialog Box and click General.

Setting the Help Mode
From the Help mode list, select Integrated (the default) to show the help contents in the Help window that is
integrated in the COMSOL Desktop environment, or select Web browser to display the help contents in a separate
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browser. For the integrated mode, the Show PDF-files in new browser window check box controls how PDF
documents are launched. Click to clear this check box to use your default system browser’s settings. Edit the

Documentation root directory file path as required.
The default file paths are based on the platform:

* On Windows C:\Program Files\COMSOL\COMSOL44\doc, or generically COMSOL44\doc.
¢ For Mac and Linux, under the main COMSOL installation directory: COMSOL44 /doc.

Selecting a Web Browser

Under Web browser (Windows and Linux only), you can choose which browser COMSOL should use to show
pages on the COMSOL website and help contents when using the web browser help mode (see below). The
following settings are available:

¢ On Windows: Choose the Program sctting System default to use the default system web browser. Alternatively,
choose Custom and then give the path to an Executable location for a different browser installed on your

computer.

¢ On Linux: Type the path to the web browser directly in the Executable field, or click the Browse button and then

point to the executable file on the file system.

On Mag, this setting is not available and COMSOL always uses the

I_E.li system’s default web browser.

The Documentation Window

To open the Documentation window:

e Press Ctrl+F1.

e From the File menu, select Help>Documentation.

To open the Documentation window:

e DPress Ctrl+F1

* On the main toolbar, click the Documentation (l! ) button.
.
* From the Help menu, select Documentation.

In the Documentation window, you can navigate to PDF or HTML versions of the documentation (availability is
based on your license), as well as search all the documentation, save or open PDFs, or view the HTML content in
this window. There are different ways to access the same information using either the left-hand side (Figure 1-1)

or right-hand side (Figure 1-2) of the window.

COMSOL DOCUMENTATION AND HELP | 37



38 |

E Documentation
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I [fffj cOMSOL Decumentation and Help The full documentation set that ships with COMSOL Multipl

[] Overview of the Reference Manual
[ifl] The comsoL Meodeling Environment
i} Building a COMSOL Model

» Introduction to COMSOL Multiphysics—information abo
references to keyboard shortcuts and common commi

[fffi Customizing the COMSOL Desktop * COMSOL License Agreement.
(i D_Eﬁ”iFiU”_S _ * COMSOL Installation Guide—besides covering various
(i hjlsuallzat|9n and Selection Tools COMSOL software on different platforms, including clie

Figure 1-1: The left side of the Documentation window. Based on your license, links to the HTML versions of the product
documentation ave accessed and can be browsed in the tree. When you click a topic in the tree, the information displays
to the vight. You can also adjust the search scope.

% Home @ Back Q Forward

R | e
COMSOL Documentation

COMSOL Multiphysics

® COMSOL Installation Guide [ HTML | PDF ]
» COMSOL Software License Agreement [ HTML | PDF ]
* COMSOL Release Notes [ HTML | PDF ]
# Introduction to COMSOL Multiphysics [ HTML | PDF ]
* Reference Manual [ HTML | PDF ]
* Model Library Manual [EDE]
& Physics Builder Manual [ HTML | PDF ]

Figure 1-2: The right side of the Documentation window. Based on your license, links to PDF and HTML versions of the
product documentation are nccessed from this window. When you click HTML, it jumps to the first page of the
documentation for that product. When you click PDF, you have the option to Open or Save a full PDF version of that
document.

* The Help Window and Topic-Based Help

@l e Table 1-1 for a list of the Documentation toolbar buttons.

Searching Help and Documentation Content

After you open The Help Window and Topic-Based Help, click the Search button ( (3, ) to open the search engine
to and search the HTML content. Search results are shown sorted by product.

You can also search The Documentation Window. where you enter search terms in the field and choose a Search
scope—All documents, Selected only, or Model library.

The first search can take a couple of minutes while the search index is
']
I_El generated.

CHAPTER |: INTRODUCTION



SEARCHING THE DOCUMENTATION

On the Documentation window, you can adjust the Search scope (sce Figure 1-1). Enter a search term and then select

All documents, Selected only, or Model library from the list to narrow or expand the search scope as required. For
Selected only (Figure 1-3), first click a branch in the tree (for example, COMSOL Installation Guide) and then the

search includes all the documents below the selected node until the beginning of the next branch, in this example

it searches until the end of the Troubleshooting License Errors section.

Search expression:  DVD

Search scope: [Selected only v|

4 [ffff coMSOL Multiphysics ‘
4 [[[fl cOMSOL Installation Guide

i} Before you Begin
i} Installing on Windows
[iil] License Manager Installation on Windows
i} Running COMSOL on Windows
i} Installing on Mac OS5 X
[iil] License Manager Installation on Mac 05X
i} Running COMSOL on Mac OS5 X
i} Installing on Linux
[iil] License Manager Installation on Linux
i} Running COMSOL on Linux
[] Troubleshooting License Errors

[fill COMSOL License Agreement

[ifl] COMSOL® Release Notes

[iil] Introduction

[iifl comsoL Multiphysics® Reference Manual

COMSON @ APT far nee with lava® Reference Mar

% Home @ Back 9 Forward

COMSOL Multiphysics

Starting the Installer from DVD

This section applies if you have received a
installation. The COMSOL Installer is a use
DVD into the DVD drive (or mount the ima

Starting the Installer from DVD

This section applies if you have received a
line installation. The COMSOL Installer is 2
COMSOL DVD into the DVD drive (or moun

Installation from a DVD

This section applies if you have received a
interface tool that guides you through the
window should appear automatically; if not

Installation from a DVD

Figure 1-3: When searching in the Documentation window, choose a Search scope to search only a selected portion of the
documentation, all the documentation, ov only the model libraries.

SEARCH PARAMETERS FOR HELP AND THE DOCUMENTATION

Some examples of search parameters you can use:

TABLE 1-2: SEARCH PARAMETERS FOR THE COMSOL HELP SYSTEM

OPERATOR  EXAMPLE SEARCH RESULT EXAMPLE

&&, AND block && cone Results include all instances of the words.

block AND cone

OR, || block OR cone  Results include any of the listed words.

block || cone

+ - +block —cone Search for one term (+block) but not the other term
(—cone).

“, ~ “plot line”~10 Search for the words enclosed in the quotation marks
(plot line) within (~) a certain number of words (10)
from each other.

~ ecentric~ Search for something “almost” spelled in a particular
way. For example, ecentric. The results include
eccentric cone.

? h’t Use in a search query to mean exactly one character.
For example, search for all instances of hat, hit, or hut
where ? represents a, i, or u, or any other letter
between h and t.

* strain® Search for any word that starts with “strain”. Results

strain®d include strain-based, strain-rate, or strain, for

example. The asterisk represents any number of

characters.

If the asterisk is used in the middle of the word, it
searches for one letter between “n” and “d”. The
result in this example is strained.

COMSOL DOCUMENTATION AND HELP |
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TABLE 1-2: SEARCH PARAMETERS FOR THE COMSOL HELP SYSTEM

OPERATOR  EXAMPLE SEARCH RESULT EXAMPLE

enclosed “time dependent  Use quotation marks around a text string to search
quotation  study” for exactly that phrase; that is, to search for the
marks “” words in the order given within the quotation marks.

@ strain@ The “at sign” is a wildcard character. All instances that
include strain, for example, are returned.

The About COMSOL Multiphysics Box

.
13 About COMSOL Multiphysics @
COMSOL 4.4
Version number; 440126
ComMsoL L | This product is licensed to:

License number:

License agreement

Licensed products Acknowledgments = H Show Information
Patents
System information

This =oftware iz furnished under a license agreement. It may be used or copied only under the terms of the license
agreement. See http://www.comsol.com/sla. © 1998-2013 COMSOL AB. Protected by U.S. Patents 7,519,518;
7,596,474; 7,623,991; 8,219,373; and 8,457,932. Patents pending. Portions of this software are owned by Siemens
Product Lifecycle Management Software Inc. © 1986-2013. All Rights Reserved. Portions of this software are owned
by Spatial Corp. © 1989-2013. All Rights Reserved. None of the Livelink™ products are affiliated with, endorsed by,
sponsored by, or supported by Autedesk, Inc., Dassault Systémes S.A., Dassault Systémes SolidWorks Corp.,
Microsoft Corp., PTC Inc., Siemens Product Lifecycle Management Software Inc., SpaceClaim Corp., The MathWorks,
Inc. or any of their affiliates and/or subsidiaries. COMSOL, COMSOL Multiphysics, Capture the Concept, COMSOL
Desktop, and Livelink are either registered trademarks or trademarks of COMS0OL AB. Autodesk, AutoCAD and
Inventor are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the
USA and/or other countries. Other product or brand names are trademarks or registered trademarks of their
respective holders. For a list of such trademark owners, see htto://www.comsol.com/tm.

COMSOL Web Page | ok |

Figure 1-4: The Abour COMSOL Multiphysics dinloy box with the Acknowledgments list.

S

To open the About COMSOL Multiphysics ([=]) window:

¢ For Windows users, select it from the File menu.

* For Mac and Linux (cross platform) users, choose it from the Help menu.

In addition to copyright and patent information, the About COMSOL Multiphysics dialog box has the following
information:

e The Version number
e The user or company This product is licensed to
¢ The License number

Select an option from the list below and then click Show Information to open a separate window of the same name
containing this information:

¢ Seclect Acknowledgments to show information about third-party software components, including license notices
required by the software component authors.
¢ Seclect License agreement to show the COMSOL Multiphysics software license agreement.

¢ Select Licensed products to show the licensed COMSOL products, including the number of used licenses and the
total number of licenses for each product.
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* Select Patents to show the patents that the COMSOL program is protected by.

¢ Seclect System information to show a list of system properties, which can be useful for troubleshooting purposes,

for example.

* Click Show Information to open an Acknowledgments window that displays detailed information about your

software installation.

¢ Click COMSOL Web Page to open your web browser on the main COMSOL web page.

You can also get information about the licensed products from the

E Licensed and Used Products window.

El. The Root Window

Checking for Product Software Updates

COMSOL provides product software updates that improve the software and correct issues found.
To check if a product update is available from the File menu, sclect Help>Check for Product Updates ( |_’£'| )-

The program then checks if an update that is applicable, but not yet installed, is available from the COMSOL

website.

If an update is available, an Update dialog box appears where you click Download to download the update directly
or click Browse Update to open the COMSOL website where you can read about and download the update.

If no updates are available, the Update dialog box reports that your COMSOL installation is up-to-date. To check
for updates automatically each time that you start COMSOL, select the Check for updates at launch check box under

Product updates on the Updates page in the Preferences dialog box.

Open The Preferences Dialog Box and click Updates to select the Check for updates at launch check box to make
the program check for updates each time COMSOL is launched.
Typographical Conventions

All documentation uses a set of consistent typographical conventions that make it easier to follow the discussion,
understand what you can expect to see on the graphical user interface (GUI), and know which data must be entered

into various data-entry fields.
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In particular, these conventions are used throughout the documentation:

CONVENTION

EXAMPLE

text highlighted in blue

boldface font

italic font

Forward arrow symbol >

code (monospace) font

Italic code (monospace)
font

Arrow brackets <>
following the code
(monospace) or code
(italic) fonts

Click text highlighted in blue to go to other information in
the PDF. When you are using the help desk in COMSOL,
links to other modules, model examples, and
documentation sets also work.

A boldface font indicates that the given word(s) appear
exactly that way on the COMSOL Desktop (or, for toolbar
buttons, in the corresponding tooltip). For example, the
Model Builder window is often referred to, and this is the
window that contains the model tree. As another example,
the instructions might say to click the Zoom Extents
button ( ), and this means that when you hover over the
button with your mouse, the same label displays on the
COMSOL Desktop.

An ztalic font indicates the introduction of important
terminology. Expect to find an explanation in the same
paragraph or in the Glossary. The names of other user
guides in the COMSOL documentation set also have an
italic font.

The forward arrow symbol > is instructing you to select a
series of menu items or nodes in a specific order. For
example, Component>Mesh is equivalent to: Under the
Component node, click Mesh.

A code (monospace) font indicates you are to make a
keyboard entry in the physics interface. You might see an
instruction such as “Enter (or type) 1.25 in the Current
density field” The monospace font also is an indication of
programming code or a variable name.

An italic code (monospace) font indicates user inputs and
parts of names that can vary or be defined by the user.

The arrow brackets included in, for example, programming
examples (after a monospace code or an italic code font)
mean that the content in the string can be freely chosen or
entered by the user, such as feature tags. For example,
model.geom(<tag>) where <tag> is the geometry’s tag
(an identifier of your choice).

When the string is predefined by COMSOL, no bracket is
used and this indicates that this is a finite set, such as a
feature name.
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KEY TO THE GRAPHICS

Throughout the documentation, icons are used to help organize the information. These icons vary in importance,

but it is reccommended that you read these text boxes.

ICON

NAME

DESCRIPTION

A

2!

Caution

Important

Note

Tip

See Also

An
example
from the
model
library

Space Dimension

Win

Linux

Windows

Mac

Linux

A Caution icon indicates that the user should proceed carefully
and consider the next steps. It might mean that an action is
required, or if the instructions are not followed, that there will
be problems with the model solution.

An Important icon indicates that the information provided is
key to the model building, design, or solution. The information
is of higher importance than a note or tip, and the user should
endeavor to follow the instructions.

A Note icon indicates that the information can be of use to the
user. It is recommended that the user read the text.

A Tip icon is used to provide information, reminders, shortcuts,
suggestions for improving model design, and other information
that might be useful.

The See Also icon indicates that other useful information is
located in the named section. If you are working on line, click
the hyperlink to go to the information directly. When the link is
outside of the current PDF document, the text indicates this,
for example “See The Laminar Flow Interface in the
COMSOL Multiphysics Reference Manual” Note that if you
are in the on-line help, the link works.

The Model icon is used in the documentation as well as in
COMSOL. If you are working on line, click the link to go to the
PDF version of the step-by-step instructions. In some cases, a
model is only available if you have a license for a specific
module. The model library path describes how to find the
actual model in COMSOL Multiphysics, for example:

If you have the RF Module, see Radar Cross Section: model
library path RF_Module/Scattering_and_RCS/radar_cross_section

Another set of icons are also used in the Model Builder—the
component space dimension is indicated by OD = , ID —,
ID axial symmetry —f-, 2D €, 2D axial ti%i symmetry, and
3D ([ icons. These icons are also used in the documentation
to clearly list the differences to a physics interface, node, or
theory section, which are based on space dimension.

The use of this icon indicates that the information is specific to
a Microsoft Windows operating system.

The use of this icon indicates that the information is specific to
a Mac OS operating system. This may also be referred to as
cross-platform when describing how to access a feature or
menu on the COMSOL Desktop.

The use of this icon indicates that the information is specific to
a Linux operating system. This may also be referred to as
cross-platform when describing how to access a feature or
menu on the COMSOL Desktop.

COMSOL DOCUMENTATION AND HELP
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Overview of the Reference Manual
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This COMSOL Multiphysics Reference Manual provides comprehensive information about all modeling steps
using COMSOL Multiphysics. See the individual module manuals for information specific to a specialized Module
(see The COMSOL Modules and Interfacing Options for a list).

As detailed in the section COMSOL Documentation and Help this
information can also be searched from the Help system in COMSOL
Multiphysics.

TABLE OF CONTENTS, GLOSSARY, AND INDEX

To help you navigate through this guide, see the Contents, Glossary, and Index.

ENVIRONMENT

The COMSOL Modeling Environment chapter provides an overview of the COMSOL modeling environment as
controlled by COMSOL Desktop and the tools and windows it provides in the Windows version as well as the
cross-platform version. Topics include The COMSOL Desktop, The Model Libraries Window, The Physics
Interfaces, Creating a New Model with the Model Wizard, and a key to the icons including links in the Toolbars

and Keyboard Shortcuts section.

MODELING

Building a COMSOL Model explains a range of methods and topics including information about the following:
details about an introduction to The Model Builder, The Component Node, The Physics Nodes, Selecting Physics,
Analyzing Model Convergence and Accuracy, Specifying Model Equation Settings, Boundary Conditions, Using

Units, and Numerical Stabilization, and much more.

CUSTOMIZING THE COMSOL DESKTOP
In the chapter Customizing the COMSOL Desktop, the settings are described related to Customizing a Model,
changing Preferences Settings, and details about the Advanced Physics Sections.

DEFINITIONS

The Definitions chapter describes the global and local (component) definitions features. Depending on the
geometric scope, you add the nodes described in this section to either the Global Definitions node or under the
Definitions node for a particular component. Topics include Operators, Functions, and Constants, Predefined and
Built-In Variables, Mass Properties, Functions, Component Couplings, Coordinate Systems, Identity and Contact

Pairs, Probes, and Infinite Element Domains and Perfectly Matched Layers.

VISUALIZATION AND SELECTION
The Visualization and Selection Tools chapter describes the tools used to visualize and control how you view
models and select parts of the model geometry in the Graphics window and the settings windows. Important topics

include Working with Geometric Entities, Named Selections, and User-Defined Views.

GEOMETRY

The Geometry Modeling and CAD Tools chapter covers geometry modeling in 1D, 2D, and 3D with examples of
solid modeling, boundary modeling, Boolean operators, and other CAD tools in COMSOL. In addition, it shows
how to use the tools for exploring geometric properties, such as volumes and surfaces. There is also information
about using external CAD data. Topics include Creating a Geometry for Analysis, Working with Geometry

Sequences, Geometric Primitives, Geometry Operations, and Virtual Geometry and Mesh Control Operations.
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MESH

The Meshing chapter summarizes how to create and control your mesh for 1D, 2D, and 3D geometries in
COMSOL. It also explains the possibilities for importing and exporting meshes in different formats. Topics include
Creating a Mesh for Analysis, Meshing Techniques, Meshing Operations and Attributes, and Importing and
Exporting Meshes.

MATERIAL
The Materials chapter introduces you to the material databases included with COMSOL. Topics include a Materials
Overview, Working with Materials, Material Properties Reference, User-Defined Materials and Libraries, Using

Functions in Materials, and Module-Specific Material Databases.

AC/DC

The AC/DC Interfaces chapter explains the interfaces available for modeling electromagnetics, which you find
under the AC/DC branch ( ‘x ) when adding a physics interface. It also contains sections about general
fundamentals and theory for electric fields.

ACOUSTICS
The Pressure Acoustics chapter describes how to use the Pressure Acoustics, Frequency Domain interface, found
under the Acoustics branch ( 1)) ) when adding a physics interface, for modeling and simulation of acoustics and

vibrations.

CHEMICAL SPECIES TRANSPORT
The Chemical Species Transport chapter explains how to use the Transport of Diluted Species interface, found
under the Chemical Species Transport branch ( 2¢) when adding a physics interface, to model and simulate mass

transfer by diffusion and convection based on Fick’s law of diffusion.

FLUID FLOW
The Fluid Flow chapter explains how to use the Laminar Flow interface, found under the Fluid Flow>Single-Phase
Flow branch (=) when adding a physics interface, to model and simulate fluid mechanics for laminar,

incompressible fluids.

HEAT TRANSFER
The Heat Transfer Modeling chapter describes the different types of Heat Transfer interfaces (Heat Transfer in
Solids and Heat Transfer in Fluids), and the Joule Heating multiphysics interface, all found under the Heat Transfer

branch ( 1|} ) when adding a physics interface.

SOLID MECHANICS

The Structural Mechanics chapter explains how to use the Solid Mechanics interface, found under the Structural
Mechanics branch (£ ) when adding a physics interface, to simulate and analyze applications involving solid
mechanics. The interface is used for stress analysis and general solid mechanics simulation. This chapter also

includes a section about Using Load Cases.

EQUATION-BASED MODELING

The Equation-Based Modeling chapter describes the use of the mathematics interfaces, found under the
Mathematics branch ( £, ) when adding a physics interface, which are used for equation-based modeling. With
those interfaces you can solve various types of PDEs using different formulations. You can also solve ODEs and
other global equations.

SENSITIVITY ANALYSIS
The Sensitivity Analysis chapter describes how to perform sensitivity analysis using the Sensitivity interface, found
under the Mathematics>Optimization and Sensitivity (C/; ) branch when adding a physics interface.
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DEFORMED MESHES

The Deformed Geometry and Moving Mesh chapter explains how to use the modeling interfaces that control mesh
deformation. It also contains fundamentals about deformed meshes and information about the Eulerian and
Lagrangian formulations of the physics, the frame types that support these formulations, and the arbitrary
Lagrangian-Eulerian (ALE) method.

STUDIES AND SOLVERS
The Studies and Solvers chapter lists the various types of solvers and studies in COMSOL and explains the study
steps and solver configurations. It also describes the major solvers and settings as well as batch jobs, parametric

sweeps, and cluster computing. See also the Optimization Module Manual for other supplementary information.

RESULTS AND VISUALIZATION

The Results Analysis and Plots chapter helps you analyze results in COMSOL and describes numerous
result-evaluation and visualization tools, including advanced graphics, data display, and export functions. Topics
include Postprocessing and Analyzing Results, Results, Data Sets, Plot Groups and Plots, Derived Values and
Tables, Exporting Data and Images, Reports, and Printing and Capturing Screen Shots.

RUNNING COMSOL
Running COMSOL is an overview of the different ways that you can run the COMSOL Multiphysics software in
addition to running the COMSOL Desktop graphical user interface on a dedicated computer, including

client/server and distributed-memory architectures and cloud-based computing.
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The COMSOL Modeling Environment

The comsoL Desktop® provides a complete and integrated modeling
environment for creating, analyzing, and visualizing multiphysics models. This
chapter provides an overview of the COMSOL Multiphysics® modeling
environment as controlled by COMSOL Desktop and the tools and windows it

provides.

47



The COMSOL Desktop

This section is an overview of the major components in the COMSOL Multiphysics environment. These
components are integrated into the COMSOL Desktop, which you can personalize to your own modeling needs
and preferences. Primarily consisting of the Model Builder, node settings windows, and Graphics windows, other
dockable windows can be opened, closed, and organized according to the modeling settings you need to access and
the GUI configuration you want to work in. You can save these configurations, and the last opened configuration
is always displayed when you open COMSOL again.

* Creating a New Model
* Building a COMSOL Model

@l * Customizing the COMSOL Desktop
* The Model Builder

The COMSOL Desktop in the cross-platform version, primarily for the
Linux and Mac operating systems, looks slightly different than for the
Windows operating system, which is shown in Figure 2-1. The primary
difference is that the Main Menu and Main Toolbar are used instead of
ribbons. Otherwise, the default windows (Model Builder, Graphics,

Linux Settings, Log, Progress, and Messages) are in the same location on the
default Desktop layout. See The COMSOL Desktop Menus and Toolbars

for more details.

You can also launch the cross-platform version on Windows using

g comsolxpl.exe.
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Figure 2-1: The default COMSOL Desktop with its major windows in o widescreen layout. The ribbon tabs and groups
are available for Windows users. For Mac and Linux users the layout is similar but you access some options from the main

menu or contextuanl toolbars.

A ribbon tab, ribbon group, or modal ribbon tab, are available in the

Windows version. See Figure 2-1 for an example of the Windows Home

Win ribbon. Also see Figure 2-2 for an example of how the ribbon changes

when a window is resized.

Linux

for an example of these toolbars.

The Model Toolbar and Contextual Toolbar are available in the

cross-platform version, primarily for Mac and Linux users. See Figure 2-9

ABOUT CHANGES TO THE RIBBON DISPLAY (WINDOWS USERS)

When the complete COMSOL Desktop is resized, the ribbon toolbar groups are collapsed and grouped under

menus instead of displaying individual buttons. In Figure 2-2, all the groups on the Home ribbon are collapsed
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into menus. As the window is widened, the ribbon groups expand to include the options as buttons or other

submenus instead.

wihedE o9 EDE X G E - comsol Mutiphysics [E=EEER
Home Definitions Geometry Physics Mesh  Study Results 3D Plot Group - * H

SANCRECHE A =8 FH B

Model Definitions | Geometry Materials Physics  Mesh  Study  Results Windows  Layout

Model Builder ~ 41 3D Plot Group vt
El Plot

= =

[T
4
8]
4

1

il

Home Definitions Geometry Physics Mesh Study Results 3D Plot Group 4

W Componentl - = u . Electric Currents ~
=) - | == A = & | F
2 Add Component - ~— E = i Add Physics & -
Definitions | Geometry Materials Mesh | Study Results Windows

Figure 2-2: When the COMSOL Desktop is resized, the ribbon toolbar buttons ave grouped together with the ribbon tab
group name. In this example for the Home ribbon, all the buttons arve available from a menn, such as Definitions,
Geometry, Material, Physics, and so forth (top). As the window is widened, the menus expand accordingly (bottom,).

OVERVIEW

The rest of this section introduces you to the features of the COMSOL Desktop, explains some basic navigation,
and provides you with an overview of the windows, toolbars, and menus available. In this chapter you will also learn
about the model file formats, the options to save files, and the units systems available for modeling.

* Basic Navigation

* Adjusting Window Location and Size on the Desktop

¢ The COMSOL Desktop Windows

e The COMSOL Desktop Menus and Toolbars

* Windows Toolbars and Menus

¢ Cross Platform (Mac and Linux) Toolbars and Menus

 Features Available on Toolbars and From Menus

* The Messages Window

e About the COMSOL Model File Formats

e Saving COMSOL Model Files

e Saving and Opening Recovery Files

e The Root Window

¢ Unit Systems in COMSOL

After this introductory overview, The Model Libraries Window section explains how to work with the model

libraries included with COMSOL. The Physics Interfaces section lists the interfaces available with a basic COMSOL

Multiphysics license. This prepares you to start creating a new model.

The next section, Creating a New Model, shows you how to use the Model Wizard to begin building a new model
by choosing a physics interface and study combination.

The last section, Toolbars and Keyboard Shortcuts, is a quick reference to all the features found on the toolbars. It
includes links to the information contained throughout this reference manual.
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Basic Navigation

Basic navigation on the COMSOL Desktop extensively involves the nodes in the Model Builder as well as moving

between windows and sections on settings windows.

WORKING WITH NODES IN THE MODEL BUILDER

The following methods are available to select nodes, expand and collapse branches, open the settings window, or

move up and down the nodes in the model tree:

Click a node in the Model Builder to highlight it and to open the associated settings window. See The Node
Settings Windows.

Once a node is highlighted, there are many things you can do; for example, you can copy, duplicate, delete, and
move some nodes around. See Copying, Pasting, and Duplicating Nodes, Moving Nodes in the Model Builder,
and Clearing Sequences and Disabling, Enabling, and Deleting Nodes.

Right-click a node to open a context menu. See Opening Context Menus and Adding Nodes.
When a node is highlighted, use the up arrow key on the keyboard to move to the node above; to move to the
node below, use the down arrow key.

To expand a branch to display all nodes in the branch, click the small left-pointing white triangle next to the
branch icon in the model tree, or press the right arrow key. To collapse a branch to display only the main branch
node, click the small downward-right pointing black triangle next to the branch icon in the model tree, or press

the left arrow key. See The Model Builder Toolbar for information about how to collapse or expand all branches.

A highlighted node is also dynamic and its appearance can change based on where in the modeling process you

are. See Dynamic Nodes in the Model Builder for a list of these visual cues.

El The COMSOL Desktop Menus and Toolbars

MOVING BETWEEN WINDOWS AND SECTIONS ON THE COMSOL DESKTOP
Keyboard shortcuts are quick ways to navigate between the windows on the COMSOL Desktop and to switch focus

between windows and settings window sections:

Press Ctrl+Tab to switch focus to the next window on the desktop.

Press Ctrl+Shift+Tab to switch focus to the previous window in the desktop.

Press Ctrl+Alt+left arrow to switch focus to the Model Builder window.

Press Ctrl+Alt+right arrow to switch focus to the settings window.

Press Ctrl+Alt+up arrow to switch focus to the previous section in the settings window.

Press Ctrl+Alt+down arrow to switch focus to the next section in the settings window.

The section Keyboard Shortcuts has additional shortcuts for all operating

[

systems.

e The COMSOL Desktop
& * The Model Builder
* Creating a New Model
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Adjusting Window Location and Size on the Desktop

MOVING AND RESIZING THE WINDOW
* To move a window, click-and-drag the window tab (the tab is where the window name—Model Builder, for

example—displays) to where you want it.
* To resize a window, hover your mouse over the window borders until a double arrow displays. Click-and-drag

the borders between windows until the layout is how you want it.

. At any time, click the Reset desktop = button.

B

FLOATING/DETACHING A WINDOW

To detach a window to move and resize it, right-click the window tab and
select Float. Right-click the window and choose Dock to return it to its

default location on the Desktop.

COMSOL Desktop, or drag and drop it back to where you want it.

Linux

To detach a window to move and resize it, right-click the window tab and
select Detached. Right-click and select the option again to dock it to the

HIDING OR PINNING A WINDOW TO THE SIDE OF THE DESKTOP (WINDOWS USERS)
To hide a window, right-click the window and select Hide. The window is minimized along the side of the Desktop
(see Figure 2-3). Hover over the name to view a hidden/minimized window. To restore a hidden window, either

right-click the window, or from the list, select Float or Dock.

Pinning a window performs the same action as hiding it. Click the pin button & in the top-right corner of any
window to pin it to the side of the COMSOL Desktop. To return the window to its unpinned state, hover over the
window name to open it, then click the pin button (now laying on its side, see Figure 2-3) to restore the window

to its default location.

ranhire

= = E~ T~ =tE L\\, Float

a buskar.mph (root) Dock

(E) Global Definitions

4 [l Component 1 (comp1)
= Definitions

A, Geometry 1
258 Materials

=
=
]
o
m
=
%

When you hide a window, it is minimized along the
side of the Desktop. Hover over the name to view
the window.

Figure 2-3: A hidden window is minimized alonyg the side of the Desktop. Hover over the window name to view it. You
can then choose to Float or Dock the window (either right-click the window or choose options from the menu), or click the

pin icon to restove it to the defanlt location on the Desktop.
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USING THE POSITION GUIDES (WINDOWS USERS)

When customizing your COMSOL Desktop, or when you want to return a floating window to the Desktop (Dock
it), there are several visual guides available to assist.

Click and hold the mouse on a window to reposition or dock it on the Desktop. This displays the positioning guides
(Figure 2-4 and Figure 2-5). Drag the window over any of the guides to highlight the area where the window is to
be placed on the desktop (Figure 2-5). The center guide has five options. There are two vertical positioning guides,
one on the left and one on the right of the Desktop and two horizontal positioning guides, one on the top and one
on the bottom of the Desktop.

i)
=

Figure 2-4: Examples of the positioning guides.

THE COMSOL DESKTOP | 53



Model Builder > * | Messagesx | progr
- =

== =~ T

sudeig

4 & Untitled. mph (root)

* (E) Global Definitions

@ 4 [l Component1 (compl)
8 = Definitions

3 2

a YA\ Geometry 1

252 Materials
4 % Electrostatics (es)
8 Charge Conservation 1
S Zero Charge 1
8 Initial Values 1

A\ Mesh1
Bl Results
& Add to Selection
= | search | =
-1 — [ .
= Model Builder ~ % | Add Physics M
E +«->E-T-EHE + Add to Compenent + Add to Selection
9 4 @ Untitled.mph (root) Search
% () Global Definitions —— |1
o 4 T Companent 1 fcompI) 1%
2 = Definitions i
o A Geometry 1

=52 Materials
4 % Electrostatics {es)
W8 Charge Conservation 1
% Zero Charge 1
8 Initial Values 1

A
£, Mesh1 Messages ¥ Progress Log

B Results
E@E-

Figure 2-5: The positioning guides display (top image) when you click and hold the mouse pointer on o window. Dray

the window over any of the guides to see the highlighted blue arven, which indicates the destination for the window. Release

the mouse button and the window drops into place (bottom image).

MOVING, MINIMIZING, AND MAXIMIZING WINDOWS (MAC AND LINUX)

* Right-click the window tab and select Move>View (to move a separate window). Move the mouse to where you
want the window to display and left-click to confirm the move.

¢ Right-click the window tab and select Move>Tab Group (to move several tabbed windows) from the list. Move
the mouse to where you want to the group of windows to display and left-click to confirm the move.

¢ To resize a window, hover the mouse over the left, right, top, or bottom boundaries of the window until a double
arrow displays. Drag the mouse to resize the window. Or right-click the window tab and select Size>Left, Right,
Top, or Bottom. A blue line highlights the choice; drag to resize.
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* To maximize and restore a window’s original position, double-click a window tab to maximize it; double-click
again to restore it.

¢ Click the Minimize or Maximize button in the top-right corner or right-click the window tab and select Minimize
or Maximize from the list.

At any time, click the Reset desktop = button on the main toolbar. The
section Keyboard Shortcuts has additional shortcuts for all operating

[

systems.

VERTICAL OR HORIZONTAL WINDOW ORIENTATION (MAC AND LINUX)
After a window is minimized along the side of the Desktop, you also have the option to change the window

Orientation to Vertical (the default) or Horizontal when you click the window icon (see Figure 2-6).

[T Madel Builder =g

= Orientation 3 Harizontal

Restore @ | Vertical

Move 3

Size
Minimize
Maximize

Close

When you minimize a window, it is available from the side
of the Desktop. Click the button to view the window.

Figure 2-6: A minimized window is accessible from the side of the Desktop. Click the window icon to view it. You can
then right-click the window to Move, Size, Minimize or Maximize the window. You can also change the Orientation of
a minimized window to be Horizontal or Vertical when you click and view it on the Desktop in its minimized state.

e The COMSOL Desktop
& * The Model Builder
* Creating a New Model

The COMSOL Desktop Windows

The COMSOL Desktop windows, including those shown in Figure 2-1, are integral to building your model. The
windows listed in Table 2-1 are described throughout the documentation and the table includes links to this
information.

TABLE 2-1: COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK DESCRIPTION

BUILDING A MODEL

The Model Wizard Start building a model by choosing the Component
space dimension, physics interfaces, and study.

The New window Open the New window to begin modeling using the
Model Wizard to start with a Blank Model. See
Open a New Window to Begin Modeling.

The Model Builder Control the modeling procedure using the model
tree. This window has all the functionality and
operations for building and solving models and
displaying the results.
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TABLE 2-1: COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK

DESCRIPTION

The Graphics Window

The Material Browser Window

The Add Material Window

The Add Physics Window

The Node Settings Windows

The Selection List Window

The Measure window

RESULTS AND ANALYSIS
The Add Study Window
The Plot Windows

The Table window

The Messages Window

The Progress Window

The Log Window

The External Process Window

The Mesh Statistics Window

This window is a graphical view of the geometry,
mesh, and results of the model. It also has useful
tools to change the view and select multiple
geometric entities, for example.

Browse the material libraries and load materials into
your models.

Add predefined materials to models.
Add physics interfaces to models.

When a node is clicked in the Model Builder a
corresponding settings window opens with the same
name as the node. It is a window with settings that
define operations and properties specific to that
node.

Choose objects, for example, while working with
complex geometries and when you need to easily
locate a geometric entity that is not easily viewed.

A tool used to measure geometry objects and
entities. See Mecasuring Geometry Objects.

Add a study or studies to models.

Plot windows are also graphics windows. These plot
windows display convergence results and monitor
probe values while solving, for example.

Displays the results from integral and variable
evaluations defined in Derived Values nodes or by
Probes and stored in Table nodes. See The Table
Window and Tables Node.

Contains information useful after an operation is
performed.

Displays the progress of the solver or mesher during
the process, including a progress bar and progress
information for each solver or mesher.

Contains information from previous solver runs,
including convergence information, solution time,
and memory use.

Follow external processes (such as distributed batch
jobs) that have been started. The window updates
when you are attached to the external processes.

This window includes information about the
minimum and average mesh element quality and a
mesh element quality histogram, which shows the
relative frequency of mesh elements with different
quality values.

MODEL EXAMPLES AND DOCUMENTATION

The Model Libraries Window

The Model Library Update
Window

Displays all the models included with an installation.
The folders contain the models specific to the
installed module.

A service that provides new and updated models for
each of the model libraries of the COMSOL
products that your license includes.
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TABLE 2-1: COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK DESCRIPTION

HELP AND DOCUMENTATION

The Help Window and Provides access to context help in the COMSOL
Topic-Based Help Desktop.

The Documentation Window  Navigate to PDF or HTML versions of the
documentation (availability is based on your license),
as well as Search, Bookmark, Print Topics, and Link
with Contents.

The Root Window The root node is the top most level of the Model
Builder tree. When you click this node, the Root
window opens and includes detailed information
about the model file.

* Creating a New Model
The COMSOL Desktop
Gl. * COMSOL Documentation and Help

* Toolbars and Keyboard Shortcuts

The COMSOL Desktop Menus and Toolbars

The menus and toolbars available from the COMSOL Desktop vary slightly between operating systems. As
described in the section About This Release of COMSOL Multiphysics, the variations are subtle and the overall
functionality remains the same.

The sections Windows Toolbars and Menus and Cross Platform (Mac and Linux) Toolbars and Menus show

examples of the main terms and locations of the toolbars and menus.
The Model Builder Toolbar is the same for all platforms and is described in this section.

The Features Available on Toolbars and From Menus section details the available features and functions.

THE MODEL BUILDER TOOLBAR

The Model Builder toolbar is the same for all operating systems. It is located at the top of the window as shown in
Figure 2-7. The actions listed in Table 2-2 are used to navigate the Model Builder tree, to show and hide various
features, and to move back and forth in the tree.

Model Builder [T Model Builder

==~ T~ StE ® ST E

Figure 2-7: The Model Builder toolbar for Windows (left) and Mac and Linux (right). The only difference is in
appearance and how options ave selected for two of the buttons.

e The COMSOL Desktop
* Creating a New Model

@'l- * The Toolbars and Keyboard Shortcuts section has detailed information
about the contextual toolbars available on the COMSOL Desktop.
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Windows Toolbars and Menus

The available ribbon toolbar options are dynamic, based on where in the model you are working and what is
logically available for a specific task. When a blank model is created, only the default tabs are included (Home,
Definitions, Study, and Results). The Physics, Geometry, and Mesh tabs are added once a model and physics
interface are added to the Model Wizard, as shown in Figure 2-8.

The top of the COMSOL Desktop includes a customizable Quick Access Toolbar. Underneath this are ribbon tabs
and ribbon groups, which together, are referred to as toolbars, except for the Home ribbon, which is a collection of
frequently used features from all the other toolbars. For documentation purposes, a toolbar uses the same name as
the tab. For example, the Physics toolbar, Geometry toolbar, or Study toolbar. See The Model Builder Toolbar and
Features Available on Toolbars and From Menus for a detailed list of all the features available.

[ HE 6o B R BX 55| The Quick Access Toolbar displays above the
ribbon by default. Click the small arrow at the
E Home Definitions Geometry Physics  ond to customize the toolbar.

Home Definitions Geometry Physics Mesh Study Results

.i <<> Fi Parameters [ = Import ¥ 122 Mew Material \
.
a= Varisbles+ | "M galivelink * [ Add Material N ;
Component Add ] Build Browse Electric Add
1~ Component » | () Functions ~ All Materials Currents = Physics

DeEeEdR o BBH X E -

Figure 2-8: The Quick Access Toolbar can be positioned above or below the ribbons. You can also customize the toolbar to
include or exclude a variety of buttons.

CUSTOMIZE THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar has several default buttons that can be displayed above or below the ribbon. Click the
small arrow at the end of the toolbar to open the Customize the Quick Access Toolbar list. You can cither edit which
of the default buttons display directly from the list, or click More Commands to Add and Remove (or double-click to
add or remove) the buttons as detailed in the section Features Available on Toolbars and From Menus. This can

also be done in the The Preferences Dialog Box in the Quick Access Toolbar section.

DISPLAY THE QUICK ACCESS TOOLBAR ABOVE OR BELOW THE RIBBON
Right-click a ribbon to select Show Quick Access Toolbar Above the Ribbon or Show Quick Access Toolbar Below the
Ribbon. These options are also available from the Customize Quick Access Toolbar menu.

Select Minimize the Ribbon. To restore the ribbon, right-click anywhere in the top of the window and click Minimize

the Ribbon to deactivate it (remove the check mark).

MINIMIZE (HIDE) THE RIBBON

Right-click anywhere on a ribbon and choose Minimize the Ribbon to hide the ribbon on the Desktop. To access the
ribbon features, click the ribbon tab name (for example, Home, Definitions, or Study). The ribbon features are then
available. To restore the ribbon to the top of the Desktop, right-click in the tab name area and click to remove the

check mark next to Minimize the Ribbon.

Cross Platform (Mac and Linux) Toolbars and Menus

For cross platform users (primarily Mac and Linux), the Main Toolbar is similar to the Quick Access Toolbar for

Windows. In addition, there is a Model Toolbar and a variety of Contextual Toolbars available. These are a mixture of
drop-down menus and buttons for frequently used actions. For documentation purposes, a toolbar uses the same
name as the contextual toolbar. For example, the Physics toolbar, Geometry toolbar, or Study toolbar. See The Model
Builder Toolbar and Features Available on Toolbars and From Menus for a detailed list of all the features available.
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The Contextual Toolbar changes when you click a Definitions, Geometry, Mesh, Study, or Results node in the Model
Builder. The Model Toolbar and Contextual Toolbar are similar to the ribbon toolbars for a Windows operating

system.
You can also launch the cross-platform version on Windows using
g comsolxpl.exe.
Main menu Main toolbar Tools menu Model toolbar
File\ Edit Windows%}ptions Tools{lp /
™ m Q| ||f§-||! Component 1 V(QT)v|Pi a= - f | @ [E Cp - | 5t

};\ Geometry N.,': Physics /&, Mesh "o Study Results | | a= | o T M X v| R

Contextual toolbar displaying in Normal mode Definitions toolbar

Figure 2-9: The menn and toolbar options for cross platform users (usually Mac and Linux operating systems). Only
part of the Model Toolbar and Contextual Toolbars ave shown. When one of the buttons is clicked on this toolbar, the
associated toolbar opens, in this example for the Definitions node. This toolbar also opens when the Definitions node is
clicked in the Model Builder.

DISPLAY OR HIDE THE TOOLBARS FROM THE TOOLS MENU

From the Tools menu, you can choose to display or hide each toolbar. Select Main Toolbar, Model Toolbar, or
Contextual Toolbar to turn that toolbar on or off in the COMSOL Desktop. For the Toolbar Button Label, you can
also choose to Show Icon Only or Show Icon and Text. Finally, choose the Toolbar Display Mode as Normal or Compact.

Compact compresses some buttons on the Contextual Toolbar and Model Toolbar under menus instead.

OTHER USEFUL FUNCTIONS AVAILABLE FROM THE WINDOWS MENU
From the Windows menu there are also other useful functions:
* Open a variety of useful windows. See The COMSOL Desktop Windows for a list and links to applicable sections.

* From the Model Builder Node Label submenu, choose a way to label the nodes in the Model Builder. See Viewing

Node Names, Identifiers, Types, and Tags.

¢ From the Desktop Layout submenu, choose a Widescreen or Regular Screen layout, or Reset the Desktop. Sce
Customizing the Desktop Layout.

Features Available on Toolbars and From Menus

The features listed in Table 2-2 are often accessed from multiple locations. In general, the button or menu option
is located as follows, with some minor differences between Windows and the cross platform (Mac and Linux)
systems and as described in Windows Toolbars and Menus and Cross Platform (Mac and Linux) Toolbars and
Menus.

* The File menu. See Figure 2-8 (Windows) and Figure 2-9 (Mac and Linux).

¢ The Model Builder toolbar. See Figure 2-7.

e The Quick Access Toolbar (Windows only see Figure 2-8). Customize the toolbar to access some of the buttons
listed in the table.
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* Main Menu and a Main Toolbar (Mac and Linux, see Figure 2-9).

* Additional menus along the top of the Desktop—Edit, Windows, Options. Tools, and Help (Mac and Linux, see
Figure 2-9).

Cross platform generally implies Mac and Linux users. However, some
users may also decide to launch the cross-platform version on Windows

g

using comsolxpl.exe.

TABLE 2-2: FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON NAME DESCRIPTION OR LINK TO MORE INFORMATION

Creating Models

D New Open the New window to begin modeling using the Model
Wizard or start with a Blank Model. Also press Ctrl+N. See
Creating a New Model. For all users, this is available from the
File menu. It is also available on the Quick Access Toolbar
(Windows users) or the Main Toolbar (cross platform users).

Additional options are available when check boxes are enabled
on the Preferences dialog box under Builder Tools.

Opening and Saving Files

Open Open an existing model file located on the computer. Also
press Ctrl+O. For all users, this is available from the File menu.
It is also available on the Quick Access Toolbar (Windows
users) or the Main Toolbar (cross platform users).

— Recent and From the File menu, select a recent model file to open. For
Recent File Windows users, the file is selected from the Recent submenu.
For cross platform users, the most recent files are listed at the
bottom of the list.

Windows users can also customize the Quick Access Toolbar
to access this button [z .

il Model Libraries  Open The Model Libraries Window window.

For Windows users, this is available on the Home ribbon or
from the File menu. You can also customize the Quick Access
Toolbar and then click the button.

For cross platform users, this is available on the Main Toolbar
or from the Windows menu.

o] Open Recovery  COMSOL can store recovery files each time you start a solver.
File This is a preference setting that is initially active by default. For
all users, this is available from the File menu. It is also available

on a customized Quick Access Toolbar (Windows users).

See Saving and Opening Recovery Files.

Revert to Saved  Opens the last saved version of the file and reinitializes the GUI.
For all users, this is available from the File menu. It is also
available on a customized Quick Access Toolbar (Windows
users) or the Main Toolbar (cross platform users).

See Reverting to the Last Saved Model File.
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TABLE 2-2: FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON  NAME DESCRIPTION OR LINK TO MORE INFORMATION

Q Save Save the current model file. Also press Ctrl+S. For all users, this
is available from the File menu. It is also available on the Quick
Access Toolbar (Windows users) or the Main Toolbar (cross
platform users).
See Saving COMSOL Model Files.

E| Save As Choose to save in one of three COMSOL model file formats.

Client Server

ch
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=

41

Model Builder Toolbar

(i 11

=t

El

Connect to
Server

Disconnectfrom

Server

Import Model
from Server

Remove Model
from Server

Previous node

Next node

Expand sections

Show

Collapse all
Expand all

The Save dialog box opens and from the Save as type list select:
COMSOL Multiphysics Model File (*.mph) (the default), Model
file for Java (*.java), or Model file for MATLAB (*.m).

For all users, this is available from the File menu. It is also
available on the Quick Access Toolbar (Windows users).

See About the COMSOL Model File Formats.

To connect to a server from the COMSOL Desktop. For all
users, this is available from the File>Client Server menu. It is
also available on a customized Quick Access Toolbar (Windows
users).

See Connecting to a Server.

To close the connection to the server or MATLAB. For all
users, this is available from the File>Client Server menu. It is
also available on a customized Quick Access Toolbar (Windows
users).

See Disconnecting from a Server.

To import a particular model when working with MATLAB,
Excel, or the COMSOL API. For all users, this is available from
the File>Client Server menu. It is also available on a customized
Quick Access Toolbar (Windows users).

See Working with MATLAB, Excel, or the COMSOL APL

To delete models (remove them from the server) that you have
created using ModelUtil. For all users, this is available from
the File>Client Server menu. It is also available on a customized
Quick Access Toolbar (Windows users).

See Working with MATLAB, Excel, or the COMSOL APL

Navigate back to the last node previously selected or to the
next node in the sequence. See also Keyboard Shortcuts.

Click to select an option from the list. See Advanced Physics
Sections and Showing and Expanding the Equation Sections
and Equation Node.

Click to select an option from the list. See Advanced Physics
Sections and Show More Physics Options.

Click to collapse or expand all nodes in the model tree, except
the top nodes on the main branch.
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TABLE 2-2: FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON

NAME

DESCRIPTION OR LINK TO MORE INFORMATION

Undo, Redo, Copy, Paste, Duplicate, and Delete

AP,
c

n

B

Other

e

el

Undo
Redo

Copy

Paste

Duplicate

Delete

Select All

Clear Selection

Compact
History

Reset Desktop

Undo and Redo the last operation for some operations (such as
adding, disabling, moving, and deleting nodes in the Model
Builder) as well as changing values in the settings window. Also
press Ctrl+Z (Undo) or Ctrl+Y (Redo).

For Windows users, this is available on the Quick Access
Toolbar.

For cross platform users, this is available on the Main Toolbar
or from the Edit menu.

See Undoing and Redoing Operations.

Copy, paste, and duplicate some features. Also right-click a
node to select one of these options from the context menu.

For Windows users, this is available on the Quick Access
Toolbar.

For cross platform users, this is available on the Main Toolbar
or from the Edit menu.

See Copying, Pasting, and Duplicating Nodes.

Delete some nodes while building a model. Also press the Del
key or right-click a node to select this option from the context
menu.

For Windows users, this is available on the Quick Access
Toolbar.

For cross platform users, this is available on the Main Toolbar
or from the Edit menu.

See Clearing Sequences and Disabling, Enabling, and
Deleting Nodes.

To select all or clear the selection of all geometric entities in
the Graphics window, click the Select All or Clear Selection
buttons, respectively.

For Windows users, this is available on the Quick Access
Toolbar. For cross platform users, this is available from the Edit
menu.

See Selecting and Clearing Selection of Geometric Entities.

The model files for Java and for MATLAB contain the entire
history of the model, including settings that are no longer part
of the model. For all users, this is available from the File menu.
It is also available on a customized Quick Access Toolbar
(Windows users).

See Compacting the Model History.

Set the COMSOL Desktop back to widescreen or regular
screen, or it reset to default settings.

For Windows users, this is available on the Home ribbon,
Layout menu. You can also customize the Quick Access Toolbar
and then click the button.

For cross platform users, this is available on the Main Toolbar
or from the Windows>Desktop Layout menu.

See Customizing the Desktop Layout.
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TABLE 2-2: FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON

NAME

DESCRIPTION OR LINK TO MORE INFORMATION

T

Licensed and
Used Products

Preferences

Open the Licensed and Used Products window to list or block
the products your license includes. See Checking and
Controlling Products and Licenses Used.

For Windows users, this is available from the File menu. You
can also customize the Quick Access Toolbar and then click the
button.

For cross platform users, this is available from the Options
menu.

To make changes to how items are displayed or available
throughout COMSOL. See Preferences Settings.

For Windows users, this is available from the File menu. You
can also customize the Quick Access Toolbar and then click the
button.

For cross platform users, this is available from the Options
menu.

Help and Documentation

b

Documentation

Help

Support Center

Training

Check for
Product
Updates

Update the
COMSOL
Model Library

About
COMSOL
Multiphysics

Open the Documentation. Also press Ctrl+FI.
For Windows users, this is available from the File>Help menu.

For cross platform users, this is available on the Main Toolbar
or from the Help menu.

See COMSOL Documentation and Help.

Open the context Help. Also press FI. See COMSOL
Documentation and Help.

For Windows users, this is available from the File>Help menu
or in the upper right-corner of the Desktop.

For cross platform users, this is available on the Main Toolbar
or from the Help menu.

Go to the online Support Center on the COMSOL website.
For Windows users, this is available from the File>Help menu.
For cross platform users, this is available from the Help menu.
Go to the Training page on the COMSOL website.

For Windows users, this is available from the File>Help menu.
For cross platform users, this is available from the Help menu.
For Windows users, this is available from the File>Help menu.
For cross platform users, this is available from the Help menu.
See Checking for Product Software Updates.

For Windows users, this is available from the File>Help menu.
For cross platform users, this is available from the Help menu.
See The Model Library Update Window.

For Windows users, this is available from the File>Help menu.
For cross platform users, this is available from the Help menu.
See The About COMSOL Multiphysics Box.
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The Messages Window

The Messages window ([ ) displays by default and contains information useful to you after an operation is
performed.

The information in this window includes:

* Details about opening and saving models such as MPH-files.
¢ Information about geometry objects imported from CAD files.
* On the Mesh and Geometry toolbars, click the Measure (;—;) button to view information about:

- The geometry finalization (forming a union or an assembly) and about the number of geometric entities

(domains, boundaries, and so on) in the finalized geometry.
- The number of mesh elements and degrees of freedom in the model.
¢ Solution times.

* Error messages. The messages are in chronological order and can be scrolled through.
To open the Messages window:

e From the Home ribbon (Windows users) select More Windows>Messages.
e From the main menu (Mac and Linux users) select Windows>Messages.

* To clear the window of all messages, click the Clear button ( }, ).

* Meshing
El. * Geometry Modeling and CAD Tools

e Studies and Solvers

About the COMSOL Model File Formats

There are three COMSOL model file formats: MPH-files, model files for Java, and model files for MATLAB.

THE ROOT NODE

When you first open or create a new model, the 700z node is the topmost level of the tree. By default, unnamed
files are called Untitled.mph. The file name changes when the file is saved for the first time, but the root node
identifier does not change for this top level node. See The Root Window for details about the settings available
when this node is clicked.

COMSOL MPH-FILES
The default standard file format with the extension .mph. The files contain binary and text data. The mesh and
solution data are stored as binary data, while all other information is stored as plain text.

You can quickly save and load MPH-files. All the models in the COMSOL Multiphysics model library and the
model libraries in the modules are MPH-files.

The MPH-files in the COMSOL model library can have two formats:

Full MPH-files include all meshes and solutions. In the Model Libraries window these models appear with the
icon ¢ . If the MPH-file’s size exceeds 25MB, a tooltip with the text “Large file” and the file size appears when
you position the cursor at the model’s node in the Model Libraries tree.

Compact MPH-files include all settings for the model but have no built meshes and solution data to save space
(a few compact MPH-files have no solutions for other reasons). You can open these models to study the settings
and to mesh and re-solve the models. It is also possible to download the full versions—with meshes and
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solutions—of most of these models through Model Library Update (see The Model Library Update Window).
In the Model Libraries window these models appear with the icon & If you position the cursor at a compact
model in the Model Libraries window, a No solutions stored message appears. If a full MPH-file is available for

download, the corresponding node’s context menu includes a Download Full Model item ( & ).

File Locking

Only one user can open and edit an MPH-file at the same time. If you try to open an MPH-file that is already open
in another user’s COMSOL Desktop, that MPH-file is locked, and you get an option to open the MPH-file in a
read-only mode (click Open As Read-Only). That means that you can edit the model but you cannot save it unless
you save the MPH-file under another name. When an MPH-file is locked, COMSOL creates a separate lock file
with the same filename as the MPH-file plus the extension . lock, stored in the same directory as the locked
MPH-file. If a lock file remains after all COMSOL Desktop sessions have ended (which can happen if the
COMSOL Desktop session is ended in a nonstandard way), you can reset the lock when trying to open the file the
next time by clicking Reset Lock and Open.

Linux and Macintosh do not support operating system locking of files.
On those platforms, locking is supported to help users avoid editing the

[

same COMSOL model file, but it is possible to ignore the file locking and
delete the lock files.

MODEL FILES FOR JAVA
Editable script files that contain sequences of COMSOL commands as Java code (see the COMSOL API Reference
Manual for more information about these commands). You can compile these Java files and run them as separate

applications. Edit the files in a text editor to add additional commands.

MODEL FILES FOR MATLAB

Model files for MATLAB are editable script files (M-files), similar to the model files for Java, for use with MATLAB.
A model file for MATLAB contains a sequence of COMSOL commands as an M-file. You can run these model files
in MATLAB like any other M-file scripts. You can also edit the files in a text editor to include additional COMSOL

commands or general MATLAB commands.

Running model files in the M-file format requires LiveLink™ for
MATLAB®.

[

* The Model Libraries Window
e Saving COMSOL Model Files

Q * Reverting to the Last Saved Model File
* Printing and Capturing Screen Shots

e Saving and Opening Recovery Files

Saving COMSOL Model Files

The following options are selected from different menus and toolbars as described in The COMSOL Desktop

Menus and Toolbars.
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SAVING A NEW MODEL

If this is the first time saving a model or you want to update the file and keep the current name and format, in
general, these are the ways to save a model:

* Click the Save button ([_]) on the Quick Access Toolbar or Main Toolbar.

e Press Ctrl+S.

¢ Select File>Save.

CREATING A COPY USING SAVE AS

If the model has been saved before and you want to create a copy you can choose to save in one of three COMSOL
model file formats (see COMSOL MPH-Files, Model Files for Java, and Model Files for MATLAB).

Select File>Save As. The Save dialog box opens and from the Save as type list select: COMSOL Multiphysics Model File
(*.mph) (the default), Model file for Java (*.java), or Model file for MATLAB (*.m).

In all cases, navigate to a the location where you want to save the model, enter a File name, and then click Save.

You can add the author to the header of model files for Java and for
MATLAB that are saved. Open The Preferences Dialog Box and under
General>History export, sclect the Include author check box.

|_i'|.

REVERTING TO THE LAST SAVED MODEL FILE
To open the last saved version of the file and reinitialize the GUI: Select File>Revert to Saved ( E’." ). For Windows

users, you can also customize the Quick Access Toolbar and then click the Revert to Saved ([5') button.

COMPACTING THE MODEL HISTORY

The model files for Java and for MATLAB contain the entire history of the model, including settings that are no
longer part of the model. To compact the model history so that the files only include the settings that are part of
the current model, select File>Compact History. For Windows users, you can also customize the Quick Access

Toolbar and then click the Compact History ( =) button.

=

e About the COMSOL Model File Formats
¢ Windows Toolbars and Menus
'El ¢ The Root Window

* Printing and Capturing Screen Shots

Saving and Opening Recovery Files

COMSOL can store recovery files each time you start a solver. This setting is initially active by default.

To open a recovery file, select File>0pen Recovery File (""E| ). For Windows users, you can also customize the Quick
Access Toolbar and then click the Open Recovery File (£z]) button. See Windows Toolbars and Menus.

The update of the recovery file occurs at the following events:

¢ After completing the solution for each time step specified as the output times in the Times field for a
time-dependent simulation.
* After completing each parameter step in a parametric simulation.

* After completing each successful Newton iteration for a nonlinear stationary simulation.
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The recovery files are COMSOL MPH-files that represent the state at the time that they were saved. They make it
possible to recover from a solver error, which can be especially useful for long time-dependent or parametric runs.

The Open Recovery File dialog box lists all recovery files found in chronological order. The files are listed with the
date and time when they were saved. When a recovery file is selected, click OK to open it in the COMSOL Desktop.

Click Delete to remove the selected recovery file. Click the Delete All button to delete all recovery files.

COMSOL keeps track of the computed time steps or parameter steps in the recovery file, so right-click the Study
node and select Continue (== ) to continue the computation from the point where it was stored in the recovery file.
If you are solving a stationary nonparametric problem, the last converged Newton iteration is stored in the recovery
file; selecting Continue causes the software to resume solving from this stored state.

You can make changes these default settings in The Preferences Dialog Box in the Temporary Files section.
* The Save recovery file check box is selected by default to save recovery files to disk during the solution process
for time-dependent, parametric, and nonlinear solvers. Click to clear as required.

* In the Folder for recovery files ficld, you can specify a different folder from the default to, for example, use a folder

where there is more disk space for storing large recovery files. Click Browse to browse to a recovery file folder.

¢ In the Folder for temporary files ficld you can specify a different folder than the default to, for example, use a
folder where there is more disk space for storing large temporary files. Click Browse to browse to a folder for

temporary files.

e Ifyou run COMSOL in a client-server configuration, you can specify a Folder for recovery files on server, Folder

for temporary files on client, and Folder for temporary files on server.

El. Studies and Solvers

The Root Window

The root node is the topmost level of the Model Builder tree. When you click this node, the Root node (i)
settings window opens and includes detailed information about the model file. Some of the fields can be edited
directly in this window, while others display system information that cannot be changed, or information that
changes as updates are made throughout the model (for example, adding a model thumbnail and saving a file with

a new name).

When you first open or create a new model, the 700z node is the top most
level of the tree. You can change a file name by saving the file, but the root

node identifier, tag, or type cannot be changed for this top level node.

[

This is different than for other nodes in the tree, where these can be
edited. See Viewing Node Names, Identifiers, Types, and Tags for
information.

NODE PROPERTIES
¢ Name: The file name and file type as determined when the file is saved. See Saving COMSOL Model Files. This

field cannot be edited, but the name changes if the file is renamed, for example.

¢ Path: The file location where a file is saved. This field cannot be edited, but is automatically updated when the
file is saved to a new path. Also see Documentation and Model Libraries Root Directories.

e COMSOL version: Includes the version and build of COMSOL. This is system generated.
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¢ The Tag is system generated and at this top level it is Mode1. The number that displays is dependent on how many
file models have been opened in the COMSOL instance. That is, every time COMSOL Multiphysics is

relaunched, this tag resets to 1.

¢ Created and Last modified: These sections cannot be edited and are automatically generated based on the
computer system or network time and date settings.

* Last modified by, Author: Enter a name of the author of the model.

* License number: The license number of the installed software is included here. Also see The About COMSOL
Multiphysics Box.

* Model version: Enter a tracking version number for the model, for example, Internal Draft V1, Sales
Demonstration V2, or Version B.

¢ Model description: Enter any text, for example, a description of the model.

USED PRODUCTS

The information included here is based on the purchased license or modules. See Checking and Controlling
Products and Licenses Used. Also see The About COMSOL Multiphysics Box.

MODEL THUMBNAIL

To illustrate the model you can save a model thumbnail image that displays in this section and when opening a
model in the Model Libraries window. The model thumbnail is a copy of the current plot. See Setting the Model
Thumbnail Image for a Model.

UNIT SYSTEM
The default unit system is SI units. Or select any other option from the list. See Unit Systems in COMSOL and
Setting the Unit System for Models to change the setting globally or locally.

FONT
The default is to use a predefined default font with a font Size of 9 points. Depending on the operating system and
the installed fonts on the computer, you can select from a number of other font families. See Changing the Font

for Plot Labels and Titles to make global changes.

Unit Systems in COMSOL

COMSOL supports the following unit systems:

METRIC UNIT SYSTEMS

 SI units, the International System of Units (SI, Syst¢eme International d’Unités). This is the default unit system
(sometimes also called MKS). For a list of SI units in COMSOL, see SI Base, Derived, and Other Units.

* CGSA units. The CGS system uses centimeter, gram, and second as basic units of length, mass, and time,
respectively. The remaining basic units are identical to the SI units. The CGS unit system gives nice values for
small lengths, masses, forces, pressures, and energies when working on a microscale and with weak
electromagnetic forces. The derived units of force, pressure, and energy have well-known and widely used names:
dyne, barye, and erg, respectively. CGSA adds ampere as the basic unit for electric current. For a list of CGSA
units, see Special CGSA Units.

¢ Electromagnetic units (EMU). This system is based on Ampere’s law, which defines the unit of electric current
once you select an appropriate value for the constant C. When dealing exclusively with magnetic effects, it is
convenient to set C = 1. If CGS units are used for the remaining basic dimensions, the current unit is called an
abampere, and the corresponding coherent unit system is called electromagnetic units. Unique names for
derived units have been introduced by prefixing the SI name with #4-. For a list of EMU units, see Special EMU
Units.
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Electrostatic units (ESU). Based on Coulomb’s law for the force between point charges, ESU uses a unit of
charge called the statconlomb with CGS units for length, mass, and time. From there, the statampere, or
franklin, and other derived units of the electrostatic unit system follow. For a list of ESU units, see Special ESU
Units.

MPa units. For stationary structural mechanics, where the density does not appear in the equations, it can be

convenient to use a system where newton and megapascal (hence the name “MPa system”) are naturally derived
units of force and pressure, respectively. Keeping the SI unit for time, the basic units of length and mass become
millimeter and tonne. Except for the force and pressure units, other derived units are nameless. For a list of MPa

units, see Special MPa Units.

ENGLISH UNIT SYSTEMS

Foot-pound-second unit system (FPS units). The original foot-pound-second system seems to be the absolute
system using the pound as a unit of mass. This version of the FPS system is in agreement with the IEEE standard
(the pound is a unit of mass and not of force). The natural derived unit of force is the poundal. For a list of FPS
units, see Special FPS Units.

British engineering units. An alternative to the standard FPS system is the British engineering unit system (also
called gravitational foot-pound-second system or foot-slug-second system). Here, the pound force is the natural
unit of force, which causes the introduction of the mass unit s/zg such that a pound force is a slug-foot per second
squared. For a list of British engineering units, see Special British Engineering Units.

Inch-pound-second unit system (IPS units). It is possible to define varieties of the FPS and British engineering
systems based on the inch instead of the foot as basic unit of length. This gives rise to two distinct
inch-pound-second systems: the absolute IPS system (just called IPS) and the gravitational IPS system. For a
list of IPS units, see Special IPS Units.

Gravitational IPS units. This alternative IPS unit system considers the pound a unit of weight rather than a unit
of mass. For a list of Gravitational IPS units, see Special Gravitational IPS Units.

OTHER

None. No units appear in the settings, which can be useful in nondimensionalized (de-dimensionalized or
dimensionless) models.

e Using Units
Gl. * Setting the Unit System for Models
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The Model Libraries window (Figure 2-10) contains sets of models that can be used for a variety of purposes. Each
add-on module includes its own model library with models showing how to use the module within its application
areas. Each model includes full model documentation and a brief model description, including the solution times

and information about the computer used for solving the model.

Model Libraries Eigenmodes of a Room

Search |

4 Y8 COMSOL Multiphysics
4 [ffl Acoustics
=) automotive muffler
® cigenmodes of room
[l Chemical Engineering
[fli] Diffusion
[l Electromagnetics
[ifll Equation-Based Models
[l Fluid Dynamics
[ifl Geophysics
[ifil Heat Transfer
[ill Meshing Tutorials
[l Muttiphysics
[fli] Structural Mechanics
[ifil Tuterial Models
% ACDC Medule
i) Acoustics Mocule

This medel simulates standing acoustic waves in a reom with furniture. The
eigenmades differ slightly from the exact solution for an empty raom.

E Open Model @ Open PDF Document ~ Properties

] Name eigenmades_of_room
Open Model and PDF Created in COMSOL 4.4 (Build: 142)
Used products  COMSOL Multiphysics
Physics Pressure Acoustics, Frequency Domain

Solutiontime 11 seconds
Help €9 Cancel s ST

Related dates
Last modified Now 14, 2013 2:35:47 PM
Created MNov 14, 2013 2:35:09 PM

Solved on: Intel(R) Xeon(R) CPU X5550 @ 2.67GHz, 8 cores

Related people
Author COMSOL
Last modified by COMSOL

Figure 2-10: The Model Libraries window with Eigenmodes of a Room highlighted in the model tree. Specific
information about the model is displayed to the right, including the model name, its size, and the solution time.

Browse through the Model Libraries tree to see what models are available for your license. Click to highlight the
model in the tree and read the information about it to the right or search for a specific model.

To open the Model Libraries window:
* From the Home ribbon, click Model Libraries ( [[!] ). When a toolbar is
compressed, you sometimes select it from the Windows> menu.

* You can also customize the Quick Access Toolbar and then click the
Model Libraries ( []]] ) button on the toolbar. See Windows Toolbars and

Menus.

¢ Select Model Libraries from the File menu.

To open the Model Libraries window:

* On the Main Toolbar, click the Model Libraries ( ][ ) button.

nux ¢ Sclect Windows>Model Libraries.
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The following sections describe what you can do from the Model Libraries window:

¢ Opening a Model and its Documentation
* Downloading a Full Model

* Searching the Model Libraries

* The Model Library Update Window

You can also set the root directory and create and remove a user-defined model library using the The Preferences

Dialog Box as described next.

MODEL LIBRARIES PREFERENCES
Open The Preferences Dialog Box and click Model Libraries to edit the following. The buttons are located at the
bottom of the Model Libraries folders tree.

Add User Model Library
Click the Add User Model Library button ( @]] ) to add customized folders. In the User Model Library tree in the Browse
for Folder dialog box, navigate to a location on your computer where you want to create a custom model library

folder. Or click Make New Folder. Click Apply to save the changes, or Cancel to exit without saving.

It is not possible to add a library identical to, containing, or being
]
E contained in, any already used library.

Set the Model Library Root
Click the Set Model Library Root button ( &Tﬂ ) to edit or set the root folder. This redirects COMSOL to a different
folder where customized models can be stored.

In the Model Library Root tree in the Browse for Folder dialog box, navigate to the new root folder location or click

Make New Folder. Click Apply to save the changes, or Cancel to exit without saving.

Remove Selected Model Library
This button is enabled after a User Model Library folder is created. Click any model or folder and then the click

Remove Selected ( ;=) button to remove it from the Model Library.

Opening o Model and its Documentation

There are two model formats to choose from in the tree, full and compact.
Some models might have been delivered with an MPH-file that contains

n no stored meshes or solutions. Such compact models are indicated by the
icon . See Downloading a Full Model.

OPENING A MODEL IN COMSOL MULTIPHYSICS
Once you have located the model you want to open, for example you used a search and it is successful (see Searching

the Model Libraries), or you browsed the Model Libraries tree, to open the model:

¢ Double-click the model name in the tree.
e Sclect the model name, then click ( [#| ) Open Model.

¢ Right-click the model name, then from the context menu select Open Model.
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OPENING A MODEL PDF DOCUMENT

To read the model documentation in PDF format, including step-by-step modeling instructions:

* Click to highlight the model name in the tree, then ( =] ) Open PDF Document.

* Right-click the model name, then from the context menu select (@ ) Open PDF Document.

OPENING A MODEL AND ITS PDF DOCUMENT SIMULTANEOUSLY

To open a model and its model documentation PDF document in a single operation:

* Click to highlight the model name in the tree, then ( ) Open Model and PDF.

* Right-click the model name, then from the context menu select (ﬁ'ﬂ) Open Model and PDF.

Downloading a Full Model

You can download the complete MPH-files via Model Library Update (see The Model Library Update Window), or

right-click a compact model node ( =] ) in the Model Libraries tree and choose & Download Full Model.

4 '3 COMSOL Multiphysics
4 m]] Acoustics
=) automotive muffler

® eig Open Model
m]] Chemn
[ Diffusi o) Open PDF Document
[ Electrq £ Open Model and PDF
m]] Equati
L)
[l Fluid @ Download Full Model
[l Geoph Help F1
m]] Heat Trarsrer
[l Meshing Tutorials

You can also generate the complete models by building the mesh sequences and computing the studies.

The procedure for restoring the solutions of a model can involve other

steps, such as adjusting physics settings. See the individual model

[

documentation for details if the simple approach does not work.

Searching the Model Libraries

You can Search the model libraries to find any models using a specific feature. For example, enter all or part of the
model name, a physics interface name, a feature name, a feature tag name, or identifier prefixed by ‘@”. or any other

phrase or words or and click Search.

By default, COMSOL searches for all words in the Search field.

COMSOL models are named using an underscore between words (for
example, effective_diffusivity) because the model name is also the
name of the corresponding Model MPH-file. The underscore is required

to form a valid filename, so it is reccommended that you, if you are not sure

2!

of the full name, enter only the first word in the Search ficld when

searching for a model name.
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SEARCH PARAMETERS

* To search for models by filename only, use the prefix “@name:”, for example @name : busbar. You can also use
the wildcard character “*” at the beginning and the end of the search expression, for example @name: fluid* or
@name:*electr*.

» To search for a phrase, enclose it in quotation marks (for example, “plane stress”). The words can be part of

the model’s name or its documentation.

¢ Limit the search to tag names and identifiers with the prefix ‘@, for example, @genext or @ehs.

* To search for a specific physics interface, use the scoping syntax @physics:<identifier>. For example, enter
@physics:solid to find all models that use the Solid Mechanics interface.

* In addition to @physics, the supported scopes include @geom, @mesh, @probe, @result, @selection, and
@study.

If the search does not return any results, the Model Libraries window contains the message No Matching Model
Found. Click the Refresh button ( (™ ) to return to the root Model Libraries folder list.

If you have any feedback or suggestions for additional models for the
libraries (including models you developed), feel free to contact COMSOL

[

at info@comsol.com.

The Model Library Update Window

Using the Model Library Update service requires Internet access. For a
default installation, you also need to run COMSOL as an administrator.
See Proxy Server Settings for Communication with COMSOL's Model

[

Library Update Server section for instructions on how you can modify

your installation to avoid this restriction.

Update COMSOL Model Library is a service that provides new and updated models for the model libraries of the
COMSOL products that your license includes.

To open the Model Library Update window from the File>Help menu (Windows users) or from the Help menu (Mac
and Linux users), select Update COMSOL Model Library (,rgﬂ] ).

When the Model Library Update window ( J[f] ) opens, click to select Full models or Compact models. Click Find
Models to check to see if all these models are up-to-date. If the message Your Model Library is up to date displays,

no updated or new models are available.

If the library is not up-to-date, browse the list of new and updated models that appear with a description and image.
Choose which models to download by selecting or clearing the check boxes next to the model thumbnail images.
By default all check boxes are selected; by clicking Uncheck all and Check all you can change the global selection state.

Click the Download Selected button to download the selected models, or click the Download All button to download
all available models. The download time depends on the size of the files, which is listed for each model, and the

bandwidth of the Internet connection.

PROXY SERVER SETTINGS FOR COMMUNICATION WITH COMSOL'S MODEL LIBRARY UPDATE
SERVER

To edit these settings, open The Preferences Dialog Box and go to the Updates section.
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If you connect to the Internet through a web proxy, you can use the controls in this section to specify the proxy
server settings to use when communicating with the COMSOL website for performing a Model Library Update.

The Configuration list has the following options:

* No proxy server: Connect to the Model Library Update server directly, bypassing any proxies. This is the default
setting.

* Use system settings: Use the system-wide proxy server settings defined on your computer.

¢ Manual: Choose this alternative if you want to specify a proxy server by entering the name (or IP address) and
port number in the Server and Port number ficlds. The default port number is 443, which is the default for HTTP
secure (HTTPS). If the proxy server requires authentication, you are asked to provide username and password

the first time you run Model Library Update in each COMSOL session.

PLACE MODEL LIBRARY UPDATE FILES IN

To edit these settings, open The Preferences Dialog Box and go to the Updates section.

The Destinations list provides two options for specifying which model and documentation directories are
synchronized with the COMSOL server when you launch a Model Library Update request:

* Current model and documentation directories (default): Synchronize with MPH-files under the Model Library
root set in the Model Libraries window and with model documentation files under the directory specified in the
Documentation root directory ficld on the Preferences dialog’s General page.

* Specify custom directories: Choosing this option lets you specify model and documentation root directories

separate from those of your current COMSOL Desktop environment.

By default, both the model library and documentation root directories lie directly under the COMSOL installation
root directory, in models/ and doc/, respectively. This typically implies that special permissions are required for
saving downloaded files, and it can therefore be beneficial to move or copy the directories to a different location.
The settings referred to in this section are provided to let you customize Model Library Update to the IT

environment of your organization.
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The Physics Interfaces

This section is an overview of the core physics interfaces included with a COMSOL Multiphysics license. If you

have an add-on module, there are additional physics interfaces described in the individual documentation.

* Building Models in the Model Builder
The Add Physics Window
'& * Modeling Guidelines

* Creating a New Model

Introduction to the Physics Interfaces

Solving PDEs generally means you must take the time to set up the underlying equations, material properties, and
boundary conditions for a given problem. COMSOL Multiphysics, however, relieves you of much of this work.

The software provides a number of physics interfaces that consist of nodes and settings that set up the equations
and variables for specific areas of physics. An extensive set of physics-dependent variables makes it easy to visualize

and evaluate the important physical quantities using conventional terminology and notation.

Suites of physics interfaces that are optimized for specific disciplines

together with specialized model libraries are available in a group of

optional products. See The COMSOL Modules and Interfacing Options.

A complement to the interfaces for physics, special interfaces for equation-based modeling simplify the setup of
PDEs for modeling that does not explicitly refer to any particular application field. In addition, other interfaces
supplement the physics with special functionality such as the Sensitivity and Moving Mesh user interfaces.

* Physics Groups
'El. e Physics Guide

* Seclecting Physics

Physics Groups

The Select Physics page in the Model Wizard, as well as The Add Physics Window, contain the main groups of physics

and mathematics interfaces as in Table 2-3(some items only display if a license includes the add-on modules).

TABLE 2-3: PHYSICS GROUPS

ICON  BRANCH NAME DESCRIPTION OF PHYSICS IN THE BRANCH

o Recently Used Contains the most recently used interfaces for easy
access.

X AC/DC Low-frequency electromagnetics such as electrostatics

and electric currents.

il Acoustics Acoustics.
At Chemical Species Chemical species transport by, for example, convection
Transport and diffusion, solving for the species concentrations.
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TABLE 2-3: PHYSICS GROUPS

ICON BRANCH NAME DESCRIPTION OF PHYSICS IN THE BRANCH

Ur Electrochemistry Electrochemistry and modeling of electrochemical
components such as batteries and fuel cells. This branch
is only available if a license includes the Batteries & Fuel
Cells Module, the Electrodeposition Module, or the
Corrosion Module.

Fluid Flow Fluid flow such as laminar single-phase flow and, with
add-on modules, multiphase flow and turbulent flow.

Heat Transfer Heat transfer in solids and fluids and thermal
multiphysics applications such as Joule heating.

|:-|-- Optics Physics interfaces for electromagnetic wave propagation
in linear and nonlinear optical media for accurate
component simulation and design optimization. This
branch is only available if a license includes the Wave
Optics Module.

@ Plasma Plasma modeling. This branch is only available if a
license includes the Plasma Module.

'Eﬁ'—'f" Radio Frequency High-frequency electromagnetic field simulations solving
the full Maxwell equations. This branch is only available
if a license includes the RF Module.

[ -] Structural Mechanics Structural mechanics, studying displacements and
stresses in solids, for example.

e Semiconductor The Semiconductor interface solves Poisson’s equation
for the electric potential and the drift-diffusion
equations for electrons and holes in a semiconductor
material.

Au Mathematics Mathematics interfaces for solving PDEs, ODEs, and
DAEs, for optimization (requires the Optimization
Module) and sensitivity analysis, and for modeling
moving meshes and parameterized geometry.

* Creating a New Model
'El * Physics Guide

e Seclecting Physics

The Add Physics Window

The Add Physics window is similar to the Select Physics page accessed through The Model Wizard. It has the same

physics interfaces available. This window is a quick way to add physics to models.

To open the Add Physics window:

* Right-click a Component node and choose Add Physics.

e From the Home ribbon, click Add Physics by

Win * Seclect More Windows>Add Physics.

e From the Physics toolbar, click Add Physics =

.
o)

76 | CHAPTER 2: THE COMSOL MODELING ENVIRONMENT



* Right-click a Component node and choose Add Physics.

* On the Model Toolbar click Add Physics :«ﬂr-;

¢ On the Physics Contextual Toolbar, click Add Physics @

-
w
Linux

¢ Select Windows>Add Physics.

The Add Physics #27 toolbar button is a toggle button: Click it again to close the Add Physics window.

TO ADD PHYSICS TO A MODEL COMPONENT
I In the Add Physics window, either enter a Search term or navigate the tree to locate the physics interface to be
added to the Component.

The tree organizes the available physics interfaces by application areas such as fluid flow, heat transfer, and structural
mechanics. The physics found in the modules your license supports display in the different application areas. In

some cases, licensing of'a module adds physics interfaces to these application areas as well as attributes to existing
physics interfaces, which are enhanced with additional functionality. The (T) Recently Used branch lists the last five
physics interfaces used in recent modeling sessions. You can also enter a text string in the search field and click the

Search button to list all the interfaces with the search term.

The contents of the Add Physics window depends on the space dimension

of the active model component. If there are no Component nodes in the

[

model, the list of physics interfaces is empty.

2 Once a physics interface is clicked, review and optionally modify any dependent variable names in the Dependent
variables section and, for some physics interfaces, specify the number of dependent variables.

3 When there is already a physics interface added to the Component, the existing Studies are listed under Physics
in study. Studies that are included appear with a check mark (4 ) in the Solve column. Click in the column and
row to change the check mark to an ( % ).

4 Click the Add to Component or Add to Selection buttons.

- If Add to Component is sclected, the physics interface is added to the Model Builder and becomes active in the

entire model component’s geometry by default.

- If Add to Selection is chosen, the physics is added to the selected geometric entities in the Graphics window

and a new node is added to the Model Builder. This is a method called preselection.

* Creating a New Model
'El e Physics Guide

THE PHYSICS INTERFACES | 77



78 |

Physics Guide

The table lists the physics in COMSOL Multiphysics and the availability for 1D, 1D axisymmetric, 2D, 2D

axisymmetric, and 3D geometries.

INTERFACE ICON  TAG SPACE AVAILABLE PRESET STUDY TYPE
DIMENSION
‘_; AC/DC
Electric Currents x ec all dimensions  stationary
Electrostatics x es all dimensions  stationary; time dependent
Magnetic Fields n mf 2D, 2D stationary; frequency domain
axisymmetric
i1l Acoustics
(71111 Pressure Acoustics
Pressure Acoustics, Frequency Domain (i acpr all dimensions  eigenfrequency; frequency
B domain
2% Chemical Species Transport
Transport of Diluted Species 4|:_",' chds all dimensions  stationary; time dependent
Fluid Flow
Single-Phase Flow
Laminar Flow spf 3D, 2D, 2D stationary; time dependent
axisymmetric
Heat Transfer
Heat Transfer in Solids G ht all dimensions  stationary; time dependent
Heat Transfer in Fluids == ht all dimensions  stationary; time dependent
%!| Electromagnetic Heating
Joule Heating1 % — all dimensions  stationary; time dependent;
- .
£—= Structural Mechanics
Solid Mechanics [ -] solid 3D, 2D, 2D stationary; eigenfrequency;

axisymmetric

time dependent
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INTERFACE ICON  TAG SPACE AVAILABLE PRESET STUDY TYPE
DIMENSION
fu Mathematics
Wall Distance % wd all dimensions  stationary; time dependent
Curvilinear Coordinates = cc all dimensions  stationary; eigenvalue
#u PDE Interfaces
Coefficient Form PDE A 4 all dimensions  stationary; eigenvalue; time
dependent
General Form PDE Futl) g all dimensions  stationary; eigenvalue; time
dependent
Wave Form PDE Jau wahw all dimensions  time dependent
Weak Form PDE Jeu w all dimensions  stationary; eigenvalue; time
dependent
Au Lower Dimensions
Coefficient Form Boundary PDE Au cb all dimensions  stationary; eigenvalue; time
dependent
Coefficient Form Edge PDE fu ce 3D stationary; eigenvalue; time
dependent
Coefficient Form Point PDE Au cp 3D, 2D, 2D stationary; eigenvalue; time
axisymmetric  dependent
General Form Boundary PDE Hu gb all dimensions  stationary; eigenvalue; time
dependent
General Form Edge PDE Au ge 3D stationary; eigenvalue; time
dependent
General Form Point PDE Futt) gp 3D, 2D, 2D stationary; eigenvalue; time
axisymmetric  dependent
Weak Form Boundary PDE Jau wb all dimensions  stationary; eigenvalue; time
dependent
Weak Form Edge PDE Jeu we 3D stationary; eigenvalue; time
dependent
Weak Form Point PDE ﬁ-,, wp 3D, 2D, 2D stationary; eigenvalue; time
axisymmetric  dependent
ﬁ ODE and DAE Interfaces
Global ODEs and DAEs ﬁ ge all dimensions  stationary; eigenfrequency;
time dependent; frequency
domain; eigenvalue
Domain ODEs and DAEs ﬁ dode all dimensions  stationary; time dependent;

eigenvalue
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INTERFACE ICON  TAG SPACE AVAILABLE PRESET STUDY TYPE
DIMENSION
Events 1 ev all dimensions  time dependent
Boundary ODEs and DAEs ﬁ bode all dimensions  stationary; time dependent;
eigenvalue
Edge ODEs and DAEs ﬁ eode 3D stationary; time dependent;
eigenvalue
Point ODEs and DAEs ﬁ pode 3D, 2D, 2D stationary; time dependent;
axisymmetric  eigenvalue
@ Optimization and Sensitivity
Optimization @"" opt all dimensions  stationary; eigenfrequency;
Requires the Optimization Module time dependent; frequency
domain; eigenvalue
Sensitivity I||I| sens all dimensions  stationary; eigenfrequency;
frequency domain; eigenvalue;
time dependent (available with
the Optimization Module)
71 Classical PDEs
Laplace Equation vl Ipeq all dimensions  stationary
Poisson’s Equation v poeq all dimensions  stationary
Wave Equation v waeq all dimensions  time dependent
Helmholtz Equation v hzeq all dimensions  stationary
Heat Equation v hteq all dimensions  stationary; time dependent
Convection-Diffusion Equation v cdeq all dimensions  stationary; time dependent
n;#:- Deformed Mesh
Deformed Geometry EE dg all dimensions  stationary; time dependent;
frequency domain; eigenvalue
Moving Mesh :D: ale all dimensions  stationary; time dependent;

frequency domain; eigenvalue

I This physics interface is a predefined multiphysics coupling that automatically adds all the physics interfaces and

coupling features required.
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PHYSICS NODES ADVANCED SETTINGS
Various settings are available by clicking the Show button ("= ) and selecting from the list of sections to display. See

Advanced Physics Sections for more information.

* Creating a New Model
The Add Physics Window
Gl. * Show More Physics Options

* Seclecting Physics
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Creating a New Model

This section describes how to create a new model using The Model Wizard or to begin with a blank model. First
you need to Open a New Window to Begin Modeling. It is also useful have a basic model added to the Model
Builder; then you can experiment with The Model Builder, which is described in the Building a COMSOL Model
chapter.

Open a New Window to Begin Modeling

To open a New window:

* On the Quick Access Toolbar (Windows users) or the Model Toolbar (Mac and Linux users), click the New button
()
e Press Ctrl+N.

¢ Seclect File>New.
After the New window opens to the Model page, select an option:

¢ Click the Model Wizard button ( ) to open the Select Space Dimension window. Go to The Model Wizard

mp!

section to continue.

¢ Click the Blank Model button (IE..I ) to open COMSOL Multiphysics without any model set up in the Model
Builder or return to the default COMSOL Desktop. You can then add components and physics to the model.

To enable the Physics Builder choose Preferences ( ) from the File menu
(Windows users) or from the Options menu (Mac and Linux users). Then
under Builder Tools select the check box. After the applicable check box is
selected under Preferences, under Physics click Physics Builder () to

.mphERE

[

create custom physics interfaces using the Physics Builder. See the Physics

Builder Manual for information.

The Model Wizard

The Model Wizard helps you build a model by choosing the space dimension, physics interfaces, and the study you
want to use. In the Model Wizard you Select Space Dimension, Select Physics, Review Physics, and finally Select
Study.

SELECT SPACE DIMENSION
I Open the Model Wizard (see Open a New Window to Begin Modeling).

2 On the Select Space Dimension page, click to choose the Component geometry dimension—3D, 2D axisymmetric,

2D, ID axisymmetric, 1D, or OD.
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Component Nodes by Space Dimension
The Component node has different icons based on space dimension 0D ( - ) (no space dimension), ID (— ), ID
axisymmetric ( i_), 2D ( € ), 2D axisymmetric (ci.%{i), and 3D (i@ )-

0D is used for physics interfaces modeling spatially homogeneous systems
such as chemical reacting systems, electrical circuits, and general ODEs.

If you want to import a geometry, this is done in the Model Builder but

[

make sure you choose spatial dimensions that this geometry exists in.
Remember, not all physics are available for all space dimensions.

Also add a Component node to the Model Builder:
* By right-clicking the Root node (4@ ) and selecting it from the Add
Component menu.

* On the Home ribbon (Windows users) or the Model Toolbar (Mac and

Linux users), select an option from Add Component list.

SELECT PHYSICS

On the Select Physics page, there are different ways to select one or several physics interfaces to add to the model.
There are also interfaces for PDEs, ODEs, and DAEs under the Mathematics branch.

The tree organizes the available physics interfaces on by application areas such as fluid flow, heat transfer, and
structural mechanics. The physics found in the modules your license supports display in the different application
areas. In some cases, licensing of a module adds physics interfaces to these application areas as well as attributes to
existing physics interfaces, which are enhanced with additional functionality. The Recently Used (L) branch lists the
last five interfaces used in recent modeling sessions. You can also enter a text string in the search field and click
Search to list all the interfaces with the term.

Once an interface is chosen, there are several options to continue. See Figure 2-11. Click to select one of these
buttons:

¢ Add to add the physics interface to the Added physics list, or right-click and select Add physics. Add as many
interfaces as you want. You can use the Review Physics page to edit the Dependent Variables as required. Click
Remove as required to organize the physics interfaces in the list.

* (@ Space Dimension to go back to the Select Space Dimension page.

@ Study to choose the study for the model.

[ Done to add the physics interface without a study.
* € Cancel to return to the COMSOL Desktop.

Help to open the context-based Help window.

Also add physics interfaces from the Model Builder and The Add Physics
Window:

* On the Home ribbon (Windows users) or the Model Toolbar (Mac and
Linux users), click the :2: Add Physics button.

* By right-clicking the Component node and selecting Add Physics.
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Select Physics
[search

% ac/DC
Il Acoustics
227 Chemical Species Transport

Review Physics

Electric Currents (ec)

Dependent Variables

Electric potential:

T Electrochemistry
Fluid Flow
4 {1 Heat Transfer
T Heat Transfer in Solids (ht)
2% Heat Transfer in Fluids (ht)
S Heat Transfer in Pipes (htp)
T Heat Transfer in Porous Media (ht)
¥l Bioheat Transfer (ht)
[ Heat Transfer in Thin Shells (htsh)
= Conjugate Heat Transfer
Radiation
4 t)| Electromagnetic Heating
8 Laser Heating
% Joule Heating

m

Add |
Added physics:

% Electric Currents (ec)
W@ Heat Transfer in Solids (t)
4y Multiphysics .

Remove |

@ soce dimenson @ sy

Help €9 Cancel [ Done

Figure 2-11: The Select Physics and Review Physics pages in the Model Wizard.

REVIEW PHYSICS

Under Added physics (see Figure 2-11), click any interface to open the Review Physics page. Here you can review
and optionally modify any Dependent Variables names and, for some interfaces, specify the number of dependent
variables. For other interfaces you can edit both the name of the field and the field components. Examples of fields
with components are the displacement field in a Solid Mechanics interface and the Velocity field for a Laminar Flow
interface.

To remove an interface already selected, highlight it in the list and click Remove under the table.

SELECT STUDY

On the Select Study page, click to select the type of study to perform. The available options depend on the set of
interfaces included in the model. Some study types are applicable to all physics interfaces for which you choose to
solve, while others are not, but all are in some way available. You can select the study type from one of the following
branches (see Figure 2-12):

* Preset Studies—Studies suggested by a single physics interface if only one has been chosen.

* Preset Studies for Selected Physics—Studies applicable to all physics interfaces that you have chosen to solve for.
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¢ Custom Studies—In some study types, not all physics solved for can generate suitable equations. The custom

Figure 2-12: The Select Study page in the Model Wizard.

studies branch accounts for those study types:

- Preset Studies for Some Physics—The study types recognized by some, but not all, of the physics being solved

for.

- Empty Study

- Other studies—Any fundamental study types (Stationary, Time Dependent, Eigenfrequency, Eigenvalue and

Frequency Domain) which are not applicable to any of the physics being solved for. There is also an empty study

type.
Select Study

4 "o Preset Studies for Selected Physics
If. Frequency-Stationary
IL'; Frequency-Transient
If. Small-Signal Analysis, Frequency Domain
EStationary
&Time Dependent
"4 Customn Studies

Added study:
E Stationary
Added physics:

X Electric Currents (ec)
& Heat Transfer in Solids (ht)
4 . Multiphysics
x| Electromagnetic Heat Source (emhl)

C1 Boundary Electromagnetic Heat Source (bemhl)

E-? Temperature Coupling (tcl)

Once a study is highlighted, information about it displays to the right of the window and it is included under Added

study. there are several options to continue. Click:

* Add to add the physics interface to the Added physics list, or right-click and select Add physics. Add as many

interfaces as you want. You can use the Review Physics page to edit the Dependent Variables as required.

& Physics to go back to the Select Physics page.

[ Done to exit the Model Wizard.

) Cancel to return to the COMSOL Desktop.

Help to open the context-based Help window.

After clicking Done, the Model Builder window displays a model tree with a set of default nodes in the Component

branches—Definitions, Geometry, Materials, Mesh, and nodes based on the physics interfaces selected (see
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Figure 2-13). The Component nodes and branches form the sequence of operations that define the model.

Model Builder v x

> & v =

- -

a Untitled.mph (root)

slobal Definitions
4 [l Component 1 {compl)
I = Definitions
I ',r\ Geometry 1
:E: Materials

LY

. Electric Currents (ec)
% Current Conservation 1
s Electric Insulation 1
T Initial Values 1

W Heat Transfer in Solids (ht)
8 Heat Transfer in Salids 1
‘s Thermal Insulation 1

L

8 Initial Values 1

LY

<ty Multiphysics
X! Electromagnetic Heat Source 1 (emhl)
) Boundary Electromagnetic Heat Source 1 (bemhl)
[i}¥ Temperature Coupling 1 (tc1)

£ Mesh 1

o Study 1

[ Step 1: Stationary

[ @ Results

2

Figure 2-13: After clicking Finish, a 3D Component with a Solid Mechanics interface and Eigenfrequency study is
added to the Model Builder.

Also add a study from the Model Builder and The Add Study Window:

* By right-clicking the Root node and selecting Add Study.

* On the Home ribbon (Windows users) or the Model Toolbar (Mac and
Linux users), click the Add Study button.
* Building a COMSOL Model
* The Component Node
El * The Add Physics Window

* The Add Study Window
* The Model Builder
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Toolbars and Keyboard Shortcuts

The toolbars and context menus in COMSOL Multiphysics are based on the stage of modeling. This section is a

single resource for each of the ribbon and contextual toolbars available on the COMSOL Desktop. There are also

several Keyboard Shortcuts that are useful for navigating during the modeling process. The following sections have

a table where there are links to more information about the available items on the ribbon toolbar or contextual

toolbar.

¢ Home Ribbon (Windows) and Model Toolbar (Mac/Linux)

* Definitions Toolbar
¢ Geometry Toolbar
* Physics Toolbar

e Mesh Toolbar

¢ Study Toolbar

e Results Toolbar

¢ Plot Group Contextual Toolbar

¢ Work Plane Modal Toolbar

El About Changes to the Ribbon Display (Windows Users)

Home Ribbon (Windows) and Model Toolbar (Mac/Linux)

The Home ribbon toolbar (Windows) and the Model Toolbar (Mac and Linux) contains many of the common

features and actions required to build and analyze a model.

TABLE 2-4: THE HOME RIBBON (WINDOWS) OR MODEL TOOLBAR (MAC AND LINUX)

BUTTON  NAME DESCRIPTION OR OPTIONS LINK TO MORE

OR MENU INFORMATION

Model

— Component Once 3D, 2D, 2D axisymmetric, The Component Node

& Add

Component
Definitions
P; Parameters
a= Variables
) Functions

ID, and |D axisymmetric
Components are available or
added, these are listed here and
you can click to take you to the
node in the Model Builder.

3D, 2D, 2D Axisymmetric, 1D,
ID Axisymmetric, 0D

Add globally available Parameters
to your model.

Choose from Global Variables
and Local Variables.

Choose from a list of all available
Functions

The Component Node

About Global and Local
Definitions and
Parameters

About Global and Local
Definitions, Predefined
and Built-In Variables

Functions
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TABLE 2-4: THE HOME RIBBON (WINDOWS) OR MODEL TOOLBAR (MAC AND LINUX)

BUTTON  NAME DESCRIPTION OR OPTIONS LINK TO MORE
OR MENU INFORMATION
Geometry
{E5 Build All Build all features in the current Editing and Building
geometry. Geometry Nodes
The Geometry Node
= Import Import the geometry from a Import
COMSOL Multiphysics file or
CAD file.
o LiveLink Choose from a list of available Overview of Geometry
LiveLink products. Modeling Concepts
Materials
lE: Browse Open the Material Browser The Material Browser
Materials where you can access and edit Window and The Add
material libraries. Material Window
=E= New Material Add an empty material to your Materials and Creating a
model. New Material Library
e Add Material Open the Add Material window  The Add Material
to add materials to components ~ Window
or selections.
Physics
5%': Select Physics For a blank model this is Selecting Physics
- available.
— Physics When interfaces are added, Physics Guide
these are listed here and you can
click to take you to the node in
the Model Builder.
}ﬂr 3 Add Physics Open the Add Physics window to  The Add Physics
add physics to the current Window
component.
Mesh
{E5 Build Mesh Build the current mesh. Adding, Editing, and
Building Meshing
Sequences
-y Select Mesh Available for a blank model. Mesh Elements for 1D,
2D, and 3D Geometries
Lf\_:_ Mesh When meshes are added, these Creating a Mesh for
are listed here and you can click  Analysis
to take you to the node in the
Model Builder.
Study
= Compute Compute the selected study. Computing a Solution
b Select Study Available for a blank model. Open a New Window to
Begin Modeling and
The Add Study Window
~h Study When studies are added, these Introduction to Solvers

are listed here and you can click
to take you to the node in the
Model Builder.

and Studies
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TABLE 2-4: THE HOME RIBBON (WINDOWS) OR MODEL TOOLBAR (MAC AND LINUX)

BUTTON NAME

DESCRIPTION OR OPTIONS

LINK TO MORE

OR MENU INFORMATION
oo Add Study Open the Add Study window to  The Add Study Window
add a study to the current
Component.
Results
Select Plot Available for a blank model. About the Plot Groups
Group

Add Plot Group

Table 2 (3D, 2D, ID or
0-7 Polar) Plot
Group

3D Plot Group, 2D Plot Group,
ID Plot Group, Polar Plot
Group.

Once results are available or
added, these are listed here and
you can click to take you to the
node in the Model Builder. It also
opens a new Plot Group
contextual toolbar for the plot

About the Plot Groups

Plot Groups and Plots

group.

For cross-platform users, the options listed in Table 2-5 are available from other toolbars and menus. See Cross

Platform (Mac and Linux) Toolbars and Menus.

TABLE 2-5: AVAILABLE ONLY ON THE HOME RIBBON (WINDOWS)

BUTTON NAME DESCRIPTION OR OPTIONS

LINK TO MORE INFORMATION

OR MENU
H“i Model Libraries Open the Model Libraries
window.
=5 More Windows Add Physics
Add Study
Add Material

Material Browser
Selection List
Messages

Table

External Process

Physics Builder Manager

Layout

g Reset Desktop ~ Reset the COMSOL
Desktop to its default
settings.

=] Desktop Layout Choose Widescreen
Layout or Regular Screen
Layout,

"._': Model Builder Choose from Show Name

Node Label Only, Show Name and
Identifier, Show Name and
Tag, Show Type and
Identifier; or Show Type

and Tag.

The Model Libraries Window

Creating a New Model

The Model Wizard

The Material Browser Window
The Material Browser Window
The Selection List Window
The Messages Window

The Table Window and Tables
Node

The External Process Window

See the Physics Builder Manual.

Customizing the Desktop
Layout

Customizing the Desktop
Layout

Viewing Node Names,
Identifiers, Types, and Tags
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Definitions Toolbar

The Definitions ribbon toolbar (Windows) and the Definitions contextual toolbar (Mac and Linux) contain many of
the common features and actions required to work with features found under the Definitions node in the Model

Builder.

For step-by-step instructions and general documentation descriptions,
g this is the Definitions toolbar.

TABLE 2-6: THE DEFINITIONS TOOLBAR

BUTTON NAME DESCRIPTION OR OPTIONS  LINK TO MORE INFORMATION
OR
MENU
Variables
a= Local Variables Add a Variables node About Global and Local
under Definitions. Definitions, Predefined
and Built-In Variables
Functions
f'ﬁ Analytic Add an Analytic node Analytic
under Definitions.
- Interpolation Add an Interpolation Interpolation
) node under Definitions.
" Piecewise Add an Piecewise node  Piecewise
under Definitions.
lx) More Functions All available Functions Functions
(except Analytic,
Interpolation, and
Piecewise).
Selections
= Explicit Add an Explicit node Named Selections and
under Definitions. Explicit
N Complement Add a Complement Union, Intersection,

8 Adjacent
® Ball

f&] Box

a Cylinder
= Union
é Intersection
é Difference

node under Definitions.

Add an Adjacent node
under Definitions.

Add a Ball node under
Definitions.

Add a Box node under
Definitions.

Add a Cylinder node
under Definitions.

Add a Union node
under Definitions.

Add an Intersection
node under Definitions.

Add a Difference node
under Definitions.

Difference, and
Complement
Adjacent

Ball

Box

Cylinder

Union, Intersection,
Difference, and
Complement

90 |
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TABLE 2-6: THE DEFINITIONS TOOLBAR

BUTTON NAME

DESCRIPTION OR OPTIONS

LINK TO MORE INFORMATION

OR
MENU
Probes
¥ Update Probes Update all probes. Probes
O
T_)_‘, Probes Select an option from
the list to add a node
under Definitions
Table 5-16.
Coupling
o Component Select an option from Component Couplings
Couplings the list to add a node
under Definitions.
[¥] Pairs Select an option from About Identity and

Coordinate Systems

IZ; Coordinate
Systems

Tk Perfectly Matched

Layer

E Infinite Element
Domains

View

[ View

o | Reset to Default

the list to add a node
under Definitions.

Select an option from
the list to add a node
under Definitions
Table 5-15.

Add a Perfectly Matched
Layers node under
Definitions.

Add an Infinite Element
Domains node under
Definitions.

Add a View node to the
current Component to
control the view and
lighting in the Graphics
window.

Restores the default

settings for the current
View node.

Contact Pairs

Coordinate Systems

Perfectly Matched Layer

Infinite Element Domain

View (2D), View (3D),
Axis

User-Defined Views

Geometry Toolbar

Once a geometry is added to the model, the Geometry ribbon toolbar (Windows) and the Geometry contextual

toolbar (Mac and Linux) contains many of the common features and actions required to create and build a

geometry.

For cross-platform users, some options listed in Table 2-7 are available from other toolbars and menus. Table 2-8

lists the geometry drawing tools available on the toolbars in 1D and 2D, as well as on the Work Plane toolbar for

3D models. See Cross Platform (Mac and Linux) Toolbars and Menus.

For step-by-step instructions and general documentation descriptions,

E this is the Geometry toolbar.
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TABLE 2-7: THE GEOMETRY TOOLBARS

BUTTON NAME

DESCRIPTION OR OPTIONS

OR

MENU

Build

s Build All'
Import/Export
= ImportI

IW]]

2] Insert Sequence

= Export

Build all features in the current geometry. See Editing and
Building Geometry Nodes.

Import the geometry from a COMSOL Multiphysics file or
CAD file.

Insert a geometry sequence from a COMSOL Multiphysics
file into the current geometry. See Insert a Sequence.

Export the current geometry as a COMSOL binary or text
file or to a CAD file format. See Exporting a Geometry.

Primitives (in 3D) See Geometric Primitives.

'T" Block

T Cone
T Cylinder
- Sphere
=) Torus

E‘::_' > Helix

More Primitives

Primitives (in 2D)

More Primitives

Primitives (in 1D)

Add a Block to the current geometry.
Add a Cone to the current geometry.
Add a Cylinder to the current geometry.
Add a Sphere to the current geometry.
Add a Torus to the current geometry.
Add a Helix to the current geometry.

Add all other primitives as in Table 7-1.

Interpolation Curve, Parametric Curve, and Point. Also
see Geometric Primitives and The Geometry Toolbar—
Drawing Tools (Table 2-8).

See The Geometry Toolbar—Drawing Tools (Table 2-8).

Work Plane
= Work Plane (1,2,
B 3.)

I= Work Plane
Operations

|__|:|I Extrude
<l Revolve

._: Sweep

Once Work Planes are available or added, these are listed
here and you can click to take you to the associated Plane
Geometry node in the Model Builder. It also opens a new
Work Plane contextual toolbar for the Work Plane. See
Using Work Planes, Work Plane Modal Toolbar and
Table 2-8.

Add a Work Plane to the current geometry. See Using Work
Planes, Work Plane Modal Toolbar and Table 2-8.

Extrude planar faces of geometry objects or objects from a
work plane to create 3D geometry objects.

Revolve planar faces of geometry objects or objects from a
work plane about an axis to create 3D geometry objects.

Sweep faces along a spine curve to create a solid object.
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TABLE 2-7: THE GEOMETRY TOOLBARS

BUTTON NAME DESCRIPTION OR OPTIONS
OR
MENU
Union Create a geometry object as the set union of other geometry
objects.
[=h Intersection Create a geometry object as the set intersection of other
geometry objects.
Difterence Create a geometry object as the set difference between two
other geometry objects (or sets of geometry objects).
= A . - .
e Compose Compose a geometry object from existing geometry objects
using a set formula containing Boolean operators.
= Partition Partition geometry objects into parts using other geometry
) objects as tool objects for the partition. Alternatively, in 3D,
use a work plane to partition the geometry objects.
mE Array Create an array (linear or rectangular in 2D, linear or
three-dimensional in 3D) of identical geometry objects.
| Copy Copy geometry objects, creating a copy with an optional
displacement from the original geometry objects.
i Mirror Mirror geometry objects in a plane (in 3D) or line (in 2D).
gh
B Move Move geometry objects.
5 Rotate Rotate geometry objects about an axis of rotation.
L7 Scale? Scale geometry objects using isotropic or anisotropic scaling.

A=

Other

. 2
Conversions

Chamfer
Fillet
Tangent

Delete2

Defeaturing and
Repair2'3

Virtual

Operations

P )
rogramming

Selections?

See Table 7-5 for a list of these features. Also see
Conversion Operations.

Chamfer corners in 2D geometry objects.
Fillet corners in 2D geometry objects.
Create a line segment tangent to a specified edge.

Delete the selected geometry objects. See Clearing
Sequences and Disabling, Enabling, and Deleting Nodes.

Choose from Cap Faces, Delete Fillets, Delete Short Edges,
Delete Sliver Faces, Delete Small Faces, Delete Spikes,
Delete Faces, Detach Faces, Knit to Solid, and Repair.

Virtual geometry operations and mesh control operations.
See Virtual Geometry Operations and Virtual Geometry
and Mesh Control Operations.

If + End If, Subsequence Call. See Using Geometry
Subsequences and If, Else If, Else, End If.

Create named selections of geometry objects or geometric
entities in geometry objects. See Creating Named
Selections in the Geometry Sequence.
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TABLE 2-7: THE GEOMETRY TOOLBARS

BUTTON NAME DESCRIPTION OR OPTIONS

OR

MENU

IE Measure2 Measure the volume, area, perimeter, or other geometric

properties of the selected geometric entities or objects. See
Measuring Geometry Objects.
! For cross-platform users, this option is available from a different toolbar or menu. See
Cross Platform (Mac and Linux) Toolbars and Menus.

2 For cross platform users (Mac and Linux), these buttons may only be visible if the
Tools>Toolbar Display Mode is set to Compact or you are on a widescreen monitor. It also
depends if the button is available on the Work Plane toolbar, in which case it may be visible.

3 These features are available for the LiveLink and CAD products.

GEOMETRY DRAWING TOOLBAR BUTTONS
In 1D and 2D there are buttons for drawing Geometric Primitives by using the mouse. In 3D, the buttons are

available to create primitives, but you cannot draw these using the mouse unless you are using a Work Plane.

TABLE 2-8: THE GEOMETRY TOOLBAR—DRAWING TOOLS

BUTTON NAME DESCRIPTION OR ACTION
OR
MENU

Draw Settings

* Snap Snap to the grid when drawing a geometry object in the
Coordinates Graphics window.

By default, the mouse pointer snaps to the grid points and
geometry vertices (for example, the corners of a rectangle).
To disable snapping, click the Snap Coordinates button.

A Draw Solid Create a solid (instead of a curve) when drawing a geometry
object in the Graphics window. Available for 2D and 2D
axisymmetric Components.

The Draw Solid button is used to toggle between drawing
solid objects or outlines (curves) and can be used in
combination with all the draw buttons on the toolbar (for
example, to draw squares, circles, and rectangles). It is
selected by default to draw solid objects. When used to draw
a polygon in combination with the Draw Line, Draw
Quadratic, and Draw Cubic operations, the solid object (or
outline) displays once the object is closed or the points
joined.

Primitives (in 2D)

Draw Line Draw line segments, quadratic curve segments, and cubic
curve segments of a Bézier Polygon in the Graphics window.

o~ Draw Quadratic To draw a polygon consisting of line segments or Bézier

- curves first click one of these buttons. Then click the control
points of the segments in the Graphics window. Click one

i Draw Cubic point for each linear segment, two points for each quadratic
segment, and three points for each cubic segment. If you want
to switch segment type, click one of the buttons and then
click some more control points. Close the polygon by
right-clicking anywhere in the Graphics window. Then, a solid
Bézier polygon appears, and a corresponding Bézier Polygon
node appears in the geometry sequence. If you want to
modify the polygon (for instance, change from solid to curve)
you can edit the Bézier Polygon node by clicking it to display
its settings window.

94 | CHAPTER 2: THE COMSOL MODELING ENVIRONMENT



TABLE 2-8: THE GEOMETRY TOOLBAR—DRAWING TOOLS

BUTTON NAME DESCRIPTION OR ACTION

OR

MENU

| Rectangle To draw a rectangle select one of these buttons from the
Rectangle [—] menu. Then, click one corner (or the center)

= Rectangle of the rectangle in the Graphics window. Drag the mouse to

(Center) the desired position of a corner. When the mouse button is

released, a solid rectangle appears and a Rectangle node is
added to the geometry sequence.

] Square To draw a square select one of these buttons from the

(O]

Square (Center)

Circle

Circle (Corner)

Ellipse

Ellipse (Corner)

Primitives (in 1D)

]
-~
L

Interval

Point (also
available in 2D
and 3D)

Rectangle [—] menu. Then, click one corner (or the center)
of the square in the Graphics window. Drag the mouse to the
desired position of a corner. When the mouse button is
released, a solid square appears and a Square node is added
to the geometry sequence.

To draw a circle select one of these buttons from the

Circle (Ej menu. Then, click the circle’s corner (or one
corner of the circle’s bounding box) in the Graphics window.
Drag the mouse to the desired position of a corner of the
circle’s bounding box. When the mouse button is released, a
solid circle appears and an Circle node is added to the
geometry sequence.

To draw an ellipse select one of these buttons from the
Circle (=) menu. Then, click the ellipse’s corner (or one
corner of the ellipse’s bounding box) in the Graphics window.
Drag the mouse to the desired position of a corner of the
ellipse’s bounding box. When the mouse button is released, a
solid ellipse appears and an Ellipse node is added to the
geometry sequence.

Draw an Interval (line) in the Graphics window. For ID
models, first click the Interval button, then click the start and
end points in the Graphics window.

Add a point to the Graphics window. Use this to draw a
single point. First click the Point button, then click in the
Graphics window (in 1D and 2D), or specify the point
location in its settings window. In 2D and 3D, this button is
available on the More Primitives menu.

Work Plane Modal Toolbar

The Work Plane modal toolbar is available after clicking Plane Geometry Node under Geometry>Work Plane in the
Model Builder.

For step-by-step instructions and general documentation descriptions,
this is the Work Plane modal toolbar.

[

The Work Plane toolbar is similar to the 2D Geometry Toolbar except

that the Virtual Operations menu is not available and there is a Close

button.
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- )‘;\ Geometry 1 {geomi}
[ Cylinder 1 {gyii}
% Cylinder 2 fcyi2}
= End plate {sell}
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Figure 2-14: Click the Plane Geometry node to open the Work Plane toolbar.

Physics Toolbar

Once physics interfaces are added to the model, the Physics ribbon toolbar (Windows) and the Physics contextual
toolbar (Mac and Linux) contains many of the common features and actions required to add physics and features
to the Model Builder.

For step-by-step instructions and general documentation descriptions,
this is the Physics toolbar.

TABLE 2-9: THE PHYSICS TOOLBAR

BUTTON NAME DESCRIPTION OR OPTIONS LINK TO MORE
OR INFORMATION
MENU

Physics

Various  Select Physics Any physics interfaces added to the
selected Component are listed.
Click to go to the node in the The Physics Interfaces
Model Builder and open the settings
window. See Physics Guide.

;5_::_;'_'-; Add Physics Open the Add Physics window to The Add Physics
' add physics to the current Window
component.

Geometric Entity
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TABLE 2-9: THE PHYSICS TOOLBAR

BUTTON NAME DESCRIPTION OR OPTIONS LINK TO MORE
OR INFORMATION
MENU
= Domains See Table 3-3 for a list of all the
icons by space dimension.
=~ Boundaries Available physics features for the
physics interface are listed. To add About Geometric
o Pairs subfeatures, however, you need to Entities
right-click the parent node. For
B Edges example, to add a Destination About Selecting
Selection subnode, right-click Geometric Entities
Points Periodic Condition.
s Global

Mesh Toolbar

Once a mesh is added to the model, the Mesh ribbon toolbar (Windows) and the Mesh contextual toolbar (Mac and
Linux) contains many of the common features and actions required to work with meshes.

TABLE 2-10: THE MESH TOOLBAR

BUTTON  NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
OR MENU
Build
] Build Mesh' Build the current mesh. Adding, Editing, and
Building Meshing
Sequences
=N Mesh (1, 2, 3..) Lists the meshes available ~ Creating a Mesh for
in the model. Click and Analysis
you go to the node in the
Model Builder
=N Add Mesh Add a new mesh to the Adding, Editing, and
current model component. Building Meshing
Sequences

Physics-Controlled

& Edit Edit the physics-controlled
sequence. )
X Physics-Controlled Mesh
‘f.'*: Reset Reset the sequence to the
physics-controlled settings.
Mesh Size
— Mesh Size See Table 8-1 for alist of  The Mesh Toolbar
options. (Predefined Mesh Element
Sizes)
Mesh Element Quality and
Size
Generators
— Inherit Size See Table 8-1 for alist of  Predefined Mesh Element
options. Sizes and Mesh Element
Quality and Size
FN Free Tetrahedral Generate unstructured Meshing Operations and

tetrahedral mesh.

Attributes
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TABLE 2-10: THE MESH TOOLBAR

BUTTON  NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

OR MENU

N Swept Generate swept mesh.

ﬁ Boundary Free Triangular, Free
Quad, Mapped, and
Edge.

@ Boundary Layers Generate boundary layer
mesh.

Operations

Do, Modify Elements: Convert and Meshing Operations and
Refine Attributes and Mesh
Size: Distribution and Attributes
Corner Refinement

[ Copy Copy Domain, Copy Meshing Operations and

Edge, and Copy Face Attributes

Import

= Import Import mesh. Importing Meshes

.ﬂi":. Partition Ball, Box, Cylinder, Partition the Geometry

-y Combine

Evaluate
e Measure

; Statistics
ulh

Plot

Clear
"_:\\ Clear Mesh

Lg
"bé Clear All Meshes

Logical Expression, and
Create Vertex.

Delete Entities and Join
Entities.

Measure the volume, area,
perimeter, or other
geometric properties of
the selected geometry
objects.

Write information about
number and quality of
elements to the Messages
window.

Add a mesh plot.

Clear the mesh.

Clear all meshes in the
model.

into Simple Domains and
Partition

Measuring Geometry
Objects

The Mesh Statistics
Window

Mesh (Plot)

Clearing Sequences and
Disabling, Enabling, and
Deleting Nodes

! For cross-platform users, this option is available from a different toolbar or menu. See
Cross Platform (Mac and Linux) Toolbars and Menus.
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Study Toolbar

The Study ribbon toolbar (Windows) and the Study contextual toolbar (Mac and Linux) contains many of the

common features and actions required to work with studies and solvers.

For step-by-step instructions and general documentation descriptions,

this is the Study toolbar.

TABLE 2-11: THE STUDY TOOLBAR

BUTTON NAME OPTIONS DESCRIPTION OR LINK TO MORE INFORMATION
OR OPTIONS
MENU
Study
= ComputeI Compute the selected Computing a Solution
study.
o Select S'cudyI See a list of all available Study Types
studies in Table 19-2 and
Table 19-3.
oo Add StudyI Open the Add Study The Add Study Window
window to add a study to
the current model
component.
== Continue Continue the The Progress Window
computation of a solver
sequence from the last
computed feature.
(= Update Solution Update the solution using  Updating a Solution
the current values of
parameters and
user-defined variables.
o Get Initial Value Generate a solution using  Computing the Initial
the initial values of the Values
dependent variables
(without solving for the
dependent variables).
Solver
[ Show Default Display the nodes in the Show Default Solver
Solver solver sequences that are
created by default.
Study Step

E Study Steps

Parametric Sweep

Operations

|__'E| Create Solution
Copy

Evaluate

See a list of all available
studies in Table 19-2 and
Table 19-3.

Choose Parametric
Sweep or Optimization,
for example.

Make a copy of a solution.

The Add Study Window
and The Relationship
Between Study Steps and
Solver Configurations

Study Extension Steps and
Advanced Study Extension
Steps

Solution Operation Nodes
and Solvers

TOOLBARS AND KEYBOARD SHORTCUTS
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TABLE 2-11: THE STUDY TOOLBAR

BUTTON NAME OPTIONS DESCRIPTION OR LINK TO MORE INFORMATION
OR OPTIONS
MENU

Statistics Display statistics for the The Statistics Page

uth
study, including the

number of degrees of
freedom (DOFs).

Clear
\ Clear Solutions Clear the solutions in the  Clearing Sequences and
current solver sequence.  Disabling, Enabling, and
'}é Clear All Solutions  Clear all solutions. Deleting Nodes

! For cross-platform users, this option is available from a different toolbar or menu. See
Cross Platform (Mac and Linux) Toolbars and Menus.

Results Toolbar

The Results ribbon toolbar (Windows) and the Results contextual toolbar (Mac and Linux) contains many of the

common features and actions required to work with studies and solvers.

For step-by-step instructions and general documentation descriptions,

E this is the Results toolbar.

TABLE 2-12: THE RESULTS TOOLBAR

BUTTON OR NAME DESCRIPTION OR OPTIONS LINK TO MORE
MENU INFORMATION
Plot Group

Plot Plot the selected plot group. Plot Groups and

Plots. Also see Plot
Group Contextual
Toolbar.

— Select Plot Choose from a list of plots
Group included in the model.

[% or [E 3DPlot Group  Create a new 3D Plot Group
for 3D plots such as volume
and slice plots. About the Plot

@ or @I 2D Plot Group Create a new 2D Plot Group Groups. Also see
for 2D plots such as surfaceand  Plot Group
contour plots. Contextual

@ or @I ID Plot Group Create a new |D Plot Group Toolbar.
for 1D graph plots.

o) Polar Plot Group Create a new Polar Plot Group
for graph plots in a polar
coordinate system.

Data Set

@ Cut Plane Create a Cut Plane data set for  Cut Plane
data on a plane in 3D.

B Cut Line 3D Create a 3D Cut Line dataset ~ Cut Line 2D and
for data along a line in 3D. Cut Line 3D
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TABLE 2-12: THE RESULTS TOOLBAR

BUTTON OR NAME DESCRIPTION OR OPTIONS LINK TO MORE

MENU INFORMATION

= Cut Point 3D Create a 3D Cut Point data set  Cut Point 1D, Cut
for data at a point in 3D. Point 2D, and Cut

Point 3D

E Cut Line 2D Create a 2D Cut Line data set ~ Cut Line 2D and
for data along a line in 2D. Cut Line 3D

|E| Cut Point 2D Create a 2D Cut Point data set  Cut Point 1D, Cut

More Data Sets

Derived Values

Evaluate All

ks Clear and
Evaluate All

285 Point Evaluation

|a_~.| Global
Evaluation

885 More Derived
Values

Export

3 Data

] Image

Animation

= Player

B Report

for data at a point in 2D.

See Table 20-6 for a list of all
data sets.

Evaluate all derived values.

Clear all current table entries
and then evaluate all derived
values.

Add a Point Evaluation node to
evaluate some expressions or
variables at points.

Add a Global Evaluation node
to evaluate some global
expressions or variables.

See Table 20-10 for a list of all
derived value types.

Data, Plot, Mesh (Export),
Table

1D Image, 2D Image, or 3D
Image

Create a movie to animate a
solutions (as an animated GIF,
Flash, or AVl movie file).

Create a Player for generating
animation directly in the
COMSOL Desktop Graphics
window.

Choose a Brief Report,
Intermediate Report, Complete
Report, Custom Report, or
Documentation.

Point 2D, and Cut
Point 3D

Data Sets

Table Window
toolbar and Menu
Options

Table Window
toolbar and Menu
Options

Point Evaluation

Global Evaluation

Derived Values and
Tables

Exporting Data and

Images

Report Types
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Plot Group Contextual Toolbar

The plot group contextual toolbar is available after clicking a specific plot group in the Model Builder. The available

tools are based on the model and the type of plot.

Home

Definitions Mesh

Wivolume
“HAmow Volume ¥ lsosurface

™ surface

Geometry Physics Study

X More
= Arrow Surface 3 Streamline & Plots

1§ Slice Line

[alPlot
& Plotin -

) Contour

Results
) Evaluate Along Normal
_/ First Point for Cut Line
/" second Point for Cut Line [ First Point for Cut Plane Normal 'y | Export

Electric Potential (ec)

&=

‘i Cut Line Surface Normal 0

] CutLine Direction

For step-by-step instructions and general documentation descriptions,

this is generally referred to as the Plot Group toolbar, where the name of

the toolbar name changes based on the plot group (3D Plot Group, 2D

Plot Group, 1D Plot Group, or Polar Plot Group). If the plot group is
renamed, the toolbar name also changes to match the new name, as in the

example above where the 3D Plot Group toolbar was renamed Electric

Potential.

TABLE 2-13: THE PLOT GROUP CONTEXTUAL TOOLBAR

BUTTON  NAME LINK TO MORE INFORMATION
OR MENU

Plot

Plot Plot Groups and Plots
=] Plot In New Window The Plot Windows

Add Plot

Various  See Table 20-7 for the available plots  About the Plot Groups

by Plot Group (3D, 2D, ID, or Polar
Plot Groups).

Select (available for creating cross-section plots)

Various  See Table 20-8 for a list of the
available buttons.

Export

Various  See Table 20-11 for a list of export

options.

Creating Cross-Section Plots
and Combining Plots and
Plotting and Cross-Section
Interactive Toolbar

Exporting Data and Images

Keyboard Shortcuts

The following table summarizes the available keyboard shortcuts on Windows and Linux and on Macintosh:

SHORTCUT (WINDOWS,  SHORTCUT (MACINTOSH)  ACTION
LINUX)
Fl Fl Display help for the selected node or
window
Ctrl+Fl Command+Fl Open the COMSOL Documentation
front page in an external Help window
F2 F2 Rename the selected node, file, or
folder
F3 F3 Disable selected nodes
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SHORTCUT (WINDOWS,
LINUX)

SHORTCUT (MACINTOSH)

ACTION

F4
F5

F7

F8

Del

Left arrow
(Windows); Shift +
left arrow (Linux)

Right arrow
(Windows); Shift +
right arrow (Linux)

Up arrow

Down arrow

Alt+left arrow

Alt+right arrow

Ctrl+A

Ctrl+D

Ctrl+C
Ctrl+N
Ctrl+O
Ctrl+P

Ctrl+S

Ctrl+Vv
Ctrl+Z
Ctrl+Y

Ctrl+up arrow

Ctrl+down arrow

F4
F5

F7

F8

Del

Left arrow

Right arrow

Up arrow

Down arrow

Ctrl+left arrow

Ctrl+right arrow

Command+A

Command+D

Command+C
Command+N
Command+O
Command+P
Command+S
Command+V
Command+Z
Ctrl+Shift+Z

Command+up arrow

Command+down arrow

Enable selected nodes

Update solution with respect to new
definitions without re-solving the
model

Build the selected node in the
geometry and mesh branches, or
compute to the selected node in the
solver sequence

Build the geometry, build the mesh,
compute entire solver sequence,
update results data, or update the plot

Delete selected nodes

Collapse a branch in the Model Builder

Expand a branch in the Model Builder

Move to the node above in the Model
Builder

Move to the node below in the Model
Builder

Move to the previously selected node
in the Model Builder

Move to the next selected node in the
Model Builder

Select all domains, boundaries, edges,
or points; select all cells in a table

Clear the selection of all domains,
boundaries, edges, or points

Copy text in fields

Create a new model

Open a model file

Print the contents of the plot window
Save a model file

Paste copied text

Undo the last operation

Redo the last undone operation

Move a definitions node, geometry

node, physics node (except default

nodes), material node, mesh node,

study step node, or results node up
one step

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,
study step node, or results node down
one step
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SHORTCUT (WINDOWS,
LINUX)

SHORTCUT (MACINTOSH)

ACTION

Ctrl+Tab

Ctrl+Shift+Tab

Ctrl+Alt+left arrow

Ctrl+Tab

Ctrl+Shift+Tab

Command+Alt+left
arrow

Switch focus to the next window on
the desktop

Switch focus to the previous window
on the desktop

Switch focus to the Model Builder
window

CHAPTER 2:

Ctrl+Alt+right arrow  Command+Alt+right Switch focus to the settings window
arrow
Ctrl+Alt+up arrow Command+Alt+up Switch focus to the previous section in
arrow the settings window
Ctrl+Alt+down arrow  Command+Alt+down Switch focus to the next section in the
arrow settings window
Shift+F10 or Ctrl+F10 Open context menu
(Windows only) Menu
key
Ctrl+Space Ctrl+Space Open list of predefined quantities for
insertion in Expression fields for
plotting and results evaluation.
THE COMSOL MODELING ENVIRONMENT



Building a COMSOL Model

This chapter explains a range of methods and topics used when building models
in COMSOL Multiphysics: From working with the Model Builder and
fundamental concepts for building a model to the use of units. For examples of how
to build a complete model step-by-step, see the model library for COMSOL
Multiphysics® and the add-on modules and the Introduction to COMSOL
Multiphysics book.
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Building Models in the Model Builder

The power of COMSOL Multiphysics is the ease of working with all the components required to build a model in
The Model Builder. The sections About the Sequence of Operations, The Component Node, Branches and
Subbranches in the Tree Structure, The Node Settings Windows, and Opening Context Menus and Adding Nodes
further introduce you to key concepts about navigating in the Model Builder, the structure of the tree, and how to
add features (nodes) as you build your model.

The physics feature nodes that are added to physics interfaces are flexible and several sections describe the ways to
identify changes, status updates, and other ways to work with these nodes: The Physics Nodes, Physics Default
Nodes, Physics Nodes by Space Dimension, Physics Node Context Menu Layout, Physics Exclusive and
Contributing Node Types, Physics Node Status, Dynamic Nodes in the Model Builder, and Errors and Warnings.

* The Root Window
& * Creating a New Model
e The COMSOL Desktop

The Model Builder

The modeling procedure is controlled through the Model Builder window, which is essentially a model tree with all
the functionality and operations for building and solving models and displaying the results. These are introduced
to your modeling procedure by adding a &ranch, such as the Geometry branch. Branches can have further nodes
(or subbranches) that relate to their parent node. It is all About the Sequence of Operations. See Figure 3-2 for an

example.

A node has its own properties and sezzings that are characteristic to it. Branches and subbranches can also contain
properties and settings. See Branches and Subbranches in the Tree Structure and The Node Settings Windows for

examples.

The Model Builder has many types of nodes to help you create models and visualize the model structure, for
example, the Component node is categorized by space dimension, and nodes are dynamic, which helps you identify
nodes that change status. See Component Nodes by Space Dimension, Physics Default Nodes, and Dynamic Nodes
in the Model Builder for more information.

Also learn about the context menu available when you right-click a node in the Model Builder (Opening Context
Menus and Adding Nodes). In the next section (Working with Nodes in the Model Builder), there is also
information about Going to the Source Node, Copying, Pasting, and Duplicating Nodes, Undoing and Redoing
Operations, and Clearing Sequences and Disabling, Enabling, and Deleting Nodes.

* The Root Window

* Creating a New Model
El * Basic Navigation
The COMSOL Desktop

About the Sequence of Operations

COMSOL operates through sequencing and evaluates most of the branch nodes in the Model Builder from the

top-down as a sequence of operations. By adding nodes to a branch in the Model Builder in a certain order, you set
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up such sequences of operations, which makes it possible to, for example, parameterize a model and rerun the
simulation. COMSOL then re-evaluates each sequence, automatically updating the geometry, mesh, physics, and
solution. A solver sequence, for example, could define your model with one solver and then, using the returned

solution, solve it with an alternative solver.

For most sequences, you run the sequence by right-clicking the top node
of the branch and selecting Build All [§ (geometry and mesh),

Compute = (studies), or Plot (plot groups), or by pressing F8.

Some nodes under a physics branch can override other nodes higher up in the sequence. How COMSOL treats
those nodes depends on whether they are contributing or exclusive nodes (see Physics Exclusive and Contributing
Node Types).

The sequence of operations means that the order of the nodes in the tree is important. In the following branches
of the model tree, the node order makes a difference, and you can move nodes up and down to change the sequence

of operations for these nodes—Geometry, Material, Physics, Mesh, and Solver.

Also, the order can have some importance in the plot groups in the Results branch and also for the Perfectly
Matched Layers and Infinite Elements nodes in the Definitions branch (those nodes are available with some of the

add-on modules).

* Physics Node Status
* Physics Exclusive and Contributing Node Types

@l * Creating a Geometry for Analysis and Working with Geometry

Sequences

* Moving Nodes in the Model Builder

The Component Node

. Previously this feature was named Model.

B

A model component is a fundamental part of the model and contains a geometry with its associated physics, mesh,
and variables and other definitions that are local to that component. The Component node defines the namespace
for each part of a model that is defined in a model component. A model can have several Component nodes. For
example, if you are setting up a system model using both a 2D simplification—represented in one 2D Component
branch—and a full 3D description in another Component, these can both be added to the Model Builder to
represent different aspects or parts of the model. You can couple variables between different components in a model

using coupling operators.

To Add Physics, Add Extra Dimension, and Add Mesh to the Component,

from the Home ribbon (Windows users), Model Toolbar (Mac and Linux
users), or for any operating system, right-click the Component node. See
Adding Extra Dimensions to a Component, The Add Physics Window,

and Creating a Mesh for Analysis for more information.
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To enable the Extra Dimensions option, go to The Preferences Dialog Box.
El- Click Model Builder, sclect the Enable technology preview functionality
= check box, and then click OK.

The Component node icon also indicates the space dimension:.

TABLE 3-1: SPACE DIMENSION ICONS IN THE MODEL BUILDER

ICON SPACE DIMENSION
m
| . .
a 2D axisymmetric
I

9Q 2D
= I D axisymmetric
— ID

0D (space-independent models for chemical
reactions and other ODEs/DAEs)

Adding a Component to a Model

You can create models with multiple geometries by adding one or more Component nodes to the Model Builder.

To add a Component node or nodes:

* Right-click the Root node (the top most node) in the Model Builder and select Add Component (sece The Root
Window).

e In The Model Wizard on the Select Space Dimension page, select 3D, 2D axisymmetric, 2D, 1D axisymmetric, or 1D.
Continue defining the model as in Creating a New Model.
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The Default Nodes

a Untitled.mph (root)
(E) Global Definitians
4 [l Component 1 {compl)
I = Definitions
I ',r'\ Geometry 1
:E: Materials

LY

. Electric Currents (ec)
% Current Conservation 1
s Electric Insulation 1
T Initial Values 1

W Heat Transfer in Solids (ht)
i Heat Transfer in Solids 1
‘s Thermal Insulation 1

L

B Initial Values 1

LY

“yy Multiphysics
X! Electromagnetic Heat Source 1 (emhl)
¥ Boundary Electromagnetic Heat Source 1 (bemhl)
[i}¥ Temperature Coupling 1 (tc1)

A Mesh 1

4 "o Study 1

[ Step 1: Stationary

[ @ Results

Figure 3-1: An example of the Model Builder default nodes for the Electric Curvents and Heat Transfer in Solids
interfaces.

These default nodes are normally added under a Component node:

* Definitions: Contains user-defined variables, selections, views, pairs, functions, probes, component couplings, and
coordinate systems, which are defined locally for the model. See About Global and Local Definitions for
=). Use Global Definitions to define

information about using these local Definitions ( = ) and Global Definitions ((=)

Parameters, Variables, Functions, and Groups with a global scope—that is, not specific to one Component node.

* Geometry (4 ): Contains the sequence of geometric objects and operations (or imported CAD data) that defines

the model geometry.

* Materials (232 ): Contains the materials and material properties used as sources for material data in the model.

See Materials for detailed information.
* Physics (%27 ): Any added physics displays as a node under Component (Solid Mechanics in Figure 3-1 for example).

¢ Multiphysics (_ﬁ:’): When a multiphysics interface is added to the Model Builder, this node contains all the
relevant multiphysics features for that interface. See Multiphysics Modeling Approaches for more information.

* Meshes ( 4 ): Contains the sequences of mesh operations that defines the computational meshes for the model.
When there is only one mesh in the model, its Mesh node appears directly under the Component node.

& Branches and Subbranches in the Tree Structure

The settings window has the following sections (also see Figure 3-3):

COMPONENT IDENTIFIER

The component identifier is a string used to define a namespace for the model component and identify variables
defined in that component. The default component identifier is comp1, comp2, and so on, but you can change it in
the Identifier ficld.
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COMPONENT SETTINGS

This section contains general settings that you normally do not need to change:

Unit System
The default setting in the Unit system list, Same as global system, is to use the global unit system, which you specify
in the root node’s settings window. If you want to use another unit system in a model, select it from this list.

Spatial Coordinates

The default names for the spatial coordinates are x, y, and z for 3D as well as planar 1D and 2D geometries. For
axisymmetric geometries, the default names for the spatial coordinates are r, @ (phi), and z. If you use the geometry
to represent something other than space, or if you for some other reason want to use other names for the spatial
coordinates, you can change the names in the fields for the First, Second, and Third coordinate under Spatial

coordinates. The field labels include the default spatial coordinate names in parentheses.

You cannot use the variable for the time, £, as a spatial coordinate name.

2

Geometry Shape Order
The setting in the Geometry shape order list determines the order of the curved mesh elements that determine the
geometry shape. The default setting is Automatic, but it is also possible to select an order such as Linear, Quadratic,

Cubic, Quartic, Quintic, Sextic, and Septic. The default setting allows for automatic reduction of the order in some

cases.
* Creating a New Model
* The Root Window
» Editing Node Properties, Names, and Identifiers
@l * Setting the Unit System for Models

* Using Extra Dimensions

e Curved Mesh Elements in the COMSOL API Reference Manual

Adding Extra Dimensions to a Component

To add an extra dimension to The Component Node, from the Home ribbon (Windows users), Model Toolbar (Mac
and Linux users), or for any operating system, right-click the Component node and choose Add Extra Dimension. An
Extra Dimension node, in the chosen space dimension, is then added under the Component node in the Model

Builder. You can to add one or several extra dimension nodes to any Component.

The added node then contains these default nodes—Definitions, Geometry, and Mesh. The settings for the Extra

Dimension are the same as for the Component node, except it has a unique identifier.

The default nodes associated to the Extra Dimension are considered the
extra dimension geometry and extra dimension mesh. The original

geometry and mesh are called the base geometry and base mesh.

[

Before the extra dimensions can be used in physics, they must be attached

on a selection in the base geometry.
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To enable the Extra Dimensions option, go to The Preferences Dialog Box.
El- Click Model Builder, sclect the Enable technology preview functionality
= check box, and then click OK.

COMPONENT IDENTIFIER
The component identifier is a string used to identify variables in the model. The default Extra Dimensions

component identifier is xdim1, xdim2, and so on, but you can change it in the Identifier ficld.

@l Using Extra Dimensions

Branches and Subbvanches in the Tree Structure

You can proceed through your modeling in the Model Builder by selecting the branches in the order suggested by
the default positions, from the top down, or selecting and defining each branch as needed. One level below the
main Component branch are subbranches as described in Table 3-2 and shown in Figure 3-2. The node appearance

can also change depending on many factors. See Dynamic Nodes in the Model Builder for examples.

BUILDING MODELS IN THE MODEL BUILDER | Il



Madel Builder * x

r v

- =

« N busbar.mph (root)
Global Definitions

Pi Parameters

4 m Component 1 (compl}
§ ————4 = Definitions
& Tibolts
A=/ Boundary System 1 (sys1)
L~ View 1
a Geometry 1
[¥ Work Plane 1 {wpl)
(0] Bxtrude 1 fext1)
[* Work Plane 2 (wp2)
[T} Extrude 2 (ext2}
[+ Work Plane 3 (wp3)
[} Extrude 3 (ext3}
[ Form Union ffin)
=8 Materials

= Copper (matl)

258 Titanium beta-215 (mot2)

8 —— | X_Electric Currents fec)

4 | Heat Transfer in Solids (ht)
7 Heat Transfer in Solids 1

“m Thermal Insulation 1
B Initial Values 1

= Heat Flux 1
8a —— 4 .y Multiphysics
X Electromagnetic Heat Source 1 (emhl)

21 Boundary Electromagnetic Heat Source 1 (bemhl)
Temperature Coupling 1 (tcI)
9 ———1 AMesh1
4 "o Study 1
= Step 1: Stationary
[*r. Solver Configurations
4 —« I Results
Data Sets
10 — 4! Derived Values
[ Tables
J{JQ\ Electric Potential (ec)
JJ.IQ\ Temperature (ht)
J{JQ\ Isothermal Contours (i)
4 J{Jil, 3D Plot Group 4
™) surface 1
& Export
[ b_‘| Reports

Figure 3-2: An example of the Model Builder tree structure showing the many diffevent types of branches and
subbranches available in a model. Refer to Table 3-2 to learn more about o node. Use the numbers to locate the node in
the table.

TABLE 3-2: THE MODEL BUILDER BRANCHES AND SUBBRANCHES

FIGURE ICON NAME DESCRIPTION AND LINK TO MORE INFORMATION
REF.

Main Branches

Global Has feature nodes to define global Parameters,

Definitions  Variables, Functions, Load and Constraint Groups,
and Geometry Subsequences that are available
everywhere in the model. See Global Definitions.

2 Various Component This branch includes the subbranches Definitions,
Geometry, Materials, Physics, and Mesh. Also see
The Component Node.
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TABLE 3-2: THE MODEL BUILDER BRANCHES AND SUBBRANCHES

FIGURE ICON
REF.

NAME

DESCRIPTION AND LINK TO MORE INFORMATION

3 gan.l

¢ &

Subbranches

8 Various

8a

Study

Results

Definitions

Geometry

Materials

Physics

Multiphysics

Mesh

This subbranch is where you set up study steps and
solver configurations to solve a model using one or
more study types for different analyses. See Studies
and Solvers.

The features contained in the subbranches for Data
Sets, Derived Values, Tables, Export, and Reports
are used to present and analyze results. See Results
Analysis and Plots.

This subbranch is used to create variables, functions,
selections and other definitions that are local to a
specific component in your model. Features available
include Functions, Selections, Coordinate Systems,
Component Couplings, and Probes.

This branch contains the definition of the model’s
geometry, where you can import a geometry or
build one yourself using the available tools. See
Geometry Modeling and CAD Tools.

Collect all material properties organized in Material
nodes with a defined geometric scope. Material
properties required by any of the physics show up
automatically in the defined material’s settings
window. See Materials.

Each physics interface forms its own branch based
on the model definition requirements. See The
Physics Interfaces and Creating a New Model to
start.

This is 2 main branch but is associated directly with
the physics branch. See The Multiphysics Node.

This subbranch collects all meshes defined for a
model. If there is only a single mesh in a2 model, its
Mesh node appears directly under the
corresponding Component node. See Meshing.
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TABLE 3-2: THE MODEL BUILDER BRANCHES AND SUBBRANCHES

FIGURE ICON
REF.

NAME

DESCRIPTION AND LINK TO MORE INFORMATION

10

Data Sets

Derived
Values

Tables

Various  Plot Groups

&

F

Export

Reports

Data Sets refer to the source of data for creating
Plots and Reports. It can be a Solution, a Mesh, or
some transformation or cut plane applied to other
data sets—that is, you can create new data sets
from other data sets.

Used to define evaluations of numerical results—
globally, in a point, or integrated quantities. For 2D
and 3D plots, you can also get numerical results
directly in a table by clicking the plot. See About
Derived Values.

This subbranch displays the results from integral and
variable evaluations defined in Derived Values nodes
or by probes and stored in Table nodes. See The
Table Window and Tables Node.

After adding a 3D, 2D, or ID Plot Group, plots are
added and defined under this subbranch. See Plot
Groups and Plots.

After a model is completed, you can add various
components to this and then generate outputs
(animations, data, images, player, or export), or
export the information to your computer as image,
movie, or data files for use in external documents
or for other purposes. See Export Types.

This subbranch opens the Report Generator, which
is a tool for reporting and documenting models
created in COMSOL. It creates a record of the
entire model including all the settings made during
the modeling process. The report is an overview of
the model and includes model properties, geometry,
physics, mesh, studies, and results and visualization.
See Reports.

The Node Settings Windows

For all operating systems, and when any node is clicked in the Model Builder (except a few container nodes such

as Definitions and Data Sets), a corresponding settings window opens with the same name as the node. The settings

14 |
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window contains settings for defining operations and properties specific to a node, as shown in Figure 3-3.

Model Builder -+ Component vt

- -

-

¥ Component Identifier

4 U_ntitled.mph (root)
Global Definitions

4 || Component 1 {compl)

Identifier  compl

¥ Component Settings

= Definitions
Y4, Geometry 1 Unit system:
Materials
4 | Heat Transfer in Solids (ht) [Same as,glohal system = |

% Heat Transfer in Solids 1 Spatial coordinates
o .
m» Thermal Insulation 1

B= nitial Values 1 First (x) Second (y) Third (z)
A5 Mesh1 x y z
4 "o Study 1 | 1 | »
& Step 1: Time Dependent Geometry shape order:
@ Results

[Automatic = |

Figure 3-3: An example of a node settings window. In this example, the Component node settings window opens when
the node of the same name is clicked.

When an operation or property is updated in the settings window, its effect on the model is displayed in the
Graphics window cither instantancously or by clicking the Build Selected ( [ ), Build All ( [§f ), or Plot ([ ) button,
which are available in some of the settings window toolbars. If you update settings for the physics, you must

recompute the solution to reflect the changes in the physics.

To select the parts of the model to define in a specific settings window, select the relevant geometric entities directly
in the displayed model in the Graphics window, from the Selection List window, or as, for example, All domains in

the settings window.

* Toolbars and Keyboard Shortcuts
& * About Selecting Geometric Entities
* The Graphics Window

Opening Context Menus and Adding Nodes

In addition to using the toolbars and menus (see The COMSOL Desktop Menus and Toolbars), you can right-click
a node to open a context menn. The context menu lists all the functionality available as subnodes to a particular
node on a branch of the tree. Figure 3-4 shows the context menu for some of the Geometry node options. From
the menu, you can add additional, and relevant, functionality, operations, or attributes to the sequence. Often there
is a mixture of submenus, keyboard shortcuts, or specific features to choose from as in Figure 3-4 and Figure 3-5.
There are also standard options such as Rename, Properties, and Help.

The context menu is also further divided and categorized for physics interfaces, as in the section Physics Node

Context Menu Layout and Figure 3-5.

To add physics nodes to physics interfaces, in general, use the Physics
n toolbar. However, subnodes/subfeatures are added from the context

menu.
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The layout of the context menu (especially for physics interfaces) depends
on whether the nodes are grouped by space dimension. The default is

e

ungrouped nodes. See Grouping Nodes by Space Dimension and Type

for an example comparing the different context menus.

a buskar.mph (root)
I (£) Global Definitions

4 |@ Component 1 (compl}

I = Definiticns
4 Geometry 1

| B BuidAl F8 | ——— A keyboard shortcut

[

[

b

| [E Import
I Livelink Interfaces 3
I Defeaturing and Repair 3
Block

Click to add a specific node

Cone e A
or open a window.

¥ Sphere

Cylinder

Mare Primitives 3

* E Work Plane
+L_.-!. Extrude
+_
F

* <= Revolve

* & Sweep
Boolean Operations 3
Transforms » | ———— Submenus to
e » additional options

* 1 Delete Entities
Pragramming 3
Selections 3
Virtual Operations 3

Measure

Insert Sequence
Expaort

Delete Sequence

Standard options on all
context menus.

Rename F2

Properties

CE R L

Help F1

Figure 3-4: A context menu opens when you right-click any node in the Model Builder. In this example, the options
available for the Geometry node are shown.

OPENING THE CONTEXT MENU
¢ Right-click any node in the Model Builder to open the context menu
* Once a node is highlighted, right-click anywhere in the Model Builder to open it.
* Use the shortcuts based on operating system:
- Windows: Press Shift+F10.
- Mac: Press Ctrl+F10.
- Linux: Press Shift+F10.
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After selecting such an option from the list, an associated settings window opens to the right (by default) of the

Model Builder window. See Figure 3-3 for an example.

In the context menu, a plus sign next to the icon (*::: ) means a node
of that type is added to the Model Builder.

!

* The Node Settings Windows
* Grouping Nodes by Space Dimension and Type
Gl. * Clearing Sequences and Disabling, Enabling, and Deleting Nodes

¢ About Geometric Entities

The Physics Nodes

An important part of building a model is where you add physics branches. For example, when Creating a New

Model. This branch (see Figure 3-2 for an example) contains the nodes that define the material properties,

equations, loads, initial values, boundary conditions, and other parts of the physics that the model describes. All

settings windows for the specification of the physics and equations accept parameters and variables as input data.

SPECIFYING PHYSICS INTERFACE SETTINGS

Each physics interface includes nodes for specifying all input data for a specific physics in a model:

¢ Material properties and material models
* Boundary and interface conditions
* Equations (for equation-based modeling)

* Initial conditions
In addition, you can specify weak form contributions and element types for additional flexibility.
Specifically, the settings are available on the following parts of the geometry:

¢ Domains

¢ Boundaries
* Edges

¢ Points

* Additional properties that are independent of the geometry

Not all of these options are available for all geometry types and physics
]
I_El interfaces.
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PHYSICS NODES BY SPACE DIMENSION
The physics nodes indicate the geometric entity level (domains, boundaries, edges, points, or pairs) based on the
space dimension of the Component (see Table 3-3). The nodes also correspond to The Graphics Window Toolbar

Buttons, some of which are also based on space dimension.

See Physics Exclusive and Contributing Node Types and Physics Node
Status for examples of other differences to how the nodes display in the
@ Model Builder.

TABLE 3-3: PHYSICS NODES BY SPACE DIMENSION

NAME 3D 2D AND 2D ID AND ID
AXISYMMETRIC AXISYMMETRIC
i 3
Domain level = [ ] I
H Do D In
Domain level, default node ] Y] B
Boundary level - - .
I Dy I
Boundary level, default node ] .
Boundary level, Pairs ) I'xl_] wt
Point level B ] —
| | ———
Edge level B — —

* The Physics Interfaces
* Physics Default Nodes
& * Physics Node Context Menu Layout

* Physics Node Status

Physics Defanlt Nodes

When you add a physics interface, COMSOL automatically adds a corresponding physics branch in the tree, which
typically includes a number of default nodes, including but not limited to:

¢ A model equation or material model node, typically on the domain level. This node defines the domain equations
(except optional sources, loads, reactions, and similar contributing domain quantities) and the related material

properties or coefficients.
¢ A boundary condition node. For multiphysics interfaces there is one boundary condition for each physics.

 For axisymmetric models, the symmetry axis has an Axial Symmetry boundary condition (see Physics Axial

Symmetry Node).

* An Initial Values node for specifying initial values for a time-dependent simulation or an initial guess for the

solution to a nonlinear model.

In most cases, the default nodes’ initial selections include all domains or all boundaries (or all instances of another
geometric entity level). Their selection is always every instance that is not overridden by another node on the same
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geometric entity level. It is not possible to delete such default nodes, but you can copy and duplicate all default
nodes. Some multiphysics interfaces also add default nodes with no initial selection, which are possible to delete
from the model. Default nodes include a D (for “default”) in the upper-left corner (fgg) to indicate their special
status. The copy or duplicate of a default node is a node of the same type but behaves as a normal node with an

initially empty selection.

For example, for a geometry with four boundaries, the default boundary condition’s initial selection includes all
four boundaries. If another exclusive boundary condition for Boundary 3 is added, that boundary becomes
overridden (inactive) in the default boundary condition’s selection. If you disable or remove that boundary
condition, the default boundary condition becomes active for Boundary 3 again. You cannot change a default

node’s selection.

Some physics also add standard nodes directly when you add them to a
model. They represent functionality that is likely to be useful but that you

[

might want to make only active on a part of the geometry or delete. Such

nodes do not include a D in the upper-left corner.

* Physics Nodes by Space Dimension
* Physics Node Status
El * Physics Exclusive and Contributing Node Types

* Dynamic Nodes in the Model Builder

Physics Node Context Menu Layout

The context menu opens when you right-click a physics interface node, or any node in the Model Builder (see
Opening Context Menus and Adding Nodes). This menu is divided into four sections for most physics: the first

section contains domain settings, the second boundary settings, the third edge settings, and the fourth has point

settings.
There can be menu items with the same name but applied at different
n geometric entity levels.
To add physics nodes to physics interfaces, in general, use the Physics
n toolbar. However, subnodes/subfeatures are added from the context

menu.
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Figure 3-5: An example of o Heat Transfer in Solids interfuce context menn. The choices ave based on the Component
dimension as well as the physics interface. The menu is further divided by geometric entity level (domain, boundary,
edye, point, and pair).

As shown in Figure 3-5, the context menu layout is also based on whether the nodes are not grouped (the default)
or if Group by Space Dimension is sclected.

Physics Exclusive and Contributing Node Types

The nodes for the physics are in a sequence, which acts like a macro that the software runs in a top-down order.
Depending on the selection for each node, a node can totally or partially override, or shadow, a node earlier in the
sequence. How the software treats these nodes depends on their relationship. There are two different types of

nodes: exclusive and contributing as shown in Figure 3-6.

The exclusive and contributing nodes maintain the described behavior
only in relation to similar types of nodes within the same physics (for

[y

example, you can have a temperature constraint and a pressure constraint
for the same boundary in the same model).
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What the node looks like in the Model Builder is based on the space

g dimension. See Physics Nodes by Space Dimension.

4 @ Heat Transfer in Solids {ht}
T4 Heat Transfer in Solids 1 {solidi}
S Thermal Insulation 1 {insi}

5 Initial Values 1 finitl} & Heat Transfer in Solids {ht}
/ mw Heat Flux1 {hfl} = Heat Transfer in Solids 1 {solid1)
Contributing node f- Thermal Insulation 1 {ins1}
T Initial Values 1 {init1}

Exclusive node s Heat Flux 1 {hf1)

Figure 3-6: An example of exclusive and contributing nodes in a 3D component’s physics interfice operating sequence
and when Ungroup is selected.

EXCLUSIVE NODES

The use of an exclusive node means that only one can be active for a given selection. That is, if you add another
exclusive node (for example, an identical node) with the same selection, the first exclusive node is overridden and
thus has no effect.

Typical exclusive nodes include model equations, initial values, and boundary conditions that are constraints, such
as prescribed values for displacements, temperatures, pressures, and so on, including special variants of these such
as ground conditions in electromagnetics and fixed constraints in structural mechanics. Also some boundary
conditions that are not constraints but have a definitive meaning are exclusive nodes—for example, electric
insulation, thermal insulation, and no-flow conditions. Depending on the selections for each node, an exclusive
node can override another node partially. Nodes are exclusive only within their specific physics. When a node is
selected in the Model Builder tree, nodes that are overridden by the selected node are indicated using a red arrow
in the lower-left corner of the icon ( =m ), and nodes that override the selected node are indicated using a red arrow

in the upper-left corner of the icon (‘g ).

CONTRIBUTING NODES

A contributing node means you can have more than one of these nodes with the same selection and that the
software adds these together when evaluating the model. Typical contributing nodes are loads, fluxes, and source
terms, where you can have more than one of each type that is active on the same domain or boundary, for example.
The total effect is then a sum of each contributing load, for example. When a node is selected in the Model Builder
tree, COMSOL shows other nodes, which the current node contributes with, indicated using a yellow dot to the

left of the icon (for example, in this boundary level icon agy ). See also Figure 3-6 for an example.

LISTING OVERRIDES AND CONTRIBUTIONS

If your preferences include showing the Override and Contribution section in the settings windows for physics nodes,
you can find the following information about how exclusive and contribution nodes interact in the model. Click
the Show button ("= ) and select Override and Contribution from the Model Builder to display the section. To expand
this section on all nodes, click Expand Sections ( = ) and sclect Override and Contribution from the Model Builder and

click the physics nodes to display the information as in Figure 3-7 and described below.

* The Overridden by list contains the names of the nodes that the selected node are overridden by. The selected
node is then overridden by these nodes at least partially, and the Selection list contains (overridden) for the
geometric entities (boundaries, for example) where it is overridden. The nodes that the selected node is
overridden by are indicated using a red arrow in the lower-left corner of the icon, for example, in this boundary

level icon .
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The Overrides list contains the names of the nodes that the selected node overrides (where the current node is
active). The nodes that the selected node overrides are indicated using a red arrow in the upper-left corner of the
icon, for example, in this boundary level icon =N

The Contributes with list contains the names of the nodes that the selected node contributes with for at least some
shared selection. The nodes that the selected node contributes with are indicated using a yellow dot to the left
of the icon, for example, in this boundary level icon agy .

If you disable physics nodes locally in a study step using the Physics and
Variables Selection section in the study step’s settings window, the
indications of overrides and contributions in the Model Builder are
unchanged (but disabled physics nodes get an asterisk to indicate that
their state has been changed in at least one study step). The local variables
and physics tree in the study step’s settings window, on the other hand,

does display the overrides and contributions taking the disabled nodes
into account.

[
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Global Definitions Selection: [ Manusl b
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. Electric Currents (ec)
.r.}) Multiphysics
A5 Mesh1
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&« 1 +

& 4

D~ oh W ha

Thermal Insulation 1

Contributes with:

Figure 3-7: The Override and Contribution section lists other physics nodes that the selected node is overvidden by,
overrides, or contributes with. This is an example for a 3D component and with Ungroup selected.

* Physics Node Status
@l * Physics Default Nodes
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Physics Node Status

The status of a physics node depends on if it is a default node, the selection that it applies to, and other nodes in
the same branch that can override nodes earlier in the sequence. You can change the order of nodes (except the

default nodes) by moving them up or down.

OVERRIDDEN SELECTIONS

A node can be partially or completely overridden by another node further down in the same branch of the model
tree that is of a similar, exclusive type. For example, if you specify a temperature boundary condition on boundary
1 and boundary 3, and then add another temperature boundary condition for boundary 3, the first temperature
boundary condition is overridden on boundary 3. In the settings window for the Temperature nodes that define the
temperature boundary condition, the Selection list then shows 3 (overridden) to indicate that the temperature
boundary condition defined on this selection is overridden for boundary 3 but is still active on boundary 1.
Deleting or disabling the other temperature boundary condition on boundary 3 reactivates the original

temperature boundary condition, and then shows 3 (without the (overridden) indication).

SELECTIONS THAT ARE NOT APPLICABLE
For selections that are not applicable for a node (such as interior boundaries for an boundary condition that is only
applicable for exterior boundaries), the Selection list then shows (net applicable) next to entries that are, in this case,

interior boundaries.

ENABLING AND DISABLING NODES
By enabling or disabling physics nodes, you can activate and inactivate (shadow) other physics interface nodes that
appear higher up in the physics inter face branches.

* Physics Default Nodes
* Physics Exclusive and Contributing Node Types
@l * Physics Nodes by Space Dimension
* Clearing Sequences and Disabling, Enabling, and Deleting Nodes

Dynamic Nodes in the Model Builder

The Model Builder is a dynamic environment. As your model is built and analyzed, there are numerous ways to
quickly identify nodes that change status during the process. Table 3-4 lists generic examples and links to the

dynamic visual aids that are used to help you.

¢ Branches and Subbranches in the Tree Structure

'El * The Component Node

TABLE 3-4: DYNAMIC NODES—VISUAL AIDS TO IDENTIFICATION

ICON TYPE NODE EXAMPLE AND LINK TO MORE INFORMATION (WHERE
APPLICABLE)

»® Error For example, on a Material node ;&: See Errors
Relating to the Material Nodes.

a Error node Errors and Warnings
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TABLE 3-4: DYNAMIC NODES—VISUAL AIDS TO IDENTIFICATION

ICON TYPE

NODE EXAMPLE AND LINK TO MORE INFORMATION (WHERE
APPLICABLE)

|:| Current node, not
built (yellow frame)

D Current node (green
frame)

|2| Enabled sequence

Harmonic
Perturbation

A Warning

* Editing, or in process
of editing, a node

ma Pairs
e Pairs—Fallback
Features
- Contributing node
1 Default node
. Override
Overridden

STUDY STEPS ANALYSIS

_ Solve For

For example, on a Geometry node (B) This node is
also displaying the asterisk indicating the node is being
Edited. The asterisk also appears on plot nodes when the
plot has not been updated to reflect changes in the data
or settings (for example, after re-solving), See The
Current Node in Geometry Sequences.

A current node is used for Geometry and Meshing nodes
and indicates that the feature or sequence of steps has
been built. It is a green line on the left and upper edges of
the node. For example, on a Geometry node E, after
building. Also see The Current Node in Geometry
Sequences.

During solution processing, the particular sequence that
is enabled and runs when selecting Compute has a green
border around its icon (Ij) See Computing a
Solution.

For example, on a boundary level node for the Electric
Currents interface, Electric Ground node : See
Harmonic Perturbation, Prestressed Analysis, and
Small-Signal Analysis.

For example, on a Mesh node f‘:'.‘.‘:;'

For example, on a Mesh node . This node is also
displaying the asterisk indicatingutl:Fe node is being Edited.
Also indicates physics nodes that have been disabled in a
Study Step. See Editing and Building Geometry Nodes
for Geometry nodes for example.

For example, on a 3D Boundary Level node i See
Identity and Contact Pairs.

For example, on a 3D Boundary Level pair node |gy. See
Identity and Contact Pairs.

For example, on a 3D boundary level node #yy. See
Physics Exclusive and Contributing Node Types and
Physics Node Status.

For example, on a 2D boundary level node 7. See
Physics Default Nodes.

For example, on a 3D boundary level node ‘g . See
Physics Exclusive and Contributing Node Types.

For example, on a 3D boundary level node =m. See
Physics Exclusive and Contributing Node Types

For example, a Laminar Flow interface === where the
green dot in the lower-right corner indicates that the

study solves for the degrees of freedom in this physics
interface. See Physics and Variables Selection.
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TABLE 3-4: DYNAMIC NODES—VISUAL AIDS TO IDENTIFICATION

ICON TYPE NODE EXAMPLE AND LINK TO MORE INFORMATION (WHERE
APPLICABLE)

- Disable in Solvers For example, a Laminar Flow interface 5:|: is enabled
(not dimmed), shows that the study step provides
degrees of freedom (the yellow dot in the lower-right
corner), and has a change of state indicated by the
asterisk. The yellow dot means that the study step
provides degrees of freedom but does not solve for the
physics. See Physics and Variables Selection.

% Change of State An asterisk appears in the upper-right corner of nodes
(editing) for which you change their state in the study step’s
selection tree compared to their state in the main model
tree in the Model Builder. For example, for the Joule
Heating interface |%¥.
@ Disabled in Model In this example, a Transport in Diluted Species interface
(provides no degrees  .[* is disabled (unavailable), provides no degrees of
of freedom) and freedom (red dot in the lower-right corner), and has a
shows a change of change of state indicated by the asterisk. See Physics and
state Variables Selection.

LOAD AND CONSTRAINT GROUPS

2 Load Group This is an example of a Boundary Load node with a load
group (—%). This is for a 2D model at the boundary level.
See Load Group and Using Load Cases.

2 Constraint Group This is an example of a Fixed Constraint node with a
constraint group [~ ¥. This is for a 2D model at the
boundary level. See Constraint Group and Using Load
Cases.

Errors and Warnings

COMSOL Multiphysics reports problems of two types—errors and warnings.

Errors: Errors prevent the program from completing a task. For errors, a COMSOL Error window appears with a brief
error description and, in some cases, an Open log file button for additional information. Under the node where the
error occurred there is, in most cases, also an Error subnode (€3 ) that contains an error message that generally

provides additional information. Also, for many error types, the icon for the node where the error occurred appears

with a red cross in the lower-right corner.

Warnings: Warnings are problems that do not prevent the completion of a task but that might affect the accuracy
or other aspects of the model. Warnings typically appear in the Log window ([£3]). The warning message also appears

as a Warning subnode ( ) ) under the node from which the warning was sent.

INDICATION OF UNEXPECTED, UNKNOWN, OR INCONSISTENT UNITS

The unit display appears orange for the properties in the settings for the physics and materials that have invalid or
inconsistent units or a different unit than expected. An inconsistent unit can occur by summing terms with units
that represent different physical quantities, such as 273[K]+3[ft], for example. A tooltip displays a message at the
corresponding field. In the case of a valid but unexpected unit, this message contains the deduced and expected

units in the current unit system.

If an unexpected or inconsistent unit appears in a text field for a physical property, COMSOL ignores the unit and
uses the numerical value, including an SI prefix if present, as the input to the model. For example, in a text field for
density using SI units, the software interprets 2930[K] as 2930 kg/ms and 2930[mK] as 2.930 kg/ms. A unit

display that appears red contains a syntax error, which can be due to, for example, missing or misplaced parentheses.
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ERRORS AND WARNINGS IN A GEOMETRY SEQUENCE
If an error occurs when you build a node, the build stops. The node with the problem then gets an Error subnode

(€3) that contains the error message. Also, the node’s icon displays with a red cross in the lower-left corner.

After a successtul build of a node, a warning message can sometimes display as a Warning subnode ( f} ). If a

warning message exists, the node’s icon displays with a yellow triangle in the lower-left corner.

ERRORS AND WARNINGS IN MESHING SEQUENCES
If a problem occurs when you build a node, the build continues if it is possible to avoid the problem in the

corresponding meshing operation, otherwise the build stops.

Continuing the Build

When you build a Free Triangular, Free Quad, or Free Tetrahedral node where problems are encountered, you can
avoid the problems related to meshing of faces and domains by leaving the corresponding faces and domains
unmeshed. The operation corresponding to the node continues meshing the remaining entities and stores
information on the encountered problems in subnodes of the node. A node that encountered this type of problems
during the build gets a Warning status. The node’s icon is decorated with a yellow triangle in the lower-right corner.
If you build several nodes in a sequence the build does not stop by a node that gets a Warning status. See Dynamic
Nodes in the Model Builder.

Stopping the Build

When you build other nodes than Free Triangular, Free Quad, or Free Tetrahedral the build stops if a problem is
encountered. This means that no changes are made to the mesh. The node gets an Error status, which the program
indicates by adding a red cross in the lower-right corner of the node’s icon. You find information about the error
in a subnode of the node where the error occurred. If the node is part of a sequence build, the build stops and the

preceding node becomes the current node.

ERRORS AND WARNINGS IN SOLVER SEQUENCES

Problems encountered when running a solver or generating a mesh are treated in two different ways depending on
if it is possible to avoid the problem and continue the operation or if the operation must be stopped. In the first
case, a Warning node ( f} ) appears under the node in the model tree that caused the problem. In the second case,
an Error node ( ) ) appears under the node in the model tree that caused the problem. For the solvers, and for

multiple meshing warnings and errors, you find the Warning and Error nodes under the Information node ((7) ).

e Using Units
El e Unit Systems in COMSOL

* Dynamic Nodes in the Model Builder
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Working with Nodes in the Model Builder

Viewing Node Names, Identifiers, Types, and Tags

Select the node labels to display in the Model Builder. You can view combinations of the following label types:

e Names are only used in the Model Builder for names (descriptions) of the nodes. You can rename the nodes,

using any name that is unique within the model, to better describe what they do or contain in a model.

e Taygsare unique for each node and are assigned automatically. Tags are primarily used when running COMSOL
models in Java or MATLAB

e Identifiers are primarily used as names for functions and operators when called in models and as identifiers for
the component and physics interface nodes that you use for variable scoping. See Variable Naming Convention
and Namespace. You can change the name of the component and interface identifiers. An identifier must begin
with a lowercase or uppercase letter (a—z or A-Z). All other characters in the identifier must be a lowercase or

uppercase letter, a number 0-9, or an underscore (_).

e Types are the unique descriptions for each type of node, which you cannot modity.

You can change the name of a node for all levels (except the root node, which gets its name from the model
filename), but the identifier can only be changed for the top Component and physics interface nodes and as a name

for functions and operators. The tag and type are automatically assigned by the software and cannot be changed.

You can specify a node’s name in its Properties section, by right-clicking the node and choosing Rename, or by
pressing F2, which opens a window where you can enter a New name. The identifier serves as the name of functions
and operators, which you can define in the settings windows’ Function Name or Operator Name section for those
nodes. You can also specify it in the Component Identifier and Interface Identifier sections for the main Component

nodes and physics interface nodes, respectively.

To access the menu where you select the node labels to display, on the
Win Home ribbon, in the Layout section, click [=] Model Builder Node Label.

To access the menu where you select the node labels to display, select a
layout from Windows>Model Builder Node Label.

SELECTING THE LABELS TO VIEW IN THE MODEL BUILDER
Select from the list: Show Name Only, Show Name and Identifier, Show Name and Tag, Show Type and Identifier, or Show
Type and Tag. Sce Figure 3-8 for examples of the different label types.

The options in the list modify the view in the Model Builder in the following way:

¢ Seclect Show Name Only to only display the name.

* Seclect Show Name and Identifier to display the name with the identifier in parentheses using an italic font. The
identifier appears only where it is defined—that is, for component nodes, physics nodes, functions, component

couplings, and geometry features. This is the default setting.
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¢ Seclect Show Name and Tag to display each node’s feature name with the predefined tag in curly braces using an
italic font.

¢ Select Show Type and Identifier to display each node’s feature type (predefined name) with the identifier in
parentheses using an italic font.

¢ Seclect Show Type and Tag to display ecach node’s feature type (predefined name) with the predefined tag in curly

braces using an italic font.
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Figure 3-8: Examples of the available label combinations on the View menn.

* Editing Node Properties, Names, and Identifiers
& * The Root Window

128 | CHAPTER 3: BUILDING A COMSOL MODEL



Moving Nodes in the Model Builder

Many of the nodes under the branches and subbranches listed in Table 3-2 can be moved around in the model tree.

To move nodes use one of these methods:

¢ Select the nodes and use the mouse to drop them in another applicable position in the model tree. A horizontal
line indicates where in the model tree the moved (or copied) nodes get inserted when releasing the mouse.

* Right-click the selected nodes and select Move Up ( § ) or Move Down ( | ).

* Use the keyboard shortcuts Ctrl+up arrow or Ctrl+down arrow to move nodes up or down.

For physics nodes it is not possible to move the default nodes (for the

default boundary condition, for example). It is possible to create a copy

[

of a default node, which initially has no selection. To click-and-drag a
default node creates a copy whether or not the Ctrl key is pressed.

The order of the nodes in some of the branches affects the evaluation of the sequence that they define. In the

following branches and subbranches it is possible to move nodes up and down to control the evaluation of the
sequence or the order in which they appear within the branch or subbranch (also see Table 3-2):

¢ Definitions: nodes can be moved relative to other nodes of the same type (functions, selections, and so on).
¢ Geometry: Geometry nodes.

e Materials: Material nodes.

* Mesh: Mesh nodes.

¢ Physics interfaces: Except for the default nodes, the nodes for physics interfaces (such as material models,

boundary conditions, domains, edges, points, and sources) can be moved within the physics branches.
¢ Study: The Study Step nodes can be moved.

¢ Results: The order of the nodes can be rearranged within each of the subbranches (Derived Values, Tables, Plot

Groups, Export, and Reports). Exceptions under the Export node are the Plot, Mesh, and Table nodes.

Copying, Pasting, and Duplicating Nodes

It is possible to copy and paste many of the nodes in the Model Builder to create additional nodes with identical
settings. Some nodes can also be duplicated underneath the original node. You can also move, copy, and duplicate

nodes using “drag-and-drop” of nodes in the Model Builder.

Duplicate (L:El) is a convenient way to copy and paste in one step. In other
words, it combines the Copy and Paste functions. When a node is
g duplicated, COMSOL adds identical nodes underneath the original

nodes on the same branch. Most, but not all nodes, can be duplicated.

Nodes that can be copied (and duplicated) include the following:
* Functions, which are possible to copy from one Definitions or Global Definitions branch to another. Also see
Functions and About Global and Local Definitions.

* Physics nodes, which can be copied within the same physics interface or to another identical physics interface.

Also see The Physics Interfaces.

¢ Geometry sequences—There are two ways to copy and paste geometry objects. Using the Transforms>Copy

operation (that keeps the nodes linked to one another), or a standard copy and paste (see Copy and Paste
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Geometry Objects). It is also possible to copy/paste and duplicate nodes corresponding to operation features,
such as the Union node.

¢ Study steps, which are possible to copy from one Study branch to another. Also see Studies and Solvers.

* Plot nodes, which are possible to copy from one plot group to another. Also see Plot Groups and Plots.

The copied object must be pasted into a model with the same space
n dimension. For example, a Sphere can only be pasted into a 3D model.

HOW TO COPY, PASTE, OR DUPLICATE NODES

¢ On the Quick Access Toolbar (Windows users) or from the main Edit menu (Mac and Linux users), click Copy
(|__'E|), Paste (ﬁj), or Duplicate (|_:;.:'])

* Right-click a node and select Copy, Paste, or Duplicate.

* To paste a node, and after selecting Copy, click the parent node and right-click to select Paste Heat Flux to paste
a copied node (a Heat Flux node in this case) to the parent node’s branch.

¢ Create a copy of a node by Ctrl-clicking it and dragging a copy to an applicable location. A small plus sign at the
cursor indicates that you drag a copy of the selected node.

* Ctrl-click and drag a duplicate to an applicable location. A small plus sign at the cursor indicates that you drag

duplicates of the selected nodes.

Undoing and Redoing Operations

Undo is not possible for nodes that are built directly, such as geometry
- . .
E| objects, solutions, meshes, and plots.

It is possible to undo the last operation for operations like adding, disabling, moving, and deleting nodes in the

Model Builder as well as changing values in the settings window. You can undo or redo several successive operations.
To undo the last operation or redo an undone operation:

* On the Quick Access Toolbar (Windows users) or from the main Edit menu (Mac and Linux users), select or

click Undo ( 45 ) or Redo ().
e Press Ctrl+Z (undo) or Ctrl+Y (redo).

* Copying, Pasting, and Duplicating Nodes
'El * Clearing Sequences and Disabling, Enabling, and Deleting Nodes

Going to the Source Node

In the settings window for many nodes, other nodes can be referenced in the model tree such as a component,

solution, study or study step, or data set, which provide data to the node where they are referenced.
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Nodes where you refer to other nodes include plot groups, data sets, and solvers; in such nodes’ settings windows,

click the Go to Source button ( £ ) to move to the node that the selection in the list next to the button refers to.

* The Node Settings Windows
El ¢ Studies and Solvers

* Results Analysis and Plots

Clearing Sequences and Disabling, Enabling, and Deleting Nodes

You can change the contents, and actions, of the sequences in the model tree by clearing a mesh sequence or

solution under a solver configuration. Or disable, enable, and delete nodes in the Model Builder.

Undo is not possible for nodes that are built directly, such as geometry
n objects, meshes, solutions, and plots.

CLEAR OR DELETE A MESH OR SOLUTION
Use a Clear function to keep the nodes and be able to recreate the mesh or solution by rebuilding the mesh sequence

or computing the solution again.

¢ Under the Component node where you want to clear or delete the mesh, right-click the Mesh node and select Clear
Mesh ( % ). To delete a meshing sequence completely, select Delete Sequence (';-_)

* To clear a set of solutions under a specific study, right-click the Solver Configurations node and select Clear
Solutions (%, ).To delete all Solver nodes, select Delete Solvers (';-_). You can also choose whether or not to

remove the Results nodes (data sets and plots, for example) associated with the solver configuration.

If you have a model geometry with several meshes or several studies, you can clear all meshes or all solutions in all
studies at the same time. From the Mesh toolbar, click Clear All Meshes ( 'hé ). Or from the Study toolbar, click Clear
All Solutions (}.f).

DISABLE OR ENABLE NODES

A disabled node does not take part in the evaluation of a sequence; see Figure 3-4. Some nodes, such as container
nodes and default nodes in the physics interfaces (see Physics Detault Nodes), cannot be disabled (or deleted).
When this is the case, the context menu does not have these options available. You can use Shift-click and Ctrl-click

to select multiple nodes that you want to delete, disable, or enable.

* To disable selected nodes, right-click and select Disable ( () ) or press F3. The nodes are unavailable (dimmed)
in the model tree to indicate that they are disabled. For a geometry or mesh sequence, the disabled node does

not affect the finalized geometry or mesh.

* To enable disabled nodes, right-click and select Enable ( (&} ) or press F4.

Instead of disabling and enabling variables and physics nodes to simulate
different analysis cases (using different boundary conditions or sources,
for example), use the selection of variables and physics in the study steps’

EI Physics and Variables Selection sections, or use load cases for solving cases
with varying loads or constraints. See Physics and Variables Selection and
Using Load Cases.
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DELETE NODES
* To delete selected nodes, right-click the nodes and select Delete ( % ) or press Del (the Delete key). Confirm the

deletion of nodes for it to take effect. Also see Clear or Delete a Mesh or Solution.

To delete a geometry right-click the Geometry node in the Model Builder and sclect Delete Sequence (-;-_) You

cannot use the Unde command.

To delete geometry objects or entities, in the Model Builder, right-click Geometry and select Delete Entities ( E ).
Or select objects in the Graphics window, and click the Delete button ( % ) in the Graphics toolbar.

If you use the Delete button to delete objects, COMSOL Multiphysics deletes the selected objects that
correspond to primitive features by deleting their nodes from the geometry sequence. If you delete objects that
do not correspond to primitive features or if you delete geometric entities a Delete Entities node appears in the

sequence.

Undo is not possible for nodes that are built directly, such as geometry

n objects, meshes, solutions, and plots.
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Modeling Guidelines

To model large-scale problems and for successful modeling in general, COMSOL makes it possible to tune solver
settings and to use symmetries and other model simplifications to reach a solution or—failing that—interrupt the

solution process to retrieve a partial solution. This section provides some tips and guidelines when modeling.

Selecting Physics

When creating a model in COMSOL Multiphysics, you can select a single physics interface that describes one type
of physics or select several physics interfaces for multiphysics modeling and coupled-field analyses.

MODELING USING A SINGLE PHYSICS

Most physics interfaces contain Stationary, Eigenvalue, and Time Dependent (dynamic) study types. As already
mentioned, these physics provide features and windows where you can create models using material properties,
boundary conditions, sources, initial conditions, and so on. Each physics interfaces comes with a template that

automatically supplies the appropriate underlying PDEs.

If you cannot find a physics interface that matches a given problem, try one of the interfaces for PDEs, which makes
it possible to define a custom model in general mathematical terms. Indeed, COMSOL can model virtually any

scientific phenomena or engineering problems that originate from the laws of science.

MULTIPHYSICS MODELING USING MULTIPLE PHYSICS INTERFACES

When modeling real-world systems, you often need to include the interaction between different kinds of physics:
multiphysics. For instance, an electric current produces heat, and the properties of an electronic component such
as an inductor vary with temperature. To solve such a problem, combine two or several physics into a single model
using the multiphysics capabilities of COMSOL. For the example just mentioned, you can use the predefined Joule
Heating interface, which is a combination of the Electric Currents and Heat Transfer interfaces. This way you create
a system of two PDEs with two dependent variables: V for the electric potential and T for the temperature. There
are many other predefined multiphysics couplings that provide a unified physics interface that combines two or

more coupled physics for common multiphysics applications.
You can also combine physics interfaces and equation-based modeling for maximum flexibility.

To summarize the proposed strategy for modeling processes that involve several types of physics: Look for physics
interfaces suitable for the phenomena of interest. If you find them among the available physics interfaces, use them;

if not, add one or more interface for equation-based modeling.

When coupling multiple physics in a multiphysics model (without using a predefined multiphysics interface), the

couplings can occur in domains and on boundaries. COMSOL automatically identifies potential model inputs for
quickly forming couplings between physics. For example, a velocity field from fluid flow is a model input for the

convective heat transport in heat transfer. In that case, the model input automatically transfers the velocity field

from the fluid to the heat transfer part.

Using Symmetries

By using symmetries in a model you can reduce its size by one-half or more, making this an efficient tool for solving
large problems. This applies to the cases where the geometries and modeling assumptions include symmetries.

The most important types of symmetries are axial symmetry and symmetry and antisymmetry planes or lines:

o Axial symmetryis common for cylindrical and similar 3D geometries. If the geometry is axisymmetric, there are

variations in the radial (r) and vertical (2) direction only and not in the angular (0) direction. You can then solve
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a 2D problem in the rz-plane instead of the full 3D model, which can save considerable memory and
computation time. Many physics interfaces are available in axisymmetric versions and take the axial symmetry

into account.

o Symmetry and antisymmetry planes or lines are common in both 2D and 3D models. Symmetry means that a
model is identical on either side of a dividing line or plane. For a scalar field, the normal flux is zero across the
symmetry line. In structural mechanics, the symmetry conditions are different. Antisymmetry means that the
loading of a model is oppositely balanced on either side of a dividing line or plane. For a scalar field, the
dependent variable is 0 along the antisymmetry plane or line. Structural mechanics applications have other
antisymmetry conditions. Many physics interfaces have symmetry conditions directly available as nodes that you

can add to the model tree.

To take advantage of symmetry planes and symmetry lines, all of the geometry, material properties, and boundary
conditions must be symmetric, and any loads or sources must be symmetric or antisymmetric. You can then build
a model of the symmetric portion, which can be half, a quarter, or an eighth of the full geometry, and apply the

appropriate symmetry (or antisymmetry) boundary conditions.

Effective Memory Management

Especially in 3D modeling, extensive memory usage requires some extra precautions. First, check that you have
selected an iterative linear system solver. Normally you do not need to worry about which solver to use because the
physics interface makes an appropriate default choice. In some situations, it might be necessary to make changes to

the solver settings and the model. For details about solvers, see the Studies and Solvers chapter.

ESTIMATING THE MEMORY USE FOR A MODEL
Out-of-memory messages can occur when COMSOL tries to allocate an array that does not fit sequentially in
memory. It is common that the amount of available memory seems large enough for an array, but there might not

be a contiguous block of that size due to memory fragmentation.
In estimating how much memory it takes to solve a specific model, the following factors are the most important:

¢ The number of node points
e The number of dependent and independent variables
¢ The element order

¢ The sparsity pattern of the system matrices. The sparsity pattern, in turn, depends on the shape of the geometry
and the mesh but also on the couplings between variables in a model. For example, an extended ellipsoid gives

sparser matrices than a sphere.

The MUMPS and PARDISO out-of-core solvers can make use of available disk space to solve large models that do

not fit in the available memory.

You can monitor the memory use in the bottom-right corner of the COMSOL Desktop, where the program
displays the amount of physical memory and total virtual memory used.

CREATING A MEMORY-EFFICIENT GEOMETRY

A first step when dealing with large models is to try to reduce the model geometry as much as possible. Often you
can find symmetry planes and reduce the model to half, a quarter, or even an eighth of the original size. Memory
usage does not scale linearly but rather polynomially (an, k > 1), which means that the model needs less than half
the memory if you find a symmetry plane and cut the geometry size by half. Other ways to create a more

memory-efficient geometry include:

* Avoiding small geometry objects where not needed and using Bézier curves instead of polygon chains.
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* Using linear elements if possible (this is the default setting in many physics interfaces). See Selecting an Element
Type.
e Making sure that the mesh elements are of a high quality. Mesh quality is important for iterative linear system

solvers. Convergence is faster and more robust if the element quality is high.

* Avoiding geometries with sharp, narrow corners. Mesh elements get thin when they approach sharp corners,
leading to poor element quality in the adjacent regions. Sharp corners are also unphysical and can lead to very

large (even infinite, in theory) stress concentrations.

INFORMATION ABOUT MEMORY USE

In the bottom-right corner of the COMSOL Desktop is information about how much memory COMSOL is
currently using. The two numbers in Figure 3-9 displayed as 921 MB | 1006 MB represent the physical memory and
the virtual memory, respectively. If you position the cursor above these numbers, the tooltip that appears includes
the numbers with the type of memory explicitly stated:

* The Physical memory number is the subset of the virtual address space used by COMSOL that is physically

resident; that is, it is the amount of physical memory (RAM) in “active” use.
¢ The Virtual memory number is the is the current size of the virtual address space that COMSOL uses.

Messages *  Progress Log i}
=M~
‘ m )

| Physical memory: 921 MB Virtual memory: 1006 MB
921 ME TT006"ME

Figure 3-9: An example of memory use displayed in COMSOL.

Selecting an Element Type

As the default element type for most physics, COMSOL uses first-order or second-order Lagrange elements (shape
functions). Second-order elements and other higher-order elements add additional degrees of freedom on midpoint
and interior nodes in the mesh elements. These added degrees of freedom typically provide a more accurate solution
but also require more memory due to the reduced sparsity of the discretized system. For many application areas,
such as stress analysis in solid mechanics, the increased accuracy of a second-order element is important because
quantities such as stresses involve space derivatives and become constant within an element when using first-order
clements.

COMSOL recommends that you use the default element types. For some applications, it might be possible to use
a lower-order element than the default element type, but you must then use care to ensure that the important

quantities are resolved.

'El For information about editing shape functions, see Equation View.

Analyzing Model Convergence and Accuracy

It is important that the numerical model accurately captures local variations in the solution such as stress
concentrations. In some cases you can compare your results to values from handbooks, measurements, or other
sources of data. Many model library examples are benchmark models that include comparisons to established results

or analytical solutions.
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If a model has not been verified by other means, a convergence test is useful for determining if the mesh density is
sufficient. Here you refine the mesh and run the study again, and then check if the solution is converging to a stable
value as the mesh is refined. If the solution changes when you refine the mesh, the solution is mesh dependent, so
the model requires a finer mesh. You can use adaptive mesh refinement, which adds mesh elements based on an
error criterion, to resolve those areas where the error is large. See the “Stresses and Strains in a Wrench” model in
the Introduction to COMSOL Multiphysics book for an example for a convergence test.

For convergence, it is important to avoid singularities in the geometry.

@l Avoiding Singularities and Degeneracies in the Geometry

Achieving Convergence When Solving Nonlinear Equations

Nonlinear problems are often difficult to solve. In many cases, no unique solution exists. COMSOL uses a
Newton-type iterative method to solve nonlinear systems of PDEs. This solution method can be sensitive to the
initial estimate of the solution. If the initial conditions are too far from the desired solution, convergence might be

impossible, even though it might be simple from a different starting value.
You can do several things to improve the chances for finding the relevant solutions to difficult nonlinear problems:

* Provide the best possible initial values.

* Solve sequentially and iterate between single-physics equations; finish by solving the fully coupled multiphysics

problem when you have obtained better starting guesses.

¢ Ensure that the boundary conditions are consistent with the initial solution and that neighboring boundaries

have compatible conditions that do not create singularities.
¢ Refine the mesh in regions of steep gradients.

» For convection-type problems, introduce artificial diffusion to improve the numerical properties. Most physics
interfaces for modeling of fluid flow and chemical species transport provide artificial diffusion as part of the
default settings.

¢ Scaling can be an issue when one solution component is zero. In those cases, automatic scaling might not work.

e Turn a stationary nonlinear PDE into a time-dependent problem. Making the problem time-dependent generally
results in smoother convergence. By making sure to solve the time-dependent problem for a time span long

enough for the solution to reach a steady state, you solve the original stationary problem.

* Use the parametric solver and vary a material property or a PDE coefficient starting from a value that makes the
equations less nonlinear to the value at which you want to compute the solution. This way you solve a series of
increasingly difficult nonlinear problems. The solution of a slightly nonlinear problem that is easy to solve serves

as the initial value for a more difficult nonlinear problem.

 Stabilization Techniques
El. * Convergence Plots

¢ Introduction to Solvers and Studies

Avoiding Strong Transients

If you start solving a time-dependent problem with initial conditions that are inconsistent, or if you use boundary

conditions or sources that switch instantaneously at a certain time, you induce strong transient signals in a system.
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The time-stepping algorithm then takes very small steps to resolve the transient, and the solution time might be
very long, or the solution process might even stop. Stationary problems can run into mesh-resolution issues such
as overshooting and undershooting of the solution due to infinite flux problems.

Unless you want to know the details of the transients, start with initial conditions that lead to a consistent solution
to a stationary problem. Only then turn on the boundary values, sources, or driving fluxes over a time interval that

is realistic for your model.

In most cases, turn on your sources using a smoothed step over a finite time. What you might think of as a step
function is, in real-life physics, often a little bit smoothed because of inertia. The step or switch does not happen
instantaneously. Electrical switches take milliseconds, and solid-state switches take microseconds.

¢ Introduction to Solvers and Studies

'&  Stationary and Time Dependent

Physics-Related Checks and Guidelines

There are some important checks and guidelines that primarily apply to different areas of physics. Making these
checks ensures that the model input is sufficient and increases the chances for successful modeling. See also the
modeling sections of the documentation for the physics and the modules for more information related to modeling

different physics.

FLUID FLOW AND TRANSPORT PHENOMENA
The following checks and guidelines primarily apply to fluid-flow modeling but also to modeling of other transport

phenomena:

* Ifnone of the boundary conditions include the pressure (most outlet conditions do, however), then you should
specify the pressure at some point in the fluid domain. Without a specified pressure, the problem is

underconstrained and it is difficult to get convergence.

* Make sure that the mesh if sufficiently fine, so that it contains at least 4-6 mesh elements across the thickness of

a channel, for example.

* Make sure that the boundary conditions and the initial conditions match for time-dependent problems. For
example, instead of starting with a full velocity on the wall, compared to a zero initial velocity field in the fluid,
ramp up the velocity with a smoothed step function or a ramp function that takes the inlet velocity from zero,

which matches the initial value for the velocity field, to the full velocity.

El. Avoiding Strong Transients

* For fluid-flow models it is important to estimate the flow regime (laminar or turbulent) using the Reynolds

number, for example. If the flow is in the turbulent regime, a turbulence model is typically required.

ACOUSTIC, STRUCTURAL, AND ELECTROMAGNETIC WAVE PROPAGATION
For models that describe wave propagation, it is important to fully resolve the wave in both time and space. In
practice that means using a maximum mesh element size that provides about 10 linear or five second-order elements

per wavelength and also, for transient simulations, a fixed time step that is small enough.
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STRUCTURAL MECHANICS

The following checks and guidelines primarily apply to modeling of structural mechanics:

Make sure that the model is fully constrained. At a minimum, you typically need to constrain the model to avoid
all rigid-body movement, which for a 3D solid mechanics model means 6 constraints for three translations and
three rotations. Otherwise the solution is not well defined and does not converge. It is not possible to add all 6
constraints in a single point, where you can constrain at most three translational degrees of freedom. For a 3D
solid model you can use a “3-2-1 approach” to constrain 3 degrees of freedom at one point (a fixed constraint),
2 at another point, and 1 at a third point. To do so, select three convenient points (vertices) that are well
separated. Then fix the first point in all three directions. Constrain the second point in the two directions
orthogonal (normal) to the vector from point one to point two making sure that there is no restriction to
deformation along the line from point one to point two. Finally, constrain the third point in a direction normal
to the plane formed by the three points. To test this approach, the model should expand or contract under
temperature loading and have small stresses throughout with no stress concentrations. The corresponding
minimum constraints for a 2D model are a fixed constraint at one point for the 2 translational degrees of freedom
and an additional constraint in one direction at another point to constrain the single rotational degree of
freedom.

Consider if you can assume that the material is linear elastic and that the deformations are small. If not, consider

using a nonlinear material model.

Avoid sharp corners in the geometry, which are unphysical and lead to unbounded stress concentrations.

Results With Unphysical Values

WHERE AND WHY DO UNPHYSICAL VALUES APPEAR?

In some models small unphysical values can occur due to numerical artifacts or other model-related reasons.

Examples include:

Negative concentrations in mass transfer.

A temperature that is slightly higher than the initial condition in time-dependent heat transfer studies.
Small reaction forces that appear in unloaded directions in structural mechanics models.

Small negative gaps in a contact analysis.

Small negative effective plastic strain values.

Stresses above the yield limit for an ideally plastic material in solid mechanics.

Some reasons for why these unphysical values occur:

Numerical noise is a common cause. When the values of the dependent variables approach zero, the numerical
noise can become relatively significant and cause some of the results to be slightly negative even if that is not
physically possible.

Interpolation and extrapolation of values can cause some values to become unphysical. Take care when using
interpolated data or a piecewise polynomial function to define a temperature-dependent material property, for
example. If you allow extrapolation outside of the defined range of input values, the material property values
cannot be valid. Also, results for an elastoplastic material are correct (within some tolerance) at the integration
points (Gauss points) inside the finite elements, but values might become unphysical when extrapolating the data

to the element boundaries.

The Plasticity feature is available as a subnode to a Linear Elastic Material
g with the Nonlinear Structural Materials Module.
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* Discontinuities in the model is another source of, for example, small negative concentrations due to a
discontinuous initial value. With an initial value that is zero along a boundary for a convective transport models,
for example, the physical interpretation is an initially sharp, gradually diffusing front moving away from the
boundary. However, for the default shape function (second-order Lagrange elements), only continuous
functions are admissible as solutions. COMSOL then modifies the discontinuous initial value before the time
stepping can begin. This often results in a small dip in the solution at the start time. In the example model that

the following figure shows, the concentration is locally slightly negative at ¢ = 0:

Line Graph: Concentration {mol/m?)
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* Lack of mesh resolution is another cause of unphysical values such as negative concentrations. The resulting
convergence problems are often the underlying issue when negative concentrations are observed in high
convection regimes (high Peclet number) and in those with large reaction terms or fast kinetics (high Damkohler
number).

* Incorrect physics in the model can also cause these types of problems. For mass transfer, for example, the use of
a constant sink in a reaction term is an approximation that only works for large concentrations. When the
concentration reaches zero, the reaction term continues to consume the species, finally resulting in a negative
concentration.

AVOIDING UNPHYSICAL VALUES

This section contains some ways to avoid computing or displaying unphysical values:

* Insome cases it is possible to add a baseline to the dependent variable so that the numerical noise does not affect
the solution in the same way as when the values of the dependent variable approach zero. This scaling is not
possible with, for example, a reaction term that depends on the concentration because then the scale and origin
do matter.

¢ Avoid discontinuities in the model using, for example, smoothed step functions.

* Formulate logarithmic variables as a way of eliminating mesh resolution problems and negative dips using the
logarithm of the original dependent variable (the concentration, for example) as the dependent variable. The
reason for this is that a linearly varying mesh sometimes does not capture the exponential behavior of the changes
in the dependent variable. Modeling the logarithm of the dependent variable also ensures that the real

concentration, for example, cannot become negative during the solution process.

¢ Avoid displaying small unphysical values due to numerical noise by clipping the values for the plot. You can do
this by plotting, for example, ¢* (¢c>0) instead of ¢, which evaluates to 0 everywhere where ¢ is smaller than 0.

You can also adjust the range of the plot data and colors to only show nonnegative values. Parts of the plots where
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values are outside the range then become empty.

¢ It can also be useful to check how the mesh affects the solution by refining the mesh and checking if the problem
with unphysical values gets better or worse. If it gets better, then continue to refine the mesh. If it gets worse,

you probably need to check the physics of the model.
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Multiphysics Modeling Approaches

The ability to create multiphysics models—those with more than one type of physics or equation such as
coupled-field problems—is one of the most powerful capabilities of COMSOL Multiphysics. In such a model, the

software can solve all the equations, taken from various areas of physics, as one fully coupled system.

Within COMSOL Multiphysics you can choose from several ways to approach multiphysics modeling and
coupled-field analysis.

In this section:

* Creating a Multiphysics Coupling

¢ Advantages of Using the Multiphysics Coupling Features
e The Multiphysics Node

* Uncoupling a Multiphysics Coupling

e Model Inputs and Multiphysics Couplings

Creating a Multiphysics Coupling

There are two fundamental ways to create and use multiphysics couplings—using Predefined Multiphysics

Couplings or by Adding Physics Sequentially.

PREDEFINED MULTIPHYSICS COUPLINGS

The Joule Heating Interface is a predefined multiphysics coupling. After Joule Heating is chosen from The Model
Wizard, the Heat Transfer in Solids interface, the Electric Currents interface, and a Multiphysics node, including the
default features applicable to the coupling (Electromagnetic Heat Source, Boundary Electromagnetic Heat Source, and
Temperature Coupling), are displayed under the Added physics list as in Figure 3-10. Figure 3-11 shows you what is
included in the Model Builder when a predefined multiphysics interface is added. Compare to Figure 3-12 where
individual physics interfaces are added, and these features are initially accessible only from the context menu.

) You can add physics interfaces when you start creating the model with The
ml

Model Wizard or at any time with The Add Physics Window.

% Electric Currents (ec)
& Heat Transfer in Solids (ht)
4 .y Multiphysics
x| Electromagnetic Heat Source (emhl)
1 Boundary Electromagnetic Heat Source (bemhl)
E—? Temperature Coupling (tcl)

Figure 3-10: When Joule Heating is selected in the Model Wizard, the default physics interfaces and coupling features
are displayed under Added physics.
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4 @ Component1 {compl}
> = Definitions
> };\ Geometry 1 {geom1}
252 Materials
4 %_ Electric Currents {ec}
i Current Conservation 1 {cucni)
S Electric Insulation 1 {einl}
B Initial Values 1 {init1}
4 \[@ Heat Transfer in Solids {ht}
T Heat Transfer in Solids 1 {solid1}
S Thermal Insulation 1 {ins1)
B Initial Values 1 {init1}
4 .{;3. Multiphysics
x| Electromagnetic Heat Source 1 {femh1}
1 Boundary Electromagnetic Heat Source 1 {bemh1}
E—? Temperature Coupling 1 {tcI}
A5 Mesh 1 {meshi)

. {E Results

Figure 3-11: An example of what is added to the Model Builder when Joule Heating is chosen in the Model Wizard. The
Electromagnetic Heat Source, Boundary Electromagnetic Heat Source, and Temperature Coupling features are
automatically included under the Multiphysics node.

ADDING PHYSICS SEQUENTIALLY

An empty Multiphysics node is added automatically when two (or more) physics interfaces are set up in a model and
when there is the possibility to couple the interfaces. In other words, if you add physics interfaces one at a time,
and the software identifies these interfaces as being of the multiphysics category, the Multiphysics node is
automatically added to the Model Builder tree. The relevant features are made available from the context menu
(right-click the Multiphysics node). See Figure 3-12.

4 @ Component1 {compl}
> = Definitions
> )f\ Geometry 1 {geomI}
252 Materials
4 %_ Electric Currents {ec}
i Current Conservation 1 {cucni)
S Electric Insulation 1 {einl}
B Initial Values 1 {init1}
4 \[@ Heat Transfer in Solids {ht}
T Heat Transfer in Solids 1 {solid1}
S Thermal Insulation 1 {ins1)
B Initial Values 1 {init1}
.{‘,’3 Multiohysics
A |2 Electromagnetic Heat Source

4 " Stu b =] Boundary Electromagnetic Heat Source
I:‘ "'lﬁ-? Temperature Coupling

. (B Res

1 Help F1

Figure 3-12: An example of when a Multiphysics node is automatically added to the model. The specific multiphysics
Sfeatures are made available from the context menu based on the physics interfaces in the model. The difference when the
predefined Joule Heating interface is added is that these featurves ave included under Multiphysics and there ave some
modified settings automatically applied. In either case, the available features depend on the add-on module license.

Advantages of Using the Multiphysics Coupling Features

One advantage to using the predefined couplings is that specific or modified settings are included with the physics
interfaces and the coupling features. But if physics interfaces are added one at a time, followed by the coupling

features, these modified settings are not automatically included.
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For example, if single Electric Currents and Heat Transfer in Solids interfaces are added to the Model Builder,
COMSOL adds an empty Multiphysics node. The features are available and can be added, but any modified settings
are not included.

In general, it is useful to use any type of multiphysics coupling because you can turn multiphysics on and off (that

is, enable and disable features), giving you more flexibility to test and observe multiphysics effects.

Even if you do not start with a predefined coupling, another benefit of this approach is that you are no longer
constrained by the use of specific physics interfaces, nor do these have to be added in any specific order. With the

new coupling approach, the order in which physics interfaces are added does not matter for the end result.

An example of this is if you start modeling by adding a Heat Transfer in Solids interface. As you continue to build
the model, you add an Electric Currents interface. At this stage of the process, you have defined several boundary
conditions, chosen materials, or experimented with other settings. You may have also solved the model successfully

at this point and now you want to continue building on this design.

Previously, you would have to start again to add and define the Joule Heating interface to access the multiphysics
features (Electromagnetic Heat Source, Boundary Electromagnetic Heat Source, and Temperature Coupling).
COMSOL Multiphysics now recognizes this and automatically adds a Multiphysics node where you can right-click
the Multiphysics node to access and add these features.

For multiphysics interfaces that consist of participating physics interfaces, the default solver settings use a segregated
solver approach with one segregated step for each physics and each of these steps calling an iterative solver. These
solver settings are suitable for large models, but if possible, a fully-coupled solver approach using direct solvers can
be more robust. You can switch to such solver settings by right-clicking the Study node and choosing Show Default
Solver. Then the solver nodes that the multiphysics interface specifies appear under the Solver Configuration node,
and you can right-click the solver node to add a Fully Coupled solver node to replace the Segregated node, for

example.

For some multiphysics interfaces, a side effect of adding physics interfaces
one at a time is that two study types—Frequency-Stationary and
Frequency-Transient—are not available for selection until after at least

n one coupling feature is added. In this case, it is better to first add an Empty
Study, then add the coupling features to the Multiphysics node, and lastly,
right-click the Study node to add the study steps as required.

The Multiphysics Node

The Multiphysics node <-‘fﬂ) contains, or has available, any coupled physics features that are likely to be used for a
particular set of physics interfaces added to the Model Builder. There are no settings required for the node itself.

There are different approaches to the use of the multiphysics coupling feature. It is either predefined when you add
a specific physics interface or it is automatically added when COMSOL recognizes there is a logical coupling
inherent in the model design. When it is added as part of a predefined coupling, the coupling features are also
included under the Multiphysics node. Otherwise, all relevant coupling features are available from the context

menu. Additional functionality is also based on the add-on modules.

Predefined multiphysics interfaces provide you with a quick entry point for common multiphysics applications. You
can create the same couplings using any of the other methods for multiphysics modeling, and you can continue to
add, modify, disable, and remove physics in a model when you start using one of the predefined multiphysics

interfaces. If instead you decide to add physics sequentially, this approach is also useful as you can verify that each
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type of physics or equation gives the expected results before adding more complexity to the model by adding
another physics or coupling fields.

For this version of COMSOL Multiphysics, and depending on the add-on
n module, some multiphysics interfaces are not yet converted to using a

predefined multiphysics coupling approach.

For links to more information about the add-on modules and the
multiphysics interfaces available go to

www.comsol.com/comsol-multiphysics.

Uncoupling a Multiphysics Coupling

¥ Electromagnetic Heat Source ¥ Electromagnetic Heat Source
Electromagnetic: Electromagnetic:

[Electric Currents {ec} - | [Electric Currents {ec} - |
Heat transfer: Heat transfer:

[HeatTransfer in Solids {ht} 4-%—> [None - |

Figure 3-13: Uncoupling a predefined multiphysics coupling feature.

For each multiphysics coupling feature, for example the Electromagnetic Heat Source, there is a section that defines
the physics involved in the multiphysics coupling. By default, the applicable physics interface is selected in the lists
to establish the coupling.

You can also select None from the lists to uncouple the node from a physics interface. If the physics interface is
removed from the Model Builder, for example if a Heat Transfer in Solids physics interface is deleted, then the Heat

transfer list for the Electromagnetic Heat Source reverts to None (Figure 3-13) as there is no interface to couple to.

If a physics interface is deleted and then added to the model again, and in
order to re-establish the coupling, you need to choose the physics

interface again from the lists. This is applicable to all multiphysics

[

coupling nodes that would normally default to the once present interface.

Model Inputs and Multiphysics Couplings

Model inputs can appear in an equation node’s or material model node’s Model Inputs section. Model inputs are
fields such as temperature and velocities that act as inputs for material models and model equations. They appear
in the Model Inputs section if a material is defined so that a material property becomes a function of the temperature,
for example. COMSOL connects the model input to an existing field (dependent variable) within the physics

interface (but not to available fields in other physics).

With more than one physics in the model, coupling of the fields is easy: all applicable fields that can serve as inputs
in another physics automatically appear in the other physics interface’s settings window’s Medel Inputs section. For
example, with a Heat Transfer in Fluids (ht) interface and a Laminar Flow (spf) interface, you can select Velocity
field (spf/fp1), which the Fluid Properties | {fpl} node in the Laminar Flow branch defines, from the Velocity field list
in the Model Inputs section of the Heat Transfer in Fluids node’s settings window. For a coupling in the other

direction (if you use temperature-dependent fluid properties, for example), you can select Temperature (ht/fluidl),
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which the Heat Transfer in Fluids 1 {fluid1} node in the Heat Transfer branch defines, from the Temperature list in the

Model Inputs section of the Fluid Properties node’s settings window.

A list in the Model Inputs section becomes unavailable if the physics itself defines the field because it is then
automatically connected to that field. For example, with a Heat Transfer in Fluids (ht) interface the Temperature
list is unavailable in the Heat Transfer in Fluids | {fluidl} node. This automatic connection selects the Temperature
(ht/fluidl) field because it is defined by the Heat Transfer in Fluids. As long as the list is unavailable, you cannot
change it. If you want to use another temperature field or an expression, you first make the list editable by clicking
the Make all model inputs editable button (@ ).

In the case that you want to use another expression for these model inputs, select User defined to enter a user-defined
value or expression in the associated text field.

See Marangoni Convection for an example of combining the Laminar
i Flow and Heat Transfer in Fluids interfaces (model library path
COMSOL_Multiphysics/Multiphysics/marangoni_convection).
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Specifying Model Equation Settings

The fundamental mathematical model, representing the physics in a physics interface, is contained in physics nodes
with selection on the same space dimension as the physics itself. The first node under a physics branch is of this type
and sets up default equations where the physics is active. These equations are controlled by specifying:

* Material properties, which COMSOL uses as coefficients in the equations

* A coordinate system, in which you can specify anisotropic material properties

¢ A material model, which selects an equation suitable for a given type of material

Not all physics allow anisotropic materials or more than one material

L] ~ .
|_E'| model. Therefore, these settings cannot be present.

The default node uses the same material model, and thus the same equations, everywhere. Material properties can
vary between different parts of the feature’s selection, if the property is specified as taken From material. Add
additional nodes to use different material models for different parts of the geometry, or to use different User defined
material property values.

In equation-based modeling, provided by the Mathematics branch interfaces, the form of the equation is fixed for
each particular node type. Each given equation form contains a number of free PDE coefficients, which you can be

specify in the settings to define the specific equation that you want to solve.

'El Equation-Based Modeling

Specifying Equation Coefficients and Material Properties

To specify an equation coefficient or a material property, enter a value or an expression directly in the corresponding
field. Such expressions can contain:

e Numerical values.

e Units (see Using Units).

¢ Built-in Mathematical and Numerical Constants.

 Spatial coordinates, time, and the dependent variables in any physics in the model as well as their spatial

derivatives and time derivatives.
e Physical Constants—built-in universal physical constants.

* User-defined parameters, variables, coupling operators, and functions, including external functions and
MATLAB functions (requires the COMSOL LiveLink™ for MATLAB®). See Operators, Functions, and

Constants.

* Built-in functions and operators such as d and mean.

You can use these types of variables, constants, functions, and operators in all settings for the physics interfaces;

many types of variables are also available anywhere in the model.
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Modeling Anisotropic Materials

Anisotropic materials respond differently to an excitation depending on its direction. Because excitations are
generally vectors and the corresponding response is a vector density, material properties are usually rank-2 tensor
densities. For example, the following material properties are anisotropic tensor densities: diffusion coefficient,
permittivity, thermal conductivity, and electrical conductivity.

These properties are, in principle, specified in matrix form and defined by their components in the coordinate
system selected in the node settings. At most four components are used in 2D and at most nine components in 3D.
When the material contains symmetries, you can specify only a few coefficients which are expanded to a matrix using

the following patterns:

¢ Isotropic (the default)—enter only one value c.

c00
C=10co
00c

* Diagonal—enter the diagonal components for an anisotropic material with the main axes aligned with the model’s

coordinate system.

c;1 0 0
C=10 Cog 0
0 0 cg5

* Symmetric—enter a symmetric matrix using the diagonal components and the upper off-diagonal components.

€11 €12 C13
C = |cgg €99 Ca3

C13 C23 C33

* Anisotropic—enter the full 2-by-2 (2D) or 3-by-3 (3D) matrix for an anisotropic material:

€11 €12 C13
C = |cgy 99 Co3

C31 C32 C33

Specifying Initial Values

An Initial Values node is added by default to each physics interface.
In some types of analyses initial values must be provided:
* As the initial condition for a time-dependent analysis.

¢ As an initial guess for the nonlinear stationary solver.

* Asa linearization (equilibrium) point when solving a linearized stationary model or when performing an

eigenvalue study.

To enter initial values, in the Model Builder, click the Initial Values node under a physics interface node. In the
settings window, enter the Initial Values for all dependent variables (fields) in the physics. The default initial values

are usually zero.
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For some physics you can also enter initial values for the first time derivative of the dependent variables. These are
used when solving time-dependent problems containing second time derivatives (wave-type applications). Like

other default settings, these initial values apply to all domains where no other values are specified.

To use different initial values in different domains, right-click the main physics node and select Initial Values to add
additional nodes to the Model Builder.

See Dependent Variables for more information about handling and plotting initial values.

Equation View

Equation View (227 ) is a subnode available for all the physics nodes. To display these subnodes, click the Show button

("= ) and select Equation View from the Model Builder.

The Equation View scttings window contains detailed information about the implementation of each physics feature:

variables, shape functions, weak-form equation expressions, and constraints.

To update the values in the Equation View node’s settings window to reflect the latest changes in a physics feature,
click the Refresh equations button ( (™ ) in the settings window’s toolbar.

Editing the predefined expressions for variables, equations, and
H constraints means that the equations are altered and that COMSOL solves

the model using the new expressions.

You can edit the values of variables, weak-form expressions, and constraints in the corresponding tables. This makes
it possible to introduce custom changes to the equations and variable definitions. If the expression that defines a

variable, for example, does not fit inside of the text field, a tooltip displays the entire expression.

For a changed definition of a variable or a change to a weak-form expression or constraint, a warning icon ( £} )
appears in the leftmost column, and a small padlock is added to the lower-right corner of the icon for the physics
node where you have made modifications in its equation view. To restore only the change in the selected variable,
weak-form expression, or constraint, click the Reset selected button (45 ) under the table in the Variables, Weak
Expression, or Constraints section. To reset all changes in the equation view, click the Reset all button ( ) in the
settings window’s toolbar. If no changes remain, the padlock disappears from the corresponding physics node. An
orange color for the expression that defines the variable is a warning that the unit of the expression does not match
the expected unit for the variable that it defines.

For information about the Equation displays available, see Physics
'& Nodes—Equation Section.

VARIABLES

This section has a table with the variables that the physics node defines. The table includes these columns:
¢ Name: the name of the variable.

* Expression: the expression, using COMSOL syntax, that defines the variable.

* Unit: the unit for the variable (in the active unit system). If the unit of the expression does not match the unit of

the variable, the expression is displayed in orange.

* Description: a description of the variable.
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¢ Selection: the geometric entities (domains, boundaries, edges, or points) where the variable is defined (Domain I,
for example).

e Details: this column contains some details about the variable’s behavior. See About the Details Column below.

SHAPE FUNCTIONS

This section has a table with the dependent variables that the physics node defines and their shape functions. This
is primarily applicable to equation model nodes; for most physics nodes such as boundary conditions, the table is
empty. The table has these columns:

¢ Name: the name of the variable.

* Shape function: the type of shape function (element) for the variable (for example, Lagrange for Lagrange

clements, which are the most common elements).

El. Selecting an Element Type

* Unit: the unit for the variable (in the active unit system).
¢ Description: a description of the variable.
* Shape frame: the frame type (typically either a spatial or a material frame) for the shape function.

* Selection: the geometric entities (domains, boundaries, edges, or points) where the shape function is defined
(Domain 1, for example)

e Details: This column contains some details about the shape function’s behavior. See About the Details Column
below.

WEAK EXPRESSIONS

This section has a table with the weak-formulation equation contributions that the physics feature generates. The
table consist of the following columns:

* Weak expression, the equation expressed in a weak formulation

¢ Integration frame, the frame type (typically either a spatial or a material frame) used when integrating the

expression.

¢ Selection: the geometric entities (domains, boundaries, edges, or points) where the weak expression is defined
(Domain 1, for example)

Each equation contribution appears on its own row under Weak expression, but the order is not significant.

The PDE interfaces and the ODEs and DAEs interfaces do not display
any weak expressions. They are either implemented using strong

2!

formulations, directly display the weak formulation, or define equations

discretized in the time domain only.

CONSTRAINTS

This section has a table with the constraints that the physics node generates. This is typically the case for boundary
conditions of constraint types, such as prescribed displacements, temperature, or velocities. Many other physics

nodes do not generate any constraints, and the table is then empty. The table consists of the following columns:

* Constraint: the expression for the constraint
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* Constraint force: the expression that defines the associated constraint force, which is typically the test function of
the constraint

* Shape function: the type of shape function (element) for the constraint (for example, Lagrange for Lagrange
elements)

* Selection: the geometric entities (domains, boundaries, edges, or points) where the constraint is defined

(Boundaries 1-5, for example)
ABOUT THE DETAILS COLUMN
The Details column shows some details about the behavior of variables and shape functions. For variables:

e An empty cell indicates that overlapping contributions are overridden.
* + operation indicates that overlapping contributions are added.

¢ For some variables, Meta indicates that the variable definitions are fully updated when solving the model. It is

therefore not recommended to edit the expressions for such variables.

¢ In rare cases, other operations (* operation, for example) can occur.
For shape functions:

* Slit means that the shape function creates a slit for the degree of freedom

Physics Nodes—Equation Section

For each physics node there is an Equation section always available on the settings window. This has options to
display mathematical equations applicable to the node.

El. Equation View

You can expand the section at any time from the settings window. Click

EI the Expand Sections button ( = ) in the Model Builder and sclect Equations.

The display options available from the lists depend on the study types and other physics-specific factors. See

Figure 3-15 for an example comparing the equations that display for a Stationary or Time Dependent study for a Heat
Transfer in Solids interface. Some settings windows do not have any options and only display the relevant equation
and other windows have additional sections that become available for the Equation display based on the study type

selected.

El. Study Types

Node Contributions Display a Dotted Line Under Part of the Equation

For all physics nodes (excluding the main physics interface node level), the equation that displays includes a dotted
line underneath where the node’s contribution is made to the equation. See Figure 3-14 for an example where a
section of the heat transfer equation is underlined, indicating where the Heat Transfer in Solids node contributes to
1t.
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Figure 3-14: The Heat Transfer in Solids contribution to the equation for a 3D model.

Equation Form
When you add physics to a Component, the default Study types are listed in the Equation form list. Study controlled

is the default; select another option as required.

Show Equation Assuming
The Show equation assuming option is available by default when Study controlled is selected (or left as the default)
as the Equation form. Availability of the options are based on the studies added and defined for the model.

For the following options—frequency and mode analysis frequency—you also have the option to use another
frequency than the one used by the solver. This can be necessary if you need two different frequencies for two

physics.

Frequency
This option is available if Frequency domain is selected as the Equation form. The default uses the frequency From

solver. If User defined is sclected, enter another value or expression (SI unit: Hz).

Mode Analysis Frequency
This option is available if Mode Analysis or Boundary Mode Analysis is sclected as the Equation Form. Enter a value or
expression in the field (SI unit: Hz). Specify a frequency (it is not present as a solver variable).

Port Name
This option is available with the RF Module Electromagnetic Waves interface and if Boundary Mode Analysis is sclected
as the Equation Form. Enter a value in the field (unitless).

4 I Heat Transfer in Solids (ht)

Sh ti ing:
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Figure 3-15: An example of the Equation section on a Heat Transfer interface. Selecting the study type updates the
equation accordingly.
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Boundary Conditions

In the interior of the selection where a physics is active, its behavior is governed by its model equations and material
properties. Boundary conditions apply to the geometric entities separating this region from the unspecified
outside, and also to interior entities of the same dimension. Therefore, boundary conditions on a 3D solid object
apply to the exterior surfaces of the solid, and to interior surfaces embedded in the solid. On a shell geometry in
3D space, boundary conditions instead apply to the edges of the shell surface. In general, boundary conditions
apply to geometric entities whose dimension is one less than the physics interface’s dimension.

All physics branches that contain a default model equation node also contain a default boundary condition node.
This boundary condition is active on all exterior boundaries of the physics’ selection, except on the symmetry axis
of axisymmetric 2D models. On interior boundaries, an implicit continuity condition applies, which makes the

physics field (the temperature, for example) continuous across interior boundaries.

Boundary Condition Types

There are two fundamental ways to specify what is happening at a boundary, and two corresponding fundamental

boundary condition types:

*  Flux conditions specify how the surroundings affect and interact with the model at the boundary, often
expressed as an applied force, flux, or current. This type of boundary condition is also called a Neuwmann
boundary condition.

o Constraints specity the result of the interaction between the model and its surroundings, expressed as expected

values of the dependent variables. This type of boundary condition is also called a Dirichlet boundary condition.

The two types are closely related because in a well-posed model, every flux condition results in some unique values
of the dependent variables, and every constraint requires a unique flux to enforce the expected values. Which type
of condition to use depends on what is known about the conditions at the boundary: if the flux is known, the model
computes the dependent variables for you; if the values of the dependent variables are known, the model computes
the flux.

FLUX CONDITIONS
Flux boundary conditions specify the component of a vector or tensor quantity in the direction normal to the

boundary, per unit area of the boundary. Typical examples of flux conditions are the specification of:

e A Boundary Load in a solid model, which prescribes the stress acting on the boundary.

e Heat Flux in a heat transfer model, which prescribes the heat per unit area flowing into (or out of) the model

across the boundary.

* A Normal Current Density in an AC/DC model, which prescribes the electrical current per unit area entering
(or exiting) the model at the boundary.

There are also more advanced types of flux conditions, where the flux or force is calculated based on local values of
dependent variables and other parameters. For example, a Convective Heat Flux boundary condition on a heated
body computes the heat flux based on a heat transfer coefficient and the temperature difference to the
surroundings.

Convective Heat Flux requires the CFD Module or Heat Transfer
Module.

[
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In COMSOL, by convention, the force acting oz the model or the flux
. into the model is specified. That is, specify how the surroundings affect

B

the model and not how the model affects its surroundings.

CONSTRAINTS
Constraint boundary conditions specify the value of one or more dependent variables at the boundary, or a

relationship between two or more dependent variables. Typical examples include specifying:

e A Prescribed Displacement of the boundary of a solid object.
e That the velocity is zero on a Wall boundary in a CFD model.
* The Temperature at the boundary of a heated solid.

¢ The Electric Potential on an electrode in an AC/DC model.

Examples specifying a relation between dependent variables include Roller conditions on solids and Wall conditions

for slip flow.

Because constraint conditions generally specify the value of a dependent variable, they also provide a reference level
for that variable—which a flux condition normally does not. In many types of physics, the model equations together
with only flux boundary conditions uniquely describe the local behavior of the dependent variable, but leave the

global level undefined. From a physical point of view, the absolute value of the dependent variables are often of less

interest, but the existence of a single, unique, solution is essential for some solvers.

Therefore it is often necessary to apply at least one constraint condition in a model, to provide a global reference
value for the dependent variables. For example, it is common to designate one of the electrodes in an AC/DC
model as Ground, which constrains the electric potential there to zero and gives a reference with which to compare

other parts of the model.

In most physics, the default boundary condition is of flux type and does
not fix a reference level for the dependent variable. Therefore when

solving certain study types, notably Stationary studies, you must manually

[

add at least one boundary condition of constraint type (or a point

constraint) for the model to be well-defined.

SWITCHING OFF A CONSTRAINT

If you want to model a constraint that is active only for a certain period of time in a time-dependent simulation, for
example, you can use the fact that a 0 constraint (or a Dirichlet boundary condition u = ) means that there is no
constraint; instead, the boundary condition becomes a “no flux” or “insulation” condition. To implement such a
time-limited constraint you can use the if operator: for example, for a Dirichlet boundary condition,
if(t<2,1,u) means that for £ <2, u is equal to 1 but at £ = 2 the boundary condition is turned oft by setting u =

u. For a Constraint node, the corresponding if statement is if (t<2,1-u,0).,

e Constraint Reaction Terms
'El. ¢ Weak Constraints

* Constraint Settings

Physics Boundary Types

There are different types of boundaries for the physics, which all support different types of boundary conditions:

* Exterior boundaries, where most boundary conditions are applicable—see below.

BOUNDARY CONDITIONS | 153



¢ Interior boundaries, where special interface conditions can be applicable—see below.
* Axial symmetry boundaries, which are artificial boundaries representing the symmetry axis in axisymmetric

models.

If a selection for a boundary condition node, for example, contains boundaries of a type that is not applicable or
supported, the Selection list has (not applicable) next to those boundary numbers.

INTERIOR AND EXTERIOR BOUNDARIES

When specifying boundary and interface conditions, COMSOL differentiates between exterior and interior
boundaries:

* An exterior boundary is an outer boundary of the modeling domain.

e A interior boundary is a dividing interface between two domains in the geometry.

If an equation or physics interface is deactivated in one domain, the interior boundary between the active and

inactive domain becomes an exterior boundary for its variables because it then borders on the outside of the active

domain for those fields. The boundaries of the inactive domain are then void.

exterior

boundary\ - __ interior
boundary

Figure 3-16: Examples of exterior and interior boundaries.

Continuity on Interior Boundaries

Unless a boundary condition is specified on interior boundaries (such as a contact resistance condition), COMSOL
ensures continuity in the field variables across interior boundaries. For assembly geometries with identity pairs,
select a Continuity node on the Pairs menu in the boundary part of the context menu for most physics. The

Continuity condition is only suitable for pairs where the boundaries match.

BOUNDARY SELECTION

The selection list in this section shows the boundaries for the selected pairs.

PAIR SELECTION
Select the pairs where you want to impose continuity across the pair boundaries. Select the pairs from the Pairs list
(Ctrl-click to deselect).

'El Identity and Contact Pairs

Physics Axial Symmetry Node

In axisymmetric models, boundaries on the symmetry axis are boundaries where only a condition for the axial
symmetry exists. COMSOL adds a default Axial Symmetry node that is active on all boundaries on the symmetry

axis. The condition on the symmetry axis is typically a zero Neumann or no-flux condition.
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BOUNDARY SELECTION
The selection list for boundaries is not available because this is a default boundary condition. In the list, boundaries

that are not on the symmetry axis have (not applicable) added after the boundary number.

El. Physics Nodes by Space Dimension

Constraint Reaction Terms

Enforcing a constraint condition is more or less a matter of finding a corresponding flux condition that leads to the
desired values of the dependent variables. The hidden flux conditions introduced this way appear as reaction terms
in the system of equations modeling the physics. These reaction terms normally have a physical meaning and

correspond to a flux condition, for example:

e The reaction term enforcing a Prescribed Displacement on a solid model is a reaction force, similar to a

Boundary Load boundary condition.
e The reaction term enforcing a Pressure in an acoustics model is a Normal Acceleration.

* The reaction term enforcing a Temperature in a heat transfer model is a Heat Flux.

The reaction terms in the model equations can be scaled in different ways, affecting mainly the numerics and
solvers. In a model with more than one dependent variable, it is also possible to distribute the reaction fluxes, or

forces, over the variables in different ways—while still enforcing the original constraint.

SYMMETRIC REACTION TERMS
Most boundary conditions of constraint type, by default, introduce reaction terms in such a way that an otherwise
symmetric system of equations remains symmetric. This makes constraints sidirectional in the sense that all

dependent variables that appear in a constraint expression are also affected by the reaction terms.

To illustrate this, suppose a Prescribed Displacement boundary condition is applied on a solid model, specifying that
the x-displacement of the boundary, u, is proportional to the y-displacement, v, with a constant of proportionality,

k, which is a function of the boundary temperature 7"
u = k(T (3-1)

If fully symmetric reaction terms are used to enforce this constraint, reaction forces are applied on both
displacement components © and v, as well as a reaction heat flux in the heat transfer equation. Applying symmetric

reaction terms this way, on completely different equations, usually makes no sense.

In particular, the solid displacement equation and the heat transfer equation have different units. Because you can
choose length and temperature unit independently, the relative scale of the equations is undefined and the
symmetry of the coupled system irrelevant. Further you would not, from a physical point of view, expect a

constraint on the displacement of a solid boundary to directly affect the temperature field in a model.

RESTRICTED AND NONSYMMETRIC REACTION TERMS

As an alternative to the default (symmetric) application of reaction terms, you can choose to have these affect only
the equations and variables in the physics interface where the constraint boundary condition is added. For the
example in Equation 3-1, the reaction terms can be restricted to act on the displacement variables and equations in
the Solid Mechanics interface, leaving the temperature unaffected. Many different restrictions of this type are

possible, in principle, and COMSOL generally provides two alternatives:

¢ The most consistent and general way to avoid spurious reaction terms affecting other physics is to start from the

globally symmetric formulation and remove the terms entering equations belonging to other physics interfaces.
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This limits the reaction terms to affecting the current physics in such a way that if there are no other physics in
the model, so the reaction terms preserve the symmetry. For Equation 3-1, this means that reaction terms are
distributed over both u and v equations, in proportions 1:£(T).

¢ The other alternative is to apply the reaction terms only on certain individual variables. Another way to look at
Equation 3-1is to read it as prescribing a value for the x-displacement u, rather than prescribing a given relation
between u and v. Accepting that view, it is reasonable to insert reaction terms only acting on . Such reaction

terms, in general, do not preserve symmetry even for a single physics interface.

Weak Constraints

The standard method to enforce constraints in COMSOL applies the constraints pointwise at node points in the
mesh. At each node point, only local values of the dependent variables are affected by the constraint, making the
constraints independent of each other. The solvers can therefore eliminate both the constrained degrees of freedom
and the constraint force terms, effectively reducing the system of equations and decreasing the number of degrees

of freedom being solved for.

Weak constraints enforce the constraint in a local average sense, using shape functions as weights. Reaction terms
are explicitly included in the system of equations, which is extended with Lagrange multiplier variables. These
Lagrange multipliers in general have a physical meaning and an interpretation as a constraint force or flux. Whereas
a standard constraint decreases the number of degrees of freedom by the number of unique constraints, weak

constraints increase the degrees of freedom by the same number.

A weak constraint is respected only on average over each Lagrange multiplier shape function, rather than pointwise
at mesh nodes. When it is possible to satisfy the constraint everywhere on each mesh element, standard and weak
constraints in general lead to the same solution. Conversely, when constraints are contradictory or impossible to

satisfy everywhere, standard and weak constraints can distribute the error differently, and therefore lead to slightly

different solutions.
Weak constraints can be of use in the following situations:

* Standard constraints must never contain time derivatives of the dependent variables. Weak constraints do not
have this limitation because they allow the same variables as any other term in the combined system of equations.
Note that reaction terms cannot be applied symmetrically to time derivatives but must be selectively applied to
individual variables.

¢ When the reaction force or flux is needed during a solution, because it enters into a coefficient somewhere, the
Lagrange multiplier from a weak constraint can provide an accurate value (see Computing Accurate Fluxes). The
corresponding variables computed from derivatives of the dependent variables are not as accurate and can, if

used, introduce considerable errors in the solution.

¢ When constraints are strongly nonlinear, weak constraints can allow faster and more robust convergence. For
nonlinear constraints, the true linearized subproblem solved in each solution step depends on the value of the
Lagrange multiplier variables from the previous step. When using standard constraints, this information is
discarded between solution steps. Using weak constraints, the Lagrange multiplier values are instead retained

between steps because they are part of the solution vector.
Compared to standard, eliminated, constraints, weak constraints can also have the following drawbacks:

¢ Discontinuous constraints result in (theoretically) infinite Lagrange multipliers. In practice, large oscillations

result.

* Pointwise and weak constraints on the same set of variables on adjacent boundaries (that is, boundaries that share
common node points in the mesh) do not work. This means that if all boundaries must be constrained on a solid
and you want to use a weak constraint on one boundary segment (one face), the weak constraint must be used

on the entire boundary of the solid (if the boundary is connected).
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e Lagrange multipliers are in some cases difficult to interpret. For example, Lagrange multipliers from Dirichlet
conditions in axial symmetry are not equal to the reaction flux per area but rather per length and full revolution.
For separate Weak Constraints nodes in axial symmetry, the default quadrature settings include a multiplication
by 2nr, making the Lagrange multiplier represent flux per area.

¢ Because extra unknowns are introduced for the Lagrange multipliers, the size of the problem increases compared
to the standard constraint elimination method.

e The Lagrange multiplier variables added by the weak constraints have a different unit than the main system
variables and can therefore be of a completely different order of magnitude. This can lead to scaling problems.
Usually the automatic variable scaling in the solvers is sufficient, but there are cases when manual scaling is

needed.

e Weak constraints introduce zeros on the main diagonal of the Jacobian matrix of the discretized system, which
therefore cannot be positive definite. This makes certain linear solvers and preconditioners unavailable for solving
problems with weak constraints. In particular, the conjugate gradients iterative solver does not work, and neither
does the SOR class of preconditioners and smoothers. Instead, try another iterative solver and use the Vanka
algorithm with the Lagrange multipliers as the Vanka variables, or use the incomplete LU factorization algorithm

as preconditioner.

Constraint Settings

Most constraint nodes have a Constraint Settings section which is only available when Advanced Physics Options is
selected from the Show menu (& ). This section provides settings controlling how reaction terms are applied and

whether standard or weak constraints are used. Choose to Apply reaction terms on:
* All physics (symmetric) to apply reaction terms symmetrically on all dependent variables taking part in the
constraint.

* Current physics (internally symmetric) to apply reaction terms symmetrically only on the dependent variables in

the physics where the constraint is added. This leaves other physics unaftected by the constraint.

* Individual dependent variables to apply reaction terms only on selected variables. For most physics, this makes the

constraint #nidirectional and often nonsymmetric.

Select the Use weak constraints check box to replace the point-wise standard constraints with weak constraints. Note

that this introduces additional equations and dependent variables.

Not all constraints provide all the above options. Some reaction term

methods can be missing and weak constraints are not allowed. Some

2!

constraint nodes can also implement additional options.

Periodic Boundary Conditions

Use periodic boundary conditions to make the solution equal on two different (but usually equally shaped)

boundaries.

To add a periodic boundary condition, in the Model Builder, right-click a physics interface node and select Periodic
Condition. The periodic boundary condition typically implements standard periodicity so that u(xg) = u(x1) (that s,
the value of the solution is the same on the periodic boundaries), but in most cases you can also choose
antiperiodicity so that the solutions have opposing signs so that u(xg) = —u(x1). For fluid flow physics interfaces,
the Periodic Flow Condition provides a similar periodic boundary condition but without a selection of periodicity.
Typically, the periodic boundary conditions determine the source and destination boundaries automatically (and

display them, under Component>Definitions, in an Explicit selection node ( “ ), which is “read only”), but you can
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also define feasible destination boundaries manually by adding a Destination Selection subnode.

For some physics you can choose the direction in which you want a

periodic boundary condition. For a description of the standard periodic

!

boundary condition, which most physics use, see Periodic Condition.

The KdV Equation and Solitons: model library path
ii“ COMSOL_Multiphysics/Equation-Based_Models/kdv_equation.

PERIODIC BOUNDARY CONDITION MODEL EXAMPLES

In addition to the KdV Equation model example, other modules have examples using this feature:

AC/DC Module
Magnetotellurics: model library path: ACDC_Module/Other_Industrial_Applications/magnetotellurics

Acoustics Module
Porous Absorber: model library path: Acoustics_Module/Industrial_Models/porous_absorber

RF Module or Wave Optics Module
Fresnel Equations: model library path: RF Module or Wave Optics Module/Verification_Models/fresnel_equations

Structural Mechanics Module
Vibrations of an Impeller: model library path: Structural_Mechanics_Module/Dynamics_and_Vibration/impeller

I58 | CHAPTER 3: BUILDING A COMSOL MODEL



Computing Accurate Fluxes

Flux Computation Methods

COMSOL provides three ways of computing accurate fluxes and reaction forces:

¢ The first approach involves the reaction force operator (reacf) that makes it possible to compute integrals of

reaction forces or fluxes during analysis. See react for details.

¢ The second, more general approach for calculating reaction forces and fluxes is to use weak constraints. Use this
approach when you need reaction forces or fluxes in other contexts than calculating integrals of reaction forces

or fluxes.

El. See Weak Constraints for more information about using weak constraints.

e Some physics provide a third way of computing accurate fluxes. Under the Discretization section, select the
Compute boundary fluxes check box. The solver then computes variables storing an accurate boundary flux from
each boundary into the adjacent domain (in addition to the standard extrapolated value). On interior
boundaries, there are two flux variables corresponding to the flux into the domains on either side of the
boundary. Unlike the other methods, these variables are available also on unconstrained boundaries. This
method is active by default in Coefficient Form PDE, General Form PDE, heat transfer, and mass transport
interfaces. There is also an Apply smoothing to boundary fluxes check box that is selected by default. The
smoothing can provide a more well-behaved flux value close to singularities.

When using weak constraints in interfaces, the Lagrange multipliers are additional dependent variables in those
physics interfaces. When using the reaction force operator, the reaction force operator of a certain dependent
variable corresponds to the Lagrange multiplier of that dependent variable. The Lagrange multipliers correspond

to the following quantities in the physics interfaces:

TABLE 3-5: INTERPRETATION OF LAGRANGE MULTIPLIERS

PHYSICS QUANTITY
Electrostatics Surface charge density
Magnetic Fields Surface current
Electric Currents Current density

Heat Transfer Heat flux

Transport of Diluted Species  Flux
Solid Mechanics Force per area

Pressure Acoustics Normal displacement (acceleration for
eigenfrequency studies)

Laminar Flow Total force per area

The sign of the Lagrange multiplier is the same as the one used when applying the corresponding quantity explicitly
in a flux condition. As a general rule, the sign corresponds to an action by the surroundings on the model, rather
than the opposite.
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COMSOL computes only the part of the boundary flux captured by the Lagrange multiplier. You might have
additional flux coming from boundary sources or nonidentity constraint matrices. This should not happen in the

physics interfaces, though.

Lagrange multipliers in axial symmetry are not equal to the reaction flux

I_El per area but rather per length and full revolution.

El. Flux Calculation Example—Heat Transfer Model

The reaction forces are computed from the value of the residual vector L at every node point where a constraint is
applied. Therefore, the reaction forces should be thought of as discrete values at each node point rather than
continuous fields.

The boundary flux variables are computed in a similar way to the reaction forces but with two important differences:

* First, on each boundary, the contributions to the residual vector from the boundary and from the adjacent
domains are computed separately. This makes it possible to compute the flux into each adjacent domain even
when there is no constraint on the boundary so that the full residual vector is zero.

¢ Second, the nodal fluxes computed from the residual vector are further processed and represented as a
continuous field on the boundary. The integral of this flux field over a boundary is equal to the sum of the nodal
fluxes.

Flux Calculation Example—Heat Transfer Model

Consider a heat transfer model where a heat flux of 1 W/ m? flows in through one boundary of a square 2D region.
All other boundaries are kept at a fixed temperature of 293.15 K. The material is copper. This example verifies that
the flux is conserved exactly using a Lagrange multiplier for computing the total flux over the boundaries with a
fixed temperature.

MODEL WIZARD

I On the Select Space Dimension page, click the 2D button.

2 In the list of physics, select open Heat Transfer>Heat Transfer in Solids. Then click the Add button.
3 Click the Study button. Then on the Select Study page, sclect Preset Studies>Stationary.

4 Click Done.

GEOMETRY MODELING

Draw a unit square (1-by-1 m).

MATERIALS

In the Material Browser, locate Built-in>Copper and then right-click it and select Add to Component I. Then click
Close.

HEAT TRANSFER
The Heat Transfer in Solids node defines the material properties to be those from the material (copper) and does not
need to be changed, but the default boundary condition is thermal insulation. Instead, add a heat flux to the

bottom boundary and a fixed temperature on the other three boundaries.
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I In the Model Builder window, right-click Heat Transfer node and select Heat Flux.

Click boundary 2 (the bottom boundary) to add it to the selection.

In the Heat Flux node’s settings window, enter 1 (1 W/mz) in the General inward heat flux field for q.
In the Model Builder window, right-click Heat Transfer node and select Temperature.

Select the other three boundaries (1, 3, and 4) and add them to the selection for the temperature condition.

o 1 A W N

The following step is only needed to show how to use a Lagrange multiplier for an accurate flux. Built-in variables
for accurate fluxes are available directly also without this step. To display the weak constraint option to add the

Lagrange multipliers, click the Show button ("= ) and select Advanced Physics Options. In the Temperature node’s
settings window, keep the default value for the temperature, 293.15 K, but select the Use weak constraints check
box in the Constraint Settings section. This adds a Lagrange multiplier for the heat flux as an extra variable to

compute.

COMPUTING THE SOLUTION
In the Model Builder window;, right-click Study 1 and choose Compute. The resulting plot shows the temperature

distribution in the domain.

RESULTS—FLUX EXPRESSION AND LAGRANGE MULTIPLIER

I In the Model Builder window, choose Results>Derived Values>Integration>Line Integration.

2 Sclect the three boundaries with a fixed temperature (1, 3, and 4) to add them to the selection in the Line

Integration node’s settings window.

3 Click the Replace Expression button ( % ) and select
Heat Transfer in Solids>Boundary fluxes>Normal total heat flux (the variable ht.ntflux).

4 Click the Evaluate button ( = ) at the top of the settings window. The total normal heat flux across these
boundaries appears in the Table window under Normal total heat flux (W/m) and is exactly equal to the influx of
1 W/m (the normal flux is by convention positive in the direction of the normal). If you would clear the Compute
boundary fluxes check box in the Discretization section of the Heat Transfer in Solids node’s settings window, and
the re-solve the model, the same flux variable is not as accurate and has a value of about 0.986 W/m. That value

approaches 1 if you refine the mesh.
5 Click the Replace Expression button ( % ) and select Heat Transfer>Lagrange multiplier for temperature (the

variable T_1m).

6 Click the Evaluate button ( = ) at the top of the settings window. The total heat flux across these boundaries
appears in the Table window under Lagrange multiplier for temperature and is —1—exactly equal to the influx (but
with opposite sign) without the need for a computationally expensive extremely fine mesh. This makes this

method useful for physics where built-in accurate flux variables are not available.
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Numerical Stabilization

About Numerical Stabilization in COMSOL

This section discusses the numerical stability of the generic scalar convection-diffusion transport equation

%—Lt‘qs.w = V. (cVu)+F (3-2)
where B is the convective velocity vector, ¢ is the diffusion coefficient, u is a transported scalar, and F is a source
term. The underlying finite element discretization method in COMSOL Multiphysics is the Galerkin method.
When discretizing Equation 3-2 using the Galerkin method, it is well known that the resulting numerical problem

becomes unstable for an element Péclet number (Pe) larger than one (Ref. 1):

Pe = % > 1 (3-3)

where A is the mesh element size. The Péclet number is a measure of the relative importance of the convective
effects compared to the diffusive effects; a large Péclet number indicates that the convective effects dominate over
the diffusive effects.

Oscillations can occur where any of the following conditions exist and the Péclet number exceeds one:

* A Dirichlet boundary condition can lead to a solution containing a steep gradient near the boundary, forming a

boundary layer. If the mesh cannot resolve the boundary layer, this creates a local disturbance.

* A space-dependent initial condition that the mesh does not resolve can cause a local initial disturbance that

propagates through the computational domain.

e A small initial diffusion term close to a nonconstant source term or a nonconstant Dirichlet boundary condition

can result in a local disturbance.

As long as diffusion is present, there is—at least in theory—a mesh resolution beyond which the discretization is
stable. This means that the spurious oscillations can be removed by refining the mesh. In practice, this method is
seldom feasible because it can require a very dense mesh. Instead, it is common practice to use stabilization
methods; that is, methods that add artificial diffusion. COMSOL provides several of these methods and described

in An Example of Stabilization.

Consistent Stabilization and Inconsistent Stabilization Sections on Settings Windows

Numerical stabilization is available for physics interfaces that model transport such as fluid flow or convective heat
transfer, where the fundamental governing equations are less stable than, for example, conduction-dominated

models, solid mechanics models, and wave propagation in the frequency domain.

Several physics interfaces have these settings available, and below you find the common information about the
stabilization settings. Differences not described below are noted for the individual interface documentation.
CONSISTENT STABILIZATION

To enable this section, click the Show button ("= ) and select Stabilization.

There are two consistent stabilization methods: Streamline diffusion and Crosswind diffusion. Usually, both check
boxes for these methods are selected by default and should remain selected for optimal performance. Consistent

stabilization methods do not perturb the original transport equation.
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The crosswind diffusion method specifies the smallest allowable concentration change across an element. As the
concentration gradient appears in the denominator in the equations describing crosswind diffusion, the gradient

ensures that unreasonable values do not occur in regions with small to negligible concentration changes.

Crosswind Diffusion and Tuning Parameter

In most cases when the Crosswind diffusion check box is selected, enter a Tuning parameter C).. The default is most
often 0.5. The Tuning parameter controls the amount of crosswind diffusion introduced. It recommended that it is
kept in the order of 1 to avoid introducing excessive amounts of diffusion. The value used must also neither be
space dependent nor time-dependent.

Crosswind Diffusion and Lower Gradient Limit

In some cases, if the Crosswind diffusion check box is selected, the Lower gradient limit gp;,,, (SI unit: K/m) field is
available. This variable corresponds to the smallest concentration change across an element considered by the
stabilization, and is used to make sure that the crosswind diffusion expressions are valid also in regions with small
to negligible concentration changes.

Residual
In some cases, and for both consistent stabilization methods, select a Residual (or Equation Residual). Approximate
residual is the default setting and it means that derivatives of the diffusion tensor components are neglected. This

setting is usually accurate enough and is faster to compute. If required, select Full residual instead.

INCONSISTENT STABILIZATION

To enable this section, click the Show button ("= ) and select Stabilization.

There is usually just one inconsistent stabilization method— lsotropic diffusion. This method is equivalent to
adding a term to the diffusion coefficient in order to dampen the effect of oscillations by making the system
somewhat less dominated by convection. If possible, minimize the use of the inconsistent stabilization method

because by using it you no longer solve the original problem.

By default there is no isotropic diffusion selected. If required, select the Isotropic diffusion check box and enter a
Tuning parameter J;4 as a scalar positive value. The default value is 0.25 (a reasonable value to start with is roughly

0.5 divided by the element order). A higher value adds more isotropic diffusion.

* An Example of Stabilization

@ * Stabilization Techniques

An Example of Stabilization

This example uses the Heat Transfer interface. To illustrate the concepts, consider the problem

cos(E g—z + sin(g)%yli = 10*4(%%2—‘ + %j,—%) +1 (3-4)

solved on the unit square. Equation 3-4 is discretized using 10 times 10 biquadratic Lagrangian elements. The
boundary conditions are:

e u=1forx=0

e u=1fory=0

e u=0forx=1

e u=0fory=1
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Figure 3-17 shows the mesh and boundary conditions. In general, using uniform meshes for transport problems is
not recommended. Nevertheless, this example uses a uniform mesh to demonstrate the different stabilization
techniques.

The expected solution rises slowly and smoothly from the left and lower boundaries and has sharp boundary layers
along the upper and right boundaries. Figure 3-18 shows a reference solution obtained using 100-by-100
biquadratic Lagrangian elements with streamline diffusion and crosswind diffusion (see the next section). The
arrows indicate the direction of f.

u=1

Figure 3-17: The computation domain, mesh, and boundary condition for Equation 3-4.

Surface: u  Arrow: [beta_1, beta_2] Max: 2.115
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Figure 3-18: Reference solution of Equation 3-4. Solved using 100 times 100 biguadratic elements with streamline
diffusion and crosswind diffusion.

The cell Péclet number for this example is

1-0.1

=5 104 = 500>>1
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Figure 3-19 displays the solution obtained using the mesh in Figure 3-17 and (unstabilized) Galerkin

discretization. As can be expected with such a high Péclet number, the unstabilized solution shows little, if any,
resemblance to the reference solution in Figure 3-18. The right plot in Figure 3-19 shows a cross-sectional plot
along the dashed line, y = 0.8 and the corresponding reference solution. Notice that the unstabilized solution is

completely destroyed by oscillations.
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Figure 3-19: Equation 3-4 solved using unstabilized Galevkin formulation. The right plot compares the unstabilized
solution (Aashed line) along the dashed line in the left plot (y = 0.8) with the refevence solution (solid line).

The Stabilization Techniques section explores how different stabilization techniques affect the solution of this
example.

Stabilization Techniques

Several techniques for handling numerical instabilities without the need for mesh refinement are available. They all
have in common that they add terms to the transport equation. These terms introduce numerical diffusion (artificial
diffusion, artificial viscosity, or numerical viscosity are other common names) that stabilize the solution. To display

these sections, click the Show button (‘& ) and select Stabilization.

¢ Consistent and Inconsistent Stabilization Methods for the Heat
'El Transfer Interfaces

* Numerical Stability—Stabilization Techniques for Fluid Flow

CONSISTENT STABILIZATION
A consistent stabilization method adds numerical diffusion in such a way that if u is an exact solution to
Equation 3-2, then it is also a solution to the problem with numerical diffusion. In other words, a consistent

stabilization method gives less numerical diffusion the closer the numerical solution comes to the exact solution.

INCONSISTENT STABILIZATION

An inconsistent stabilization method adds numerical diffusion in such a way that if u is an exact solution to
Equation 3-2, then it is not necessarily a solution to the problem with numerical diffusion. In other words, an
inconsistent method adds a certain amount of diffusion independently of how close the numerical solution is the
to exact solution.

ISOTROPIC DIFFUSION

Adding isotropic diffusion is equivalent to adding a term,

Cart = 8idh”B”
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to the physical diffusion coefficient, ¢. Here ;4 is a tuning parameter. This means that you do not solve the original
problem, Equation 3-2, but rather the modified O(h)-perturbed problem
ou

—+B-Vu =V-((c+c

o Wu)+F (3-5)

art

Hence, isotropic diffusion is an inconsistent stabilization method. If §;q = 0.5, the new cell Péclet number can be
expressed as

hlBl ABI
P = =
® = %cre,y  2c+hlpl

Clearly, as ||B|| approaches infinity, Pe approaches, but never exceeds, one. While a solution obtained with isotropic
diffusion might not be satisfactory in all cases, the added diffusion definitely dampens the effects of oscillations and
impedes their propagation to other parts of the system. It is not always necessary to set 8;q as high as 0.5 to get a
smooth solution, and its value should be smaller if possible. A good rule of thumb is to select 6 = 0.5/p, where p is
the order of the basis functions. The default value is 8;3 = 0.25

Figure 3-20 shows the effect of isotropic diffusion on Equation 3-4 with §;3 = 0.25. Although the solution is
smooth, the comparison with the reference solution in the right plot reveals that the isotropic diffusion introduces
far too much diffusion.
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Figure 3-20: Equation 3-4 solved using isotropic diffusion. The rvight plot compares the stabilized solution (dashed line)
along y = 0.8 with the veference solution (solid line).

STREAMLINE DIFFUSION

The streamline diffusion method in COMSOL is a consistent stabilization method. When applied to Equation 3-2,
it recovers the streamline upwind Petrov-Galerkin (SUPG) method, but it can also recover functionality from the
Galerkin least-squares (GLS) method. Both methods are described below. For theoretical details, see Ref. 1 and
Ref. 2.

Streamline Upwind Petrov-Galerkin (SUPG)

The theory underlying SUPG is a bit too complicated to describe here, but the resulting expressions can be shown
to be closely related to upwinding schemes in finite difference and finite volume methods. SUPG can be shown to
add a smaller amount of stability than isotropic diffusion (see Ref. 3), but while the accuracy of isotropic diffusion
is at best O(h), the accuracy of SUPG can be shown to be at least OHWP +1/2) where p>1 is the order of the basis

functions.

Figure 3-21 displays the effect of SUPG on the solution of Equation 3-4. The solution closely follows the reference
solution away from the boundary layers, but at the boundary layers, oscillations occur. This is a typical behavior for
streamline diffusion: the solution becomes smooth and exact in smooth regions but can contain local oscillations

at sharp gradients.
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Figure 3-21: Equation 3-4 solved using streamline diffusion. The right plot compares the stabilized solution (dashed
line) along y = 0.8 with the reference solution (solid line).

Galerkin Least-Squares (GLS)
Galerkin least-squares (GLS) is a more advanced version of SUPG, with which it shares many features. GLS, for

example, is also a consistent method and has the same order of accuracy as SUPG. To understand the differences
between GLS and SUPG, consider the following extended form of Equation 3-2:

%%+B~Vu=V-(cVu)+su+F (3-6)

where s is a production coefficient if s > 0 and an absorption coefficient if s < 0. If s # 0, the numerical solution of

Equation 3-6 is characterized by the Péclet number (see Equation 3-3) and the element Damkohler number:

|s|h
Da =
1Bl
A new dimensionless number can be formed by combining the Damkohler number and the Péclet number:
2
2DaPe = |§|—£‘— (3-7)

The (unstabilized) Galerkin discretization becomes unstable if 2DaPe > 1 (Ref. 4), that is, if the
production/absorption effects dominate over the viscous effects. GLS differs from SUPG in that GLS relaxes this
requirement while SUPG does not.!

CROSSWIND DIFFUSION

Streamline diffusion introduces artificial diffusion in the streamline direction. This is often enough to obtain a
smooth numerical solution if the exact solution of Equation 3-2 (or Equation 3-6) does not contain any
discontinuities. At sharp gradients, however, undershoots and overshoots can occur in the numerical solutions (see
Figure 3-21). Crosswind diffusion addresses these spurious oscillations by adding diffusion orthogonal to the
streamline direction—that is, in the crosswind direction.

Crosswind diffusion methods are consistent, but they are also nonlinear. This means that the discrete equation
system becomes nonlinear even if the original equation (Equation 3-2 or Equation 3-6) is linear, which can increase
the computational cost.

Use crosswind diffusion if it is important to avoid undershoots or

overshoots. Typical examples are concentrations that must not become

e

negative and mass fractions that must be between zero and one.

1. The streamline diffusion stabilization in COMSOL is GLS but without any viscous terms in the test operator in the stabilization term.
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The crosswind diffusion option adds a weak contribution as suggested in Ref. 5. For the scalar example here, the

term reads

oc ;:oc
_yh & i e
v axg 6xj

i

P is for Navier-Stokes systems a modified version of the

where gij is the covariant metric tensor. The coefficient v
Hughes-Mallet (HM) formulation of Ref. 6. In the scalar case, the modified HM formulation reduces effectively
to the form suggested in Ref. 6. Additionally, Ref. 7 suggests to reduce v for higher-order elements. The

COMSOL formulation multiplies vP with a factor

(J2)1-N

where N is the shape function order.

Figure 3-22 shows the example problem (Equation 3-4) solved using streamline diffusion and crosswind diffusion.
Oscillations at the boundary layers are almost completely removed (compare with Figure 3-21), but it has been
achieved by the introduction of some extra diffusion. In general, crosswind diffusion tries to smear out the
boundary layer so that it becomes just wide enough to be resolved on the mesh (Figure 3-17). To obtain a sharper

solution and remove the last oscillations, the mesh needs to be refined locally at the boundary layers.
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Figure 3-22: Equation 3-4 solved using streamline diffusion and crosswind diffusion. The right plot compares the
stabilized solution (dashed line) along y = 0.8 with the vefevence solution (solid line).
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Using Units

COMSOL supports a number of consistent unit systems, including the SI unit system, which is the default unit
system. The physics interface displays the unit for the physical quantities entered in the selected unit system, but by
Using Standard Unit Prefixes and Syntax you can use any available and applicable unit or SI prefix to define your
input quantities. In addition to SI units, many English units and units from the CGS (or cgs) system are also
available, regardless of the unit system used in the model. All data in the material databases and Material Library
product use SI units with declared units using the unit syntax (see Materials). This makes it possible to use the
material data also in models with non-SI unit systems. Regardless of the selected unit system, you can always choose

from a list of applicable units for plotting and results evaluation.

I___ll- In the unit tables, “N/A” means that no unit symbol is available.

e Unit Systems in COMSOL
& * Indication of Unexpected, Unknown, or Inconsistent Units

* Setting the Unit System for Models

Using Standard Unit Prefixes and Syntax

STANDARD UNIT PREFIXES

For SI units you can scale data using the standard prefixes for powers of 10—*kilo, mega, milli, or micro, for
example. Either the full prefix or the symbol can be used, but you must use the same form for the prefix and the
unit—that is, [milliampere] and [mA] are valid but not [mampere] or [mil1iA]). In the settings windows for
plotting and numerical results, the Unit list contains the ST unit for the quantity, including the most common

prefixes. The lists also contain applicable non-SI units, which in a few cases also support these prefixes.

Use Table 3-6 as a guide for the format to enter.

TABLE 3-6: SI PREFIXES

FULL PREFIX SYMBOL FACTOR
yotta Y 10%4
zetta z 102!
exa E 10'8
peta P 103
tera T 10'2
giga G 10°
mega M 10
kilo k 103
hekto h 102
deca da 10!
deci d 10!
centi c 102
mill m 103
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TABLE 3-6: S| PREFIXES

FULL PREFIX SYMBOL FACTOR
micro u 10
nano n 107
pico p 1072
femto f 10!
atto a 0!8
Zepto z 102!
yocto y 1024

STANDARD UNIT SYNTAX

You can use the unit syntax to specify a quantity with any applicable unit. To do so, append the unit to any constant
or variable in a model using a syntax where you enclose the unit in brackets, for example, 200[ft] and
3e6[kg/m~3].

Both the name and the symbol can be used for a unit. For example, 2.4[ampere] and 2.4[A] are both valid to
indicate an electric current in SI units. The SI units can also contain standard prefixes. Appending a unit means that
you multiply the constant or variable to the left of the unit declaration with this unit. This multiplication takes
precedence over other operators so, for example, 1/2[m] evaluates to 0.5 m1 (0.5[1/m]) whereas both (1/2)[m]
and 1/2*1[m] evaluate to 50 cm (0.5[m] or 50[cm]). Also, if L is a variable defined as 2[m], L[1/s] evaluates to
2[m/s].

The following examples show how to apply the unit syntax:

* Adding two quantities of the same kind that use different units: 0.5[ft]+33[mm]. COMSOL converts the result
to the base unit system’s length unit.

¢ Using multiplication with a unit to get consistent units for two quantities that you want to add, for example,
14[kg]+ht.rho[m~3], which works if ht.rho represents the density for a heat transfer model. You can also
concatenate several units, for example, 3.6[N] [m], which is equivalent to typing 3.6[N*m] and evaluates to

3.6 N-m.

For unit names with spaces and hyphens, such as British thermal unit
]
E| and pound-force, only use the symbols when declaring units.

It is possible to add constants (without units) to any quantity. COMSOL then assumes that this value has the same

unit as that quantity (as indicated in the settings window).

All data in the material databases and Material Library product use SI units and this unit syntax.

DECLARING UNITS FOR PARAMETERS, VARIABLES, AND FUNCTIONS

n It is important to be aware of the following aspects of unit handling.

When using parameters, variables, and functions in expressions:

e Ifuser-defined parameters or variables are used in the physics, it is good practice to use the unit syntax to define

them. The settings windows for parameters and variables display the resulting unit, in the models base unit
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system, of user-defined parameters and variables. It is important to verify that the variables have the expected
unit before using them in the physics settings. The unit of parameters and variables is otherwise undefined.

e Most user-defined and built-in functions expect dimensionless inputs and outputs, so it is good practice to use
make inputs, such as time, dimensionless using unit syntax. If the input is not dimensionless, COMSOL marks
the expression in an orange color and reports an unexpected unit of input. For example, to use the time ¢ as input
to a Rectangle function rect1, use [1/s] to make the input dimensionless: rect1(t[1/s]).

¢ Using properties with undefined units in a model does not affect the numerical results during the analysis, but
undefined units are required in the results and visualization stages—expressions involving such parameters and

variables are also unitless.

¢ If other units than the base unit system’s units are used or if SI prefixes are included, the conversion to base units
also affects the value (quantity) using a scaling factor (and an offset for temperature units). The Value column in
a Parameter scttings window displays the quantity and unit in the base unit system so that you can see the result
of the unit conversion. For example, a parameter is defined as 3[ ft ], the result in the Value column is 0.9144 m

if the base unit system is SI.

SI Base, Derived, and Other Units

The SI units form an internationally accepted system with seven units for base quantities and a large number of
derived units. Use the symbols for these and other units when declaring units in COMSOL (for example, 10[m/s]

uses the SI unit for velocity).
e Table 3-7 lists the SI units for the seven base quantities.

* Table 3-8 lists the SI derived units supported in COMSOL.

e Table 3-9 lists additional units available in COMSOL regardless of the unit system in the model. If more than
one name or symbol is available, use any of them, except when names contain more than one word or a hyphen.
See also the tables with special units for other unit systems than the SI system; special units that are not listed in

Table 3-9 are only available when using such non-SI unit systems.
e Table 3-10 lists other SI derived units without special names or symbols.

TABLE 3-7: BASE SI UNITS

BASE QUANTITY UNIT NAME SYMBOL
length meter, metre* m
mass kilogram kg
time second s
electric current ampere A
temperature kelvin** K
amount of substance mole mol
luminous intensity candela cd

* See About Editing Geometry Length and Angular Units

**See About Temperature Units

TABLE 3-8: SI DERIVED UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
absorbed dose gray Gy
capacitance farad F
conductance siemens S

dose equivalent sievert Sv
electric charge coulomb C
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TABLE 3-8: SI DERIVED UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
electric resistance, impedance, reactance ohm* Q

electric potential difference, voltage volt \

energy, work, heat joule ]

force, weight newton N

frequency hertz Hz
inductance henry H

magnetic flux weber Wb

magnetic flux density, magnetic induction tesla T

plane angle radian rad

power watt W

pressure pascal Pa

* See the additional notes following the next table.
TABLE 3-9: ADDITIONAL UNITS IN COMSOL

QUANTITY NAME SYMBOLS VALUE

acceleration galileo Gal 0.01 m/s>

dipole moment debye D 3.33564095:103% C'm
dynamic viscosity poise P 0.1 Pa's

energy British thermal unit*  BTU, Btu 1055.05585 |
energy calorie* cal 4.184 ]

energy electronvolt eV 1.6021765314-107"° J
energy erg erg 10”7 J

force dyne dyn 10° N

force kilopond* kp, kpf 9.80665 N

force poundal pdl 0.138254954376 N
force pound-force Ibf 4.4482216152605 N
frequency rpm RPM 1/60 Hz

length angstrom A 100 m

length inch in 0.0254 m

length foot ft 0.3048 m

length mile* mi 1609.344 m

length microinch uin 0.0254-10® m
length milliinch mil, thou 0.0254- IO'3 m
length nautical mile*, nmi 1852 m

nautimile

length yard yd 09144 m

magnetic field strength  oersted Oe |03/(4'TC) A/m
magnetic flux density  gauss G 104 T

mass atomic mass unit, u, amu, Da 1.660538782-10°27 kg

dalton

mass gram g 0,001 kg

mass pound, pound-mass Ib, Ibm 0.45359237 kg
mass stone st 6.35029318 kg
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TABLE 3-9: ADDITIONAL UNITS IN COMSOL

QUANTITY NAME SYMBOLS VALUE

mass slug slug approx. 14.5939 kg

mass ton, tonne t 1000 kg

permeability millidarcy* mD 9.869233:10°'® m?

plane angle degree deg n/180

pressure atmosphere atm 101325 Pa

pressure bar bar 100000 Pa

pressure barye ba 0.1 Pa

pressure kilopound per square  ksi 6.894757-10° Pa
inch* (1000 psi)

pressure psi psi 6.894757-10° Pa

pressure torr Torr, mmHg 133.322 Pa

pressure inches water* inAg, inH20 249.089 Pa

speed mph, MPH mph 0.44704 m/s

speed knot* knot 1852 km/h (approx.

0.614 m/s)

temperature Celsius** degC T+273.15

temperature Fahrenheit** degF 5/9-T+459.67

temperature Rankine™* R, Ra 5/9-T

time year*® a,yr 31556952 s

time day d 86400 s

time hour h 3600 s

time minute min 60 s

volume gallon* gal 0.00378541 1784 m*

volume imperialgallon impgal 0.00454609 m>

volume liter, litre L1 0.001 m?

volume pint* pt 0.000473176473 m*

volume quart* qt 0.000946352946 m3

volumetric flow rate cubic feet per minute CFM, cfm 4.719474-1 0'4 m3/s

* See the additional

** See About Temp

notes following this table.

crature Units

ADDITIONAL NOTES ABOUT UNITS IN Table 3-8 anp Table 3-9

UNIT NAME

NOTE

British thermal
unit

calorie

kilopond

An energy unit defined as the amount of heat required to raise the
temperature of one pound (pound-mass) of water by one degree
from 60° to 61° Fahrenheit at a constant pressure of one
atmosphere. Refer to the British thermal unit using the symbol
only (Btu or BTU): for example, 0.28[Btu/(h*in*degF)] fora
thermal conductivity.

Small calorie or gram calorie, which equals 4.184 ). A large calorie
or kilogram calorie is 1000 calories (4.184 kJ). Use [kcal] for large
calories.

The kilopond (kp) or kilogram-force (kpf) is a gravitational metric
unit of force. Refer to this unit using kilopond, kp, or kpf only.
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ADDITIONAL NOTES ABOUT UNITS IN Table 3-8 anp Table 3-9

UNIT NAME

NOTE

kilopound per
square inch

millidarcy (mD)

mile
nautimile

ohm

inches water

knot

year

gallon (gal)

pint and quart

The kilopound per square inch (ksi) is a scaled pressure unit
derived from psi (1 ksi is equal to 1000 psi). Refer to this unit using
the symbol only (ksi).

Widely used for permeability in petroleum engineering. Typical
values for the permeability of porous media are in the range of a
few to a few hundred mD. The symbol D represents the debye, a
unit for the magnetic dipole moment, and not the darcy unit.

The international statute mile, which equals 1609.344 m.
The nautical mile equals 1852 m.

To declare the Sl unit for electric resistance, ohm, use [ohm].
COMSOL then displays this as

The value of | inch of water is defined as the pressure exerted by
one inch of water for a pure water density of 1000 kg/m3 at

4 degrees Celsius and standard gravity of 9.80665 m/sZ. Refer to
this unit using the symbol only (inH2O or inAq).

The same as nautical miles per hour.
A Gregorian year, which equals 365.2425 days.

This is the U.S. liquid gallon which equals 0.0037854 11784 m3; the
Imferial (UK) gallon (imperialgallon, impgal) is equal to 0.00454609
m~.

The US. liquid pint and U.S. liquid quart, respectively.

TABLE 3-10: EXAMPLES OF SI DERIVED UNITS WITHOUT SPECIAL NAMES

DERIVED QUANTITY NAME SYMBOL
acceleration meter per second squared m/s2
amount-of-substance concentration mole per cubic meter mol/m>
area square meter m?
current density ampere per square meter Alm?
heat capacity, specific heat joule per kilogram kelvin JI(kg'K)
magnetic field strength ampere per meter A/m
mass density kilogram per cubic meter kg/m3
permeability henry per meter H/m
speed, velocity meter per second m/s
wave number reciprocal meter m’!
volume cubic meter m3

Special British Engineering Units

The base units in the British engineering unit system are identical to the SI units with the following exceptions:

TABLE 3-11: SPECIAL BASE UNITS IN THE BRITISH ENGINEERING UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length foot ft

mass slug N/A
temperature Fahrenheit degF
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There is one derived unit that differs from the corresponding SI unit:

TABLE 3-12: DERIVED BRITISH ENGINEERING UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL

force pound-force Ibf

The British thermal unit is also available as Btu or BTU.

If the British engineering unit system is the base unit system, COMSOL
constructs derived units from the applicable SI base units and the units
listed in Table 3-11 and Table 3-12. This means, for example, that the
unit for voltage displayed in the physics interface is 1bf-ft/As rather than
V (volt). In a text field that expects a voltage as input, you need to use the

[

unit syntax when entering a numerical value, for example, 10[V].

Special CGSA Units

The base units in the CGSA unit system are identical to the ST units with the following exceptions:

TABLE 3-13: SPECIAL BASE UNITS IN THE CGSA UNIT SYSTEM

BASE QUANTITY NAME SsYMBOL
length centimeter cm
mass gram g

The CGSA unit system includes the following derived units that differ from the corresponding SI units:

TABLE 3-14: DERIVED CGSA UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
acceleration galileo Gal
energy erg N/A
force dyne dyn
pressure barye N/A
speed kyne N/A

Special EMU Units

The base units in the EMU unit system are identical to the SI units with the following exceptions:

TABLE 3-15: SPECIAL BASE UNITS IN THE EMU UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length centimeter cm
mass gram g
electric current abampere, biot N/A

The EMU unit system includes the following derived units that differ from the corresponding SI units:

TABLE 3-16: DERIVED EMU UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
acceleration galileo Gal
capacitance abfarad N/A
conductance absiemens N/A
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TABLE 3-16: DERIVED EMU UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
electric charge abcoulomb N/A
electric resistance abohm N/A
electric potential difference, voltage abvolt N/A
energy erg N/A
force dyne dyn
inductance abhenry N/A
magnetic flux abweber N/A
magnetic flux density abtesla N/A
pressure barye N/A
speed kyne N/A

Special ESU Units

The base units in the ESU unit system are identical to the SI units with the following exceptions:

TABLE 3-17: SPECIAL BASE UNITS IN THE ESU UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length centimeter cm
mass gram g
electric current statampere, franklin - N/A

The ESU unit system includes the following derived units that differ from the corresponding SI units:

TABLE 3-18: DERIVED ESU UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
acceleration galileo Gal
capacitance statfarad N/A
conductance statsiemens N/A
electric charge statcoulomb N/A
electric resistance statohm N/A
electric potential difference, voltage statvolt N/A
energy erg N/A
force dyne dyn
inductance stathenry N/A
magnetic flux statweber N/A
magnetic flux density stattesla N/A
pressure barye N/A
speed kyne N/A
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Special FPS Units

The base units in the FPS unit system are identical to the SI units with the following exceptions:

TABLE 3-19: SPECIAL BASE UNITS IN THE FPS UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length foot ft

mass pound Ib
temperature Fahrenheit degF

There is one derived unit that differs from the corresponding SI unit:

TABLE 3-20: DERIVED FPS UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL

force poundal N/A

Special IPS Units

The base units in the IPS unit system are identical to the SI units with the following exceptions:

TABLE 3-21: SPECIAL BASE UNITS IN THE IPS UNIT SYSTEM

BASE QUANTITY NAME SsYMBOL
length inch in

mass pound Ib
temperature Fahrenheit degF

Special MPa Units

The base units in the MPa unit system are identical to the SI units with the following exceptions:

TABLE 3-22: SPECIAL BASE UNITS IN THE MPA UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length millimeter mm
mass tonne, ton t

There is one derived unit that differs from the corresponding SI unit:

TABLE 3-23: DERIVED MPA UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL

pressure megapascal MPa

Special Gravitational IPS Units

The base units in the Gravitational IPS unit system are identical to the SI units with the following exceptions:

TABLE 3-24: SPECIAL BASE UNITS IN THE GRAVITATIONAL IPS UNIT SYSTEM

BASE QUANTITY NAME SYMBOL
length inch in

mass GIPS_mass N/A
temperature Fahrenheit degF
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The following derived units differ from the corresponding SI units:

TABLE 3-25: DERIVED GRAVITATIONAL IPS UNITS IN COMSOL

DERIVED QUANTITY NAME SYMBOL
force pound-force Ibf
pressure psi psi

Switching Unit System

If the unit system is switched during modeling, COMSOL does not convert the data in the model (except for length
units and angular units in the geometry if specified). All physical constants and data in the material libraries are in
SI units and defined using the unit syntax, so you can use them with any unit system because COMSOL converts

these values to the corresponding values in the model’s unit system.

The units of other input data must be declared for the model using the

unit syntax (or manually convert the numerical values to the new unit

!

system).

About Temperature Units

The relationship between different temperature units involve an offset in addition to the usual scale factor. The
offset is often not important to the physics equations because these equations are concerned only with temperature
differences. There are, however, some cases where an absolute or thermodynamic temperature measure must be

used. One example is the Stefan-Boltzmann law for blackbody radiation used in radiation boundary conditions.

The ST unit system uses the kelvin, which is an absolute temperature, as the basic unit of temperature. English unit
systems use degree Fahrenheit as the basic unit of temperature, which, because the Fahrenheit scale is not absolute,
is fine for most purposes except radiation. For such purposes, the Rankine scale provides the corresponding absolute
temperature unit. See Table 3-26 for a list of acceptable unit syntax.

TABLE 3-26: TEMPERATURE UNITS

SCALE UNIT

Celsius [degC]
Fahrenheit [degF]
Kelvin [K]

Rankine [R] or [Ra]

DIFFERENTIAL VS. ABSOLUTE TEMPERATURE

If the dimension of an expression that includes a unit is temperature or 1/temperature, COMSOL interprets the
dimension as an absolute temperature. If the dimension is something other than temperature but the unit
expression includes temperature, the temperature is a differential temperature; that is, COMSOL uses no offset

when converting between different temperature units.

The following examples show how the unit conversion works for different expressions that include temperature

units:
¢ 100[degC] is an expression that has temperature as the dimension. COMSOL interprets it as an absolute
temperature and evaluates it as 373.15 K.

e 373.15[1/K] is interpreted as an absolute inverse temperature (but no conversion is necessary from kelvin to

kelvin).

e 373.15[1/degC] evaluates to 100[1/K] using the offset of 273.15 degrees between kelvin and degrees Celsius.
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e 100[degC/K] is dimensionless, and the temperature is therefore a differential temperature; that is, the result is
100 because the conversion uses no offset.

¢ To make COMSOL interpret 100[degC/K] as an absolute temperature, split the expression using two separate
expressions such as 100[degC]*1[1/K], which equals 373.15. This is also what occurs when you use a variable
(TC, for example) defined as 100[degC]. TC[1/K] is then also two expressions where both are interpreted as

absolute temperature.

About Editing Geometry Length and Angular Units

The default units are meters for length and degrees for angles. For many applications an independent length unit
for the geometry might be required. For example, if the model describes a MEMS device, the natural length unit
might be pm (micrometers), or the geometry imported from a CAD file might use another unit than meters. It can

also be useful to specify the angular unit in radians instead.

The length unit for the geometry does not affect the units that include
]
I_El length in the physics interfaces or any other part of COMSOL.

I Create or open a model file.
In the Model Builder, under a Component node, click the Geometry node.
Under Units, select a Length unit from the list.

Select an Angular unit—Degrees or Radians.

vi A W N

Select the Scale values when changing units check box to automatically scale for dimensions in the existing

geometry.

6 Enter a Default relative repair tolerance and sclect a Geometry representation.

When importing 3D CAD geometries, you can choose to use the length unit from the CAD file or the length unit
from COMSOL.

'El The Geometry Node

Units and Space Dimensions

Most physics interfaces support 2D (and in some cases also 1D) models in addition to 3D models. The units for
intensive physical quantities such as density in the physics interfaces are the same regardless of the space dimension
(for density, kg/ m? in SI units). This makes it possible to use common material property values also in models with
other space dimensions than 3D using their well-known, physical units regardless of the dimension you are
modeling in. In planar 2D, this means that the implementation includes an implicit unit depth in the out-of-plane
direction, except for some physics interfaces (for solid mechanics and electric currents, for example), where the
thickness is a user-defined property that defines the volume of the model domain. In axisymmetric models, the
volume of the domain is defined by the 2D cross section in the rz-plane that is the geometry you define for such
models. The volume that it defines is the area of the 2D cross section integrated a full 360 degrees in the

circumferential direction.
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Customizing the COMSOL Desktop

This chapter describes a variety of tasks that can be done to organize and simplify
the model building process. For example, set the layout and other features of the
COMSOL Desktop using the Preferences settings, change the language and fonts,
restrict or allow features to display based on license, or learn about how to edit

node names.
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Customizing a Model

A variety of tasks can be done to organize and simplify the model building process.

e Customizing the Desktop Layout

* Changing Fonts and the Desktop Language

» Editing Node Properties, Names, and Identifiers
* Grouping Nodes by Space Dimension and Type
* Setting the Unit System for Models

¢ Checking and Controlling Products and Licenses Used

e Preferences Settings

* The Model Libraries Window
El * Advanced Physics Sections
The COMSOL Desktop

Customizing the Desktop Layout

To customize the COMSOL Desktop environment, you can rearrange the windows by moving, resizing, detaching,
or docking each window (see Adjusting Window Location and Size on the Desktop). Predefined layouts are also
available and selected from the Desktop Layout menu where you can adjust to a widescreen or regular layout or reset
it to the default.

You can also adjust the fonts and the language. See Changing Fonts and
'El the Desktop Language.

CHANGING AND RESETTING THE DESKTOP LAYOUT

The COMSOL Desktop layout can be set to widescreen or regular screen, or you can reset it to its default settings.
Resetting can be useful after you have been moving or resizing the windows and you want to quickly return to the
default. The default settings are restored either for a widescreen layout or a regular screen layout depending on the
monitor. Also see The COMSOL Desktop Menus and Toolbars.

From the Desktop Layout menu, select one of the following:

* Widescreen Layout: suitable for widescreen monitors. The Model Builder window and the settings window display

side by side.

* Regular Screen Layout: suitable for monitors with a regular screen (4:3). The Model Builder window displays on

top of the settings window.

To access the menu, on the Home ribbon, click [[Z] Layout>Desktop Layout
Win to choose a layout, or choose to Reset Desktop.
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To access the menu, select a layout from Windows>Desktop Layout. To
reset the desktop, select Reset Desktop or click the Reset desktop (IT;L)

button on the main toolbar.

Changing Fonts and the Desktop Language

COMSOL uses a default font for texts in plots such as axis labels and titles. This might be necessary to display
non-Latin characters such as Chinese and Japanese characters. You can also change the Desktop language. You can

make these changes using The Preferences Dialog Box.

CHANGING THE FONT FOR PLOT LABELS AND TITLES

The Font option is for the text that displays for plots in the Graphics window. The change is applied when creating

a new model. You can also change the setting used for a model from the root node’s settings window. In the

Preferences dialog box, click Graphics.

I Under Font, select a font Family from the list and enter a font Size (in points). The default is to use a predefined
default font with a font Size of 9 points. Depending on the operating system and the installed fonts on the
computer, you can select from a number of other font families.

2 Click OK. The program stores the specified font family and size as a preference setting, so you only have to change

it once.

* Dlot Titles for Plot Groups and Plot Types
]
I_i'| * The Root Window

CHANGING THE COMSOL DESKTOP LANGUAGE

I In the Preferences dialog box, click General.

2 Select an available Language for the graphical user interface (GUI). The following languages are available:
Traditional Chinese, English, French, German, Italian, Japanese, Korean, and Spanish.

3 Click OK. A message displays indicating that COMSOL must be restarted for the changes to take effect. Click 0K
again, exit and re-open COMSOL to display the GUT in the selected language.

If you selected a language during the COMSOL installation, that
language becomes the default language when you first start COMSOL

B

Multiphysics.

Editing Node Properties, Names, and Identifiers

All nodes, except container nodes, have a common set of node properties, some of which can be changed and some
system generated properties that cannot be edited. The Root node has additional information that provides an
overview of the complete model file. The settings window for the Root node also includes a Node Properties section
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with additional information about the model file. The Model Thumbnail is set from The Root Window.

¢ The Root Window

* To learn about how some of these properties can be viewed, see
'ﬂ Viewing Node Names, Identifiers, Types, and Tags.

* Variable Naming Convention and Namespace

EDITING A COMPONENT IDENTIFIER FOR USE WITH VARIABLES

Use a component identifier to access variables throughout the model. The identifier is part of the full reference to
variables (for example, when referring to variables in another model). To edit a component identifier, in the Model
Builder, click a Component node. The Component node’s settings window opens. Edit the default identifiers (compl,
comp2, and so on) as required in the Component Identifier ficld. See The Node Settings Windows (Figure 3-3) for

an example.

RENAMING A NODE
To rename a node in the Model Builder (except container nodes with fixed names such as Global Definitions), click a
node and select Rename (44 ) or press F2. Enter a New name and click OK. The Name is both updated in the Model

Builder and in the Node Properties scction.

THE NODE PROPERTIES SETTINGS WINDOW
In the Model Builder, right-click a node (except “container nodes” such as Materials) and select Properties from
the context menu (see Figure 3-4). The Properties window for that specific node replaces the settings window. The

node properties vary by node type.

Node Properties
This section contains these fields:
e The Name field defaults to a system name for the node. Edit as required as a description for the node.

e The Tag is a unique system-defined tag for the node, which cannot be changed and is mainly used when using
the COMSOL API and the optional LiveLink™ for MATLAB®.

¢ Identifier: For physics interfaces, this is the node identifier.
e The Created field is system generated and shows the node creation date and time.

* The Author ficld contains the name of the author (creator) of the node. In addition to editing the author name

manually, you can make a change for all nodes that you add later on from The Preferences Dialog Box.
* The Version and Description ficlds are empty by default. Enter version numbers or comments to track model

changes or changes to specific node contents.

Returning to the Settings Window
When you are finished editing the properties, right-click the node again and select Settings to return to the settings
window (or click another node and then click the node again).
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Grouping Nodes by Space Dimension and Type

The default setting, found under Model Builder in the The Preferences

E Dialog Box section, disables grouping in new models.

The Group by Space Dimension (for physics interface nodes), Group by Type (for Definitions nodes), or Ungroup
options are available from the context menu for these features:
* Global Definitions—nodes can be grouped by type: Variables, Functions, or Groups.

* Definitions—nodes can be grouped by type: Functions, Variables, Selections, Probes, Component Couplings,

Coordinate Systems, Pairs, and Domain Properties (this includes Perfectly Matched Layers and Infinite Elements).

* For any physics interface, nodes can be grouped by space dimension—that is, by geometric entity level: Domains,

Boundaries, Edges (3D only), or Points.

For physics interfaces, when either of these options is selected, the way the
nodes are organized changes in the Model Builder and when you

right-click to view the context menu.

GROUPING NODES BY SPACE DIMENSION
The default is Ungroup in the Model Builder for all new models. Right-click and select Group by Space Dimension (

In Figure 4-1 for the Pressure Acoustics, Frequency Domain physics and when Group by Space Dimension is sclected,
the default Pressure Acoustic Model and Initial Values subnodes are included under the Domains node, and four
boundary level nodes are included under Boundaries. However, there are no nodes under Edges or Points even

though these nodes display in the Model Builder.

;) is selected from the context menu (or the default is kept), the tree is flattened and all nodes

are ungrouped. Only default physics nodes and user-added nodes are included in the Model Builder sequence.
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Figure 4-1: The context menn and Model Builder sequence for physics nodes when Group by Space Dimension or
Ungroup is selected. For the Global Definitions and Definitions nodes, the same principles apply but the nodes ave
grouped by type instead.

GROUPING NODES BY TYPE

The same principles apply for the Global Definitions and Definitions nodes as for the physics nodes, except the nodes
are grouped by type, that is:

¢ Under Global Definitions the types are Variables, Functions, or Groups.

¢ Under Definitions the types are Functions, Variables, Selections, Probes, Component Couplings, Coordinate Systems,

Pairs, and Domain Properties.

The default is Ungroup in the Model Builder for all new models. Right-click and select Group by Type (=) from the

context menu to both group the nodes in the Model Builder and in the context menu.

When Ungroup (

N

is selected from the context menu (or the default is kept), the tree is flattened and all nodes

are ungrouped. Only default Definitions or Global Definitions nodes and user-added nodes are included in the Model
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Builder sequence as in Figure 4-2.

4 m Component 1 (compl) 4 m Component 1 (compl)
4 4 = Definitions
A= Boundary Systern 1 (sys1) a= Variables
[ view1 %) Functions
T_)‘— Probes

& Mass Properties
& Component Couplings

i Selections
[+ Pairs
E} Coordinate Systems

| Boundary System 1 (sysI)

o, Extra Dimensions

=) Domain Properties
4 =L~ Views

[ view1

h

Figure 4-2: When Ungroup (left) or Group by Type (right) is selected from the context menu for the Definitions node.
When grouped by type, all categories display underneath the node even if it does not contain a feature node.

* Opening Context Menus and Adding Nodes
* The Physics Nodes

El. * The Physics Interfaces
* Building a COMSOL Model

Setting the Unit System for Models

SETTING THE UNIT SYSTEM ON THE GLOBAL LEVEL
To set the unit system for the entire MPH-file on a global level:

I In the Model Builder, click the root node (the top node in the model tree). The root node’s name is the name of
the MPH-file or Untitled.mph before you have saved your work.

2 In the root node’s settings window, select the unit system from the list in the Unit System section or None to turn

off unit support.

SETTING THE UNIT SYSTEM FOR INDIVIDUAL MODELS

By default, all components in a model use the same global unit system, but it is possible to use different unit systems
in each component. To do so, follow these steps:

I In the Model Builder, click the top node for a Component branch (Component I, for example).

2 In the Component node’s settings window, locate the Component Settings section.

3 Select the Override global system check box, and then select the unit system from the list of unit systems that

becomes available.

To disable unit support in a model, choose None from the list in the Unit
System section in the root node’s settings window and make sure that the
corresponding setting for each component is Same as global system. If unit
EI support is turned off only for some components (or if the settings at
global and component level differ for a model with a single component)

unexpected side effects can occur.
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e Using Units
El. ¢ The Root Window

Checking and Controlling Products and Licenses Used

Open the Licensed and Used Products dialog box to view a list of licenses or to block the use of a product. Blocking
a license can be useful for consultants who want to duplicate a client’s environment while building a model or when
collaborating with other users who do not have access to the same set of COMSOL products. You can also use these

settings to prevent the use of a module when sharing a floating-network license, for example.

By default the use of all products is active and the check boxes for all products are selected. The licenses currently
in use are unavailable (you cannot block the use of products with functionality already in use without restarting
COMSOL).

To open the Licensed and Used Products dialog box:

¢ From the File menu, select Licensed and Used Products ( T ) (Windows users). You can also customize the Quick
Access Toolbar and then click the button. See Windows Toolbars and Menus.

¢ From the main menu select Options>Licensed and Used Products ( T ) (Mac and Linux users).

Click to clear the check box next to a product to hide or block it from use. Click Select All to activate all products.

Click Deselect All to block all products (except the ones that are already in use). Click OK to save the changes or

Cancel to discard any changes and close the window.

PRODUCT INFORMATION

Click the Product Information button to go to the product information pages on the COMSOL website, where you
find information about all COMSOL products.

_ You can also get information about the licensed products from The About
g COMSOL Multiphysics Box.

BORROW A LICENSE

If you have a floating network license (FNL) or a class kit license (CKL) and your license file has been enabled for
borrowing, click Borrow to open the Borrow Licenses dialog box and borrow licenses from the license server. Select
the licenses you want to borrow from the list and specify the number of days you want to keep them. Click OK to

save.

Remember that other users cannot use the licenses that you have checked
out. If you try to borrow a license that has already been borrowed, you
n receive an error message that shows for which products the license has

been borrowed.
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Preferences Settings

The Preferences Dialog Box

To make changes to how items are displayed throughout COMSOL edit the following settings in the Preferences
dialog box as required.

To open the Preferences dialog box:

¢ Windows users: From the File menu, select Preferences ( ) You can also customize the Quick Access Toolbar

and then click the button. See Windows Toolbars and Menus.

* Cross-platform (Mac and Linux) users: From the main menu select Options>Preferences ( ).

For some setting changes, a message window displays to tell you that
COMSOL needs to be restarted for the changes to take effect. For each

n preference settings window, you can click the Factory Settings button to
restore the factory default values, or click Factory Settings for All to reset
all the preferences to the factory default.

As shown in Figure 4-3, the following are available in the Preferences dialog box:

¢ General ¢ Graphics and Plot Windows

¢ Graphics Window Selections e Results

* Model Builder * Builder Tools

* Model Libraries e Temporary Files

e Multicore and Cluster Computing * Parametric Sweep

* Remote Computing e Updates

¢ Geometry * Quick Access Toolbar (Windows
only)

¢ LiveLink Products
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Builder Tools

Temporary Files

Parametric Sweep

Updates

Quick Access Toolbar
LiveLink Preducts

Factory Settings for All

Precision
Input display precision: 5

Output display precision: 5

Web browser

Program: [System default ~

Language
Language: [English -

Help

Help mode: [Integrated -
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History export
[[] Include author

Browse.

Factory Settings

Figure 4-3: The Prefevences dialog box.
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Advanced Physics Sections

To display the functionality described in this section, click the Show button (“& ) on the Model Builder and then
select the applicable option. To always display sections on a physics interface settings window, click the Expand
Sections button ( = ) and choose as many of these options as required—Equation, Override and Contribution,

Discretization, Stabilization, and Advanced Physics Options.

From either menu, select:

¢ Reset to Default to reset the sections to show only the Equation Sections and Override and Contribution. Or click
the Expand Sections button to reset it so all sections are collapsed (not expanded).

* Select Reset from Preferences to reset the sections to display the system preferences defined from The Preferences

Dialog Box.

* Set as Preferences to transfer the local settings made here to be used globally in all models. In other words, to

make these selections the default system preferences as defined in The Preferences Dialog Box.

- =-F-2tE
These options are also accessed (and activated) from The Preferences
]
I_E| Dialog Box in the Model Builder section.

SHOW MORE PHYSICS OPTIONS
There are several general options available for the physics interfaces and for individual nodes. This section is a short

overview of these options, and includes links to additional information.

To display additional options for the physics interfaces and other parts of the model tree, click the Show
button ("& ) on the Model Builder and then select the applicable option.

After clicking the Show button (& ), additional sections are displayed on the settings window when a node is

clicked and additional nodes are made available.

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac or Linux

users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
g operating system you are using.

The additional sections that can be displayed include Equation, Advanced Settings, Discretization, Consistent

Stabilization, and Inconsistent Stabilization.

You can also click the Expand Sections button ( = ) in the Model Builder to always show some sections or click the
Show button (“& ) and select Reset to Default to reset to display only the Equation and Override and Contribution

sections.

For most nodes, both the Equation and Override and Contribution sections are always available. Click the Show button
("= ) and then select Equation View to display the Equation View node under all nodes in the Model Builder.
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Availability of each node, and whether it is described for a particular node, is based on the individual selected. For
example, the Discretization, Advanced Settings, Consistent Stabilization, and Inconsistent Stabilization sections are

often described individually throughout the documentation as there are unique settings.

SECTION CROSS REFERENCE
Show More Options and Expand Advanced Physics Sections
Sections The Model Builder
Discretization Show Discretization

Discretization (Node)

Discretization—Splitting of complex Compile Equations
variables

Consistent and Inconsistent Stabilization ~ Stabilization

Numerical Stabilization

Constraint Settings Weak Constraints and Constraint Settings
Override and Contribution Physics Exclusive and Contributing Node
Types

OTHER COMMON SETTINGS
At the main level, some of the common settings found (in addition to the Show options) are the Interface Identifier,

Domain Selection, Boundary Selection, Edge Selection, Point Selection, and Dependent Variables.

At the node level, some of the common settings found (in addition to the Show options) are Domain Selection,
Boundary Selection, Edge Selection, Point Selection, Material Type, Coordinate System Selection, and Model Inputs.

Other sections are common based on application area and are not included here.

SECTION CROSS REFERENCE
Coordinate System Selection Coordinate Systems
Domain, Boundary, Edge, and About Geometric Entities

Point Selection (geometric

About Selecting Geometric Entities
entity selection)

The Geometry Entity Selection Sections
Equation Physics Nodes—Equation Section

Interface Identifier Predefined and Built-In Variables

Variable Naming Convention and Namespace

Viewing Node Names, Identifiers, Types, and

Tags
Material Type Materials
Model Inputs About Materials and Material Properties

Selecting Physics
Model Inputs and Multiphysics Couplings
Pair Selection Identity and Contact Pairs

Continuity on Interior Boundaries

Showing and Expanding the Equation Sections and Equation Node

To always display the Equations section in its expanded view on physics node settings windows, click the Expand

Sections button ( = ) and select Equations.

To display the Equation section on all physics nodes’ settings windows, click the Show button (& ) and select
Equation Sections.
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To display the Equation View node under all physics nodes in the Model Builder, click the Show button (& ) and
select Equation View.

These options are also accessed (and activated) from The Preferences
]
ri'| Dialog Box in the Model Builder section.

* Equation View

'El * Physics Nodes—Equation Section

Showing Advanced Physics Options

To enable this feature, click the Show button (& ) and select Advanced Physics Options. This displays the Advanced

section on physics settings windows. It also activates additional options on the context menus or toolbars.

ADVANCED SETTINGS

This section does not normally show unless the physics interface contains some advanced options.

CONSTRAINT SETTINGS

This section controls how constraints are enforced, usually in boundary conditions.

To Apply reaction terms on all dependent variables, select All physics (symmetric). Otherwise, select Current physics
(internally symmetric) or Individual dependent variables to restrict the reaction terms as required. Select the Use weak

constraints check box to replace the standard constraints with a weak form implementation.

ADDITIONAL ADVANCED PHYSICS OPTIONS

There are additional nodes that can be added to the model either from the context menu (from the More or Global
submenus) or from the Physics toolbar.

* Weak Contribution. Sce Weak Contribution (PDEs) and Weak Contribution (ODEs and DAEs).

e Weak Constraint

¢ DPointwise Constraint

e Weak Contribution on Mesh Boundaries. This feature is similar to Weak Contribution but is active on mesh
boundaries. See Weak Contribution (PDEs) and Weak Contribution (ODEs and DAEs).

* Global Equations. Also see Adding ODEs, DAEs, and Other Global Equations.
¢ Global Constraint. Also see Symmetric and Nonsymmetric Constraints and Constraint.
e Weak Contribution. See Weak Contribution (PDEs) and Weak Contribution (ODEs and DAEs).

¢ Discretization. See Discretization (Node) and Discretization Section Shape Function Types and Element Orders.

o) These settings can also be activated from The Preferences Dialog Box.
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Show Discretization

There are two categories of discretization—a section on the physics

interface node’s settings window (described here) and adding a

[

Discretization (Node) for global equation-based modeling.

To enable this setting, click the Show button (“& ) and select Discretization. The options available for each node are

described individually in the documentation.

DISCRETIZATION

Element Order and Shape Function Type

The Element order (or, more precisely, the order of the shape function) directly affects the number of degrees of
freedom in the solution and the accuracy of the solution. Increasing the order of the elements roughly corresponds
to a uniform mesh refinement. Most physics interfaces uses Lagrange elements, which can be of order 1 to 4 (in
3D) or 5 (in 1D and 2D), with 2 being the default order. You can change the order using the Element order list.
The software adapts the order of the numerical integration to the element orders for the physics in the model. Some

physics use special element types or a reduced element order for some of the field variables.

Some additional information is included in Discretization Section Shape
El. Function Types and Element Orders and Finite Elements (described in
the COMSOL API Reference Manual).

Discretization of Fluids
The following is an example of the choices of element order for the Laminar Flow interface:

¢ PI+PI means linear elements for both the velocity components and the pressure field. Linear elements are
computationally cheaper than higher-order elements and are also less prone to introducing spurious oscillations,

thereby improving the numerical robustness.

¢ P2+PIl means second-order elements for the velocity components and linear elements for the pressure field.

Second-order elements work well for low flow velocities.

e P3+P2 means third-order elements for the velocity components and second-order elements for the pressure field.

This can add additional accuracy but it also adds additional degrees of freedom compared to P2+P1 elements.

The abbreviation P,,P,, is often used to indicate the polynomial order of,
in this case, the shape functions (elements) for the velocity components
(m) and the pressure (n) when using tetrahedral or triangular elements.

Here a corresponding nomenclature is used for all element shapes.

2!

The theory about this is in P.M. Gresho and R.L. Sani, Incompressible
Flow and the Finite Element Method, Volume 2: Isothermal Laminar
Flow, John Wiley & Sons, 2000.

Accurate Boundary Fluxes

Some physics can create and compute variables that accurately represent the flux across all boundaries. To enable
these variables, select the Compute boundary fluxes check box. Optionally, a smoothing can be applied when
computing the boundary flux variables. You add smoothing by selecting the Apply smoothing to boundary fluxes
check box.
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Complex-Valued Variables

Under Value types when using splitting of complex variables, you can specify the Value type (Real or Complex) of
dependent variables when Split complex variables in real and imaginary parts sctting is activated in the Compile
Equations node of any solver sequence used. The default is the complex value type, but you can specify that the
value of a dependent variable is real to make sure that it does not get affected by small imaginary contributions,
which can occur, for example, when combining a Time Dependent or Stationary study with a frequency-domain

study. If the split complex variables setting is not active the value type is ignored.

For information about how to specify the splitting of complex variables,
'& see Compile Equations.

Selecting Other Options from the Show Menu

Click the Show button ("= ) and select one of the following options to enable nodes either in context menus or on
the toolbars.

ADVANCED STUDY OPTIONS

Select Advanced Study Options to ecnable these options from the context menu, which can then be added to the Model
Builder—]Job Configurations and Solver Configurations. These nodes also display if they contain content.

¢ Right-click the Study node to enable Cluster Computing, Cluster Sweep, and Batch Sweep and Batch.

* Right-click the Solver Configurations node to be able to select the option Create a Custom Solver and add a Solver

node without any added solver settings or other nodes.

* Right-click any of the Study Step nodes to enable the Multigrid Level option from the context menu.

ADVANCED RESULTS OPTIONS

To display the Views node under Results, sclect Advanced Results Options.

e User-Defined Views
El. * Results Analysis and Plots

STABILIZATION
Select Stabilization to display the Consistent Stabilization and Inconsistent Stabilization sections on the settings

windows. If you have access to the Level Set and Mixture Model interfaces, it displays a Stabilization section instead.

For detailed information about this feature, see Numerical Stabilization
El. and Consistent Stabilization and Inconsistent Stabilization Sections on

Settings Windows.

OVERRIDE AND CONTRIBUTION
Select Override and Contribution to include the section in all physics nodes (for material models, sources, boundary

conditions, and so on). For a specific node, the Override and Contribution section in its settings window contains
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lists of other nodes that the node is overridden by, other nodes that the node overrides, and other nodes that
contributes with the node (to the total load or flux, for example).

* Physics Exclusive and Contributing Node Types
'El * Listing Overrides and Contributions

¢ Overridden Selections
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Definitions

This chapter describes the available functionality in the Global Definitions and
Definitions branches such as parameters, variables, functions, and coordinate

systems.
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About Global and Local Definitions

Depending on the geometric scope, there are two types of definitions nodes that can be defined in the Model

Builder—Global Definitions and local Definitions.

Global Definitions

The Global Definitions main branch has features that apply to the entire model. Add the following features either
using the toolbars (the Home toolbar for Windows users and the Main toolbar for Mac and Linux users) or right-click

Global Definitions ([é_}) and choose an option from the context menu:

e Variables (a= ): user-defined variables that can be used anywhere to simplify the specifications of some
properties.

e Parameters (Pj ): user-defined global, scalar values that are used to parameterize any part of the model. See
Parameters.

¢ Functions (fix)): function templates for creating user-defined functions based on analytic expressions or
imported data, or specifying parameters for common function types such as step functions, ramps, and random
functions.

* Geometry Subsequence (%4 ): 3D, 2D and 1D parametrized geometry subsequences which can be called as a

subroutine from a geometry sequences in a Component. These features are only available from the context

menu.

Definitions

Just as the Global Definitions branch collects user-defined parameters, variables, and functions accessible at all levels
in the Model Builder, the Definitions branch (one per Component) collects the definitions of variables, functions,
and other objects where the geometric scope is restricted to a single component.

Definitions are under the Component branch because several models can separately be defined in one multiphysics
file, for example, when treating certain parts of the whole model in 2D and other parts in 3D. Definitions which
in some way refer to domains in a geometry, the geometry’s dimension or its coordinate names must therefore be
held apart in different Component branches.

An example of the type of objects you can add under the Definitions branch is a Selectzon node ("5 ), which saves
selections of geometric entities (boundaries, for example) that relate to a region or part of the overall geometry for

reuse in operations later in the modeling process.

Add a Component node to the Model Builder, then add definitions with a local scope that apply to that specific
model Component. Click or select features either using the Definitions toolbar or right-click Definitions ( = ) and

choose an option from the context menu:
Select among the following definition types:

¢ Variables (a= ): add user-defined variables to simplify the expressions of other variables and properties. See
Variables.
* View (-

Selection Tools chapter.

_a): create a user-defined view to visualize the model. See User-Defined Views in the Visualization and
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* Mass Properties ( gl ): set up nodes which compute quantities such as volume, mass, center of mass, and moment

of inertia. See Mass Properties.

* Functions (f{x}): add user-defined functions based on analytic expressions or imported data, or specifying

parameters for common function types such as step functions, ramps, and random functions. See Functions.

* Probes ( ﬁ) add a probe to monitor the development of a scalar-valued quantity (real or complex-valued

number) during a dynamic simulation. See Probes.

* Component Couplings ( .+ ): add nonlocal couplings inside or between Components, in the form of integration,

mapping, projection and similar user-defined operators. See Component Couplings.

¢ Selections ( iz ): create a user-defined set of geometric entities for reuse throughout the model. See Named

Selections in the Visualization and Selection Tools chapter.
e Pairs: There are two types of pairs:

- Contact Pair ([#] ), which specifies two boundary selections that cannot penetrate cach other under
deformation. The contact pairs are only available if your license includes the Structural Mechanics Module or
the MEMS Module.

- Identity Pair ([#] ), which specifies two boundary selections (also available for edges and points) that coincide
while belonging to different parts of an assembly. Special boundary conditions connect the physics in the two
parts.

Pairs are only available and necessary when the model geometry is an assembly. See Identity and Contact Pairs.
* Coordinate Systems (E.:r ): create coordinate systems for use in the physics interfaces. See Coordinate Systems.

* Perfectly Matched Layer (PML) (E-,t-_.-:) and Infinite Elements (E ): surround your model by a perfectly matched layer
or infinite elements, behaving as an unbounded extension of the modeling domain. See Infinite Element

Domains and Perfectly Matched Layers.

¢ Extra Dimensions: attach extra dimensions to a selection in the base geometry of a model. This is a technology

preview feature enabled from The Preferences Dialog Box. See Using Extra Dimensions for more information.

About Parameters, Variables, and Expressions

PARAMETERS AND VARIABLES
Parameters and variables are used to parameterize and organize your model. They are different in their definition

and use.

Parameters
Parameters are user-defined constant scalars with a global scope that are available for use throughout the Model
Builder tree. In particular, they can be used for parameterization in the Geometry, Mesh, and Study branches.

Important uses include:

¢ Parameterizing geometric dimensions

* Parameterizing mesh element sizes

* Defining parametric sweeps

A parameter expression can contain: numbers, other parameters, mathematical constants, physical constants,
functions of parameter expressions, unary operators, and binary operators. Parameters can have units. For example,

a parameter can be defined as (exp (-pi*i)+a)*c_const, where a is another parameter, but it is often a scalar

numerical value for use in a parametric sweep, where that value is updated during the sweep.

Variables
A variable’s expression can contain numbers, parameters, mathematical constants, physical constants, other

variables, functions of variable expressions, unary operators, and binary operators. Variables can also depend on
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dependent variables (the solution) and their derivatives, and they can have units. For example, a variable can be
defined as pi* (R_tube~2-r_tube~2), where R_tube and r_tube are two other variables or parameters, for
example defined as 10[mm] and 25[mm], respectively.

Variables cannot be used in the Geometry and Mesh branches, and only
]
E to a limited amount in the Study branch.

Variables can have global or local scope depending on where they are defined. A variable with local scope is limited
to a geometric entity level within a model component: the entire component’s geometry or selected domains,
boundaries, edges (3D only), or points.

Variables can make a model easier to understand by introducing short and descriptive names for complicated
expressions. Most variables for material properties, coordinates, and other quantities defined on the computational
domain are “field variables”—that is, they are defined so that they can vary in space and time. For example, a
built-in variable for the density in a Solid Mechanics interface, solid. rho, represents a density p as p(x, ¥, 2, ¢) in
3D. You can visualize it in a surface or volume plot, for example, but you cannot use it in an ODE or a global
evaluation, even if it should happen to be defined as a constant value. In such a situation, use a component coupling

that computes an average quantity or a point probe to obtain a quantity with a global evaluation scope.

NAMING CONVENTIONS, RESERVED NAMES, AND ERRORS

Parameter names and variable names are case sensitive and must begin with a lowercase or uppercase letter (a—z or
A-Z). All other characters in the name must be a lowercase or uppercase letter, a number 0-9, or an underscore
(_). Dots (.) are also allowed in names but are best avoided because they have a special meaning as delimiters in the
namespace. It is possible that the first part of a variable name containing a dot is misinterpreted as a dot symbol for

accessing a variable in the namespace.

It is good practice to use descriptive names that are different from the names of built-in functions and constants.
Some fundamental built-in mathematical and numerical constants and built-in variables have reserved names;
defining a variable using a reserved name is not recommended because it can cause unexpected results. If you use
a variable name that is a reserved name (see Summary of Built-In Variables With Reserved Names), the name
appears in orange and if you move the cursor to the name, a tooltip such as j is a reserved name appears. The
following names are reserved: eps, nan, NaN, inf, Inf, i, j, and pi. Also, when used in a model, errors about
duplicate variable names occur if you defined parameter names using names of built-in variables for the geometry,
mesh, and physics (h, dom, and similar names of built-in variables as well as the names of dependent variables and

spatial coordinates in the model).

If the expression contains a syntax error, it appears in red. Syntax errors can be due to illegal characters, mismatched
parentheses, and other syntactic errors. The Error node ( {3 ), which occurs when trying to solve a model with a

syntax error, typically contains information about the position and expression where the syntax error is located.

Parameters

To create a Parameters node (P; ):

e From the Home (Windows users) or Main (Mac and Linux users) toolbar click Parameters, or

¢ Right-click Global Definitions ( and select Parameters.

If the node has been created previously—there can only be one—you will find the Parameters node under the Global

Definitions node. Parameters are useful in the following context:

* As parameters in dimensions for geometric primitives or other geometry operations
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e As parameters for the mesh generators, for example specifying mesh size
* As parameters to control some aspects of the solution process

¢ To quickly evaluate a mathematical expression, including unit conversion
* In physics settings, expressions, and coupling operators

e In expressions when evaluating results

PARAMETERS
Enter values in the Parameters table to define parameters used throughout the whole model. In the Parameters

section you can enter parameters manually or import them from a text file.

* In the Parameters table or the field under the table, enter a parameter Name.

* In the Expression column or field, enter a parameter expression that defines the parameter value—including a unit
if desired.

¢ The Value column displays the value of the parameter in the base unit system.

 In the Description column or field, enter an optional description.

You can save the parameters to a text file to reuse in other models. Click the Save to File button ([] ) and enter a
File name in the Save to File dialog box, including the extension .txt. Click Save to store the parameters in a text file
or in a Microsoft Excel Workbook spreadsheet if the license includes LiveLink™ for Excel®. The information is saved
in space-separated columns in the same order as displayed on screen. When saving to Excel, an Excel Save dialog

box appears where you can specify the sheet and range and whether to overwrite existing data, include a header, or

use a separate column for units.

You can import or load data in files from a spreadsheet program, for example, with the Load from File button (=)
and the Load from File dialog box that appears. Data must be separated by spaces or tabs. If there is already data in
the table, imported parameters are added after the last row. Move or edit rows as required. If the license includes
LiveLink™ for Excel® you can also load parameters from a Microsoft Excel Workbook spreadsheet. Then an Excel
Load dialog box appears where you can specify the sheet and range and whether to overwrite existing data. It is also

possible to import from a spreadsheet containing a separate column for units.

Variables

Choose to add Global Variables or Local Variables from the Home (Windows users) or Main (Mac and Linux users)

toolbar or right-click the Global Definitions or Definitions nodes to add a Variables ( a= ) node to the Model Builder.

Use this node to define expressions as user-defined variables. Global variables can be used in any context which
accepts variable expressions, in all Components and on all geometric entities—provided that their expressions are
also global expressions. In contrast, local variables have a specific geometric domain of definition. Such variables
can only be used and evaluated in a specific Component, or on selected domains, boundaries, edges, or points.

Global variables are primarily useful for expressions involving parameters that do not depend on the geometry, such
as time, or dependent variables in an ODE or algebraic equation. Whenever possible, define variables under

Definitions in a Component to minimize the risk of variable name conflicts in the global namespace.

Which variables are available for evaluation in postprocessing is decided at the time a solution is created. This means
that variables you define do not immediately show up as predefined quantities in results nodes or become available
for use in expressions when postprocessing an existing solution. To access the new variables, you must solve the

model or update an existing solution by right-clicking a Study node (~da) and selecting Update Solution ( (™).
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GEOMETRIC ENTITY SELECTION (LOCAL DEFINITIONS ONLY)
Select the geometric scope from the Geometric entity level list—Entire component, Domain, Boundary, Edge (3D
only), or Point. For all levels except Entire component, you must also specify the variables domain of definition either

by adding entities to a Manual selection or choosing All boundaries, for example, from the Selection list.

Variables defined in a Component but with Geometric entity level set to

Entire component are in fact global; they can be used anywhere using their

[

full name. For example, if you define variable a in Component 1 in this

way, you can refer to it in another Component as comp1. a.

VARIABLES

In the Variables table or the fields under the table, enter variables by defining a variable name under Name, an
expression that defined the variable under Expression (see About Parameters, Variables, and Expressions), and
(optionally) a description that explains the variable under Descriptions. Alternately, you can import variable
definitions from a text file.

The Save to File button ( Q ) saves variables to a text file (or to a Microsoft Excel Workbook spreadsheet if the
license includes LiveLink™ for Excel®) for reuse in other models. The information is saved in space-separated
columns in the same order as displayed on screen. When saving to Excel, an Excel Save dialog box appears where
you can specify the sheet and range and whether to overwrite existing data, include a header, or use a separate
column for units.

Using the Load from File button ([, ), you can import or load data in text files created, for example, by a
spreadsheet program. Data must be separated by spaces or tabs. If the license includes LiveLink™ for Excel® you
can also load variables from a Microsoft Excel Workbook spreadsheet. Then an Excel Load dialog box appears where
you can specify the sheet and range, whether to overwrite existing data, and declare if the data is stored using a
separate column for units.

For an example of global variables, see Effective Diftusivity in Porous
il Materials: model library path
COMSOL_Multiphysics/Diffusion/effective_diffusivity

For examples of local variables see:
* Acoustics of a Muftler: model library path
COMSOL_Multiphysics/Acoustics/automotive_muffler

Tl * Tubular Reactor: model library path
COMSOL_Multiphysics/Chemical_Engineering/tubular_reactor

* Fluid Valve: model library path
COMSOL_Multiphysics/Fluid_Dynamics/fluid_valve

Commeon Settings for the Definitions Nodes

Many nodes which can be added under Global Definitions or under Definitions in a Component share the same
settings, or use settings generally found throughout COMSOL. Links to Common Settings Window Descriptions
provides cross references to information relevant to some of these settings.
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COMMON BUTTONS ON THE SETTINGS WINDOWS
The following buttons are available on many of the settings windows and are mostly self explanatory. These are not

explicitly described or explained for every node.

* In general, use the Move Up ( ), Move Down ( | ), and Delete (:= ) buttons and the ficlds under tables to edit
the table contents. Or right-click a table cell and select Move Up, Move Down, or Delete.

e The Add button ( == ) under a list of named selections opens an Add dialog box that contains all existing selections

for the same geometric entity level.

* To save the contents of a table, click the Save to File button ( Q ) and enter a File name in the Save to File dialog
box, including the extension . txt. Click to Save the text file. The information is saved in space-separated

columns in the same order as displayed on screen.

e Use the Load from File button (=) and Lead from File dialog box to import data in text files, generated by, for
example, a spreadsheet program. Data must be separated by spaces or tabs (or be in a Microsoft Excel Workbook

spreadsheet if the license includes LiveLink™ for Excel®).

* About Selecting Geometric Entities
Q * The Model Builder

¢ Named Selections

IDENTIFIER AND NAME SETTINGS
Many nodes under Global Definitions or under Definitions in a Component contain a setting which requires a unique

identifier or name.

Name

For Functions and component couplings you must specify a function name or operator name that is unique on the
global level or within the model component where the feature is added. You can use this function name or operator
name in expressions, and it is also the node’s identifier. A unique default function name or operator name is always

generated when the node is created.

Note that if you right-click the node in the Model Builder and select Properties, the name you entered appears in

the Identifier field, while the Name field contains the descriptive name shown on the node in the Model Builder.

Identifier
Nodes that automatically generate variables generally have an identifier setting. The identifier must be unique on
the global level or within the model component where the feature is added. It provides a namespace for variables

created by the node. A unique default identifier is always generated when the node is created.

For example, coordinate system nodes define a variable that evaluates the determinant of the system’s coordinate
transformation matrix. Internally in the coordinate system, this variable’s name is detT. If a coordinate system has
the identifier sys1, the determinant variable can be accessed in equations and postprocessing as sys1.detT. A

complete list of variables defined by a node is usually available in its Equation View subnode.

To display the Equation View node under all nodes creating variables, click

(]
E the Show button and select Equation View. See also Equation View.

* The Node Settings Windows
'El » Editing Node Properties, Names, and Identifiers
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LINKS TO COMMON SETTINGS WINDOW DESCRIPTIONS
e Name

* Plotting Functions

¢ Smoothing

* Geometry Subsequence

Geometry Subsequence

You can add a Geometry Subsequence node ( '/, ) to the Global Definitions branch. It is a geometry sequence that can
be called (several times) from other geometry chucnccs. You can use geometry subsequences to make your own
parametrized geometric primitives. When calling a subsequence, the input to the subsequence is numerical values
of'its arguments. The output from the subsequence is a number of geometry objects and a number of selections on
these objects. The geometry subsequence node behaves like an ordinary geometry sequence with a few minor

differences as described in the Using Geometry Subsequences section.

See Creating a Geometry Sequence in the Geometry Modeling and CAD
'El Tools chapter, which also explains The Geometry Node and the geometry

features.
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Operators, Functions, and Constants

Many built-in mathematical and logical operators, functions, and constants can be used to specify parameters,
variables, equation coefficients, and material properties. These tables list the unary and binary operators (Table 5-1
and Table 5-2), special operators (Table 5-8), mathematical functions and constants (Table 5-6), and physical
constants predefined as variables (Table 5-7) that are available in COMSOL Multiphysics. See also Component
Couplings for information about coupling operators.

Unary, Binary, and List Operators and Theiv Precedence Rules

TABLE 5-1: UNARY OPERATORS

OPERATOR DESCRIPTION

+ Unary plus
- Unary minus

! Logical not

The binary operators include arithmetic and logical operations.

TABLE 5-2: BINARY OPERATORS

OPERATOR DESCRIPTION

+ Plus

- Minus

* Multiply

/ Divide

A Power

== Equal

1= Not equal

> Greater than

>= Greater than or equal to
< Less than

<= Less than or equal to
&& Logical and

I Logical or

The following operators are used for precedence, grouping, lists, and unit definitions:

TABLE 5-3: GROUPING, LIST, AND UNIT OPERATORS

OPERATOR DESCRIPTION
0 Parentheses for controlling precedence in expressions
{ Vector and tensor expressions

, Element separator in lists
Scoping operator
M Unit
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The following list shows the precedence order for the operators above:

TABLE 5-4: PRECEDENCE LEVELS

PRECEDENCE LEVEL SYMBOL DESCRIPTION

I 0 {r . Grouping, lists, namespace

2 " Power

3 Po- o+ Unary: logical not, minus, plus

4 [1 Unit

5 * Multiplication, division

6 + - Addition, subtraction

7 < <= > >= Comparisons: less than, less than or equal,
more than, more than or equal

8 == |= Comparisons: equal, not equal

9 && Logical and

10 | Logical or

I ) Element separator in lists

Mathematical and Numerical Constants

The following table includes the built-in mathematical and numerical constants. The names of these constants are

reserved names that you cannot use when creating user-defined variables and parameters.

TABLE 5-5: MATHEMATICAL AND NUMERICAL CONSTANTS

NAME DESCRIPTION

eps Floating point relative accuracy (machine epsilon, 272 or about
222041076, for double floating point numbers).

i, ] Imaginary unit, J——l

inf, Inf Infinity, co. A value larger than what can be handled with

floating-point representation.

NaN, nan Not-a-number. An undefined or unrepresentable value such as
the result of 0/0 or inf/inf.
pi Pi (about 3.141592653589793).

Mathematical Functions

The following list includes the built-in mathematical functions that you can use when defining variables or directly
in expressions in the physics settings, for example. The function names are reserved names that cannot be used for

user-defined functions, but they can be used for variable and parameter names.

TABLE 5-6: MATHEMATICAL FUNCTIONS

NAME DESCRIPTION SYNTAX EXAMPLE
abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)
acosh Inverse hyperbolic cosine acosh(x)

acot Inverse cotangent (in radians) acot(x)
acoth Inverse hyperbolic cotangent acoth(x)
acsc Inverse cosecant (in radians) acsc(x)
acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)
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TABLE 5-6: MATHEMATICAL FUNCTIONS

NAME DESCRIPTION SYNTAX EXAMPLE

asec Inverse secant (in radians) asec(x)

asech Inverse hyperbolic secant asech(x)

asin Inverse sine (in radians) asin(x)

asinh Inverse hyperbolic sine asinh(x)

atan Inverse tangent (in radians) atan(x)

atan2 Four-quadrant inverse tangent (in radians) atan2(y,x)

atanh Inverse hyperbolic tangent atanh(x)

besselj Bessel function of the first kind besselj(a,x)

bessely Bessel function of the second kind bessely(a,x)

besseli Modified Bessel function of the first kind besseli(a,x)

besselk Modified Bessel function of the second kind besselk(a,x)

ceil Nearest following integer ceil(x)

conj Complex conjugate conj (x)

cos Cosine cos(x)

cosh Hyperbolic cosine cosh(x)

cot Cotangent cot(x)

coth Hyperbolic cotangent coth(x)

csc Cosecant csc(x)

csch Hyperbolic cosecant csch(x)

erf Error function erf(x)

erfinv Inverse error function erfinv(x)

exp Exponential function €. Thatis, exp (1) isthe  exp(x)
mathematical constant e (Euler’s number).

floor Nearest previous integer floor(x)

gamma Gamma function gamma (X)

imag Imaginary part imag(u)

log Natural logarithm log(x)

log10 Common logarithm (base 10) log10(x)

log2 Base-2 logarithm log2(x)

max Maximum of two arguments max(a,b)

min Minimum of two arguments min(a,b)

mod Modulo operator mod(a,b)

psi Psi function and its derivatives psi(x,k)

range Create a range of numbers range(a,step,b)

real Real part real(u)

round Round to closest integer round (x)

sec Secant sec(x)

sech Hyperbolic secant sech(x)

sign Signum function sign(u)

sin Sine sin(x)

sinh Hyperbolic sine sinh(x)

OPERATORS, FUNCTIONS, AND CONSTANTS
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TABLE 5-6: MATHEMATICAL FUNCTIONS

NAME DESCRIPTION SYNTAX EXAMPLE
sqrt Square root sqrt(x)

tan Tangent tan(x)

tanh Hyperbolic tangent tanh (x)

Physical Constants

Physical constants are fundamental, universal constants that represent physical quantities. COMSOL Multiphysics
includes the most widely used physical constants as built-in constants. Table 5-7 lists all supported physical

constants with their names, symbol (variable name), value, and SI unit. The values are taken from Ref. 1 and include

the SI unit.

TABLE 5-7: PHYSICAL CONSTANTS

NAME SYMBOL VALUE
Acceleration of gravity g_const 9.80665[m/s"2]
Avogadro constant N_A const 6.02214129e23[1/mol]
Boltzmann constant k_B_const 1.3806488e-23[J /K]
Characteristic impedance of Z0_const 376.730313461...[ohm]
vacuum (impedance of free (mud*c)

space)

Electron mass me_const 9.10938291e-31[kg]
Elementary charge e_const 1.602176565e-19[C]
Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant
Gravitational constant

Molar volume of ideal gas (at
273.15 K and | atm)

Neutron mass

Permeability of vacuum
(magnetic constant)

Permittivity of vacuum (electric

constant)

Planck’s constant

Planck’s constant over 2 pi
Proton mass

Speed of light in vacuum
Stefan-Boltzmann constant

Universal gas constant

Wien displacement law constant

alpha_const
G_const

V_m_const

mn_const

muO_const

epsilon0_const

h_const
hbar_const
mp_const
c_const
sigma_const
R_const

b_const

7.2973525698e-3

6.67384e-11[m"3/ (kg*s*2) ]

22.413968e-3[m"3/mol]

1.674927351e-27[kg]
4*pi*1e-7[H/m]

8.854187817e-12[F/m]

6.62606957e-34[J*s]
1.054571726e-34[J*s]
1.672621777e-27[kg]
299792458[m/s]

5.670373e-8[W/(m"2*K"4) ]

8.3144621[J/ (m01*K) ]
2.8977721e-3[m*K]

REFERENCE

1. The NIST Reference on Constants, Units, and Uncertainty,

http://physics.nist.gov,/cuu,/Constants /index.html
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Built-In Operators

There are special built-in operators available for modeling and for evaluating results; these operators are similar to

functions but behave differently. Many physics interfaces use these operators to implement equations and special
functionality. See Table 5-8 and the detailed descriptions that follow.

TABLE 5-8: BUILT-IN OPERATORS

OPERATOR DESCRIPTION CROSS REFERENCE
adj (expr) Evaluate expression using the adjoint adj

sensitivity.
at Access the solution at any time. at

ballint(r,expr),
ballavg(r,expr),

(

(

circint(r,expr),

circavg(r,expr),
(

diskint(r,expr),
diskavg(r,expr),
sphint(r,expr),
sphavg(r,expr)
bdf (expr,i)

bndenv (expr)

centroid(expr)
circumcenter (expr)
d(f,x)

depends (expr)
depends (expr,var)
dest (expr)

down (expr)

dtang(f,x)

emetric(exprx,expry)
emetric(exprx,expry,
exprz)

env (expr)

error(“string’)

fsens (expr)

Evaluates the integral or average of the
expression on the specified shape with
radius r.

Apply backward differentiation formula of
order i on expression.

Evaluates the expression expr at the
coordinates of a particle at a boundary.

For simplex meshes it evaluates the
expression expr in the centroid of the
mesh element to which the point belongs.

Evaluates the expression expr in the
circumcenter of the mesh element to
which the point belongs.

Differentiation operator. Differentiation
of f with respect to x.

True if expression expr depends on the
solution or var, respectively.

Evaluate parts of an integration coupling
expression on destination side.

Evaluate expression as defined in adjacent
downside.

Tangential differentiation of an expression
T defined on a boundary with respect to a
spatial dimension x.

The square of the length of the global
vector (exprx, expry, exprz) computed in
the mesh element’s own metric.

Evaluates the expression expr at the
coordinates of a particle in a domain.

Generates an error with error message
string.

Evaluate expression using the functional
sensitivity.

ball, circle, disk,
and sphere

bdf

env and bndenv

centroid

circumcenter

Differentiation
Operators: d,
pd, and dtang
depends

dest

up and down

Ditfferentiation
Operators: d,
pd, and dtang

emetric
env and bndenv
error

fsens
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TABLE 5-8: BUILT-IN OPERATORS

OPERATOR

DESCRIPTION

CROSS REFERENCE

if(cond,exprl,expr2)

integrate(expr,var,

lower,upper)

isdefined(variable)

isinf (expr)

islinear(expr)

isnan(expr)

jacdepends (expr)
jacdepends (expr,var)

lindev

linper

linpoint

linsol

lintotal

lintotalavg

lintotalpeak

lintotalrms

linzero

mean (expr)

nojac (expr)

pd(f,x)

ppr

pprint

prev(expr,i)

Conditional expression evaluating the
second or third argument depending on
the value of the condition.

Evaluate integral of general expression
with respect to an integration variable
over a real interval specified by lower and
upper limits.

Returns one where the variable is defined
and zero where it is not defined.

True if expression evaluates to infinity.

True if expression is a linear function of
the solution.

True if expression evaluates to NaN
(not-a-number).

True if the derivative of the expression
expr with respect to the solution
depends on the solution or var,
respectively.

Evaluate an expression linearized at the
linearization point (when a linearization
point is stored in the solution).

Marks a load term to be used in a Linear
perturbation solver.

Access the linearization point (when a
linearization point is stored in the
solution).

Access the standard solution (for

example inside 1inpoint or lintotal).

Access the sum of the linearization point
and linear perturbation.

Evaluate average of lintotal (expr)
over all phases.

Evaluate maximum of lintotal (expr)
over all phases.

Evaluate RMS of 1intotal (expr) over
all phases.

Evaluate expression with zero solution.

Mean value of expression as evaluated on
adjacent boundaries.

No contribution to the Jacobian.

Differentiation operator. Differentiation
of f with respect to x. No chain rule for
dependent variables.

Accurate derivative recovery.

Accurate derivative recovery within each
domain group.

Evaluate expression at the ith previous
time step.

if

integrate

isinf and isnan

islinear
isinf and isnan

jacdepends

lindev

linper

linpoint

linsol
lintotal
lintotalavg
lintotalpeak
lintotalrms

linzero

mean

nojac
Differentiation
Operators: d,
pd, and dtang

ppr and pprint

ppr and pprint

prev
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TABLE 5-8: BUILT-IN OPERATORS

OPERATOR DESCRIPTION CROSS REFERENCE

reacf Accurate evaluation of reaction forces reacft
and fluxes.

realdot(a,b) Treat complex numbers a and b as real realdot
2-vectors and return their dot product.

scope.ati (coordinate  Evaluates the expression expr at an spatial at

exprs,expr) i-dimensional entity in the point with
coordinates given by the coordinate
expressions coordinate exprs.

sens(expr,i) Evaluate expression using the forward sens
sensitivity for the parameter given by the
second argument.

shapeorder(variable) The element order used for discretization  shapeorder
of a variable.

side(entity,expr) Evaluate expression as defined in the side
adjacent entity.

subst (expr, Substitute variables in an expression with  subst

exprl_orig, , other variables or expressions.

exprl_subst,...)

sum(expr, index, Evaluate sum of general expression for all sum

lower,upper) indices from lower to upper.

test (expr) Test function operator. test

timeint, timeavg

try_catch(tryExpr,

Integrate or compute the average of a
time-dependent expression over a time
interval.

Attempts to evaluate tryExpr, but if

timeint and
timeavg

try_catch

catchExpr) this fails for any point, catchExpr is
evaluated instead.

up (expr) Evaluate expression as defined in adjacent  up and down
upside.

var (expr,fieldnamel,  Variation operator. var

fieldname2, ...)

with Access any solution. with

AD]

* When you apply the adjoint sensitivity operator adj to an expression, COMSOL uses the adjoint sensitivity

solution instead of the primal solution for the evaluation.

* The adjoint sensitivity solution is available for results when the sensitivity solver has been used with the adjoint

sensitivity method, and for the dependent variables that have been solved for.

AT

* The at operator can access a solution to a time-dependent problem at any time. COMSOL provides the solution

at that time using interpolation.

¢ The first input argument is the time. The second input argument is the expression that you want to evaluate using

this solution. For example, at(12.5,u) is the solution at 12.5s.

¢ The at operator can only be used during results evaluation, so it should not be used when setting up the model.

BALL, CIRCLE, DISK, AND SPHERE

e The ballint(r, expr) operator computes the volume integral of the expression expr in a ball with radius r

around the point in which it is evaluated. The ballint operator can be evaluated on all entities in 3D.

OPERATORS,

FUNCTIONS, AND CONSTANTS
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The ballavg(r, expr) operator is defined as ballint(r, expr)/ballint(r, 1).

The circint(r, expr) operator computes the curve integral of the expression expr on a circle with radius r
around the point in which it is evaluated. The circint operator can be evaluated on all entities in 2D and on

edges in 3D, when used in 3D the integration is done on the circle in the normal plane to the edge.

The circavg(r, expr) operator is defined as circint(r, expr)/circint(r, 1).

The diskint(r, expr) is similar to the circint operator but calculates the surface integral on a disk instead.
The diskavg(r, expr) operator is defined as diskint(r, expr)/diskint(r, 1).

The sphint(r, expr) is similar to the ballint operator but computes the surface integral on a sphere instead.
The sphavg(r, expr) operator is defined as sphint(r, expr)/sphint(r, 1).

All of operators can be used with a third argument N that approximately specifies the number of integration
points used—for example, circint(r, expr,100).

To all operators you can add a suffix (“_frameld”) that specifies the frame in which the integration is done—

for example, circint_spatial(r, expr).

BDF

Use the bdf operator to approximate time derivatives when the time discrete solver is used.

The expression bdf (expr, ) results in a discretization of the time derivative of expr using a backward

differentiation formula.

The second argument, ¢, determines the order of accuracy of the discretization. Currently, first order and second
order is available, so allowed values are i = 1 and i = 2. A second-order formula requires access to two previous
time steps. Because this is not possible at the initial step, the evaluation at the initial step always uses the

first-order formula.

The bdf operator can be implemented using the prev operator. For example, obtain the first-order backward
differentiation formula, also known as the backward Euler method, through bdf (u,1) =
(u-prev(u,1))/timestep.

CENTROID

The centroid(expr) operator evaluates the expression expr in the centroid of the mesh element to which the

point belongs for simplex meshes.

Note that the operator is context sensitive in the sense that it chooses the mesh element of the same dimension

(a point often belongs to several different mesh elements) as the context in which the evaluation is performed.

CIRCUMCENTER

The circumcenter(expr) operator evaluates the expression expr in the circumcenter of the mesh element to
which the point belongs. This point is in general only well defined for simplices, but for other mesh elements a

natural generalization is available.

Note that the operator is context sensitive in the sense that it chooses the mesh element of the same dimension

(a point often belongs to several different mesh elements) as the context in which the evaluation is performed.

You can add a suffix (“_frameld”) that specifies the frame in which the evaluation is done—for example,
circumcenter_spatial(expr).

DIFFERENTIATION OPERATORS: D, PD, AND DTANG
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All differentiation operators (d, pd, and dtang) can be used both in model settings and in results evaluation.

Use the d operator to differentiate a variable with respect to another variable. For example, d (T,x) means
differentiation of T with respect to x. Some space derivatives are also available using predefined variables. For
example, uxx, d(ux,x),and d(d(u,x),x) are equivalent for a dependent variable u when evaluated in a domain.

On a boundary, however, d (u,x) is 0, while ux is the average of the values from the adjacent domains. The
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expression d(E, TIME) computes the reference time derivative of the expression E.

e The pd operator works in a similar way to the d operator. The main difference is that pd(u,x) is O rather than

ux (no chain rule is applied for dependent variables).

* Use the dtang operator to compute derivatives in the tangential direction along a boundary. The dtang
operator can be applied to expressions that are only defined on the boundary and therefore cannot be
differentiated by the d operator. In a 3D model, (dtang(f,x), dtang(f,y), dtang(f,z)) is a vector in the
tangent plane of a boundary at the point where it is evaluated, and similarly in a 2D model, (dtang(f,x),
dtang(f,y)) is a vector in the tangent line of a boundary point. When evaluated in a domain, dtang (f,x) is
the same as d (f, x). The second argument of dtang (f,x) must be one of the spatial coordinates. Not all
quantities have rules for evaluating tangential derivatives. Applying dtang(f,x) to an expression with no

tangential derivative rule results in an error message.

Examples of Using the Differentiation Operators

The expressions d (u~2,u) and pd(u~2,u) both equal 2*u—d also takes the spatial and time variables into account
and treats their derivatives accordingly. In other words, if u is the dependent variable and x and ¢ are the spatial
coordinate and time, respectively, then d (u+x,x) equals ux+1 (ux is the spatial derivative of u with respect to x),
while pd (u+x,x) equals 1 because u is considered to be independent of anything but itself in the case of pd.

Equivalently, d(u,t) equals ut, while pd(u,t) is zero.

If u is a dependent variable defined only on a boundary, d (u,x) is not defined, but the tangential derivative
dtang(u,x) can be evaluated on the boundary. The tangential derivative obeys most of the common differentiation
rules, such as the product rule and the chain rule. It is worth pointing out, however, that dtang(x, x) is not always

equal to 1.

DEPENDS

¢ The depends(expr) operator returns 1 if the expression expr that it operates on depends on the solution;
otherwise it returns 0.

¢ depends(expr, var) returns 1 if expr depends on var; otherwise it returns 0.

Use this operator to check user-defined expressions for dependency on the solution.

DEST

The dest (destination) operator is available for use in integration coupling expressions. This operator forces the
expression that it operates on to be evaluated on the destination points instead of the source points. This means
that the destination operator can be used to create convolution integrals and other integral transforms. For instance,
integrating the expression u/ ( (dest(x)-x)"2+(dest(y)-y)~2) gives the following function of x and y:

fooy) = [—HEY)  grgy
J @-2)+(y-y)

EMETRIC

The emetric (vector) returns the square of the length of a vector computed in the mesh element’s own metric.
In this metric, the edges of the mesh element typically have length 1, and vectors orthogonal to the element have

length 0. The number of input arguments defining the vector should be equal to the space dimension.
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ENV AND BNDENV

These operators can only be evaluated on particles in a particle tracing
]
El simulation. Thus, the Particle Tracing Module is required.

Evaluating env(expr) on a particle evaluates expr at the point in the domain where the particle is. When
evaluating a variable var on a particle, if the variable is not defined on the particle it is automatically replaced by

env(var). Therefore the env operator can often be omitted.

Evaluating bndenv(expr) on a particle, evaluates expr at the point on the boundary where the particle is. If the
particle is not on a boundary, the evaluation fails. Use this operator instead of env when evaluating expressions

that are only defined on boundaries.

ERROR

The error(string) operator generates an error with error message string.

You can for instance use this operator to make assertions on how your solution should behave. If you write
if (cond,expr,error(cond is false”)) you will calculate expr when cond is true and get an error message

including the text cond is false, when cond is false.

FSENS

The functional sensitivity operator fsens evaluates the sensitivity of the current objective functional with respect
to the control variable given as the single argument. Note that the argument must be a control variable name;

other dependent variables or general expression are not allowed.

The functional sensitivity is available for analysis when the sensitivity solver has been used with either the adjoint

or the forward sensitivity method, and for the control variables that have been solved for.

The if (cond,exprl,expr2) operator implements a conditional expression.

The first argument is a condition that COMSOL treats as a Boolean expression. If—at a particular evaluation
point—cond is true, then the second argument is evaluated, otherwise the third argument is evaluated. That is,

only one branch is evaluated at any evaluation point.

Use the if operator to avoid illegal operations. For example, if (x==0,1,sin(x)/x) is a valid and continuous

expression for all values of x, including x = 0.

INTEGRATE

integrate (expr,var, lower,upper) computes the integral of expr for the integration variable var over an
interval specified by expressions lower for the lower limit and upper for the upper limit. The expressions for

lower and upper limits do not have to be constants but are required to evaluate to real values.
integrate (expr,var, lower,upper,tol) sets the relative tolerance in the numerical integration to tol. The

default value of the relative tolerance (used when the fifth argument is omitted) is 1e-3. The tolerance must be

a real constant between 0 and 1.

ISINF AND ISNAN
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The isinf operator returns 1 if the expression that it operates on evaluates to infinity (or minus infinity);

otherwise it returns 0.

The isnan operator returns 1 if the expression that it operates on evaluates to NaN (not-a-number); otherwise

it returns 0.
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ISLINEAR

* The islinear operator returns 1 if the expression that it operates on is a linear function of the solution;

otherwise it returns 0.

¢ Use this operator to check user-defined expressions for linearity with respect to the solution. The stationary

solver does this automatically to choose between a linear or a nonlinear solver.

JACDEPENDS
e The jacdepends(expr) operator returns 1 if the derivative of the expression expr, with respect to any part of

the solution, depends on the solution; otherwise it returns 0.

* jacdepends(expr, var) returns 1 if the derivative of the expression expr, with respect to any part of the
solution, depends on var; otherwise it returns 0.

LINDEV

The lindev operator evaluates its argument in the following way when the solution has a stored linearization point:
The expression is first linearized at the linearization point and then evaluated at the current solution. In particular,
if f depends linearly on the solution, 1indev (f) is the same as f. If f does not depend on the solution, Lindev (f)

is 0. If the solution does not have a stored linearization point, using lindev causes an error message.

LINPER

The linper operator has one single use: To indicate load terms that should be used by stationary solvers setting

Linearity to Linear perturbation in the Stationary Solver node’s settings. Terms not enclosed by linper are ignored
by such solvers. On the other hand, terms inside linper are ignored by all other solvers. Evaluating the linper

operator always gives the result 0.

LINPOINT
The linpoint operator can access the linearization point in a solution with a stored linearization point. If the

solution does not have a stored linearization point, using 1inpoint causes an error message.

LINSOL
The linsol operator evaluates an expression using the standard solution. This is the default, so in most contexts
the operator is not very useful. However, it can for example be used inside the argument of 1inpoint to evaluate

a part of the expression with the standard solution instead of the linearization point.

LINTOTAL
The lintotal operator can access the sum of the linearization point and the linear perturbation in a solution with
a stored linearization point. If the solution does not have a stored linearization point, using lintotal causes an

Crror message.

LINTOTALAVG

The lintotalavg operator evaluates the average of an expression over all phases. lintotalavg(f) is evaluated by
taking the average of lintotal (f) with the solution (but not the linearization point) multiplied by e'® for a
number of phases ¢ . The number of phases is automatically selected to achieve an accurate value.
lintotalavg(f,n) uses n equidistantly spaced phases.

LINTOTALPEAK

The lintotalpeak operator evaluates the maximum of an expression over all phases. 1intotalpeak(f) is
evaluated by tal;ing the maximum of real(lintotal(f)) with the solution (but not the linearization point)
multiplied by e’? for a number of phases ¢ . The number of phases is automatically selected to achieve an accurate

value. lintotalpeak(f,n) uses n equidistantly spaced phases.
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LINTOTALRMS
The lintotalrms operator evaluates the RMS of an expression over all phases. lintotalrms(f) is the same as
sqrt(lintotalavg(abs(f)~2)).

LINZERO

The 1inzero operator evaluates an expression using a zero solution. This is mostly used internally in the definitions

of some other operators.

MEAN

COMSOL can evaluate expressions on entities of different dimensions and this might affect the result. For
instance, a point can lie on an edge, which can be an edge of a square, which can be part of the boundary of a
cube. If you now want to access the numbering of the entity it is obvious that you should get different results
for the point, edge, square and cube. If on the other hand you want to know the value of the dependent variable,

this should be the same if you think of the point as part of a point, edge, square, or cube.
The mean operator can be called on any entity that has a lower dimension than the model. The dimension of the
entity from where the call is made is called n.

The mean operator determines the smallest integer m>n for which there are adjacent entities of dimension m. It
then evaluates the expression at the point one time for each m dimensional adjacent entity, regarding the point

as a point in the entity, and takes the average of the calculated values.

See also up and down and side for similar operators.

NOJAC

The nojac operator makes sure that any expression that it operates on is excluded from the Jacobian
computation. This is useful if a Jacobian contribution is not strictly necessary and the computational
requirements for it are high, such as when using a nonlocal coupling. The use of the nojac operator can then
significantly lower the memory requirements by avoiding fill-in of the Jacobian matrix, but its use might also

slow down the convergence of the solution.

The k-¢ turbulence model is an example where a built-in use of the nojac operator improves performance.

PPR AND PPRINT

When the ppr operator is applied on an expression, COMSOL uses polynomial-preserving recovery to evaluate
all variables in the expression that are discretized using Lagrange shape functions. For example,ife = ux + vy,
then ppr(e~2)=(ppr(ux)+ppr(vy))~2.

El. Accurate Derivative Recovery

The pprint operator similarly applies polynomial-preserving recovery within each group of domains with equal
settings. Use these operators to get an estimate of the discretization error in the gradient. For example,

ux-pprint(ux) in a 1D model.

If these operators are applied on expressions that are used when solving
the model, COMSOL computes the Jacobian approximately by ignoring
the operator. For example, the Jacobian of ux-pprint (ux) is 0.

[
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PREV

When the time discrete solver is used, it stores the solution at a number of previous time steps.

* The expression prev (expr,i) evaluates expr using the solution obtained i time steps before the current time

step.
* The operator can be used in equations as well as for results evaluation.

e When used in equations, the prev operator makes it possible to discretize time derivatives. For example, to
discretize ut (the time derivative of «) with the formula known as the backward Euler method, use the
expression (u-prev(u,1))/timestep. Here, timestep is the size of the time step used to reach the current
solution u. The prev operator is also applicable for timestep. For example, prev (timestep, 1) is the size of

the time step used to reach the solution at the previous time step.

* When using the prev operator, sufficiently many previous time steps must be stored. Specify the number of
previous time steps to store in the time discrete solver (time discrete levels) in the Number of time discrete levels
field in the General section of the Time Discrete Solver node’s settings window. Evaluating an expression at a

previous time step that has not been stored results in an error.

REACF
The reaction force operator (reacf) evaluates the reaction force at each node point where a constraint is applied.
The reaction force at a node is equal to the corresponding component of the negated residual vector —L computed

while solving the model. The reaction forces are stored together with the solution vector by the solvers.

¢ The reaction force operator (reacf) is useful when calculating integrals of reaction forces or fluxes.

e Apply the reacf operator on the names of dependent variables when doing a surface integration. For example,
in structural mechanics, with dependent variables © and v corresponding to x- and y-displacements, use
reacf(u) and reacf(v) to access integrals of the reaction forces in the x- and y-direction, respectively. The
integration for the reaction force is a summation over the nodes, so the integration method must be summation
rather than integration. The automatic integration method in the integrations available under Results>Derived

Values detects the use of the reacf operation and then uses the summation method.

* Storing of the reaction forces can be disabled by clearing the Reaction forces check box in the Output section in
the solver’s settings window. This saves some computational time and memory. It is then not possible to use the

reaction force operator.

* When using weak constraints, the residual vector is always 0, so reaction forces are not available.

REALDOT

¢ The expression realdot(a,b) treats complex numbers a and b as if they were real-valued vectors of length 2
and returns their dot product. Also think of the operator call as a shorthand form of real(a*conj(b)). This
expression, however, is not an analytical function of its complex arguments and therefore has no unique partial
derivatives with respect to @ and b.

¢ The difference between realdot(a,b) and real(a*conj (b)) is that the partial derivatives of the former with
respect to @ and b are defined as conj(b) and conj(a), respectively, while for the latter expression, the partial
derivatives are real(conj(a)) and real(a).

The difference between the partial derivative definitions is important

during sensitivity analysis of frequency-response problems (scalar or

2

vector Helmholtz equations).

¢ Common objective function quantities like power and energy must be redefined in terms of realdot(a,b)
rather than real(a*conj (b)) for the sensitivity solver to compute correct derivatives. This applies also to the
absolute value, abs(a), via the definition |a|2 =realdot(a, a).
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SENS

* When the forward sensitivity operator (sens) is applied to an expression, COMSOL uses the forward sensitivity
solution with respect to the indicated control variable instead of the primal solution for the evaluation. This
means, in practice, that when the first argument is a linear expression in the dependent variables, the operator
returns its derivative with respect to the control variable given as second argument. The result for a nonlinear

expression usually lacks meaning.

e The forward sensitivity solution is available for analysis when the sensitivity solver has been used with the forward
sensitivity method, and for the dependent variables and control variables that have been solved for.

» For scalar control variables, access the corresponding forward sensitivity solution by giving the control variable
name as the second argument to this operator. For example, with the dependent variable u and the scalar control
parameter q, access the forward sensitivity solution du/dq as sens(u,q).

» For a control variable field, which is not a scalar, a more elaborate syntax specifying a unique degree of freedom

must be used. This is done by giving an integer as the second argument, corresponding to the global degree of

freedom number for the requested control variable degree of freedom.

SHAPEORDER
e The expression shapeorder (u) gives the element order used for discretization of the variable u.

e The argument u must be a dependent variable or a partial derivative of a dependent variable. In the latter case,

the order returned is the order of the dependent variable itself and not the order of its derivative.

e Itisan error to apply the shapeorder operator to, for example, an expression, a constant, or a spatial coordinate.

SIDE

¢ COMSOL can evaluate expressions on entities of different dimensions and this might not affect the result. For
instance, a point can lie on an edge, which can be an edge of a square, which can be part of the boundary of a
cube. If you now want to access the numbering of the entity it is obvious that you should get different results
for the point, edge, square, and cube. If you, on the other hand, want to know the value of the dependent

variable, this should be the same if you think of the point as part of a point, edge, square, or cube.

* The side operator can be called on an entity that has lower dimension than the model. The dimension of the

entity from where the call is made is called n.

* The side operator is an operator that evaluates an expression, not on the entity where it is called but instead on
one of the adjacent entities of dimension n+1. You choose which entity by giving its number (this is the number

displayed, for instance, in the selection fields) as the first argument to the operator.

* It can happen that the entity you choose is adjacent to the evaluation point more than once. For instance, a
boundary can have the same domain on both sides. In such cases the side operator takes the average of the

different values.

See also up and down and mean for similar operators.

SPATIAL AT
¢ The scope.ati(<coordinate expressions>, expr) operator evaluates the expression expr in the geometry
with the given model scope on an i-dimensional entity in the point given by the coordinate expressions. For

example, root.comp1.at1(0,y,dom) evaluates dom in the two-dimensional geometry on an edge in the point
©,).

* To all operators you can add a suffix (“_frameld”) that specifies the frame in which the coordinate expressions
are used, for example, at1_spatial(x,y, expr).

SUBST
* The subst operator takes a variable or expression as its first argument, followed by one or more argument pairs,

each consisting of a variable name and an expression. The first argument in each pair is an original variable that
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appears in the variable or expression that you specify as the first argument, and the second argument in each pair
is the variable or expression that you want to substitute the original variable with. This can be useful, for example,
for replacing the variable for temperature in a temperature-dependent expression for some quantity by a fixed
initial temperature for use as an initial condition.

¢ Asan example, the expression subst (hmnf.nutildeinit,p,pin_stat) (taken from the Sajben Diffuser model
in the CFD Module model library) substitutes the dependent variable for pressure, p, with a user-defined variable
pin_stat for the inlet static pressure. The evaluation of the variable hmnf.nutildeinit (for the undamped

turbulent kinematic viscosity) then takes the value of pin_stat instead of p.

¢ The unit of the output from the subst operator is the same as the unit for its first input argument.

SUM
The sum operator, when used as sum(expr, index, lower, upper),isasummation operator that computes the
sum of the terms expr for all index values from lower to upper. The expressions for lower and upper limits are

required to evaluate to real values and to be independent of the evaluation point. For example, sum(i~2,i,1,4)
- 12422432442 - 30.

TEST

* The test operator is available for modeling using the weak formulation of the equations.

¢ This operator creates the test function for the variable that it operates on. For an expression, test(F(u, Vu)), the
test operator is equivalent to:

0
ov

Ztest(ui)aiF(ui, Vu,) + test(Vu,)
- Uj

1

F(u;, Vu;)
u;

for all dependent variables u;.

TIMEINT AND TIMEAVG

e The timeint and timeavg operators integrate and compute the average of a time-dependent expression over a
time interval, respectively. timeint (t1,t2,expr) and timeavg(t1,t2,expr)compute the integral and
average of expr over the interval t=t1 to t=t2, respectively. The first two arguments must be real scalars. The
integral is computed by numerical integration, subdividing the interval until the required accuracy is reached.
The timeavg operator numerically integrates the expression in the same way as timeint and then divides the
result by t2-t1.

e timeint(t1,t2,expr,tol) and timeavg(t1,t2,expr,tol) set the relative tolerance in the numerical
integration procedure to tol. The tolerance must be a positive real scalar. The default tolerance (used when the
fourth argument is omitted) is 1e-8.

e timeint(t1,t2,expr,tol,minlen) and timeavg(t1,t2,expr,tol,minlen) set the smallest length of the
subintervals used in numerical integration as a fraction of the length of the whole integration interval.
Subintervals smaller than this length are not further subdivided even if that means that the required accuracy is
not reached. minlen must be a positive real scalar. The default value of minlen (used when the last argument is
omitted) is 1e-6.

e The timeint and timeavg operators can only be used during results evaluation, so they should not be used

when setting up the model.

TRY_CATCH

e The try_catch(tryExpr,catchExpr) operator attempts to evaluate the expression tryExpr, but if this fails
for any point, the operator evaluates catchExpr instead.

¢ Note that the result might depend on how the mesh elements are partitioned into blocks during evaluation,

which can be rather arbitrary. As soon as evaluation of the first argument fails in some part of the block, the
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second argument gets evaluated in the entire block. Also, during postprocessing the behavior might change
because NaN (Not-a-Number) values in a subset of the evaluation points are then accepted, so then the second
argument’s expression might not be evaluated even at points where the first argument fails.

¢ Consider using the if operator (see if) with a suitable condition as the first argument instead of the try_catch
operator, if the if operator is applicable.

UP AND DOWN

¢ COMSOL can evaluate expressions on both sides of a boundary. One way to do this is by using the up and down
operators. These operators are available only on boundaries (that is, geometric entities of dimension one less then

the dimension of the model).

¢ For an expression or a variable that is discontinuous across a boundary, the value is different on either side, and
COMSOL normally displays the mean values on the boundary.

e Use the up and down operators to evaluate an expression on the upside or downside of the boundary. If the
upside or downside is outside of the geometry, or if the variables in the expression are not active on that side,
the up or down operator returns 0.

For more information about the upside and downside of a boundary, see Tangent and Normal Variables. See also

side and mean for similar operators.

VAR
* The var operator (variation operator) is available for modeling using the weak formulation of the equations.
¢ The var operator has the same function as the test operator but is limited to the specified set of fields.

» This operator creates the test function for the variable that it operates on. For an expression, var(¥(u, Vu, v, Vv),
a), where the dependent variable u is in the field named a and the dependent variable v is not, the var operator

is equivalent to:

0
ov

0
Ztest(ui)ﬁF(ui, Vu, v, Vu;) +test(Vu,)
. 13

1

F(u;, Vu;,v;, Vv;)
u;

for all dependent variables u;.

WITH

* The with operator can access any solution during results evaluation.

¢ For time-dependent problems, parametric problems, and eigenvalue problems, this makes it possible to use the
solution at any of the time steps, any parameter value, or any eigensolution in an expression used for plotting or
data evaluation.

¢ Use the solution number as the first input argument. The second input argument is the expression that you want
to evaluate using this solution. For example, with (3,u"2) provides the square of the third eigensolution for an

eigenvalue problem.
¢ For example, you can use the with operator to verify that two eigensolutions are orthogonal.

e The with operator can only be used during results evaluation, so it should not be used when setting up the

model.
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Predefined and Built-In Variables

This section provides information about available predefined and built-in variables that represent properties of the

physics, geometry, mesh, and other parts of the model, including some tips on how you can use them in models.

Predefined Physics Variables

Physics variables are predefined variables that the physics introduce. They are typically functions of the dependent
variables and their derivatives. Many of these variables are available in the Predefined quantities lists in the settings
for plots and other results nodes.

To access physics variables, use a variable scoping syntax that uses the interface identifier to indicate the physics that

they belong to.

The Equation View subnode is available for all physics nodes and contains
a table with the names, expressions, units, and descriptions for the physics
variables that the node defines. To display the Equation View subnodes,
click the Show button (& ) and select Equation View from the Model
Builder.

Variable Naming Convention and Namespace

COMSOL Multiphysics uses a namespace with a hierarchical structure to control the access to variables within a
model component and variables in other components within the same model. To access variables, use the following

namespace syntax:

¢ To refer to the top level of the model tree, use root.
* To refer to variables in a Component branch, use its component identifier, such as comp1.
* To refer to variables in a physics interface, use its interface identifier, such as solid.

¢ To refer to material properties, use the material node’s tag, such as mat1, and the tag of the property group for
the material property group, which is typically def for the Basic property group. For example, to access the
density p in Material 1 use mat1.def.rho (or, using the full name for Component 1,
root.compi.mat1.def.rho; see below). Use this pattern when referencing to other material properties too.

¢ COMSOL evaluates the physics variables in the model component’s namespace, so you need to prepend the
interface identifier to access these variables. For example, solid.disp refers to the total displacement in a Solid

Mechanics interface with the interface identifier solid.

¢ The dependent variables (field variables) are unique within a model, and you do not need the interface identifier
to access them. For example, enter T to access the temperature in a Heat Transfer interface using the default name

for the temperature.

* When referring to a variable you only need to provide the part of the full name that makes the variable unique.
For example, within a Solid Mechanics interface solid in Component 1 comp1, it is sufficient to type
solid.disp, but comp1.solid.disp and the full name root.comp1.solid.disp are also correct. To access
the same variable from another Component, use comp1.solid.disp or root.comp1.solid.disp. The same
mechanism applies to variables defined within a component. To access a global parameter parami, you can use

parami directly or root.parami.

These variable naming conventions mean that the syntax becomes shorter when defining variables locally in a

Component branch instead of globally. For example, to access the x-component of the electric field, E,, in an
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Electrostatics interface with the interface identifier es in a Component 1 with the identifier comp1, you can use
es.Ex in a variable defined in Component 1, but for a variable defined globally, the syntax is comp1.es.Ex.

Variable Classification and Geometric Scope

COMSOL provides a set of variables that you can use in expressions when specifying a model and for visualizing
and analyzing the solution. A number of variables are common to all physics interfaces in a Component, for

example, the spatial coordinate variables x, v, and z (for 3D and planar 1D and 2D geometries).

Every physics interface also has its own set of variables to represent quantities relevant to the physics or equations
that it covers. Characteristics of variables include:
* Parameters and geometric variables are always available.

¢ The choice of physics interfaces and the dimension of the geometries in the model affect the set of available field

variables and special variables.

¢ Equations can be active in different domains, which also affects the set of available variables. Variables
corresponding to certain equation terms are available only in the particular part of the geometry (such as

domains, boundaries, or points) where the equation is active.

¢ Variables defined on boundaries, edges, and points are active if the adjacent domain is active.
Variables are divided into the following general categories:

e User-defined variables

* Built-In Global Variables

e Physical Constants (predefined universal constants)

* Geometric Variables and Mesh Variables (variables that characterize geometric properties).

o Field variables (dependent variables and variables derived from them). For example, Shape Function Variables
and Predefined Physics Variables.

e Component Couplings

* Solver Variables (available only during the solution process)

Built-In Global Variables

The following variables represent time (t), frequency (freq), eigenvalue (lambda), and the number of degrees of
freedom (numberofdofs).

THE TIME VARIABLE

¢ For time-dependent problems use the time variable (t) with the unit seconds (s).

e It can be part of any expression in the point, edge, boundary, and domain settings, as well as during analysis.
* It is always scalar, even when the solution contains more than one output time.

¢ For stationary models, the value of t is 0.

* The value of t for results evaluation corresponds to the selection made in the Time list in the Data sections for
the visualization and data evaluation nodes in the Results branch in the Model Builder. See the Results Analysis

and Plots section.

THE FREQUENCY VARIABLE
The frequency variable (freq) is the global frequency for models in the frequency domain (time-harmonic models

and frequency response analysis, for example).
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THE EIGENVALUE VARIABLE

When specifying an eigenvalue problem, use the eigenvalue variable (lambda) like any other variable.

The eigenvalue solver extracts the Jacobian, the damping matrix, and the mass matrix through Taylor expansion
of the problem with respect to the eigenvalue variable around a specified eigenvalue linearization point (which
is zero by default).

Other solvers treat the eigenvalue variable as a constant with value zero, unless it is set by an eigenvalue solution
used as initial solution.

After solving an eigenvalue problem, the eigenvalue name is available as a scalar variable for use in expressions.

To choose between different eigenvalues, select one from the Eigenvalue list in the Data sections for the
visualization and data evaluation nodes in the Results section of the Model Builder. The value of the eigenvalue

variable corresponds to the selection made in the Eigenvalue list. See the Results Analysis and Plots section.

For many physics interfaces, the default is to use an eigenfrequency study and compute and display the
eigenfrequencies rather than the eigenvalues.

THE NUMBER OF DEGREES OF FREEDOM VARIABLE
The variable numberofdofs returns the total number of degrees of freedom (DOFs), which is the number of DOFs
solved for plus any internal DOFs that the solver might add. The number of DOFs solved for plus the number of

internal DOFs are reported in the Messages window when you compute the solution. COMSOL sometimes uses

internal DOFs for storing information during solution that would be expensive or impossible to recompute

afterward. Internal DOFs have no equations and therefore do not make the system matrices larger.

Geometric Variables and Mesh Variables

The variables that characterize geometric properties and the mesh are listed in Table 5-9, with detailed descriptions

for some of the variables following the table.

TABLE 5-9: GEOMETRIC VARIABLES AND MESH VARIABLES

VARIABLE DESCRIPTION
curv The curvature of a boundary in 2D is called curv.
curvi,curv2 A boundary in 3D has two principal curvatures corresponding to

the minimal and maximal normal curvatures. They are called curv1
and curv2, respectively. See Curvature Variables for details.

dom The domain number, the boundary number, the edge number, or

the vertex (point) number (all are integer values).

dvol The volume scale factor variable, dvol, is the determinant of the

Jacobian matrix for the mapping from local (element) coordinates
to global coordinates.

For 3D domains, this is the factor that the software multiplies
volumes by when moving from local coordinates to global
coordinates. In 2D and |D domains, it is an area scaling factor and
length scaling factor, respectively.

If a moving mesh is used, dvol is the mesh element scale factor for
the undeformed mesh. The corresponding factor for the deformed
mesh is named dvol_spatial.

Available on all geometric entities, the variable h represents the
mesh element size in the material/reference frame (that is, the
length of the longest edge of the element).
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TABLE 5-9: GEOMETRIC VARIABLES AND MESH VARIABLES

VARIABLE DESCRIPTION

linearizedelem In some calculations COMSOL forces mesh elements to become
linear. This variable returns one inside such an element and zero
otherwise. Note that the faces of the linearized mesh elements are
not considered to be linearized themselves. You can use this
variable to identify mesh elements with linearized elements.

meshtype The mesh type index for the mesh element. This is the number of
edges in the element.

meshelement The mesh element number.

meshvol Volume of the (linearized) mesh element.

nx, ny, nz See Normal Variables.

qual A mesh quality measure.

reldetjac The determinant of the Jacobian matrix for the mapping from the

reldetjacmin

s, s1,s2
tcurvx,
tcurvy (2D)
tcurvix,
tcurviy,
tcurviz,
tcurv2x,
tcurvzy,
tcurv2z (3D)
tx and ty (2D)

tix, t1y, t1z
(3D edges)

t2x, t2y, t2z
(3D surfaces)

X, Y, Z
nz

straight mesh element to the possibly curved element used when
solving.

Use this variable to measure the difference in shape between a
curved element and the corresponding straight element.

The variable reldetjacmin is a scalar for each element defined as
the minimum value of the reldetjac variable for the
corresponding element.

A reldetjacmin value less than zero for an element means that
the element is wrapped inside-out; that is, the element is an
inverted mesh element.

See Parameterization Variables.

Tangential directions for the corresponding curvatures. See
Curvature Variables for more information.

See Tangent Variables.

See Spatial Coordinate Variables.

When entering the spatial coordinate, parameterization, tangent, and

normal geometric variables, replace the letters highlighted below in italic

n font with the actual names for the dependent variables (solution

components) and independent variables (spatial coordinates) for the

Component node.

For example, replace u with the names of the dependent variables in the model, and replace x, y, and z with the
first, second, and third spatial coordinate variable, respectively. x; represents the ith spatial coordinate variable. If

the model contains a deformed mesh or the displacements control the spatial frame (in solid mechanics, for
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example), you can replace the symbols x, y, and z with either the spatial coordinates (x, y, and z by default) or the

material (reference) coordinates (X, Y, and Z by default).

The variables curv, dvol, h, qual, reldetjac, and reldetjacmin are based on the mesh viewed in the material

(reference) frame. If you have a moving mesh, the corresponding variables for the mesh viewed in the spatial frame

have a suffix _spatial (thatis, curv_spatial, dvol_spatial, and so on). If you use a deformed geometry, the

corresponding variables for the original, undeformed mesh have a suffix _mesh (for example, h_mesh).

SPATIAL COORDINATE VARIABLES

* The spatial coordinate variables (independent variables) are available for all domain types.

¢ For a Cartesian geometry the default names for the spatial coordinates are x, y, 2.

 For axisymmetric geometries the default names for the spatial coordinates are r, ¢ , and z.

e Ifa deformed mesh is used, x, y, z can be both the spatial coordinates (x,y, z) and the material/reference

coordinates (X, Y, Z); see Mathematical Description of the Mesh Movement.

¢ Ifthe model includes a deformed mesh, the variables xTIME, yTIME, 2TIME represent the mesh velocity. To access

these variables, replace x, ¥, and z with the names of the spatial coordinates in the model (x, y, and z).

PARAMETERIZATION VARIABLES

The surface-boundary parameterization variables can be useful for defining distributed loads and constraints such

as a parabolic velocity profile. The available parameterization variables are:

The curve parameter s (or s1) in 2D. Use a line plot to visualize the range
of the parameter, to see if the relationship between x and y (the spatial
coordinates) and s is nonlinear, and to see if the curve parameterization is
aligned with the direction of the corresponding boundary. In most cases
it runs from O to 1 in the direction indicated by the arrows shown on the
edges when in the boundary or edge selection mode and if you have
sclected the Show edge direction arrows check box in the View node’s ([#¥)
settings window. You can use s on boundaries in 2D when specifying

boundary conditions.

The arc length parameter s1 available on edges in 3D. It is approximately
equivalent to the arc length of the edge. Use a line plot to visualize the
values of s1.

The surface parameters s1 and s2 in 3D are available on boundaries
(faces). They can be difficult to use because the relationship between x, y,
and z (the spatial coordinates) and s1 and s2 is nonlinear. Often it is more
convenient to use expressions with x, y, and 2z for specifying distributed
boundary conditions. To see the values of s1 and s2, plot them using a
surface plot.

TANGENT AND NORMAL VARIABLES

The tangent and normal variables are components of the tangential and normal unit vectors.
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Tangent Variables

In 2D, tx and ty define the curve tangent vector associated with the
9 direction of the boundary.

In 3D, the tangent variables t1x, t1y, and t1z are defined on edges. The
tangent variables t1x, t1y, t1z, t2x, t2y, and t2z are defined on surfaces

according to

0x(81,89) 0Y(81,89) 02(Sq, 82)) )
B (Fis tiys ti2) = i( s s s ) i=1,2

1 1 1

These most often define two orthogonal vectors on a surface, but the
orthogonality can be ruined by scaling geometry objects. The vectors are

normalized; &; is a normalizing parameter in the expression just given.

If a deformed mesh is used, the tangent variables are available both for the deformed configuration and for the
undeformed configuration. In the first case, replace x, y, and z with the spatial coordinate names (x, y, and z by
default). In the second case, replace x, ¥, and z with the material /reference coordinate names (X, Y, and Z by
default).

Normal Variables

In 1D, nx is the outward unit normal pointing out from the domain.

In 2D, nx and ny define a normal vector pointing outward relative to the

Q domains.

In 3D, nx, ny, and nz define a normal vector pointing outward relative to

.i the domains.

Direction of the Normal Component on Interior Boundaries
To get control of the direction of the normal component on interior boundaries, the following variables are

available:

In 1D:

* unx, the outward unit normal seen from the upper domain

e dnx, the outward unit normal seen from the lower domain
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In 2D:

* unx and uny for the up direction

Q * dnx and dny for the down direction
The upside is defined as the left side with respect to the direction of the
boundary.
In 3D:

] e unx, uny, and unz for the up direction

e dnx, dny, and dnz for the down direction

To visualize any of these vector variables use arrow plots on surfaces or lines.

If a deformed mesh is used, the normal variables are available both for the deformed configuration and for the
undeformed configuration. In the first case, replace x, y, and z with the spatial coordinate names (x, y, and z by
default). In the second case, replace x, ¥, and z with the material /reference coordinate names (X, Y, and Z by
default).

Normal Vector Variables Representing Element Surface Normals
A similar set of variables—nxmesh, unxmesh, and dnxmesh, where x is the name of a spatial coordinate—use the

element shape function and are normal to the actual element surfaces rather than to the geometry surfaces.
CURVATURE VARIABLES

The curvature variables are defined on boundaries in 2D and 3D.

In 2D the curvature is denoted curv. Positive curvature is toward the normal (nx,ny).

In 3D there are two principal curvatures named curv1 and curv2, where curv1 is less than curv2 and seen as real
numbers. These correspond to the minimal and maximal values for the curvature of a curve you get by intersecting

the boundary with a plane in which the normal lies. Positive curvature is toward the normal (nx,ny,nz).

The components of the normalized tangential directions for the corresponding curvatures are called tcurvx,
tcurvy in 2D and tcurvix, tcurviy, tcurviz, tcurv2x, tcurv2y, and tcurv2z in 3D. The tangents
(tecurvix,tcurviy,tcurviz) and (tcurv2x,tcurv2y,tcurv2z) are orthogonal.

Note also that you can choose on which frame you evaluate all these variables by using the general instructions
found below Table 5-9.

Shape Function Variables

A finite element defines a number of variables, typically a dependent variable and its derivatives. Such variables are
called shape functions variables because they are computed directly from shape functions and the degrees of
freedom.
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When a physics interface is selected, you can enter names for the dependent variables—these names are used to
construct the finite elements. The dependent variable name is the basis for additional variable names that the finite
elements generate.

When entering the shape function variables, replace the letters
highlighted below in stalic font with the actual names for the dependent

variables (solution components) and independent variables (spatial
coordinates) for the Component.

For example, replace u with the names of the dependent variables in the individual Component, and replace x, y,
and z with the first, second, and third spatial coordinate variable, respectively. x; represents the ith spatial coordinate
variable. If the Component contains a deformed mesh or the displacements control the spatial frame (in solid
mechanics, for example), you can replace the symbols x, y, z with either the spatial coordinates (x, y, and z by
default) or the material /reference coordinates (X, Y, and Z by default).

AN EXAMPLE OF LAGRANGE ELEMENT VARIABLES

For the Lagrange element, which is the element type used by most physics interfaces, Table 5-10 lists the available
variable names, assuming you gave the name u as the argument to the shape function, and that the names x, y, and
z are provided for the independent variables.

TABLE 5-10: LAGRANGE ELEMENT VARIABLE NAMES

ENTITY TYPE\ ID 2D 3D
SPACE DIMENSION

POINT u u
EDGE

u, uTx, uTy, uTz

BOUNDARY u,uTx, ut, uTxt u, uTx, uTy, ut, u, uTx, uTy, uTz, ut,
uTxt, uTyt uTxt, uTyt, uTzt
DOMAIN u, ux, uxx, ut, u, ux, uwy, uxx, u, ux, wy, uz, uxx,

uxt, uxxt, utt,
uxtt, uxxtt,

uxy, uyx, uyy, ut,
uxt, uyt, uxxt,
uxyt, uyxt, uyyt,
utt, uxtt, uytt,
uxxtt, uxytt,
uyxtt, uyytt

uxy, uxz, uyx, uyy,
uyz, uzx, uzy, uzz,
ut, uxt, uyt, uzt,
uxxt, uxyt, uxzt,
uyxt, uyyt, uyzt,
uzxt, uzyt, uzzt,
utt, uxtt, uytt,
uztt, uxxtt, uxytt,
uxztt, uyxtt,
uyytt, uyztt,
uzxtt, uzytt, uzztt

For example, with a fluid-flow interface, you get the set of variables indicated in Table 5-10 for u, v, w, and p,

respectively.

e The variables ux, uy, and uz are the components of the gradient Vu, that is, the 1st-order spatial derivatives.

* The variables uxx, uxy, uxz, uwyx, uyy, uyz, uzx, uzy, and uzz are the 2nd-order space derivative components.
They are meaningful only if the degree of the polynomial shape function used in an element is high enough. For
first-order elements all these variables evaluate to zero.

* For elements with 2nd-degree polynomial shape functions (2nd-order elements), the polynomial degree of the

2nd-order derivatives is zero; that is, the second derivatives are constant in each element.

¢ For element orders lower than two, the second derivatives evaluate to zero regardless of the values of the
2nd-order derivatives of the true solution.

228 | CHAPTER 5: DEFINITIONS



If the model uses a deformed mesh, each finite element is associated with a certain frame (the spatial frame or the
material frame). The frame determines the names of the variables generated by the finite element. For instance, if
the spatial frame is used, the Lagrange element computes derivatives with respect to the spatial coordinates, ux, uy,
and uz. If the material frame is used, the Lagrange element computes derivatives with respect to the material

coordinates uX, uY, and uZ.

THE TIME DERIVATIVES OF THE DEPENDENT VARIABLES
The variable ut is the time derivative of the dependent variable u. You can also form mixed space-time derivatives

as ux;t, for example, uxt,

ou
OxOot

The t must be last in a mixed derivative. The second time derivatives can
n also be used, such as utt or uxtt (but not higher derivatives in time).

If the model contains a deformed mesh, there is, in addition to the usual time derivative ut, the mesh time

derivative uTIME. This also holds for mixed space-time derivatives.

TANGENTIAL DERIVATIVE VARIABLES
On boundaries, edges, and points you also have access to tangential derivative variables. They have names such
as uTx, uTy, and uTz. Using these variables, it is possible to create models with phenomena on boundaries, edges,

or points as described with PDEs.

The tangential derivative variables represent the Cartesian components of the tangential projection of the gradient

of shape function variables:
(Vu)y = I-nn") - Vu

In this equation, (Vu)p is the tangential gradient, which consists of the tangential derivatives in each spatial

direction, I is the unity tensor, n is the outward unit normal vector, and Vu is the gradient of u.

LAGRANGE MULTIPLIER VARIABLES

If weak constraints are activated for boundary conditions that are constraints (Dirichlet boundary conditions),
COMSOL adds variables for the Lagrange multipliers (one for each dependent variable) by adding _1m as a suffix
to the dependent variable name. For example, for a dependent variable u, the corresponding Lagrange variable is
u_1m. The Lagrange multipliers are available on boundaries, and you can also evaluate them on edges (in 3D) and
points (in 2D and 3D).

VARIABLE INHERITANCE
On boundaries, edges, and points, gradients and second derivatives of the shape functions are available by
inheritance; that is, the average of the values of the variables from the adjacent domains are computed. This process

can progress for several levels.

For example, ux is the average on a boundary from the adjacent domains, then the average on an edge from the

adjacent boundaries, and finally, the average at the points from the adjacent edges.

If possible, avoid using variable inheritance for gradients and second derivatives in a model. Instead, use the
tangential derivative variables for equation-based modeling on boundaries.

For computations of integrals of reaction forces and fluxes, use the react operator.
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For high accuracy reaction forces and fluxes in other circumstances, use weak constraints and Lagrange multipliers

on boundaries instead of directly accessing the gradient through inheritance (see Computing Accurate Fluxes).

When you plot or evaluate—on a boundary, for example—the value of a
variable that is discontinuous across that boundary (a thin resistive layer,

for example), the value is the average of the value on the “up” and

[

“down” sides of the boundary. You can use the up and down operators to

get the value on either side of the boundary (see up and down).

Solver Variables

The following table lists global solver variables that are available during the solution process only. They can be used

in solver settings in the Study branches but are not available for use in, for example, results evaluations and plots.

TABLE 5-11: SOLVER VARIABLES

VARIABLE DESCRIPTION

niterCMP This variable contains the iteration number for nonlinear iterations.
It starts from one and increases with one for each fully coupled or
segregated iteration. It is used by some physics to control damping
mechanisms. Examples are pseudo-time stepping in fluid dynamics
and the penalty factor in the augmented Lagrangian method for
contact problems in structural mechanics.

gmg_level This variable contains the geometric multigrid level. It is zero for the
top level (the one solved for), one for the next coarser level, and so
on. It is used by some physics to control artificial stabilization.

timestep This variable contains the current time step used by the
time-dependent solver. It is used by some physics to control artificial
stabilization. You can use it, for example, to create a stop condition
that stops the time stepping if the time step becomes smaller than
some threshold value.

Entering Ranges and Vector-Valued Expressions

You can enter ranges and vector-valued expressions such as extra grid-line coordinates using the following formats:

e A space-separated or comma-separated list of values: 10, 15, 23, 29.7, 30.

e A delimited space-separated list using curly braces; for example, as an argument to a function: cos ({0 pi/4
pi/2}).

* Equally-spaced values using the range function as in range (start value,step_size,end value). For

example, range(0,0.2,3) creates the values 0, 0.2, 0.4,..., 2.6, 2.8, and 3.0. The step size is 1 if you provide

only start and end values and skip the step value.

start_value can be cither smaller or larger than end_value. In the
latter case, the step size must be negative. For example,

range(0, -5, -100) creates the values 0, -5, 10, ..., 95, =100, while
range(0,5,-100) is an empty set of values.

[

Combine these formats in a single expression to create an array of values that contain an arbitrary number of

segments with differently spaced values mixed with other freely specified values.
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EXAMPLES USING THE RANGE FUNCTION

* range(a,(b-a)/(n-1),b) gives a list of n equally-spaced increasing values in the range [a, b] if b >a or
decreasing values in the range [b, a] if a >b.

¢ 10"range(-3,3) gives the exponentially increasing sequence 10_3, 10_2, et 103.

* 1”range(1,10) givesasequence of length 10 where all elements equal 1. Multiplying the vector 1~ range (1,n)

by a constant value a gives a vector of n elements all equal to a.

* 0“range(1,5) gives the sequence 0 0 0 0 O.

USING RANGES TO GENERATE ARRAYS
A convenient way to generate vectors of values is to use the Range dialog box, which you open by clicking the Range

button (| |) next to most of the fields that accept vectors of values.

In that dialog box, use the Entry method list to select Step to enter a step size or Number of values to specify the
number of values in the array. Specify the start value for an array of values in the Start field. Enter the step size in
the Step field or the number of values in the Number of values field, depending on the setting in the Entry method
list. Specify the end value for the array of values in the Stop field. By default, the spacing of the values is linear, but
you can select a function to apply to all values. To do so, choose one of the available arithmetic and trigonometric
functions from the Function to apply to all values list. For example, select exp10 to create an array of exponentially
increasing values. The list includes the following functions:

e The default value None, which means linear spacing using the range function directly with the values specified.

¢ The exponential functions expl0 (base-10 exponential function) and exp (base-e exponential function), which
create exponentially-spaced values using the specified range of values as powers of 10 and of the mathematical

constant e, respectively.
e The trigonometric functions ces (cosine) and sin (sine), which create sinusoidally varying values.

* The square root function sqrt, which creates a vector with values that are the square roots of the values specified.
Click Replace to replace the contents in the field with the values specified in the Range dialog box.

Click Add to add the range of values to the end of the existing values in the associated field. That way you can create

more complex ranges.

For ranges that contain integer values only, an Integer Range dialog box opens instead of the normal Range dialog
box. The Integer Range dialog box only contains Start, Step, and Stop ficlds, all of which must contain integer values.

SUPPORT FOR RANGES AND VECTOR-VALUED EXPRESSIONS

The following modeling settings support ranges and vector-valued expressions:

¢ Extra grid lines in the Axis node’s settings window.

 Interval coordinates when using the Interval node’s settings window for 1D geometries.
* The Copy, Move, and Rotate transforms for geometry modeling.

¢ The times for output from the time-dependent solver and the list of parameter values in the settings windows for
study step nodes for time-dependent and stationary solvers and for parametric sweeps.

e The contour levels, the streamline start-point coordinates, and the coordinates in arrow plots. Whenever you
specify a number of coordinates in settings windows for plots, COMSOL uses scalar expansion—if one
component is the same for all coordinates, enter a single number in the corresponding text field. For example,
to get 101 linearly spaced coordinates fromy = 6 to y = 7 along x = 3, enter it as the single scalar 3 for x and
then range(6,0.01,7) fory. Thus, you need not enter 101 similar values for x.

¢ Element distribution in the meshing settings.

PREDEFINED AND BUILT-IN VARIABLES | 23l



Summary of Built-In Variables With Reserved Names

This section is an overview of the built-in elements of the following categories as defined by the underlying
COMSOL language:

¢ Constants
e Variables

¢ Functions

These language elements are built-in or user-defined. In addition there are operators that cannot be user-defined,

and expressions, which are always user-defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be vedefined by the user. If you try to use a reserved
name for a user-defined variable, parameter, or function, the text where you enter the name turns orange and you
get a tooltip error message if you select the text string. Reserved function names arve veserved only for function
names, which means that such names can be used for variable and parameter names, and vice versa. The

following tables list the most commonly used built-in elements and hence those reserved names.

CONSTANTS AND PARAMETERS

There are three different types of constants: built-in mathematical and numerical constants, built-in physical
constants, and parameters. Parameters are user-defined constants that can vary over parameter sweeps. Constants
are scalar valued. The tables below list the built-in mathematical and numerical constants as well as built-in physical

constants. Constants and parameters can have units.
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BUILT-IN PHYSICAL CONSTANTS

NAME DESCRIPTION

g_const Acceleration of gravity

N_A_const Avogadro constant

k_B_const Boltzmann constant

Z0_const Characteristic impedance of vacuum (impedance of free space)
me_const Electron mass

e_const Elementary charge

F_const Faraday constant

alpha_const
G_const
V_m_const
mn_const
muO_const
epsilon0_const
h_const
hbar_const
mp_const
c_const
sigma_const
R_const

b_const

Fine-structure constant

Gravitational constant

Molar volume of ideal gas (at 273.15 K and | atm)
Neutron mass

Permeability of vacuum (magnetic constant)
Permittivity of vacuum (electric constant)
Planck’s constant

Planck’s constant over 2 pi

Proton mass

Speed of light in vacuum

Stefan-Boltzmann constant

Universal gas constant

Wien displacement law constant

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION

abs Absolute value

acos Inverse cosine (in radians)

acosh Inverse hyperbolic cosine

acot Inverse cotangent (in radians)
acoth Inverse hyperbolic cotangent
acsc Inverse cosecant (in radians)
acsch Inverse hyperbolic cosecant

arg Phase angle (in radians)

asec Inverse secant (in radians)

asech Inverse hyperbolic secant

asin Inverse sine (in radians)

asinh Inverse hyperbolic sine

atan Inverse tangent (in radians)

atan2 Four-quadrant inverse tangent (in radians)
atanh Inverse hyperbolic tangent
besselj Bessel function of the first kind
bessely Bessel function of the second kind
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NAME DESCRIPTION

besseli Modified Bessel function of the first kind
besselk Modified Bessel function of the second kind
ceil Nearest following integer
conj Complex conjugate

cos Cosine

cosh Hyperbolic cosine

cot Cotangent

coth Hyperbolic cotangent

csc Cosecant

csch Hyperbolic cosecant

erf Error function

exp Exponential

floor Nearest previous integer
gamma Gamma function

imag Imaginary part

log Natural logarithm

log1o Base-10 logarithm

log2 Base-2 logarithm

max Maximum of two arguments
min Minimum of two arguments
mod Modulo operator

psi Psi function and its derivatives
range Create a range of numbers
real Real part

round Round to closest integer
sec Secant

sech Hyperbolic secant

sign Signum function

sin Sine

sinh Hyperbolic sine

sqrt Square root

tan Tangent

tanh Hyperbolic tangent

The following tables summarize the built-in variables and functions that are generally available in all COMSOL
models. Some are only available in certain geometries or in time-dependent models, for example. These variable

names are reserved names and appear in orange in the settings windows for parameters and variables.

TABLE 5-12: BUILT-IN VARIABLES

NAME DESCRIPTION TYPE
t Time Scalar
freq Frequency Scalar
lambda Eigenvalues Scalar
phase Phase angle Scalar
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TABLE 5-12: BUILT-IN VARIABLES

NAME DESCRIPTION TYPE
numberofdofs Number of degrees of freedom Scalar
X, ¥, z, ry, X, ¥, Z, R Position Field
s, s1, s2 Edge/surface parameters Field
n, nx, ny, nz, nr Edge/surface normals Field
tx, ty, tz, tr Edge tangents Field
tix, tily, ti1z, t2x, t2y, Surface tangents Field
t2z
un, unx, uny, unz Edge/surface upward normals Field
dn, dnx, dny, dnz Edge/surface downward normals Field
eps, i, j, pi, inf, Inf, Numerical constants Scalar
nan, NaN
h Local mesh element size (length of the Field
longest element edge)
dom The domain number, boundary number,  Field
edge number, or point number
meshtype Mesh type index for the mesh element;  Field
this is the number of edges in the
element.
meshelement Mesh element number Field
meshvol Volume of the (linearized) mesh element  Field
dvol Volume scale factor variable; this is the Field
determinant of the Jacobian matrix for
the mapping from local (element)
coordinates to global coordinates.
qual A mesh quality measure between 0 Field
(poor quality) and | (perfect quality)
reldetjac Determinant of the Jacobian matrix for ~ Field
the mapping from the straight mesh
element to the possibly curved element
used when solving
reldetjacmin The minimum value of the reldetjac Field
variable in each element
linearizedelem One inside elements that have been Field
linearized; zero otherwise
niterCMP Iteration number for nonlinear iterations Scalar
gmg_level Geometric multigrid level Scalar
timestep Current time step Scalar

The suffixes x, y, z, and r in some of the variables are the default names

L] . . . . .
El for the spatial coordinates, which you can change if desired.
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The following user-defined variables generate built-in variables such as space and time derivatives. See Shape
Function Variables for information about those built-in variables.

TABLE 5-13: USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES

DEFAULT NAME  DESCRIPTION TYPE
X, Y, Z Spatial coordinates (Cartesian)  Field
rz Spatial coordinates (cylindrical) Field

u, T, and so on  Dependent variables (solution)  Field
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Mass Properties

Overview

You can add one or more Mass Properties nodes to create variables for and compute the following quantities for a
model component:

* The volume of the geometry or part of the geometry.

¢ The mass of the geometry or part of the geometry

¢ The center of mass

* The moment of inertia

¢ The principal moment of inertia

When you compute the solution, COMSOL adds the following variables:

TABLE 5-14: VARIABLES CREATED BY A MASS PROPERTIES NODE

QUANTITY TYPICAL VARIABLE NAMES
Volume mass1.volume

Mass massi1.mass

Center of mass mass1.CMX, mass1.CMY, mass1.CMZ

Moment of inertia massi.IXX, mass1.IXY, mass1.IXZ, and so on
Moment of inertia, mass1.Ip1X, mass1.Ip2X, mass1.Ip3X, and so on

principal direction

Moment of inertia, massi1.Ip1, massi.Ip2, and massi.Ip3X
principal values

Use a Global Evaluation node, for example, to evaluate the resulting measurement quantities, which you can select
from a Definitions>Mass Properties submenu after clicking the Replace Expression ( ' ) or the Insert Expression ( == )
button.

Mass Properties

Right-click Definitions in a Component branch to add a Mass Properties node ( gy ) to compute the variables for mass,
volume, center of gravity, and moment of inertia. The settings window for a Mass Properties node includes the

following sections:

SOURCE SELECTION

The source selection defines the source for the mass property variables—the part of the geometry over which the
program computes the measurement variables and to which the density contribution is limited. you can add other
density contributions by right-clicking the Mass Properties node and choose Mass Contributions ( ‘+); see Mass

Contributions.

From the Geometric entity level list, sclect Domain (the default), Boundary, Edge (3D only), or Peint. Select Manual
or All domains (the default), All boundaries, All edges, or All points from the Selection list. If Manual is selected, select

geometric entities in the Graphics window.

DENSITY

In this section you define the source of the density values used for computing some of the mass properties. In the
Density expression ficld, type a value or expression for the density (SI unit: kg/ms). For example, material.rho,
which is a variable for the density from the materials in the model.
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From the Integration frame list, choose the frame to use for the integration. The default, Material (X, Y, Z) in 3D,
uses the material frame.

VARIABLES
In the Variables section you select which variables to create and on which frame they are defined.

From the Frame list, choose the frame to use when computing the mass properties. The default, Material (X, Y, Z)

in 3D, uses the material frame.

Select the following check boxes to create and compute the corresponding mass property (by default, all of them
are selected):

* Create volume variable to create a variable for the volume of the selected geometric entities.

* Create mass variable to create a variable for the mass of the selected geometric entities.

¢ Create center of mass variables to create variables for the center of mass of the selected geometric entities.

e Create moment of inertia variables to create variables for the moment of inertia of the selected geometric entities.

* Create principal moment of inertia variables to create a variables for the principal moment of inertia of the selected
geometric entities.

INTEGRATION SETTINGS

In this section you can specify the integration order of the integration used to compute the output variables. The
default in the Integration order ficld is 4 (which typically is twice the order of the shape order function for the
physics).

Mass Contributions

Right-click a Mass Properties node ( i ) to add a Mass Contributions (‘+) node, which you can use to add
contributions to the mass used for computing the mass properties in the parent Mass Properties node. The
contributions can come from a connected boundary, for example. The settings window for a Mass Contribution node

includes the following sections:

SOURCE SELECTION
The source selection defines the source for the mass contribution to the mass properties—the part of the geometry

where you want to add mass contributions.

From the Geometric entity level list, sclect Domain (the default), Boundary, Edge (3D only), or Peint. Select Manual
or All domains (the default), All boundaries, All edges, or All points from the Selection list. If Manual is selected, select

geometric entities in the Graphics window.

DENSITY
In this section you define the source of the density values used for computing some of the mass properties. In the
Density expression ficld, type a value or expression for the density (SI unit: kg/ mg)

From the Integration frame list, choose the frame to use for the integration. The default, Material (X, Y, Z) in 3D,

uses the material frame.
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Functions

User-defined functions can be added globally or locally:

* To add global functions, on the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select an

option from the Functions menu, or right-click the Global Definitions ((=)

¢ You can add local functions (for any Cemponent branch), from two toolbars, either the Definitions toolbar in the
Functions group, or on the Home toolbar (Windows users) or Main toolbar (Mac and Linux users), where you
choose it from the Functions>Local submenu. You can also right-click the Definitions ( = ) node and choose an

option from the Functions submenu.

About User-Defined Functions

There are three broad categories of user-defined functions—Analytic, Interpolation, and Piecewise—and a number
of templates for common function types, such as step and ramp functions. You can also create external function
interfaces to include functions written in C and MATLAB. Functions can be global or local in a model component,
although external functions and MATLAB functions can only be defined globally.

NAMING FUNCTIONS

Function names for built-in mathematical functions such as abs, cos, and test are reserved function names, and
naming a user-defined function using one of the reserved function names is not reccommended because it can cause
unexpected results. If the name that you type in the Function name text field is a reserved function name, the text
color changes to orange, as a warning. If you move the cursor to a function name in orange, the tooltip is a reserved

name is displayed.

PLOTTING FUNCTIONS
Click the Plot button (fg5]) in the upper-right corner of the settings window to plot any user-defined function of
1-3 variables directly in the Graphics window. This plot is temporary and disappears when you move to another

Model Builder node making use of the Graphics window.

Click the Create Plot button ([Eg) in the upper-right corner of the settings window to create a persistent plot of the
function under Results, including a Function data set, a plot group and a plot feature. The added nodes can be used

for plotting multiple functions on top of each other or for direct comparison to model results, for example.

For analytic functions, first define a range for the arguments in the Plot Parameters section. Note that the range is
expressed in the current unit system’s base unit corresponding to the set function argument unit. For example, if

the current unit system is SI and the function argument unit is cm, the plot range is expressed in m.

UNITS FOR FUNCTION INPUTS AND OUTPUTS

By default, functions expect dimensionless inputs and provide dimensionless outputs. When such a function is called
with arguments having well-defined units (except when explicitly dimensionless), a unit warning will be displayed.
If the function is used anyway, it will be called for the numerical value of the argument expressed in the current unit
system for the context where function is called. The return value will from the unit handling perspective behave like

a number, adapting its unit to the context where it is used.

In the Units section in the settings window for the Analytic, Interpolation, and Piecewise function nodes, you can
define units for the function’s inputs and output. In the Arguments ficld, type a single unit for all inputs, or specify
space-separated or comma-separated units for each input (type m, s, for example, for two input arguments with

the units meter and second, respectively). In the Function ficld, type the unit for the function’s output.
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Common Settings for the Function Nodes

UNITS

By default, functions expect dimensionless inputs and provide dimensionless outputs. In the Units section in the
settings window for the Analytic, Interpolation, and Piecewise function nodes, you can define units for the
function’s inputs and output. In the Arguments field, type a single unit for all inputs, or specify space-separated or
comma-separated units for each input (type m, s, for example, for two input arguments with the units meter and

second, respectively). In the Function field, type the unit for the function’s output.

DERIVATIVES
For External functions and MATLAB functions, enter expressions for the partial derivatives of each function with
respect to their input arguments. The derivative information is needed by the automatic Jacobian computation. In

the Derivatives table, each row contains a partial derivative of a function with respect to one of its arguments:

¢ The entries in the Function name column must occur in the Functions table, and the entries in the Argument

column must occur among the arguments listed for that function in the Function table.

e The Partial derivative column contains expressions for the partial derivatives. Partial derivatives that are not
specified in the table default to 0.

PLOT PARAMETERS

Use this table to set the range for arguments in preview plots. For each argument, enter a Lower limit, and an Upper
limit in the Plot Parameters table. In Analytic function plot settings, the argument column is updated automatically
and must always match the specified argument list. For External and MATLAB functions, the argument column is
absent. Instead, the limits specified in the table are applied to in order from top to bottom to the arguments of the
first function with a matching number of arguments. It is also this first matching function which is plotted when
you click the Plot button ([gg]) or the Create Plot button ([Z51)-

SMOOTHING

Smoothing makes a function more well-behaved and suitable for modeling. It replaces jumps with smooth
transitions that eliminate discontinuities and can represent the inertia present in real applications. Use smoothing
to improve the behavior of the model by avoiding discontinuities that are difficult to handle numerically. The

smoothed functions have continuous first and, optionally, second derivatives.

For the Ramp, Step, Triangle, and Rectangle functions, enter a value in the Size of transition zone ficld to control
the amount of smoothing. Set the Number of Continuous Derivatives to | or 2. The default is to make derivatives
continuous up to second order. For the Ramp function, additionally choose whether to Smooth at start and/or
Smooth at cutoff.

Note that smoothing affects for which values of the arguments the
function is different from zero. In particular, when applying smoothing

to a Ramp or Step function, it will start to rise before the position

[

specified in the Location field. This may interfere with initialization

assuming that the function is zero at this point.

The Waveform function also supports smoothing for some of the
'& waveform types.
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Analytic

An Analytic function ( f'a ) is defined by a symbolic expression. Analytic functions have the ability to bind arguments
during function calls. In other words, they do not require the actual argument names in an expression when writing
the function. For example, you can define a function f{x) = 2 with the input argument x and the expression x*2
and the call it as f(T), where T is the temperature in a heat transfer model. The default Function name is an1.

To add a global or local (for any Component) Analytic function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Analytic from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (=

submenu.

1) node or the Definitions ( = ) node and choose it from the Functions

* See Naming Functions for information about allowed function names.
El. * See Units for information about the Unit section.

¢ See Plot Parameters for information about plot range settings.

DEFINITION

In the Expression field, enter the mathematical expression that defines the function, such as
sin(x)*cos(y)+g_const or atb*cos(c). Enter Arguments to the analytic function as comma-separated entries
(x,y and a, b, ¢ for the functions above). In addition to the arguments that are defined, analytic functions also

recognize global parameters and physical constants.

From the Derivatives list, Automatic is selected by default and computes the derivatives symbolically. COMSOL uses
the derivatives of a function if a variable that depends on the solution is used in a function argument. Select Manual
to specify the function derivatives with respect to its arguments in a table. If Manual is selected, enter the derivatives
with respect to the function’s arguments. For undefined derivatives, COMSOL uses 0 as the value of the derivative.
In the second example above, enter a, b, and ¢ in the top three rows of the Argument column, and 1, cos(c), and

-b*sin(c)in the associated text fields in the Partial derivative column.

PERIODIC EXTENSION
Select the Make periodic check box to make the function periodic and extend its definition within an interval to the

whole real axis. Then define the interval by entering values in the Lower limit (default is 0) and Upper limit (default
is 1) fields.

ADVANCED
Select the May produce complex output for real arguments check box if the defined function works similarly to sqrt;

that is, if it sometimes returns complex values for a real-valued input.

e Ifyou have the AC/DC Module, see Geoelectrics: model library path
ACDC_Module/Other_Industrial_Applications/geoelectrics.
| * Ifyou have the RF Module, see Second Harmonic Generation of a
Gaussian Beam: model library path

RF_Module/Tutorial_Models/second_harmonic_generation.

Elevation

The Elevation function (%)) makes it possible to import geospatial elevation data from digital elevation models (on
the DEM file format using the USGS standard from the United States Geological Survey) and map the elevation
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data to a function of x and y. A DEM file contains elevation data for a portion of the Earth’s surface. The resulting
function behaves essentially like a grid-based interpolation function. The default Function name is elev1.

To add a global or local (for any Component) Elevation function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Elevation (DEM) from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (:j%_]) node or the Definitions ( = ) node and choose it from the Functions

submenu.

FILE

Enter the path and name of the elevation file in the Filename text field, or click Browse to select a DEM file with
clevation data in the Elevation Data dialog box. When a DEM file is open, the File section displays the coordinates
for the southeast corner.

Click Import to import the elevation data in the specified DEM file into the model; otherwise, COMSOL references
the elevation data on your file system. When the elevation data is imported, the File section (under Data imported
into model) contains information about the filename and the location for the data. Click Export to save the elevation
data to a file and reference from that file instead of including it in the model. Click the Discard button to delete the

imported data from the model.

INTERPOLATION AND EXTRAPOLATION

For interpolation in the elevation data, select an Interpolation method from the list—Nearest neighbor or Linear (the
default).

For extrapolation of values that are outside the range in the elevation data, select an Extrapolation method from the
list—Constant (the default), Linear, Nearest function (which evaluates the function from the closes grid point at the
actual point where a value is requested), or Specific value. For a Specific value, enter a value to Replace missing data
with field (ST unit: m). The default is 0 m.

On the settings window toolbar, click the Create Surface button ( /") to add a Parametric Surface node to represent

the elevation function as a parametric surface in the Geometry branch for 3D models.

External

The External function is only available with the Global Definitions node.
See also model.func() in the COMSOL API Reference Manual for

details about the interface to external functions, including an example and

[

information about compiling the function on the supported platforms.

An External function (LT‘EI) interfaces to other external functions written in the C language (using a native C
function or, through a wrapper function, interfacing with source code written in, for example, Fortran). Then use
those functions as any other functions defined in COMSOL. For example, use it for a user-created shared library
(depending on the platform, a DLL, .so, or .dylib file).
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To add a global External function:

¢ On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select External from the

Functions>Global menu, or

* Right-click the Global Definitions ({=]) node and choose it from the Functions submenu.

Go to Common Settings for the Function Nodes for information about

'& the Derivatives and Plot Parameters sections.

FUNCTIONS
Enter a Library path and name (the complete network path), or click Browse to locate a library to import. For each
row in the table, enter a Function name (myfun, for example) and a space-separated or comma-separated list of the

names of its input Arguments (x Y, for example).

ADVANCED

Enter a value in the Initialization data ficld. The value is sent to the library when it is loaded. Select the Thread safe
check box to declare that the function is a thread-safe pure function (that is, a function that always returns the same
results using the same input argument values and that do not have any side effects or output). Select this check box

to then improve performance.

Gaussian Pulse

The Gaussian Pulse function (__) is the common bell-shaped curve (Gaussian function). It has a shape that is similar

to a Gaussian (normal) distribution. The default Function name is gp1.
To add a global or local (for any Component) Gaussian Pulse function:

¢ On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Gaussian Pulse from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (

submenu.

) node or the Definitions ( = ) node and choose it from the Functions

The Gaussian pulse has the same characteristics as the normal distribution: it is a pulse with a shape that is similar

to a normal or Gaussian distribution as a function:

—(x = x,)*
1 26°

e
GA2T

y(x)=

In the equation above, x is the input variable, x( is the location (mean), and o is the standard deviation. This

function is a function of one variable (the time ¢, for example).
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PARAMETERS
Enter a Location value for the Gaussian pulse mean x (the default location is 0). Enter a Standard deviation & of the

normal distribution. The defaultis 1.

* Ifyou have the RF Module, see Transient Modeling of'a Coaxial Cable:
model library path

RF_Module/Verification_Models/coaxial_cable_transient.

il * Ifyou have the Chemical Reaction Engineering Module, see Surface
Reactions in a Biosensor: model library path
Chemical_Reaction_Engineering_Module/Surface_Reactions_and_Depositio

n_Processes/reacting_pillars.

Imaye

The Image function (|, ) makes it possible to import an image (in BMP, JPEG, PNG, or GIF format) and map the
image’s RGB (red, green, blue) data to a scalar (single channel) function output value. By default the function’s

output uses the mapping (R+G+B)/3.

The default Function name is im1. An image is defined on a two-dimensional domain, and you typically call the

image function using spatial coordinates: im1(x,y).
To add a global or local (for any Component) Image function:

¢ On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Image from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (-j%_]) node or the Definitions ( = ) node and choose it from the Functions

submenu.
* See Naming Functions for information about the Function Name
section.
'El * See Common Settings for the Function Nodes for information about
the Units section.
FILE

Enter the path and name of the image file in the Filename text field, or click Browse to select an image file in the
Image dialog box. Click Impert to import the image in the specified image file into the model; otherwise COMSOL
references the image on your file system. When you have imported the image, the File section, under Data imported
into model, contains information about the image’s filename and size. Click Export to save the image to a file and
reference it from there instead of keeping it in the model. Click the Discard button to delete the imported image

data from the model.

COORDINATES

Define the 2D coordinates and if required, flip the image. Select the In place check box to use the pixels in the image
as the coordinates. Click to clear the check box to define the image coordinates explicitly using the x minimum, x
maximum, y minimum, and y maximum fields. Select the Flip horizontally check box to flip the image horizontally
from left to right and vice versa. Select the Flip vertically check box to flip the image vertically from up to down and

vice versa.
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COLOR SCALING

From the Scaling list, select Automatic (the default) to use the default scaling, which outputs the mean of the RGB
values for each pixel in the image. Select Manual to specify a custom expression for the scalar image function output
value in the Expression field. The default is (r+g+b) /3, which is the automatic scaling, giving a scalar value that is

the mean of the RGB values in each pixel.
For interpolation in the image, select an Interpolation method from the list—Nearest neighbor or Linear (the default).

For extrapolation of values that are outside the range in the image, select an Extrapolation method from the list—
Constant (the default), Linear, Nearest function (which evaluates the function from the closes grid point at the actual
point where a value is requested), or Specific value. If Specific value is selected, enter a value in the Value outside range
field (default value: 0).

CLIPPING

Apply clipping to create a box-shaped region inside of the original image where the image is rendered. From the
Clipping list, select None (the default) for no clipping, or Manual to define the box-shaped region using the x
minimum, x maximum, y minimum, and y maximum fields (unit: px). The default x maximum and y maximum values

are both 1000 px; the default minimum values are 0.

Interpolation

An Interpolation function () is defined by a table or file containing the values of the function in discrete points.

e

The interpolation data can be structured (defined on a grid) or unstructured (defined on a generic point cloud).
To add a global or local (for any Component) Interpolation function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Interpolation from the

Functions>Global or Functions>Local menu, or

=) node or the Definitions ( = ) node and choose it from the Functions

e Right-click the Global Definitions (|

submenu.

DEFINITION
Select a Data source—Table (the default) or File to define the interpolation function by entering values in a table or

by importing interpolation data from a file, respectively.

¢ If Table is selected, enter a Function name and enter coordinates ¢ and function values f{¢) into the table cells. A
function of one variable can be defined in this way. For functions of two or more variables, such as
space-dependent data in 2D and 3D, use a file with the function data. The default Function name is int1.

* Optional: Save the parameters to a text file to reuse in other models. Click the Save to File button ([] ) and enter
a File name, including the extension .txt. Click to Save the text file. The information is saved in space-separated

columns in the same order as displayed on screen.

e Optional: Import or Load data from a spreadsheet program or other format by saving the file with a .txt
extension. Data must be separated by tabs or colons. Click the Load from File button ( ) and navigate to the
text (.txt) file to load and click Open. If the license includes LiveLink™ for Excel® you can also load interpolation
data from a Microsoft Excel Workbook spreadsheet. The data loads to the table. If there is other data already in
the table, it adds it after the last row. Move or edit as required.

e Optional (for functions defined by a table only): If you want to define the inverse function f~ L for the
interpolation function f, select the Define inverse function check box and enter a function name for the inverse
function in the Inverse function name field (the default is the name of the interpolation function with a suffix

_inv). If you want to plot the inverse function instead of the interpolation function itself, first select the Plot the
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inverse function check box in the Plot Parameters sections, which is only available when you have chosen to define

the inverse function.

The inverse function only exists if the function is strictly monotonic.

[

If File is selected to import interpolation data from a file, select a Data format—Spreadsheet, Grid, or Sectionwise. If
the license includes LiveLink™ for Excel®, you can also import interpolation data from a Microsoft® Excel
Workbook spreadsheet. COMSOL then uses the spreadsheet format and the Data format list is not available.

¢ Enter a Filename (the complete network path) or Browse to locate a file to import.

¢ From the Data format list sclect Spreadsheet, Grid, or Sectionwise. The spreadsheet format is the default format,
and that format is the easiest to use for functions defined on an unstructured grid or for general tabulated

function values with one or more arguments.

If Spreadsheet is sclected, enter a Number of arguments (1-3). For all file types, enter information about the functions
into the table. Add a Function name and its Position in file. The first function in the file has position 1, the following
has position 2, and so on. For spreadsheet data, the first columns contain the arguments (typically spatial

coordinates); the following columns can contain one or more functions, and the positions entered are the relative

position for each function’s data column.

When the data format is specified, enter the path and name of the interpolation data file in the Filename text field,
or click Browse to select a text or data file with interpolation data in the Interpolation Data dialog box. Then click
Import to import the interpolation data into the model; otherwise COMSOL references the interpolation data on
your file system. When you have imported the interpolation data, the Parameters section, under Data imported into
model, contains information about the filename, data type, and dimension for the data. Click Export to save the
interpolation data to a file and reference from there instead of including it in the model. Click the Discard button
to delete the imported interpolation data from the model.

For the common case where the data source contains function values that are functions of the spatial coordinates,
select the Use space coordinates as arguments check box. Then select the frame to which the spatial coordinates are
attached from the Frame list (the default is Spatial for the spatial frame). Then the function can be called without
arguments when used in the model; the spatial coordinates are added as function arguments automatically. The Use
space coordinates as arguments check box is available for Interpolation nodes in a Component branch when the Data

source is File or when using a Table in 1D models.

The Interpolation functions support 1, 2, or 3 arguments. You cannot

define functions with more than three (3) arguments because the

[

algorithm creates a mesh for the point cloud, which is not possible in four

dimensions or higher.

An Example of Importing a File Data Source into a Parameter Table
The file named temp.txt contains temperature measurements in nine points in the plane:

10 3 310
20 3 309
30 3 314
10 6 302
20 6 307
30 6 311
10 9 307
20 9 308
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20 9 314

The data columns contain x-coordinates, y-coordinates, and temperature values, respectively. To use this file as an

interpolation function called tempfun, perform the following steps.

I Select File from the Data source list.
Enter a Filename (the complete network path) or Browse to locate a file to import.

From the Data format list sclect Spreadsheet.

2
3
4 Enter a Number of arguments. In this example, enter 2.
5 Enter the Function name tempfun.

6

Enter its Position in file as 1. The first function in the file has position 1, the following has position 2, and so on.
The position in file for a function is the column after the spatial coordinates (or other function arguments) where

it is defined. In this example with two arguments (spatial coordinates), the third column is Position 1 in the file.

7 If desired, adjust the interpolation and extrapolation settings in the Interpolation and Extrapolation section (see

below).

Use the function tempfun with x and y as input arguments in a 2D model to get the interpolated value for the
temperature at any position. If the Use space coordinates as arguments check box is selected, use tempfun without

adding the input arguments.

Examples of Spreadsheet, Sectionwise, and Grid File Formats

Spreadsheet File A spreadsheet file contains unstructured mesh and function data for space-dependent functions

or general input variables and function values for functions of one or more variables.

%Header (optional)
Columns containing x, y (optional), and z (optional), or any other arguments, followed
by function data columns.

Include function names in the header. In that case, the input columns must be labeled with x, y, and z, respectively,

depending on input dimension. For example, a file with the following content creates two 2D functions named
myfuni and myfun2:

x y myfuni myfun2
0 0.12 0.34
1 0.52 1.50
0 0.67 0.91

If the file does not include any header to indicate the function dimension, the software assumes that it is identical
to the largest geometry dimension present in the model. A file with four columns, for example, is interpreted as
one 3D function in a 3D Component model, two 2D functions in a 2D Component model, and three 1D functions

in a 1D Component model.

Sectionwise File A sectionwise file has coordinates and function values.

%sCoordinates

One to three columns containing x, y (optional), and

z (optional)

%sElements

Triangulation where each row contains the row indices of the
points in the Coordinates section that make up one element
(triangular in 2D, tetrahedral in 3D)

%Data (funname)

Column of data values for each point

It is possible to include more than one function in the file as long as a %Data header separates them one from the

other.
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Grid File A grid file

%Grid

X grid points separated by spaces

y grid points separated by spaces (optional)

z grid points separated by spaces (optional)

%Data

Data values separated by spaces
Each row contains values for different x grid points for fixed values of ¥ and z. The rows first increase the y grid
value and then the z grid value. The grid points can also represent another independent variable that the data values
depend on. For example, the “grid points” can be temperature values and the data values the thermal conductivity

at these temperatures.

It is possible to include more than one function in the file as long as a %Data header separates them one from the
other.

It is important to use a comment line starting with % to separate the grid
n points or other interpolation points and the data values that are associated

with these coordinates or interpolation points.

INTERPOLATION AND EXTRAPOLATION
The interpolation and extrapolation settings control how the program evaluates the function between the discrete
points where it is defined by the table or file, and the behavior of the function outside the domain where it is defined

by the table or file.

Select an Interpolation method:

» For functions of one variable select Nearest neighbor, Linear (the default interpolation method), Piecewise cubic,
or Cubic spline.
- Nearest neighbor interpolation selects the value of the nearest point where the function is defined.
- Linear interpolation uses a linear polynomial to interpolate the function between the points where it is defined.

- Piecewise cubic interpolation uses a piecewise-cubic Hermite polynomial with continuous first derivatives. It

preserves the shape of the data and respects monotonicity.

- The Cubic spline method also performs interpolation with a piecewise cubic polynomial. Here, even second

derivatives are continuous; however, the method does not necessarily respect monotonicity.
» For functions of more than one variable, select Nearest neighbor or Linear. The other options are not supported.
Select an Extrapolation method to specify how to treat arguments outside the grid or mesh of points.
* Constant. Uses the value from the closest point inside the grid (for structured interpolation) or the value from

the closest mesh element (for unstructured interpolation). The function evaluates the polynomial from the

closest grid point at the actual point where a value is requested. This is the default extrapolation method.

¢ Linear. The function is linear outside the grid with a continuous function value and continuous first derivative at

the boundary of the grid. Piecewise cubic or Cubic spline must be selected from the Interpolation list.
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* Nearest function. Evaluates the polynomial from the closest grid point at the actual point where a value is
requested.

* Specific value. Uses a single value, such as zero or NaN (Not-a-Number), everywhere outside the grid or mesh.

Enter the value in the Values outside range ficld.

l___|- Unstructured extrapolation supports a constant or a specific value only.

PLOT PARAMETERS
If you have selected to define the inverse function, this section becomes available. Select the Plot the inverse function
check box to plot the inverse function instead of the interpolation function itself when you click the Plot button

([&m]) to generate a preview plot.

A plot group for an interpolation function contains three connected line graphs: a line graph of the piecewise
function and two line graphs using dashed red lines, Left Extrapolation and Right Extrapolation, which show how
the selected extrapolation extends the interpolation function on both sides. In addition, a point graph shows the

interpolation points (interpolation nodes).

* See Common Settings for the Function Nodes for information about
'& the Units section.

If you have the:

* Acoustics Module, see Muftler with Perforates: model library path

Acoustics_Module/Industrial_Models/perforated_muffler.

* CFD Module, see Transonic Flow in a Sajben Diffuser: model library
path CFD_Module/High_Mach_Number_Flow/sajben_diffuser.

¢ Corrosion Module, see Cathodic Protection of Steel in Reinforced
Concrete: model library path

Corrosion_Module/Cathodic_Protection/cathodic_protection_in_concrete.

e Heat Transfer Module, see Temperature Field in a Cooling Flange:
Tl model library path

Heat_Transfer_Module/Thermal_Processing/cooling_flange.

* Molecular Flow Module, see Knudsen’s Minimum: model library path

Molecular_Flow_Module/Benchmark_Models/knudsen_minimum.

* Pipe Flow Module, see Geothermal Heating from a Pond Loop: model
library path Pipe_Flow_Module/Heat_Transfer/geothermal_heating.

* Structural Mechanics Module, see Nonlinear Magnetostrictive
Transducer: model library path
Structural_Mechanics_Module/Magnetostrictive_Devices/nonlinear_magnet

ostriction.
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MATLAB

A LiveLink™ for MATLAB® license is required. Also confirm that
n MATLARB is installed on the same computer as COMSOL Multiphysics.

Use MATLAB functions node (*a) from COMSOL to interface to functions written in MATLAB. These functions
can be used as any other function defined in COMSOL. MATLAB functions are evaluated in MATLAB. You select
a MATLAB function node from the Functions submenu.

FUNCTIONS

Under Functions, add the names of the MATLAB functions in the Function name column, and for each function in
the table, enter a space-separated or comma-separated list of the names of its input Arguments (x y, for example).
Click the Clear Functions button to force a reload of the functions if they have been edited. Alternatively, you can

select the Clear functions automatically before solving check box.

* Go to Common Settings for the Function Nodes for information

'El about the Derivatives and Plot Parameters sections.

* The LiveLink™ for MATLAB® User’s Guide

Piecewise

A Piecewise function ( /*, ) is created by splicing together several functions, each defined on one interval. Define
the argument, extrapolation and smoothing methods, and the functions and their intervals. The piecewise function
is a function of one variable with different definitions on different intervals, which must not overlap or have any
holes between them. The default Function name is pw1.

To add a global or local (for any Component) Piecewise function:
* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Piecewise from the
Functions>Global or Functions>Local menu, or

¢ Right-click the Global Definitions (-jé_ju) node or the Definitions ( = ) node and choose it from the Functions
submenu.

DEFINITION

Enter a name for the argument to the piecewise function in the Argument ficld.

Select an Extrapolation method to control what happens when the function is evaluated in a point that does not

belong to any interval— Constant (the default), None, Nearest function, Specific value, or Periodic.
e Constant. Uses the function value from the endpoint of the closest interval. Uses the value from the start point
of the first and the end point of the last interval on the corresponding sides.

* None. Evaluation fails outside of the intervals where it is defined. Trying to evaluate the function generates an
error and evaluates to NaN (Not-a-Number).

¢ Nearest function. Evaluate the function from the closest interval. The function at the first or last interval

(depending of the side) is used to evaluate at the actual point where a value is requested.

¢ Specific value. Also enter a value in the Value outside range ficld. If selecting the specific-number method, assign

a single value (usually zero or NaN) to all points outside the intervals.
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* Periodic. The function becomes periodic by repeating its values in the interval where it is defined in regular
intervals of the same size.

Select a Smoothing: No smoothing (the default), Continuous function (to make the function continuous but not its
derivatives), Continuous first derivative, or Continuous second derivative. For any selection (except No smoothing),
enter a value in the Relative size of transition zone ficld (dimensionless). The default is 0.1. Relative size means
relative in relation to the size of the intervals on both sides of the border.

The functions in contiguous intervals need not evaluate to the same value
where the intervals meet. If the values differ the function has a

discontinuity, and it is reccommended that you apply smoothing to make

[

the piecewise function more well-behaved numerically. Functions from

neighboring intervals are then blended close to where the intervals meet.

For each cell in the Intervals table, enter Start and End interval limits. The intervals must not overlap, and there

cannot be any holes between intervals. Enter an expression defining the Function.

n The intervals must be contiguous.

A plot group for a piecewise function contains three connected line graphs: a line graph of the piecewise function
and two line graphs using dashed red lines, Left Extrapolation and Right Extrapolation, that show how the selected
extrapolation extends the piecewise function on both sides.

See Common Settings for the Function Nodes for information about the
'El Units section.

If you have the Heat Transfer Module, see Radiative Heat Transfer in a
i Utility Boiler: model library path
Heat_Transfer_Module/Thermal_Radiation/boiler.

Ramp

A Ramp function (/) is a linear increase with a user-defined slope that begins at some specified time. The ramp
function is a function of one variable (the time ¢, for example). The default Function name is rm1.
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To add a global or local (for any Component) Ramp function:

¢ On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Ramp from the

Functions>Global or Functions>Local menu, or

=)) node or the Definitions ( = ) node and choose it from the Functions

* Right-click the Global Definitions (|

submenu.
* See Naming Functions for information about the Function Name
section.
@ * See Common Settings for the Function Nodes for information about
the Smoothing section.
PARAMETERS

Enter a Location value s for the start of the ramp. The function evaluates to 0 for values less than its start location

and increases linearly for values greater than the location.

If the Smooth at start check box is selected under Smoothing, then the
Ramp function can become nonzero at some time before the location
value. A model might not solve due to the possible inconsistencies

A between the ramp excitation and the initial condition (for example, the
initial condition is zero, but the ramp function returns a small nonzero

value at the starting time for the simulation).

Enter a Slope £ (dimensionless) of the ramp. The default is 1.

To ensure that the value never exceeds a certain point, select the Cutoff check box and enter a value. The default is
1. For an input variable s, a start location s, and a slope %, the ramp function’s value is 0 for s<sg and k(s—s) for

$28(.

Random

A Random function (4 ) generates white noise with uniform or normal distribution and has one or more

arguments to simulate white noise. Its distribution is either uniform or normal. The default Function name is rn1.

To generate a random function of the spatial coordinates x, y, and z, for example, use this function with three input
variables—it returns the same value each time it is called for a given set of input arguments. To do a Monte Carlo

simulation, add one or more additional input arguments that vary during a parametric sweep, for example.
To add a global or local (for any Component) Random function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Random from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (|

submenu.

1) node or the Definitions ( = ) node and choose it from the Functions

'El See Naming Functions for information about the Function Name section.
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PARAMETERS

Enter a Number of arguments to the random function (the default is 1). Select a Distribution method—Uniform (the
default) or Normal. If Uniform is sclected, enter a Mean and Range. The default mean and range is 0 and 1,
respectively. The range is the difference between the largest and smallest values that the function can return. If

Normal is selected, enter a Mean and Standard deviation. The defaults are 0 and 1, respectively.

Rectangle

A Rectangle function ( [ ) is 1 in an interval and 0 everywhere else. This function (also called top hat or boxcar) is
useful for band-pass filtering; you can use it to select values within an interval. It can also simulate a signal that is
turned on during an interval or a load that is active on a part of a boundary, for example. The rectangle function is

a function of one variable (the time ¢, for example). The default Function name is rect1.
To add a global or local (for any Component) Rectangle function:

¢ On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Rectangle from the
Functions>Global or Functions>Local menu, or
¢ Right-click the Global Definitions (-jéljn) node or the Definitions ( = ) node and choose it from the Functions

submenu.

LIMITS
Enter a Lower limit (the default is —0.5) and Upper limit (the default is 0.5) to specify the interval for the rectangle
function. For example, if the input argument is time, enter a start and end time. This function evaluates to 1 for

values within the interval from the lower limit to the upper limit. Outside the interval it evaluates to 0.

* See Naming Functions for information about the Function Name
section.
El. * See Common Settings for the Function Nodes for information about

the Smoothing section.

If you have the Batteries & Fuel Cells Module, see Soluble Lead-Acid
i Redox Flow Battery: model library path
Batteries_and_Fuel_Cells_Module/Batteries/pb_flow_battery.

Step

A Step function (_[" ) is a sharp transition from 0 to some other value (amplitude) at some location (a certain time,
for example). Create a single step function with a certain amplitude from an initial level to a final level at a start
location. The step function is a function of one variable (the time ¢, for example). The default Function name is

stepl.
To add a global or local (for any Component) Step function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Step from the

Functions>Global or Functions>Local menu, or

* Right-click the Global Definitions (:j%_]) node or the Definitions ( = ) node and choose it from the Functions

submenu.
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PARAMETERS

Enter a Location (sg) of the step. The value of the step function is the initial level for input values that are smaller
than the location of the step. In the From field, enter a start level (Lggap ). In the To field, enter a final level (Lepq)-
For an input variable s, a start location s, and initial level L, and a final level L4, the step function’s value is

L, for s <sgand Lgyq for s > sg. The amplitude of the step is Lenq — Lgtart

¢ See Naming Functions for information about the Function Name
section.

'& * See Common Settings for the Function Nodes for information about

the Smoothing section.

Fluid Valve: model library path
il COMSOL_Multiphysics/Fluid_Dynamics/fluid_valve

Thermodynamics Package

COMSOL provides a Thermodynamics Package feature to enable the linking to external physical and thermodynamic

property calculations for use in the Chemical Reaction Engineering Module.

For more information see the Chemical Reaction Engineering Module
'El User’s Guide.

Triangle

A Triangle function ( /) is a linear increase and linear decline within an interval and 0 everywhere else. You can
use the triangle function for band-pass filtering, for example; that is, use it to select values within an interval. The

triangle function is a function of one variable (the time ¢, for example). The default Function name is trif.
To add a global or local (for any Component) Triangle function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Triangle from the
Functions>Global or Functions>Local menu, or
¢ Right-click the Global Definitions (-jé_ju) node or the Definitions ( = ) node and choose it from the Functions

submenu.

LIMITS

Enter a Lower limit (the default is —0.5) and Upper limit (the default is 0.5) to specify the interval for the triangle
function. For example, if the input argument is time, enter a start and end time. In the midpoint of the interval,
this function evaluates to 1, and moving toward the interval boundaries it falls off to 0. Outside the interval it

evaluates to 0.

* See Naming Functions for information about the Function Name
section.
El. * See Common Settings for the Function Nodes for information about

the Smoothing section.
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Waveform

A Waveform function (/i ) is a periodic function with one of several characteristic shapes: sawtooth, sine, square,
or triangle. The waveform function is a function of one variable (the time ¢, for example). The default Function name

is wv.
To add a global or local (for any Component) Waveform function:

* On the Home toolbar (Windows users) or Main toolbar (Mac and Linux users) select Waveform from the
Functions>Global or Functions>Local menu, or
¢ Right-click the Global Definitions (-jé_ju) node or the Definitions ( = ) node and choose it from the Functions

submenu.

See Naming Functions for more information about the Function Name

'El section.

PARAMETERS
Select a waveform Type: Sawtooth, Sine (the default), Square, or Triangle. For any selection, enter Angular frequency
(default is 1), Phase (unit: radians; the default is 0), and Amplitude (default is 1) values.

If you have the Batteries & Fuel Cells Module, see 1D Lithium Ion
Battery Model for Thermal Models: model library path
ii“ Batteries_and_Fuel_Cells_Module/Batteries/li_battery_ld_for_thermal_mode

Is.

Specifying Discontinuous Functions

To specify a discontinuous function, such as a step in space or time, you can use logical functions that evaluate to
1 if true and O otherwise. For instance, the following function defines a sine wave that exists for 10 seconds and

afterward takes the value 0:
sin(2*pi*t)*(t<10)

If a coefficient or a material property contains a step function or some other discontinuity, convergence problems
can arise. For time-dependent problems, the time-stepping algorithm can run into problems. For stationary
problems, mesh-resolution issues can arise such as overshooting or undershooting of the solution due to infinite
flux problems. To avoid problems with a discontinuity, replace it with a smoothed step function that emulates steps.

Doing so serves two purposes:

* Numerical reliability and convergence are improved.

e What is thought of as a step function is, in reality, a smoothed continuous function because of inertia.

SMOOTHING OF DISCONTINUOUS FUNCTIONS

The easiest way to create a smooth step is to use the predefined Step function. It includes smoothing by default.
The Piecewise, Ramp, Rectangle, and Triangle functions also include smoothing (active by default for Rectangle
and Triangle functions).

Smoothed Step and Rectangle functions are defined by piecewise 5th-degree polynomials, smoothed Ramp
functions by piecewise 4th-degree polynomials, and smoothed Triangle functions by piecewise 3rd-degree

polynomials. None of these functions have any overshoot or undershoot.
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ADDITIONAL SMOOTHED FUNCTIONS

In addition, the following smoothed functions are available:

flsmhs, a smoothed step function, or Heaviside function, with a continuous first derivative and overshoot on
both sides of the step. The overshoot ensures that the integral from 0 to infinity is correct. y=f1smhs (x,scale)
approximates the logical expression y = (x>0) by smoothing the transition within the interval

—scale < x < scale. fldsmhs is the derivative of the smoothed Heaviside function.

flsmsign, a smoothed sign function with a continuous first derivative. y = flsmsign(x,scale) approximates
the functiony = sign(x) by smoothing the transition within the interval —scale < x < scale. f1ldsmsign is the
derivative of the smoothed sign function.

flc1hs, a smoothed Heaviside function with a continuous first derivative without overshoot. Its syntax is similar

to the functions just described.

flc2hs, a smoothed Heaviside function with a continuous second derivative without overshoot. Its syntax is

similar to the functions just described.

These functions can be useful as a complement and extension to the predefined Step function. In the interval

-scale<x<scale, the functions f1lsmhs and flsmsign are defined by a 7th-degree polynomial chosen so that the

2nd derivative is continuous. Moreover, the moments of order 0, 1, and 2 agree with those for the Heaviside

function and the sign function, respectively. This implies that the functions have small overshoots.

Now consider an example. Use flc1hs to model the heat capacity C), of a phase-changing material. Assume that a

crystalline material has a heat capacity of 1 kJ /kg. Its melting point at the present pressure is 273.15 K. The liquid

phase has a heat capacity of 2 kJ /kg. Create a parameter scale with a value of 0.1 and then an Analytic node where

an analytic function HeatCapacity is defined using the following expression with an argument T:
1+flc1hs(T-273,scale); then define a plot range of 272.5-273.5 K under Plot Parameters and click the Plot

button in the Analytic scttings window to plot C,, around the melting point.
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Component Couplings

About Component Couplings and Coupling Operators

Component Coupling was previously called Model Coupling.

[

Component conplings establish couplings between different parts of a model or between different models. A

component coupling is defined by a coupling operator, taking an expression as its argument. When the operator is
used at a point in the destination, the value is computed by evaluating the argument in the source. You can use a
coupling operator to compute several quantities that use the same source and destination by calling it with different

arguments. All types of component couplings have a source and a destination.

Scalar coupling operators, such as the Integration coupling operator, have
a global destination that does not need to be defined; the values are

[

available globally.

The source is a subset of a single model (such as some domains or boundaries) where the coupling operator
evaluates the supplied expression (as an integration over the source, for example), while the destination is the part
of the geometry where the result of the coupling operator is defined. The destination can, depending on the type
of coupling, be a subset of one or several models or a “global destination” (for a scalar value that is available
everywhere). The coupling operator’s value is computed by evaluating the expression given as an argument at one
or several points in the source. The source and destination are both geometrical objects, but the source is limited

to one geometry whereas the destination is often global.
To add a Component Coupling to any Component:

¢ On the Definitions toolbar select features from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose an option from the Component Couplings submenu.

ABOUT COUPLING OPERATORS

Coupling operators are useful for modeling coupled problems and are generalizations of expressions. They are
defined by first selecting the source, where the argument of the operator is evaluated, and, in some cases, a
destination. An expression to evaluate is not required when you define a coupling operator; instead you can use
coupling operators in different modeling contexts, passing the expression to evaluate as an input argument.

There are three categories of coupling operators:

e Extrusion. These operators—General Extrusion, Linear Extrusion, Boundary Similarity, and Identity
Mapping—connect a source and a destination and take an expression as an argument. When it is evaluated at a
point in the destination, its value is computed by evaluating the argument at a corresponding point in the source.
When the source and destination are of the same space dimension, it is typically a pointwise mapping. When the
destination has a higher dimension than the source, the mapping is done by extruding pointwise values to the
higher dimensions. For some examples of the use of extrusion coupling operators, see Examples of Extrusion

Couplings.

* Projection. These operators—General Projection and Linear Projection—evaluate a series of line or curve
integrals on the source, where the line or curve positions depend on the positions of the evaluation points in the

destination. In this way it is possible to compute the integral of an expression over one space variable for a range
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of different points along the other space axis, giving a result that varies over the latter space variable. For example,
you can obtain the average along the y direction of a variable u defined on some 2D domain in the xy-plane by

computing the integral
w) = [ulxy)dy

COMSOL uses a method whereby it first applies a one-to-one map to the mesh of the source. It then carries out
the integrals in the source over curves that correspond to vertical lines in the transformed source mesh. You can
define the map between source and destination in two ways: as a linear projection or as a general projection.

For some examples of the use of projection coupling operators, see Examples of Projection Couplings

e Scalar. These operators—Integration, Average, Maximum and Minimum—define a scalar value such as an
integration, the average over a set of geometric entities, or the maximum or minimum value of an expression and

have a “global destination” (that is, they are available everywhere in the model):

- An Integration coupling operator is the value of an integral of an expression over the source, which is a set
of geometric entities (domains, for example).

- An Average coupling operator computes the average of an expression over the source.

- A Maximum or Minimum coupling operator computes the maximum or minimum, respectively, of an
expression over the source.

These operators can be evaluated anywhere in a model, and the value does not depend on where in the model
the evaluation occurs. Integration couplings are useful for evaluating integrated quantities. To evaluate the total
current across a boundary in a 2D Electric Currents model, for example, define an integration coupling operator
intop1 with a source on the boundary where the current flows. Then the value of intop1(ec.normd*ec.d),
where normd is the current density norm (SI unit: A/ m2) and d is the thickness of the 2D geometry (SI unit:
m), is the total current flowing across that boundary (SI unit: A). For some other examples of the use of

integration coupling operators, see Examples of Integration Couplings
Coupling operators can:

* Make the value and the exact Jacobian of an expression available nonlocally.

¢ Take information from a boundary, for example, and make it available on other parts of a model (a domain, for

example).
¢ Be used for results evaluation and visualization purposes.

* Define nonlocal couplings including mesh transformations, integrals over domains and boundaries, and

projections.
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ABOUT SOURCE AND DESTINATION MAPPINGS

Destination
(3D domain)

Source
(2D boundary)

Destination
transformation

Source
transformation

Intermediate mesh
(2D, planar)

Figure 5-1: An example of a general extrusion mapping.

The definition of any extrusion component coupling involves two mesh maps. The source map is a one-to-one
mapping that maps the mesh of the physical source of dimension srcedim to an intermediate mesh of the same
dimension embedded in a space of dimension idim > srcedim. The destination map is a mapping from the
destination of dimension dstedim, where the operator can be evaluated, to the same space that contains the

intermediate mesh.

When the value of the coupling operator is requested somewhere in the destination, the software transforms the
destination points using the destination map. It compares the resulting coordinates to the elements in the
intermediate mesh to find corresponding locations in the physical source. This means that the source map must be
inverted but not the destination map. The latter can in fact be noninvertible, which is, for example, the case when

dstedim > idim, leading to an extrusion.

To avoid the need to solve a nonlinear system of equations for every destination point, COMSOL assumes that the
source map is linear on each element of the intermediate mesh. In practice, the map is often trivial and leaves the
coordinates unchanged, but it can also rescale, stretch, bend, or reflect the mesh.

EXAMPLES OF EXTRUSION COUPLINGS

All the graphics in these examples use General Extrusion component
» .
|E coupling.

One application of a General Extrusion coupling is to mirror the solution on the x-axis.

. This can be useful for analysis. Both source and destination are two-dimensional, as
Do Y well as the intermediate mesh (srcedim = idim = dstedim). The source map to enter
is X, Y, and the destination map is x, -y. This can also be done with Linear Extrusion.
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Another General Extrusion example is to extrude the solution in the 1D geometry to
a 2D domain along the s-axis. The source map is x, and the destination map is r, so
here srcedim = idim = 1, dstedim = 2.

-

Another example maps values on the lower boundary of a rectangle that extends from
x=-1tox=1and fromy =0 toy =1, to the right boundary on the same rectangle.

The source map is (x+1) /2 and the destination map is y. Both maps have a single

r~

component since srcedim = idim = dstedim. This map is also linear and can be done

with General or Linear Extrusion, or with Boundary Similarity.

Extrusion Component Coupling—Example 2

Consider the case of a single rectangular domain where the source term in Poisson’s

y coordinate.

equation comes from the inward flux over the right boundary for the corresponding

0
-Au = —u(x,, on Q
an ( 23’)
u =xy on 0Q)

The figure to the left illustrates the extrusion process. The values of the influx on the

boundary become available throughout the domain by extrusion along the y-axis.

The source map is y, and the destination map is y.

EXAMPLES O

F PROJECTION COUPLINGS

All the graphics in these examples use the General Projection component

2

coupling. These examples can also be done using Linear Projection.

Projection Coupling—Example |

For each point r, the coupling operator returns the integral

(i

CHAPTER 5:

RN u(r) = I u(x,y)dx
y=r/2
(x,5) €S,
—
r

The source map is y, x, and the destination map is r/2.
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Projection Coupling—Example 2

For each point (0, s), the coupling operator returns the integral

v(0,s) = I u(x,y)dx

y=s
(x,y) €S,

The source map is y, x, and the destination map is s.

For each point (7, 0), the coupling operator returns the integral

u(r, 0) = j

y=r/2
(x,y) €S,

u(x,y)dx

The source map is y, x, and the destination map is r/2.

The integration can also sweep nonrectangular domains. The integrals

!

external area.

include only the source domains; they exclude other domains and the

Consider the case of a single rectangular domain with Poisson’s equation. Integrate the solution squared along lines

parallel to the x-axis and make the result available for analysis on the left boundary.

X9 X

-Au =
u

1 onQ
0 on oQ

genproji(u~2).

EXAMPLES OF INTEGRATION COUPLINGS

R
.:->
A

The figure illustrates the projection process. Project the integral of the solution
squared on the boundary. The source map is y, x and the destination map is y. If the
1

projection operator is called genproj1, the desired result is obtained by evaluating

Consider Poisson’s equation on a rectangular domain. The integral of the solution

L

X boundaries have zero influx.
-Au =1 on Q
u=x on 0Q
ou
- 0 on 692’ 3
ou _ —IMZdQ on 0Q,
on o
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squared serves as the influx in a Neumann boundary condition on the right boundary.

There is a Dirichlet boundary condition on the left boundary, and the top and bottom
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For example, define an integration coupling operator called intop1, with the rectangular domain as source. The
influx for the Neumann boundary condition is obtained as intop1(u*2).

A second example is when a scalar value from a vertex is used everywhere on a

boundary to which the vertex belongs. In structural mechanics use this type of

ry coupling to formulate displacement constraints along a boundary in terms of the
v Y displacements of the end point. In electromagnetics the same technique can

implement floating contacts.

-« -------

Another example is to use the integral over a domain in a 2D geometry along a
yT domain in another 1D geometry. This approach is helpful for process-industry models

where two processes interact.

m

v
—
r
Integration coupling operators can implement integral constraints. First define a
IR coupling operator at some vertex in such a way that it represents the value of the
TN . . . . .
L, integral to be constrained. Then use a point constraint to set the coupling operator,
-

T and thereby the integral, to the desired value.

yL

X

NONLOCAL COUPLINGS AND THE SPARSITY OF THE JACOBIAN

The Jacobian for problems formulated using the finite element method is usually large
but sparse. This is because the solution at each mesh node can depend at most on the degrees of freedom at the
neighboring mesh elements. However, by introducing nonlocal component couplings using coupling operators,
nonlocal dependencies are created that fill up the rows and columns of the affected source and destination nodes.
These additional elements might make the Jacobian matrix only slightly less sparse, with marginal effects on
solution speed; they can also make it a great deal less sparse, in which case memory use and CPU time involved in
solving the problem increases considerably. For this reason, take particular care when introducing nonlocal
couplings. For example, defining a heat source based on an integration operator over the whole domain that is also
a function of temperature (the dependent variable) leads to a coupling between all the degrees of freedom in the

model creating a full Jacobian matrix instead of the sparse limited-bandwidth matrices typical of finite element

models.
You can prevent the fill-in of the Jacobian matrix using the nojac
operator, which forces COMSOL to exclude the expression that it
encloses when forming the Jacobian. Using the nojac operator can slow
g down the convergence of the solution. Another possible solution is to add

a single degree of freedom that represents the value of an expression with

a scalar coupling operator.

General Extrusion

A General Extrusion coupling operator (%57) maps an expression defined on a source to an expression that can be
evaluated on any destination geometry where the destination map expressions are valid. Compared to the Lnear

extrusion, these operators define a more general, possibly nonlinear, relation between source and destination.
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Specifically, when the destination has more space dimensions than the source, the operator performs extrusion of
values. The default Operator name is genext1.

To add a General Extrusion Component Coupling for any Component:

* On the Definitions toolbar select General Extrusion from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information

'& about the Operator Name, Source Selection, Source, and Advanced sections.

DESTINATION MAP

Specify the general extrusion destination map by entering an expression in the x-expression, y-expression, and
z-expression fields. This maps each point in the destination to a point in the intermediate mesh, where the argument
of the extrusion operator is evaluated. A general extrusion operator can be evaluated at any point where the

destination map expressions are defined.

The number of destination map expressions is the same as the space

dimension of the intermediate mesh. For example, if the intermediate

[

mesh is in two-dimensional space, there is no z-expression ficld.

If you have the:

* Acoustics Module, see Flow Duct: model library path

Acoustics_Module/Industrial_Models/flow_duct.

* Chemical Reaction Engineering Module, see Packed Bed Reactor:
model library path
Chemical_Reaction_Engineering_Module/Packed_Bed_Reactors/packed_be

d_reactor.

ii“ ¢ Geomechanics Module, see Concrete Beam With Reinforcement Bars:
model library path

Geomechanics_Module/Tutorial_Models/concrete_beam.

* RF Module, see Radar Cross Section: model library path
RF_Module/Scattering_and_RCS/radar_cross_section.

* Subsurface Flow Module, see Aquifer Characterization: model library

path Subsurface_Flow_Module/Fluid_Flow/aquifer_characterization.

Linear Extrusion

A Linear Extrusion coupling operator ([£]) maps an expression defined on a source to an expression that can be
evaluated in the destination. Use this to define a linear mapping of this kind. Linear extrusion can be used when
the correspondence between evaluation points in the source and destination is linear and in some nonlinear cases.
Otherwise, use a general extrusion coupling. The Linear Extrusion operator defines a linear extrusion that maps
between geometric parts of the same dimension. The parts can exist in geometries of different space dimensions.
For example, you can couple edges (boundaries) in 2D to edges in 3D; or couple 2D domains to 3D faces. In these
cases geometries of different space dimensions are needed for the source and destination. You define the linear

extrusion by specifying points in both source and destination. The default Operator name is 1inext1.
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To add a Linear Extrusion Component Coupling for any Component:

¢ On the Definitions toolbar select Linear Extrusion from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information
'El about the Operator Name, Source Selection, Source, Source Vertices,

Destination Vertices, and Advanced, scctions.

DESTINATION

The mapping from destination to source is defined as the following:

* First, the destination is orthogonally projected onto the linear space spanned by the destination vertices.

* Then this linear space is mapped linearly to the source, so that each destination vertex is mapped to the
corresponding source vertex.

Select an option from the Destination geometry list if there is more than one geometry in the model. A linear

extrusion operator can only be evaluated on the destination geometry and the destination vertices must be chosen

in the destination geometry. Select an option from the Destination frame to evaluate the destination vertex

coordinates in the specified frame.

* Ifyou have the CFD Module, see Turbulent Flow Over a Backward
Facing Step: model library path
CFD_Module/Single-Phase_Benchmarks/turbulent_backstep.
i * If'you have the Heat Transfer Module, see Turbulent Flow Over a
Backward Facing Step: model library path
Heat_Transfer_Module/Verification_Models/turbulent_backstep.

Boundary Similarity

The Boundary Similarity coupling operator ([ {|) maps an expression defined on a part of a boundary to another

part of a boundary with the same shape. This operator is slightly different for 2D and 3D models:

e In 3D, the destination map is a similarity that maps a destination boundary onto a set of source boundaries. The
mesh is always viewed in the mesh frame. By default, the algorithm automatically chooses a map when symmetries

make several maps possible. To control this choice in 3D, add a One-Point Map, Two-Point Map, or Edge Map
subnode ( ).

- Edge Map: Specify that a certain destination edge should be mapped onto a certain source edge. The edge’s
relative direction is given by the property direction. The edges must be adjacent to the given boundary.

- One-Point Map: Specify that a certain destination vertex should be mapped onto a certain source vertex.
- Two-Point Map: Specify that two destination vertices should be mapped onto two source vertices.
¢ In 2D, it works the same except the destination map is a similarity that maps a destination edge onto a set of

source edges and there are no subnodes to add.

The default Operator name is bndsim1.
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To add a Boundary Similarity Component Coupling for any Component:

¢ On the Definitions toolbar select Boundary Similarity from the Component Coupling menu, or

* Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information
'El about the Operator Name, Source Boundaries and Destination Boundary
sections, as well as the rest of the Advanced, section.

ADVANCED

For 2D models, select a relative Direction of the source and destination

edges—Automatic orientation (the default), Same orientation, or Opposite
Q orientation. This specifies the relative direction of the source and

boundary edges and specifies which one of the two possible similarity

mappings between the source and destination edge to use.

For 3D models, a similar direction functionality is provided by the
subnodes One-Point Map, Two-Point Map, and Edge Map to exactly

| specify the similarity mapping between the source and destination when
more than one possibility exists.

Select the Use source map check box to have a nonlinear correspondence between the source and destination. The

source map is specified by entering expressions in the x-expression, y-expression, and z-expression fields.

Only one map node is allowed per boundary similarity coupling and only

n one source or destination point per field is allowed.

One-Point Map

Use a One-Point Map to control a Boundary Similarity component coupling mapping in 3D. Right-click the
Boundary Similarity node to add a One-Point Map subnode.

POINTS

To select a single Point on source and a single Point on destination adjacent to the source and destination selection,

click the Active button to toggle between turning ON and OFF selections. For Windows users, the buttons are
o ] and [Fjorf] - For Mac and Linux users the buttons are ({1} ) for ON, and ( (!} ) for OFF.

Then define the source or destination boundaries. Select Manual or All points for the points on the source or
destination side. If Manual is selected, click in the Graphics window to add points to the Selection section. If required,

click the Swap source and destination button ( I ).

Two-Point Map

Use a Two-Point Map to control a Boundary Similarity component coupling mapping in 3D. Right-click the

Boundary Similarity node to add a One-Point Map subnode.
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SOURCE POINTS

To select a single First point on source and a single Second point on source, click the Active button to toggle between
turning ON and OFF selections. For Windows users, the buttons are [an [ and [FJarf] - For Mac and Linux users
the buttons are ({13 ) for ON, and ( {1} ) for OFF.

Then define the source or destination points. Select Manual or All points for the points on the source. If Manual is
selected, click in the Graphics window to add points to the Selection section. If required, click the Swap Source and
Destination button ( I ).

DESTINATION POINTS
To select a single First point on destination and a single Second point on destination adjacent to the destination

selection, click the Active button to toggle between turning ON and OFF selections. For Windows users, the
buttons are [y [ and [Jarr| . For Mac and Linux users the buttons are ({3 ) for ON, and ( (!} ) for OFF.

Then define the source or destination points. Select Manual or All points for the points on the source or destination
side. If Manual is selected, click in the Graphics window to add points to the Selection section. If required, click the

Swap Source and Destination button ( I ).

Edge Map

Use an Edge Map to control a Boundary Similarity component coupling mapping in 3D. Right-click the Boundary
Similarity node to add a One-Point Map subnode.

EDGES

To select a single Source edge and a single Destination edge, click the Active button to toggle between turning ON
and OFF selections. For Windows users, the buttons are [on and [FTore] - For Mac and Linux users the buttons
are ((1y) for ON, and ( (1} ) for OFF.

Then define the source or destination edges. Select Manual or All edges for the edges on the source or destination
side. If Manual is selected, click in the Graphics window to add edges to the Selection section. If required, click the
Swap Source and Destination button ( | ). The destination edge is mapped to the source edge by the similarity

mapping from destination to source.

ADVANCED
Select a relative Direction of the source and destination edges—Automatic orientation (the default), Same orientation,
or Opposite orientation. This specifies the relative direction of the source and boundary edges and specifies which

one of the two possible similarity mappings between the source and destination edge to use.

Identity Mapping

An Identity Mapping component coupling ([#f]) maps between geometric entities that overlap, possibly when
viewed in different frames. When it is evaluated at a specific set of coordinates in the destination frame, its argument

is evaluated with the same coordinates in the source frame. The default Operator name is idmap1.
To add an Identity Mapping Component Coupling for any Component:

¢ On the Definitions toolbar select Identity Mapping from the Component Coupling menu, or

* Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

FRAMES
Select a Source frame to use on the source geometric entity and a Destination frame to use on the destination

geometric entity. In most cases the default Spatial (x,y,z) frame can be used in both cases. Or choose Material,
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Geometry, or Mesh, followed by the coordinate names: (x, y, z) or (X, Y, Z) depending on the physics. Choose a
Destination geometry from the list.

Go to Common Settings for Component Couplings for information

'& about the Operator Name, Source Selection, and Advanced sections.

If you have the CFD Module, see Solar Panel in Periodic Flow: model
ii“ library path CFD_Module/Single-Phase_Tutorials/solar_panel.

General Projection

Use a General Projection component coupling (@?ﬁ) to define integration along curves. A projection coupling
operator evaluates an expression defined on a source by integration along lines or curves depending on the
evaluation point in the destination. The General Projection operator is defined by mapping the source to an abstract
intermediate space of dimension srcedim, and the destination to the subspace of dimension srcedim—1 obtained
by setting the last coordinate to 0 (srcedim is the dimension of the source selection). To every point in the
destination, there is a vertical line in the intermediate space, obtained by allowing the last coordinate to vary while
the remaining coordinates are given by the destination map. The set of points in the source selection that are
mapped onto this line by the source map is a line or curve, and the projection operator is evaluated by integrating

along this line or curve. The default Operator name is genproji.

It is only possible to use projection component coupling with simplex

]
I_E| elements such as triangles and tetrahedra.

To add a General Projection Component Coupling for any Component:

¢ On the Definitions toolbar select General Projection from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information

'& about the Source Selection section.

SOURCE MAP
Specify the general projection source map by entering expressions in the x-expression, y-expression, and z-expression
fields.

The dimension of the intermediate space equals the dimension srcedim
of the source. If the selection has lower dimension than the source

B

geometry, specify only the first srcedim expressions.

Use expressions containing spatial coordinates in the source geometry when defining the map. The map must be

approximately linear within each mesh element. Select a Source frame from the list.
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DESTINATION MAP
Enter an x-expression and, depending on the dimensions, y-expression for each coordinate except the last in the

intermediate space.

The destination map has one field less than the source map. When defining the map you can use expressions
containing spatial coordinates in the destination geometry. The destination mapping can be highly nonlinear or

noninvertible.

¢ If the selection has lower dimension than the source geometry, specify only the first srcedim—1 expressions. A

general projection operator can be evaluated at any point where its destination map is defined.

¢ If the source selection has dimension 1, no destination map needs to be specified, and consequently this section

is not shown if the source geometry is 1D. In this case, it is probably better to use an integration coupling.

ADVANCED

Enter an Integration order of the numerical integration method (default: 4).

Linear Projection

Use a Linear Projection component coupling (%) when the argument is to be integrated along a line, and the line

depends linearly on the evaluation point.

The linear projection maps between a source and a destination of the nearest lower dimension. The source and
destination can exist in geometries of different space dimensions. For example, you can couple domains in 2D to
edges in 3D or couple 3D domains to 2D domains. You define the linear projection by specifying points in both
the source and destination. The default Operator name is 1inproji.

It is only possible to use projection component coupling with simplex

]
I_El elements such as triangles and tetrahedra.

To add a Linear Projection Component Coupling for any Component:

¢ On the Definitions toolbar sclect Linear Projection from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information
'El about the Operator Name, Source Selection, Source Vertices, and Destination

Vertices scctions.

SOURCE

Select a Source frame from the list to evaluate the coordinates of the source vertices in the selected frame.

Then specify the linear projection by giving a set of points in the source and in the destination. The order of the
vertices is significant. COMSOL constructs a linear projection from the source to the destination using the
subspaces spanned by the vertices. Denote the map rank by 72, denote the source vertices by xg, x1,..., %5, and
denote the destination vertices x'p, x'1,..., x ;. After padding the source and destination vertices’ vectors with zeros
as necessary, the software solves the following matrix equation for a transformation matrix T and a translation

vector V:
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xg=Txy+V
xy-x'g=T(xq-xp)
x,-x'g=T(x,-xq)
For the projection component coupling there must be one more vertex in the source than in the destination.

DESTINATION

Select an option from the Destination geometry list if there is more than one geometry in the model.

* Alinear projection operator can only be evaluated on the destination geometry and the destination vertices must

be chosen in the destination geometry.

¢ The destination vertex coordinates are evaluated in the selected Destination frame.

ADVANCED

Enter an Integration order of the numerical integration method (default: 4).

Integration

An Integration component coupling ( [4v) integrates an expression over the source (some selected geometric
entities like domains, boundaries, or edges). You can also use it with a point as the source to make the value of an
expression at that point available globally. The integral is evaluated by integrating the expression (integrand) in the
argument over the source (or, in some cases, by summing the expression over the node points in the source).
Integration coupling operators have global destination, so they can be evaluated anywhere in the model. Because
it is an operator, you can define one integration operator (intop1, for example) for a part of the geometry (a
boundary, for example) and then use that several times in the model to compute integrals over that boundary for
different integrands. For example, intop1(T) is the integral of the temperature 7" over the boundary, and
intop1 (1) is simply the length (2D) or area (3D) of the boundary. Also, using the dest operator it is possible to

create convolution integrals. The default Operator name is intop1.
To add an Integration Component Coupling for any Component:

¢ On the Definitions toolbar select Integration from the Component Coupling menu, or

* Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information

'El about the Operator Name, Source Selection, and Advanced sections.

e Acoustics of a Muffler: model library path:
COMSOL_Multiphysics/Acoustics/automotive_muffler

i  Fluid Valve: model library path
COMSOL_Multiphysics/Fluid_Dynamics/fluid_valve

Average

An Average component coupling (av ) computes the average of an expression over the source (some selected
geometric entities). It can be evaluated anywhere in any model. It is similar to the Integration operator; the

difference being that the integral is divided by the volume, area, arc length, or number of points in the source,
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depending on the type of geometric entities in the source. The default Operator name is aveop1.
To add an Average Component Coupling for any Component:

¢ On the Definitions toolbar select Average from the Component Coupling menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

Go to Common Settings for Component Couplings for information

'& about the Operator Name, Source Selection, and Advanced sections.

Effective Diffusivity in Porous Materials: model library path
il COMSOL_Multiphysics/Diffusion/effective_diffusivity

Maximum and Minimum

The Maximum (max) and Minimum (i) coupling operators compute the maximum or minimum of an expression
over selected geometric entities in the source and gives the maximum or minimum value of the expression in the
argument over the source. The operator can be evaluated anywhere in any model. Two arguments can be given,
and the returned value is then the value of the second argument evaluated in the max/min of the first argument.
This is useful for evaluating, for example, the location of the maximum or minimum. In a 2D model where the
temperature T'is solved for, use the following syntax for the maximum operator maxop1 in a Global Evaluation node,
for example, to get the x- and y-coordinate for the maximum of the temperature: maxop1 (T, x)and maxop1(T,y).
The default Operator name is maxop1 or minop1.

When a Max/Min Volume, Max/Min Surface, or Max/Min Line plot is used, the
maximum and minimum values, along with the coordinates for the
corresponding locations, appear in a table (underneath the plot with the
default COMSOL Desktop layout).

[

To add a Maximum or Minimum Component Coupling for any Component:

¢ On the Definitions toolbar select Maximum or Minimum from the Component Coupling menu, or

* Right-click the Definitions ( = ) node and choose it from the Component Couplings submenu.

ADVANCED
Select a Point type—Node points (the default), Integration points, or Lagrange points. The point type controls the
choice of evaluation points—the result is more accurate with more points, but more points also means a slower

evaluation.

¢ If Integration points is sclected, enter an Integration order. The default is 4.

¢ Seclect Lagrange points to compute the maximum or minimum by evaluating the expression in the argument at a
finite set of points in the source and taking the maximum or minimum of these values. If it is selected, enter a

Lagrange order. The default is 2.

Go to Common Settings for Component Couplings for information

'& about the Operator Name and Source Selection sections.
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Deformation of a Feeder Clamp: model library path
HH“ COMSOL_Multiphysics/Structural_Mechanics/feeder_clamp

Common Settings for Component Couplings

The following sections in the settings windows for the component coupling nodes are similar or the same for some

of the component coupling nodes and are described in this section.

OPERATOR NAME
Enter a name for the operator in the Operator name field or use the default name. This is the name that is used to

access the operator in the model, so use a name that describes it well.

SOURCE SELECTION
The source selection defines the source for the component coupling—the part of the geometry where the coupling

operator evaluates the supplied expressions.

From the Geometric entity level list, sclect Domain, Boundary, Edge (3D only), or Peint. Select Manual or All domains,
All boundaries, All edges, or All points from the Selection list. If Manual is selected, select geometric entities in the

Graphics window. Select All domains, for example, to add all applicable geometry to the Selection list.

SOURCE VERTICES AND DESTINATION VERTICES

The selection of Source Vertices and Destination Vertices define the linear
E| mapping from the destination to the source.

Click the Active button activate one of vertex selections. For Windows users, the buttons are [an [ and [Far] -
For Mac and Linux users the buttons are ( {1} ) for ON, and ( {1} ) for OFF.

Select a single source vertex for each of Source vertex I, Source vertex 2, Source vertex 3, and Source vertex 4. Then
select a single destination vertex for each of Destination vertex I, Destination vertex 2, Destination vertex 3, and

Destination vertex 4 (vertex 4 is available for Linear Extrusion only).

¢ For Linear Extrusion: The number of source vertices must be at least one and not more than
1+min(srcsdim,dstsdim), where srecsdim and dstsdim are the dimensions of the source and destination
geometries, respectively. The number of destination vertices entered should be the same as the number of source

vertices. If not all destination vertex selections are used, the empty selections must be last.

¢ For Linear Projection, select srcedim+1 source vertices where srcedim is the dimension of the source selection.
Depending on the dimension of the source selection, it can be that some of the last source vertex selections
should be left empty. The number of destination vertices should be oze less than the number of source vertices.
If not all destination vertex selections are used, the empty selections must be last. Select srcedim destination
vertices where srcedim is the dimension of the source selection. Depending on the dimension of the source

selection, it can be that some of the last destination vertex selections should be left empty.

An evaluation point in the destination geometry is first orthogonally projected onto the linear space spanned by
the destination vertices (unless they span the entire space). The projected point is then mapped to the source
geometry by a linear mapping taking each destination vertex to the corresponding source vertex. Let L be the
line through this point, which is parallel to a line through the first and the last source vertex. If the source
selection lies in the linear space spanned by the source vertices, the Linear Projection operator is evaluated by

integrating along L. In general the operator is evaluated by integrating along the line or curve in the source
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selection, which is mapped to L under orthogonal projection onto the linear space spanned by the source

vertices.

SOURCE BOUNDARIES AND DESTINATION BOUNDARY
Select Manual or All boundaries from the Selection list to define the source selection. If Manual is selected, select
boundaries in the Graphics window. Select All boundaries to add all boundaries to the Selection list.

There can only be one destination boundary. Click the Active button to enable or disable the Destination Boundary
selection. For Windows users, the buttons are [an [ and [[FJarf] . For Mac and Linux users the buttons are ( (1} )
for ON;, and ( {1} ) for OFF. Then choose the boundary in the Graphics window.

SOURCE FRAME AND SOURCE MAP
Select a Source frame to use in the source. In most cases the Source section default settings can be used. Optionally,

select the Use source map check box and enter expressions in the x-expression, y-expression, and z-expression ficlds

for the source map from the source to the intermediate mesh.

For the General Extrusion component coupling, the number of source map expressions is the same as the number
of destination map expressions. With the default source map expressions, the intermediate mesh can be considered

identical to the source.

The dimensionality idim of the intermediate space is determined by the number of nonempty source and
destination map expressions, which must be the same, and must also satisfy srcedim < idim < sresdim, where

srcedim is the dimension of the source selection, and sresdim is the dimension of the source geometry.

ADVANCED SETTINGS FOR COMPONENT COUPLINGS

For the General Extrusion, Linear Extrusion, Boundary Similarity and Identity Mapping component couplings,
select an option from the Mesh search method list to specify what should happen if an evaluation point in the
destination is mapped to a point outside the source:

e If Use tolerance is selected (the default) the result depends on the other field definitions in this section.

e If Closest point is selected, the closest point in the source selection is used.

Enter a value in the Extrapolation tolerance field. If the mapped point is within a distance of the extrapolation

tolerance times the mesh element size, the point is considered to be in the source. Otherwise, the mapping fails.

Select the Use NaN when mapping fails check box to evaluate the operator to NaN (Not-a-Number) if the mapping
fails. Otherwise an error occurs.

For the Integration and Average couplings, select Integration or Summation over nodes from the Method list. In most
cases use integration. Summation over nodes is useful, for example, for calculating reaction forces. If Integration is

selected, enter a value in the Integration order ficld.

Also, when working with multiple frames, select a Frame from the list for the volume element to be used in the

integration.

For axisymmetric geometries, select the Compute integral in revolved geometry check box to perform the integration

in 3D (for a 2D axisymmetric model) or in 2D (for a 1D axisymmetric model).
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Coordinate Systems

About Coordinate Systems

COMSOL uses a global Cartesian coordinate system by default to specify material properties, loads, and constraints
in all physics interfaces and on all geometric entity levels (points, edges, boundaries, and domains). In boundary

conditions and fluid domains, the global system is generally interpreted as having fixed axis directions in space; that
is, it is a spatial frame system. When specifying properties of solid materials, the global system axes are instead fixed

in the material. In other words, it is a material frame system in that context.

Not only the global coordinate system, but also coordinate systems defined as a rotation relative to the global
system, are context-dependent in this way. Such systems are collectively referred to as relative coordinate systems,
to distinguish them from absolute coordinate systems.

The spatial Cartesian coordinate system coordinates default to the following names in 2D and 3D (in 2D

axisymmetric geometries, COMSOL uses cylindrical coordinates):

GEOMETRY DEFAULT NAME OF SPATIAL COORDINATES
2D Xy

3D xXyz

Axial symmetry 2D roz

z
In 3D, an image displays in the lower-left corner of the Graphics window ¥ I/x to indicate the orientation of the

global coordinate system.

User-defined coordinate systems can be used on all geometric entity levels to simplify the modeling process. In

some of the physics interfaces, these coordinate systems can be used to define orthotropic and anisotropic material
properties that are not aligned with the global Cartesian coordinate system. See Table 5-15 for an overview of the
available coordinate systems. Note in particular that some coordinate systems specify absolute directions in space,

while others specify a rotation relative to the default global system, as indicated by the Type column in the table.
To add a Coordinate System to any Component:

¢ On the Definitions toolbar sclect features from the Coordinate Systems menu, or
¢ Right-click the Definitions ( = ) node and choose an option from the Coordinate Systems submenu. :

TABLE 5-15: COORDINATE SYSTEM DESCRIPTIONS

NAME AND LINK ICON TYPE DESCRIPTION

Base Vector System s relative 1D, 2D, and 3D. Define this using a set of base
vectors to form a coordinate system, which

are declared as orthonormal.

Boundary System i absolute 2D and 3D. A local base vector system on 2D
boundaries (t, n) and on 3D boundaries
(tl, £2, n). Use it to apply loads that apply in a
normal or tangential direction on a boundary
that is not aligned with the global Cartesian
coordinate system. This coordinate system is
always available.

Cylindrical System L absolute 2D and 3D. Use this where rotational
’ symmetry about the axis is required. Not
applicable in geometries with 2D axial
symmetry, where a cylindrical coordinate
system is the default coordinate system.
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TABLE 5-15: COORDINATE SYSTEM DESCRIPTIONS

NAME AND LINK ICON TYPE DESCRIPTION

Mapped System J«l absolute  ID, 2D, and 3D. This can deal with translated
and rotated coordinate systems. Use this to
create a system that defines a mapping from
the frame coordinate system.

Rotated System i relative 2D and 3D. Use this to define rotation about
the out-of-plane direction in 2D and Euler
angles in 3D.

Spherical System i absolute 3D only. Use this when a field or property

using spherical coordinates is to be specified.

Scaling System ]ﬂ.‘ absolute  For physics that support infinite elements or
perfectly matched layers only. Use this
coordinate system, which is similar to a
mapped coordinate system, to arbitrarily
deform the domain.

* Grouping Nodes by Space Dimension and Type

El. » Spatial Coordinate Variables

COORDINATE SYSTEM IDENTIFIER

The Coordinate System Identifier provides a namespace for variables created by the Coordinate system. The default
identifier is sys1. For example, the determinant of the coordinate system’s transformation matrix can typically be
accessed in equations and postprocessing as sys1.detT. See the Equation View subnode for a complete list of
available variables.

To display the Equation View node under all nodes creating variables, click

]
|_E'| the Show button and select Equation View. See also Equation View.

Base Vector System

Define a Base Vector System (-./-) using a set of base vectors to form a coordinate system. The system does not
necessarily need to be orthonormal, but when it is, declaring it orthonormal and linear enables simplifications which

improve performance.

A vector F is represented by its contravariant components [Fq, Fg, F' 3]T in the base of the new base vector system
defined by the base vectors uy, ug, and ug on the form F = Fyuy + Foug + Fgug. Expressing the base vectors as

components in another system (for example, the global spatial system [e,, e

> €,]) gives the transformation matrix

between bases:

Fx Fl

Fy [ul u, u3] F,

Fz FS
Fl 1 Fx |ul|=1 T Fx
T Y I B VRN Y
FS Fz LY Y Fz
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where the last equality holds when the base vector system is orthonormal.

Note that you specify the base vectors as components in the default global coordinate system, which is
context-dependent. The base vector system is therefore a relative coordinate system whose interpretation depends

on the interpretation of the global system in the current context.

The Curvilinear Coordinates interface can create special base vector
]

I_El systems in Curvilinear System nodes (./*). See Curvilinear Coordinates.

To add a Base Vector System to any Component:

¢ On the Definitions toolbar select Base Vector System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.

SETTINGS

Coordinate Names

In the Coordinate names table, the default names are entered—=x1, x2, and x3. In planar 2D models, x1 and x2 are
typically the in-plane coordinates, and x3 is the out-of-plane coordinate. Note that these coordinate names are only
used as indices for vector and tensor variable names, and cannot be evaluated as variables. The labels for each

coordinate name—First, Second, and Third—include the default name in parentheses.

Base Vectors
Define the Base vectors in terms of the global Cartesian coordinates (typically x, y, and z); one base vector on each
row (two for 2D and three for 3D).

For 1D models, select which basis vector is parallel to the 1D geometry.
- Select an option from the In-plane index list. The default is 1.

For 2D models, select which basis vector to compute as the cross product
of the two in-plane vectors specified. Select an option from the
Q Out-of-plane index list. The defaults are 3 for a plane 2D model and 2 for
an axisymmetric 2D model. For example, to map the first vector, x1, to
the direction defined by y =x in 2D, enter 1 in the fields under x and y on
the xI row.

Simplifications
Set base vector system properties that help simplify the coordinate transformations. Select the Assume orthonormal

check box if the coordinate system is orthonormal.

Go to Coordinate System Identifier for information about the Coordinate
'El System ldentifier section.
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* Ifyou have the Nonlinear Structural Materials Module, see Pressurized
Orthotropic Container: model library path

Nonlinear_Structural_Materials_Module/Plasticity/orthotropic_container.

f * Ifyou have the Structural Mechanics Module, see Piezoelectric
Shear-Actuated Beam: model library path

Structural_Mechanics_Module/Piezoelectric_Effects/shear_bender.

Boundary System

A Boundary System (| 1. ) is a local base vector system on 2D boundaries (t, n) and on 3D boundaries (t1, to, m).
Use it to apply loads and other boundary conditions in a normal or tangential direction on a boundary that is not
aligned with the global Cartesian coordinate system.

] For 3D and 2D models, a Boundary System node is automatically added
under Definitions.

Common applications for this coordinate system include specifying pressure or normal displacement on a surface.

To specify the boundary coordinate system, you specify the direction of the normal and a direction that is projected
onto the boundary, normalized, and used as the first tangent vector. The normal direction is in most cases the

outward-pointing normal vector, but you can reverse the normal direction. The general definition of the normal is
the direction of the normal vector n, which can be plotted using the variables for its components (typically nx, ny,

and nz). See Normal Variables.

¢ In 2D the local coordinate system is defined by (t1, n, t,), representing the tangential and normal direction of
the boundary. This coordinate system is always right-oriented. The second tangent direction (t,) is the cross
product between normal vector (n) and the first tangent direction (t1). This method always gives a

right-oriented orthonormal system, unless the tangent direction is parallel to the normal.

* In 3D the local coordinate system is defined by (t1, to, m), representing two tangential directions (t and tg9) and
one normal direction (n).This coordinate system is always right-oriented but not always orthogonal. The second
tangent direction (t9) is the cross product between the specified normal vector (n) and the first tangent vector
(t1). This method always gives a right-oriented orthonormal system, unless the tangent direction is parallel to

the normal.
To add a Boundary System to any Component:

¢ On the Definitions toolbar sclect Boundary System from the Coordinate Systems menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.

SETTINGS

Frame

Select a Frame—Deformed configuration (the default), Geometry configuration, or Reference configuration. The
deformed configuration follows the material whereas the reference configuration is attached to the spatial frame.
The geometry configuration is used to specify normal and tangential components of boundary conditions and refers

to the undeformed geometry when using a Deformed Geometry interface.
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Coordinate Names

In the Coordinate names table, the default names are entered—t1, t2, and n (for 3D models) or t1, n, and to (for
2D models). Click the table cells to edit the names. The labels for each coordinate name—*irst, Second, and Third—
include the default name in parentheses. To reverse the direction of the normal for the boundary system, select the
Reverse normal direction check box.

Select an option from the Create first tangential direction from list: Global Cartesian (the default) or Manual. If Global
Cartesian is selected, select I, 2, or 3 (that is, x, y, or z) from the Axis list. If Manual is selected, default values are
displayed for the local tangent variables t1x, t1y, and t1z (3D) or t1x and t1y (2D). Enter other values as
required to define a tangent direction by specifying directions for a local tangent plane in the x, y, and z fields.

Go to Coordinate System Identifier for information about the Coordinate
'& System ldentifier scction.

Many model examples use this coordinate system. For one example, see
il Electric Sensor: model library path
COMSOL_Multiphysics/Electromagnetics/electric_sensor.

Cylindrical System

A Cylindrical System (_,L_ ) can be used in 2D and 3D where rotational symmetry about the axis is required. The

cylindrical coordinate system is not applicable in geometries with 2D axial symmetry. The local coordinate system
is defined by (7, ¢, @), where r represents the radial distance from the longitudinal axis, ¢ is the azimuthal angle
(in the interval from —= to ©), and a is the distance from the origin along the longitudinal axis. In 2D models, only
the origin can be specified, whereas in 3D models, the longitudinal axis direction, a, and the radial base vector, e,

(¢ =0), can be specified as well. These direction vectors are automatically normalized.

The definitions of the cylindrical coordinates in terms of the global Cartesian coordinates r = r(x, y, 2) are

’r -(rp+a(a-(r- ro)))‘

r _ (axe,) (r-ry)
e e, (r-rgy)
a

a-(r-rg)

To add a Cylindrical System to any Component:

¢ On the Definitions toolbar select Cylindrical System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.
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SETTINGS

Frame

Select with respect to which Frame—Spatial (the default), Mesh, Material, or Geometry—the coordinate system is
cylindrical as defined by the above transformations. Note that the actual coordinate names—typically (x, y, z) or
(X, Y, Z)—are displayed for each frame, indicating which frames actually differ from each other in the current model.

A coordinate system with Frame set to Spatial is orthonormal only in the
spatial frame. Similarly, a Material system is orthonormal only in the

material frame. Some physics require that coordinate systems used are

!

orthonormal in a particular frame. For example, choose the Material frame

if you want to use the coordinate system in a structural mechanics model.

Coordinate Names
In the Coordinate names table, the default Coordinate names are entered—r, phi, and a. In planar 2D models, r and
phi are in-plane polar coordinates, and a is the out-of-plane coordinate. The labels for each coordinate name—

First, Second, and Third—include the default name in parentheses.
Origin
Specify the location of the Origin of the cylindrical coordinate system in the global Cartesian system. The default is

an origin coinciding with the one from the global system.

Longitudinal Axis
For 3D models, enter the Longitudinal axis direction. The default is the z direction in the global system.

Direction of Axis
For 3D models, specify the Direction of axis ¢ =0, where ¢ is the azimuthal angle. The default direction is the

x direction in the global system.

Go to Coordinate System Identifier for information about the Coordinate
'& System Identifier section.

If you have the AC/DC Module and Particle Tracing Module, see
i Magnetic Lens: model library path
ACDC_Module/Particle_Tracing/magnetic_lens.

Mapped System

Use a Mapped System (1) to create a system that defines a mapping from the frame coordinate system.

This method can deal with translated and rotated coordinate systems:

Uj ul(x,y, 2)
u2 = uz(x’y5 2)
u3 u3(x9ya Z)
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To add a Mapped System to any Component:

¢ On the Definitions toolbar select Mapped System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.

SETTINGS

The Frame list is the same as for the Cylindrical System.

Coordinate Names
In the Coordinate names table, the default names are entered—x1, x2, and x3. In planar 2D models, x1 and x2 are
typically the in-plane coordinates, and x3 is the out-of-plane coordinate. The labels for each coordinate name—

First, Second, and Third—include the default name in parentheses.

Coordinate Mapping
Under Coordinate mapping, the Coordinate column displays the Coordinate names with the Expression column

displaying the associated mapped coordinate.

Simplifications
Ifrequired, select the Assume orthonormal check box. The program then uses the assumption that the settings define

an orthonormal coordinate system.

Go to Coordinate System Identifier for information about the Coordinate
'El System ldentifier section.

Rotated System

Use a Rotated System (.) to define rotation about the out-of-plane axis in 2D and Euler angles in 3D.

In the Rotated System node’s settings window, define the rotation relative to the global Cartesian coordinate
system. In 3D models, you specify the local coordinate system (xj, ¥}, 21) using three consecutive Euler angles
(rotation angles) o, B, and y. See Figure 5-2.

A

Figure 5-2: 3D Euler angles in a rotated coordinate system.

The transformation matrix for the 3D case is then
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. . . . . . T
*1 cosa.cosy — sinacosfsiny — cosasiny — sinocosffcosy sinfsina x
Y1| = |sinocosy + cosacosBsiny — sinasiny + cosacospcosy —sinfcosa| |y
zy sinfsiny sinfcosy cosf z

In 2D models, you describe the rotated coordinate system by the rotation angle about the out-of-plane vector. In

both cases the origin of the coordinate system can be defined.
To add a Rotated System to any Component:

¢ On the Definitions toolbar select Rotated System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.

SETTINGS

Coordinate Names
In the Coordinate names table, the default names are entered—x1, x2, and x3. In planar 2D models, x1 and x2 are
typically the in-plane coordinates, and x3 is the out-of-plane coordinate. The labels for each coordinate name—

First, Second, and Third—include the default name in parentheses.

Specify the location of the origin of the rotated coordinate system. Define it as a vector with two (for 2D) or three
(for 3D) components. The default is the origin for the global Cartesian coordinate system. Using another origin
translates the coordinates in the rotated system by that distance from the global Cartesian origin.

Out-of-plane Axis (2D)
For 2D models, select an out-of-plane axis from the Out-of-plane axis list (first, second, or third coordinate direction
into or out-of screen), and then if necessary adjust the base vectors in the table under Base vectors. Enter the

Rotation about out-of-plane axis (in radians). The default is 0.

Euler Angles (3D)
For 3D models, enter the Euler angles (Z-X-Z) (in radians) in the a, B, and v fields (see the graphics in the settings

window for definitions of these angles). The default values are O for all angles.

Go to Coordinate System Identifier for information about the Coordinate
'ﬂ System ldentifier section.

If you have the MEMS Module, see Gecko Foot: model library path
ii“ MEMS_Module/Actuators/gecko_foot.

Spherical System

Usc a Spherical System ( (L) to define a spherical coordinate system in 3D by its origin, zenith axis, and azimuth

axis.

The coordinates of a local spherical coordinate system are (7, 6, ¢ ), where r represents the radial distance from the
origin, 0 is the inclination (in the interval from 0 to «t), and ¢ is the azimuthal angle (in the interval from —x to ).
Specify—in terms of the global Cartesian coordinates x, y, and z—the position of the origin, the axis 0 = 0 (the
zenith axis, Z), and the axis 6 = /2, ¢ =0 (the azimuth axis, A). The direction vectors are automatically

normalized.

This is a mapped normalized coordinate system using the following transform in global coordinates

280 | CHAPTER 5: DEFINITIONS



¢ = atan2(r, - (ZxA),r, -A)

where r, is the position of the origin, Z is a unit vector along the axis 0 = 0, and the component of r — r in the

plane 6 = /2 is
r, =(r-r,-Z(Z (r-r,)))

To add a Spherical System to any Component:

¢ On the Definitions toolbar select Spherical System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.
SETTINGS
The Frame list is the same as for the Cylindrical System.

In the Coordinate names table, the default Coordinate names arc entered—r, theta, and phi. The labels for each

coordinate name—First, Second, and Third—include the default name in parentheses.

Enter the location of the Origin in the global Cartesian coordinate system. The default is an origin coinciding with
that of the global system.

Enter the Direction of axis 6=0 (the zenith axis). The default axis direction is the z direction in the global Cartesian

system.

Define the Direction of axis 0=n/2, ¢ =0 (the azimuth axis). The default direction is the x direction in the global

Cartesian system.

Go to Coordinate System Identifier for information about the Coordinate
'& System Identifier section.

Scaling System

Use a Scaling System (]ﬂ..) to create a system that maps the geometry, as represented by the independent
coordinates of an underlying frame, onto a virtual geometry represented by virtual scaling system coordinates.
Physics interfaces that support infinite elements or perfectly matched layers accept the scaling system coordinates
as being the physical domain, in which the underlying frame coordinates are seen as a parameterization. Therefore,
using a scaling coordinate system you can arbitrarily deform the domain, essentially in the same way as when using

Deformed Geometry with a Prescribed Deformation node.

The Scaling System is only available for physics that support infinite
]
I_E| elements or perfectly matched layers. See Infinite Element Domain.

The scaling coordinate system is defined as a map from real frame coordinates to virtual scaling system coordinates:
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xl xl(xayaz)
xQ = xQ(x’ Y, Z)

.’)C3 ‘x3(xay9z)

The selected frame coordinates (the setting is invisible if there is only one frame) are seen as a parameterization of
the “true geometry” in which the physics is solved. What you specify in the Coordinate mapping table is therefore a
“true position” for each point in the mesh, expressed in the frame coordinates. When applied to a domain with a
compatible material model in a physics interface, the equations in that domain are first reformulated in terms of the
virtual x1, x9, and xg coordinates but then automatically mapped back to the frame coordinates. This leads to

explicit transformation expressions appearing in the equations.
To add a Scaling System to any Component:

¢ On the Definitions toolbar sclect Scaling System from the Coordinate Systems menu, or

* Right-click the Definitions ( = ) node and choose it from the Coordinate Systems submenu.

SETTINGS
Under Coordinate mapping, the Coordinate column displays the virtual coordinate names with the Expression column
displaying the map from underlying frame coordinates to virtual coordinates. The default expressions are the spatial

coordinates x, ¥, and z, which means no scaling.

Go to Coordinate System Identifier for information about the Coordinate

'El System ldentifier section.
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ldentity and Contact Pairs

Pairs are available for assemblies (that is, geometries created by not forming a union of all geometry objects as the
final step), where there is a need to connect boundaries between parts. By default, pairs are created automatically

when forming an assembly. There are two types of pairs—identity and contact.

About Identity and Contact Pairs

IDENTITY PAIRS

An identity pair (D(j ) is a pair that by default makes the fields across two connected boundaries (one from each
connecting part in an assembly) continuous. This is equivalent to the continuity that is obtained by default on
interior boundaries in a geometry created by forming a union. Some physics provide special boundary conditions
for identity pairs to model “slit conditions” such as resistive layers. You can specify boundary conditions for these
pairs from the Pairs submenu at the bottom of the boundary condition part of the context menu for the physics.
The nodes in the Model Builder that represent pair boundary conditions use an icon with a pair symbol in the
lower-left corner: [ey.

CONTACT PAIRS
A contact pair ([#]) is a pair that define boundaries where the parts can come into contact but cannot penetrate
each other under deformation for modeling of structural contact and multiphysics contact.

Contact pair modeling requires the Structural Mechanics Module or
MEMS Module. Details about this pair type can be found in the

[

respective user guide.

FALLBACK BOUNDARY CONDITIONS ON NON-OVERLAPPING PARTS

For pairs where parts of the boundaries do not overlap you need to specify boundary conditions for the
non-overlapping parts, which typically represent exterior boundaries outside of the overlapping area. These
boundary conditions (fallback boundary conditions) appear as subnodes to the pair’s boundary condition node in
the Model Builder. By default, the default boundary condition for exterior boundaries is added to the
non-overlapping parts. If you want to use another boundary condition for any of the non-overlapping parts,
right-click the pair’s boundary condition node (Continuity, for example) and select any of the standard boundary
conditions from the Fallback Features submenu. In the settings window, the selection includes all applicable
boundaries by default, but a separate boundary condition can be added for only a subset of the pair boundaries. In
the following illustration, which shows a simple example with two partially overlapping rectangles, there is one

identity pair that consists of two boundaries, each with a non-overlapping part. You can right-click the pair’s
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boundary condition node and, from the Fallback Features submenu, add one fallback boundary condition for the
top boundary and another fallback boundary condition for the bottom boundary if desired.

Fallback boundary condition for
top boundary active here

Pair boundary 3

condition active here

Fallback boundary condition for
bottom boundary active here

The options for the available fallback conditions are based on the physics interface and the license type (see
Figure 5-3).

With only a few exceptions for the Solid Mechanics interface or other

physics interfaces using Solid Mechanics functionality, all subnodes to

[

pairs are fallback nodes.

When additional fallback feature nodes are added, the node has an indicator in the lower-left corner (jgmw )

identifying it as a fallback feature node.

4 % Solid Mechanics
7 Linear Elastic Material 1
o
w Freel
B Initial Values 1
mw Fixed Constraint 1
a Boundary Load 1
@ Continuity 1

£,
£ Mesh1 Fallback Features 3 ;‘E- Free
"o Study 1 .
@ Results 1o Boundary Load
T Mave Up ;E- Prescribed Displacement
JEE
| | Copy ;E- Reller
B .
¥ Duplicate ;E- Shell Connection
X Delete
@ Disable
43 Rename
Properties
L& Help

Figure 5-3: An example of the Fallback Features submenn for o Continuity pair added to the Solid Mechanics interface.

To add Pairs to any Component:

¢ On the Definitions toolbar select features from the Pairs menu, or

* Right-click the Definitions ( = ) node and choose an option from the Pairs submenu.

Identity Pair

Use an Identity Pair node (D{j for an identity boundary pair) to specity two selections of boundaries that overlap
but belong to different parts of an assembly. Then assign a boundary condition to connect the physics in the two
parts in a physics interface. Identity pairs connect overlapping boundaries in different connecting parts of an

assembly.
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The Identity Boundary Pair (D(] ) is the most commonly used. For 3D models, the Identity Edge Pair is available ([J(],
which can be useful for connecting two edges in a shell model, for example. You can also choose the Identity Point

Pair ([={]).

To add an Identity Pair to any Component:

¢ On the Definitions toolbar select Identity Boundary Pair, Identity Edge Pair, or Identity Point Pair from the Pairs

menu, or

* Right-click the Definitions ( = ) node and choose an option from the Pairs submenu.

GENERAL
Enter a Pair name. It is used as a suffix in names of operators and variables defined by the pair. The default Pair type
is Identity pair, or select Contact pair. Identity and Contact pairs are both available for boundary pairs, and Identity

pairs are also available on edge and point levels.

Manual Control of Selections
If the pair was created automatically when forming an assembly, the Manual control of selections check box is visible.
Click to clear this check box to be able to make manual changes to the Source Boundaries and Destination Boundaries

selections. Pairs in manual mode do not have their selections updated when the geometry sequence is rebuilt.

The operator mapping an expression E on the source side to the destination side is denoted src2dst_pn(E), where

_pn is the pair name.

For an Identity Pair, the variable src2dst_pn (defined on the destination) is 1 where there is a corresponding source
point, and 0 otherwise. The corresponding operator and variable for use on the source side are denoted
dst2src_pn.

Similarly, for a Contact Pair there is an operator src2dst_pn_mph that is suited for use in multiphysics coupling.
The variable geomgap_dst_pn is the geometric gap between the source and the destination, seen from the
destination side (following the normal of the destination boundary). The corresponding operators and variables for
use on the source side are denoted dst2src_pn, dst2src_pn_mph, geomgap_src_pn.

SOURCE BOUNDARIES AND DESTINATION BOUNDARIES

The destination boundaries should overlap the source boundaries. The condition that connects the physics on the
destination and source boundaries is specified in the physics interface. For example, it can be a constraint that
constrains a dependent variable (temperature, for example) on the destination side to be equal to a dependent
variable on the source side.

Click the Active button to toggle between turning ON and OFF selections. For Windows users, the buttons are
on [ and [Jerr] . For Mac and Linux users the buttons are ( (1) ) for ON, and ( (!} ) for OFF.

Then define the source or destination boundaries. Select Manual or All boundaries for the boundaries on the source
or destination side. If Manual is selected, click in the Graphics window to add boundaries to the Selection section. If
required, click the Swap Source and Destination button ( ] ).

Select Manual or All boundaries for the boundaries on the source side or the destination side. If Manual is selected,
click in the Graphics window to add boundaries to the Selection section. If required, click the Swap Source and

Destination button ( | ) to swap the source boundaries and the destination boundaries.

For Identity Edge Pairs and Identity Point Pairs, cdges and points,

respectively, replace boundaries in the selections of the pair’s source and

[

destination.
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FRAME

If there are several frames in the model, the Frame section is visible. Select the Source frame and the Destination

frame. Source and destination points are connected if their coordinates in their respective frames are equal.

Thin-Layer Diftusion: model library path
il COMSOL_Multiphysics/Diffusion/thin_layer_diffusion

Contact Pair

Use a Contact Pair node ([#]) to specify two selections of boundaries that cannot penetrate each other under
deformation. The contact pairs define boundaries for parts that can come into contact (boundaries that cannot
penetrate each other under deformation). For more information about contact modeling and guidelines for
selecting source and destination boundaries for contact pairs, see the Structural Mechanics Module or MEMS

Module documentation.
To add a Contact Pair to any Component:

¢ On the Definitions toolbar seclect Contact Pair from the Pairs menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Pairs submenu.

GENERAL
This section is the described for the Identity Pair except that the default Pair type is Contact pair.

SOURCE BOUNDARIES AND DESTINATION BOUNDARIES

The contact algorithm constrains the destination boundaries so that they do not penetrate the source boundaries.

Click the Active button to toggle between turning ON and OFF selections. For Windows users, the buttons are
on [] and [TJore] . For Mac and Linux users the buttons are ( {!} ) for ON, and ( (!} ) for OFF.

Then define the source or destination boundaries. Select Manual or All boundaries for the boundaries on the source
or destination side. If Manual is selected, click in the Graphics window to add boundaries to the Selection section. If
required, click the Swap Source and Destination button ( T ) to swap the source boundaries and the destination

boundaries.

ADVANCED
The Search method defaults to Fast—the algorithm only keeps track of source and destination points that have a

distance less than a certain search distance. Select Direct for a slower but more robust search.

Select the Manual control of search distance check box to tune the search distance (SI unit: m). By default, the search
distance is taken as 0.01 times the diagonal of the geometry’s bounding box. If the Manual control of search distance
check box is selected, enter a different value in the Distance field.

For a contact pair, the fallback boundary condition is applied to all parts

L] ~ . .
|_E'| of the boundaries currently not in contact.
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* If'you have the MEMS Module, see Microgripper: model library path
MEMS_Module/Piezoelectric_Devices/microgripper.

* Ifyou have the Nonlinear Structural Materials Module, see Snap Hook:
model library path

Nonlinear_Structural_Materials_Module/Plasticity/snap_hook.

* Ifyou have the Structural Mechanics Module, see Cylinder Roller

Contact: model library path

Structural_Mechanics_Module/Verification_Models/cylinder_roller_contact.
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Probes

About Probes

Probes ( ﬁ) monitor the development of a scalar-valued quantity (real or complex-valued number) from a
time-dependent, frequency-domain, or parametric simulation by two different results presentations: tabulated data
and 1D graph plots. You can probe while solving, as a monitor and diagnostic tool, and probe after the computation
is finished for results analysis. On top of this functionality, a probe variable in the model component’s namespace
and with a global evaluation scope is also defined. The probe variable’s name appears in the Probe variable ficld. You
can use this variable can be used as any other variable in, for example, equations, boundary conditions, or a stop

condition.

Plot while solving is a technique used to briefly interrupt the simulation and launch some predefined plot
commands and then continue with the simulation. Both normal plots and graphs can be plotted for probes during

the simulation.

There are these types of probes (see Table 5-16 for the icon by space dimension):

e Domain probes, boundary probes, and edye probes make it possible to probe the average, minimum, maximum,
or integral of a field quantity over a domain, on a boundary, or along an edge.

e Domain point probes and boundary point probes provide the value of some field quantity at a point in the
domain or on a boundary. Any point within the domain or on the boundary can be defined.

e Use Global variable probes ( ﬁ) for probing the value of any global variable.
The probes automatically create a Probe Table node for displaying numerical results in the Table window and an
associated plot group with a Probe Table Plot node that plots the probe data as a line graph in a separate Probe Plot

window. For further processing, the probes also add data sets such as Domain Point Probe data sets ([ = | ), which give

access to the probe data. For further control, specify the table and plot window each probe uses.
To add a Probe to any Component:

¢ On the Definitions toolbar select features from the Probes menu, or
* Right-click the Definitions ( = ) node and choose an option from the Probes submenu.
When the simulation has finished, click the Update Results button ( (* ) in the probe settings window (or on the

Definitions toolbar) to change the settings for a probe and update the results information. Then right-click the
Definitions node and select ﬁi Update Probes.

TABLE 5-16: PROBE TYPES AND ICONS BY SPACE DIMENSION

PROBE TYPE 3D 2D ID
Domain P = 2
Boundary 4 - A
Edge = — —

Domain Point

™
B,
|

288 | CHAPTER 5: DEFINITIONS



TABLE 5-16: PROBE TYPES AND ICONS BY SPACE DIMENSION

PROBE TYPE 3D 2D ID

Boundary Point & — —

Global Variable ﬁ ﬁ ﬁ

& Getting Results While Solving

Common Settings for Probes

SOURCE SELECTION
The source selection defines the source for the probes—the part of the geometry over which the program computes

the probes.

From the Geometric entity level list, select Manual or based on the probe type, All domains, All boundaries, All edges,

or All points from the Selection list. If Manual is selected, select geometric entities in the Graphics window.

EXPRESSION

In the Expression section you can:

* Enter a text string with your own expression.

* Click the Replace Expression () button to select a predefined quantity and replace the contents of the Expression
field with the corresponding variable.

* Click the Insert Expression () button to insert the corresponding variable at the current position in the Expression
field.

* Seclect a Table and plot unit from the list. You can select from a predefined number of applicable units for the
quantity that the variable represents, but you can also click in the unit’s text field and type any compatible unit
for that quantity to use a unit that is not in the list (for example, mi/h for miles per hour as a unit for a velocity
quantity).

* Select the Description check box to enter a description (or edit the default).

* About Parameters, Variables, and Expressions
El. * Entering Ranges and Vector-Valued Expressions

* Expressions and Predefined Quantities

TABLE AND WINDOW SETTINGS

By default, COMSOL uses a probe table (typically Probe Table 1) under Tables and a probe table plot (typically Probe
Table Plot 1) in a Probe 1D Plot Group node, which appears in a separate plot window for probe plots (typically Probe

Plot 1). To organize and group multiple probes, control the table and plot window to use for the probe results:

From the Output table list, select Default, New table, or any existing probe table. If an existing probe table is selected,
click the Go to Source button ( 2% ) to move to the selected Probe Table node under Tables.

From the Plot window list, select Default, New window, or any existing plot window. Click the Add Plot Window button

( == ) to create a new plot window and make it the default for this list.
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By default for both the Output table and Plot window, COMSOL uses a probe table or probe table plot that is created
automatically. If Default is selected, COMSOL updates the list to show the name of the default probe table or probe

plot window after the solution process.

Domain Probe, Boundary Probe, and Edge Probe

Use a Domain Probe (ﬂ,{' ), Boundary Probe (ﬁ ), or Edge Probe ( ") to monitor the development of a scalar-valued
quantity (real or complex valued number) from a dynamic simulation (time-dependent, frequency-domain, or

parametric solution).

Go to Common Settings for Probes for information about the Source

'& Selection, Expression, and Table and Window Settings sections.

To add a Probe to any Component:

¢ On the Definitions toolbar select Domain Probe, Boundary Probe, or Edge Probe from the Probes menu, or

* Right-click the Definitions ( = ) node and choose an option from the Probes submenu.

PROBE SETTINGS

Select an option from the Type list—Average (the default), Maximum, Minimum, or Integral depending on what type
of value takes over the domain, boundary, or edge that you want the probe to compute and output. If needed, enter
or edit a name for the Probe variable. The defaults are dom1 for a Domain Probe, bnd1 for a Boundary Probe, and

edge1 for an Edge Probe.

INTEGRATION SETTINGS
If you have selected Average or Integral from the Type list, the Integration Settings section contains the following

settings:

e From the Method list, select Integration (the default) or Summation. Only reaction forces use the summation
method.

e Enter an integer value in the Integration order ficld (default: 4).

If you have selected Maximum or Minimum from the Type list, the Integration Settings section contains an Element

refinement ficld, where you can enter the element refinement (number of partitions of an element edge) to control

the accuracy of the maximum or minimum value (default value: 4).
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When working with multiple frames for any type of probe, you can also select a Frame—Spatial (x,y,z), Material,
Geometry, or Mesh, followed by the coordinate names: (x, y, z) or (X, Y, Z) depending on the physics, for the volume
element to be used in the integration.

* Ifyou have the Batteries & Fuel Cells Module: For a boundary probe
example, see Edge Effects in a Spirally Wound Li-Ion Battery: model
library path
Batteries_and_Fuel_Cells_Module/Batteries/li_battery_spiral_2d. For a
domain probe example, see Mass Transport Analysis of a High

il Temperature PEM Fuel Cell: model library path
Batteries_and_Fuel_Cells_Module/PEMFC/ht_pem.

* Ifyou have the Nonlinear Structural Materials Module and for a
boundary probe example, see Snap Hook: model library path

Nonlinear_Structural_Materials_Module/Plasticity/snap_hook.

Domain Point Probe

Use a Domain Point Probe ( ;") to monitor the development of a real or complex-valued number from a dynamic
simulation (a time-dependent, frequency-domain, or parametric study). By default a Point Probe

Expression subnode is added, or right-click Domain Point Probe to add additional nodes.
To add a Domain Point Probe to any Component:

¢ On the Definitions toolbar select Domain Point Probe from the Probes menu, or

* Right-click the Definitions ( = ) node and choose it from the Probes submenu.

POINT SELECTION
When working with multiple frames, select a Frame—Spatial (x,y,z), Material, Geometry, or Mesh, followed by the

coordinate names: (x, ¥, z) or (X, Y, Z) depending on the physics.

For 3D models, select a Line entry method—Point and surface normal (the default), Point and direction, Two points,
or None.

For all models, enter Coordinates—Enter x and y coordinates (2D) or x, y, and z coordinates (3D). Also select the

Snap to closest boundary check box to snap the selected points to the grid.

For Point and surface normal, Point and direction, or Two points, enter a Depth along line or use the slider to select a
value between 0 and 1 to determine the probe location along the line anywhere from the starting point (0) to the

ending point (1).

¢ For Point and surface normal click at a position on the surface of the geometry. The direction becomes the inward
surface normal as defined by the geometry, which for an exterior boundary means that the probe location can

be anywhere from the start position to the end of the geometry in the normal direction.
¢ For Point and direction, the direction becomes that of a ray directed away from the point in the current camera

view (that is, the direction depends on the view).

For Two points, from the Point being modified list, also select First point and click on the geometry to define the first

point (starting point). Then select Second point and click to define the second point (ending point) for the line.

Process Control Using a PID Controller: model library path
il COMSOL_Multiphysics/Multidisciplinary_Models/pid_control
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Boundary Point Probe

Use a Boundary Point Probe () to monitor the development of a scalar-valued quantity (real or complex valued
number) from a dynamic simulation (time-dependent, frequency, parametric). By default a Point Probe
Expression subnode is added, or right-click Boundary Point Probe to add additional subnodes.

To add a Boundary Point Probe to any Component:

¢ On the Definitions toolbar select Boundary Point Probe from the Probes menu, or

¢ Right-click the Definitions ( = ) node and choose it from the Probes submenu.

BOUNDARY SELECTION
Select a single boundary to add to the Selection.

POINT SELECTION
When working with multiple frames, select a Frame—Spatial (x,y,z), Material, Geometry, or Mesh, followed by the

coordinate names: (x, ¥, z) or (X, Y, Z) depending on the physics.

Enter the Coordinates. A red dot indicates the position of the point on the selected surface in the Graphics window.
Click the surface to move the point, or enter x, y, and z coordinates. If the point is not on the boundary, the probe

location becomes the closest point on the boundary, with coordinates indicated by On surface under the fields.

Point Probe Expression

A Point Probe Expression ( ﬁfr‘) is automatically added as a subnode to a Domain Point Probe and a Boundary Point
Probe. Right-click the main node to add additional Peint Probe Expression subnodes. Under Probe Settings, edit or

enter a name for the Probe variable. The default name is ppb1.
To add a Point Probe Expression to any Component:

¢ On the Definitions toolbar select Point Probe Expression from the Probes menu, or

* Right-click the Definitions ( = ) node and choose it from the Probes submenu.

Go to Common Settings for Probes for information about the Expression,
'& and Table and Window Settings sections.

Global Variable Probe

Use a Global Variable Probe ( ﬁ) to monitor the development of a scalar-valued quantity (real or complex-valued
number) from a dynamic simulation (time-dependent, frequency, parametric). Under Probe Settings, edit or enter

a name for the Probe variable. The default name is vari.
To add a Global Variable Probe to any Component:

¢ On the Definitions toolbar select Global Variable Probe from the Probes menu, or

* Right-click the Definitions ( = ) node and choose it from the Probes submenu.

Go to Common Settings for Probes for information about the Expression,
'El and Table and Window Settings sections.
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If you have the Plasma Module or MEMS Module:

* See Harmonic Content of the Power Deposition into a Dual
Frequency Capacitively Coupled Plasma: model library path
HH“ Plasma_Module/Capacitively_Coupled_Plasmas/harmonic_content.
e See Transient Response of a Biased Resonator—2D: model library path
MEMS_Module/Actuators/biased_resonator_2d_transient.
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Infinite Element Domains and Perfectly Matched
Layers

Simulation of Infinite Domains

Simulation of unbounded or infinite domains is a challenge encountered in many types of physics. Normally, any
physics simulates a process within a bounded domain represented by the geometry drawn in, or imported into,

COMSOL. But the domain is often delimited by artificial boundaries inserted to limit the extent of the model to
amanageable region of interest. You might not be interested in the details of the solution far away from any sources
or material inhomogeneities, but the solution inside the region of interest must not be affected by the presence of

the artificial boundaries. You simply want it to behave as if the domain was of infinite extent.

Artificial truncation of the domain can be handled in several ways. Some physics interfaces include special boundary
conditions to absorb outgoing propagating waves without spurious reflections, so-called low-reflecting boundary
conditions. Others allow impedance boundary conditions, which can account for a finite impedance between the
model boundary and a reference at infinity. Such boundary conditions are often efficient and useful but lack some

generality and sometimes accuracy.

Another way to accomplish the same desired effect is to apply a coordinate scaling to a layer of virtual domains
surrounding the physical region of interest. For stationary and transient problems, these virtual domains can be
stretched out toward infinity, giving rise to infinite elements. To absorb outgoing waves in a frequency-domain
problem, you must instead stretch the virtual domains into the complex plane, creating so-called perfectly matched
layers (PMLs).

Because of their common background as coordinate stretching, infinite elements and PMLs in COMSOL share a
number of important properties. They share part of the user interface and many modeling principles can be
translated directly from one to the other. In the description below, infinite elements and PMLs are therefore

sometimes referred to collectively as scaling systems.

The Scaling System node provides direct access to coordinate

» ~ . . . . .
El transformation machinery underlying PMLs and infinite elements.

Standard Geometry Configurations

Automatic scaling systems are available in COMSOL for three distinct geometrical configurations: Cartesian,

Cylindrical, and Spherical. Which ones you can use depends on the space dimension of the Component.

Plane 2D Models
The available scaling types in plane 2D models are Cartesian and Cylindrical. Cartesian domains are stretched in one
or two directions depending on whether they are attached to an edge or to a corner of the physical region of

interest.

It is important that separate, normally quadratic, domains are drawn at
n the corners.

294 | CHAPTER 5: DEFINITIONS



1.6] |
14| |
1.2 i

0.8]
0.6
0.4
0.2}

uf
04|
0.6]

-0.8|

-1.2] |
-1.4] |

-2 -15 -1 -0.5

Figure 5-4: Typical Cartesian scaling configuration. Note the distinction between edge and corner domains.
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Figure 5-5: Example of cylindvical scaling configuration in plane 2D. You must specify the center point of the model
when diffevent from the ovigin of the coordinate system.

AXISYMMETRIC 2D MODELS

The available scaling types in 2D axisymmetric models are Cylindrical and Spherical. The axisymmetric cylindrical
configuration, from the practical point of view, behaves identically to the plane 2D Cartesian option. Similarly, the
axisymmetric spherical scaling is similar to plane 2D cylindrical scaling, except that it is always centered on the axis.

INFINITE ELEMENT DOMAINS AND PERFECTLY MATCHED LAYERS | 295



1]
0.8] |
0.6] i
0.4 | |
0.2} I
ol E
-0.2] 9
-0.4 | I
-0.6 | |
-0.8] I
£=0
0 02 04 086 08 1 1.2 14

-06 -04 -0.2 16 18 2

Figure 5-6: Axisymmetric cylindvical scaling uses domains of three distinct types: with vadial stretching, with axial
stretching, and with both radial and axial stretching. The latter ave the corner zones, which must be dvawn as distinct

domains.
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Figure 5-7: Axisymmetric sphevical scaling assumes radial stretching in an annulus centered at a point on the axis. If
the centerpoint is not the origin of the coordinate system, you must specify its axial position.

3D MODELS

The available scaling types in 3D are Cartesian, Cylindrical and Spherical. The Cartesian scaling domains are of three
different types. Depending on whether they are attached to a surface, an edge, or a point in the physical domain,
they are stretched in one, two, or three directions, respectively. Cylindrical scaling domains are also of three

different types: radially stretched, axially stretched, and stretched both radially and axially. Spherically scaled
domains are always stretched only in the spherical domain’s radial direction.
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Figure 5-8: There ave three different types of Cartesian scaling domain, attached to faces, edges and corners, vespectively.

They differ in the number of scaled divections. Note that the edge and corner zones must be dvawn as distinct domains
in the geometry.

Figurve 5-9: The three different types of cylindvical scaling domain arve attached to the sides, top and bottom, and edges
of the cylindrical physical domain. The position and ovientation is specified as a center point and an axial dirvection.

The scaling system domains ave stretched in the radial divection, away from the axis, in the axial divection, and in both
radial and axial divection, respectively.
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Figure 5-10: A spherical scaling domain stretches the coordinate system only in the radial divection velative to a specified
center point.

Note on Availability

Infinite elements and perfectly matched layers are available only for some physics and when COMSOL is used
together with certain add-on modules. If you have not added any physics that is compatible with infinite elements

or perfectly matched layers under the available licenses, you cannot add such features to the model.

Further, after turning a domain into a PML or infinite element, that domain is not allowed in the active selection
of physics interfaces and individual nodes that are not compatible with these special domain types. This means that

the scaled domains are either not selectable at all or display as Not applicable in the selection list.

PML Implementation

PMLs apply a complex coordinate stretching in one, two, or three directions, depending on how the PML domain
connects to the physical domain. In each direction, the same form of stretching is used, defined as a function of a
dimensionless coordinate &, which varies linearly from 0 to 1 over the PML layer. For a PML absorbing waves

propagating in the direction of unit vector ng, & is defined as

¢ = n. -X-x
A

w

where x is the original, unscaled, coordinate vector, A, is the original width of the PML (as drawn in the geometry),
and x is a reference distance defined such that & = 0 whenever x lies on the boundary between the PML and the

physical domain. For a cylindrical or spherical PML, for example, x is its radius.

The corresponding scaled coordinate vector X’, in which the equations are reformulated inside the PML, is defined

as
X' =X+ ngf(&)

where f(€) is a scalar stretching function, and X is the projection of the unscaled coordinate vector x onto the

surface &=0:
Xq = x—né(ng-x)+x0

In the PML nodes, you can choose between a polynomial stretching function and a rational stretching function.

The polynomial stretching function is defined as
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(&) = sAEP(i-1)

where A is a typical wavelength parameter, p is a curvature parameter, and s is a scaling factor. The rational

stretching function is defined as

_ 1 i
1o = el 5D
The quantities ng, xg, and A, are computed automatically based on the sclected geometry type and an analysis of
the actual geometry. The typical wavelength A is normally supplied by a physics interface while p and s are user

inputs.

There is no check that the geometry of the region is correct, so it is

n important to draw a proper geometry and select the corresponding region

type.

INTERPRETING PML PARAMETERS
The PML coordinate stretching is controlled by three parameters:

e The typical wavelength represents the longest wavelength of propagating waves in an infinite medium. It is
normally provided by a physics interface. For nondispersive media, it is expected to be inversely proportional to

the frequency and serve to make the PML perform similarly for all frequencies.

In eigenfrequency studies, the typical wavelength parameter must not
depend on the—unknown—frequency. When the typical wavelength is set
to be obtained from a physics interface, it is therefore redefined to be
n equal to the PML width A, instead. A user-defined typical wavelength
applies as entered, but must not be a function of the frequency. It is often
most convenient to draw and mesh the PML as if it had been part of the

physical domain. To tune its effective thickness, use the scaling factor.

e The PML scaling factor multiplies the typical wavelength to produce an effective scaled width for the PML.
For example, to retain perfect absorption for plane waves incident at an angle 0 relative to the boundary normal,
it is necessary to compensate for the longer wavelength seen by the PML in the stretching direction. In this case,

1/cos(0) is a suitable scaling factor.

Conversely, if resolving the field inside the PML proves too costly, it is possible to lower the scaling factor below
its default value 1, to make better use of the available mesh elements. Note that this has a price in terms of less

efficient absorption.

e The PML curvature parameter serves to relocate mesh resolution inside the PML. When there are components
present which decay inside the PML much faster than the longest waves, the resolution must be increased in the
zone closest to the boundary between PML and physical domain. Increasing the curvature parameter effectively
moves available mesh elements toward the inner PML boundary. This is often necessary when the wave field
contains a mix of different wavelengths or a mix between propagating and evanescent components.

If you increase the curvature factor, you must normally still resolve the

long propagating waves sufficiently, so an overall increase of the number

[

of mesh elements across the PML is called for.

INFINITE ELEMENT DOMAINS AND PERFECTLY MATCHED LAYERS | 299



CHOOSING A STRETCHING TYPE
Which coordinate stretching type is most appropriate depends on the problem at hand. Consider the following

when choosing between polynomial and rational stretching:

Polynomial The polynomial stretching strategy makes a minimum of assumptions about the wave field incident on
the PML. Its finite and equal real and imaginary parts mean that propagating and evanescent waves with the same
length scale are treated alike. The default scaling factor gives a PML with a maximum attenuation of about 109 dB

for normal incidence and provided sufficient mesh resolution.

The polynomial stretching is generally applicable and most appropriate when there is a mix of different wave types
in the model and you can afford at least 8 mesh elements across the PML. Also, compared to the rational stretching,

it interferes less with the convergence of iterative linear solvers.

Rational The rational stretching is designed for propagating waves of mixed wavelengths and angles of incidence.
The real part of the stretching scales the effective PML thickness to a quarter of a typical wavelength, while the
imaginary part—responsible for the attenuation—is stretched out toward infinity. This means that provided
sufficient mesh resolution, the PML absorbs any propagating wave perfectly.

In reality, the mesh resolution limits the effectiveness of the rationally stretched PMLs. For a single wavelength at
normal incidence, 3 mesh elements across the PML normally give sufficient attenuation and accuracy. If the wave
field contains also longer- or shorter-wavelength components, the mesh resolution must be increased. When other
wave components are shorter than the supplied typical wavelength, increasing the curvature factor may be useful
to make best use of the available resolution.

PMLs in Multiphysics

The coordinate stretching used in the PMLs is by default controlled by one of the physics interfaces in the model,
which provides a typical wavelength. If each PML region contains a single active physics, and the PML regions are
disjoint, you can set up separate PML nodes and choose different physics interfaces as wavelength source. If,
instead, there are multiple physics active in the same PML domains or in adjacent domains—such as when an
air-water interface extends into the PML—you must choose a single typical wavelength. Either choose a wavelength

provided by one of the interfaces, or set a user-defined wavelength.

The way the stretching functions are defined, it usually makes the most sense to select the longest wavelength of
propagating waves actually excited and propagating into the PML. Any shorter wavelengths must be accounted for
by increasing the mesh resolution and curvature factor in the PML.

In the Acoustics Module, MEMS Module, and Structural Mechanics Module, you can control the typical
wavelength passed from the physics interface to the PML, by changing the Typical Wave Speed property in the
physics interface’s settings window. The default wave speed generally corresponds to a compressional or pressure
wave, which is the fastest wave type and therefore of longest wavelength. In the RF Module, the default for the

typical wavelength is 2n/k, where & is the local wavenumber.

Perfectly Matched Layer

A Perfectly Matched Layer node (T_L-:) applies a complex coordinate scaling to a layer of virtual domains surrounding
the physical region of interest. When appropriately tuned, this layer absorbs all outgoing wave energy in

frequency-domain problems, without any impedance mismatch—causing spurious reflections—at the boundary.

To add a Perfectly Matched Layer to any Component, on the Definitions toolbar click Perfectly Matched Layer.
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COORDINATE SYSTEM IDENTIFIER
The default Identifier is pm11. The identifier provides a namespace for variables created by the Perfectly Matched
Layer node. For example, the scaled x coordinate can typically be accessed in equations and postprocessing as

pml1.x. See the Equation View subnode for a complete list of available variables.

To display the Equation View node under all nodes creating variables, click

]
E the Show button and select Equation View. Sce also Equation View.

DOMAIN SELECTION

Select a set of domains conforming to the selected geometry type. See Standard Geometry Configurations.

GEOMETRY
Select a Type—Cartesian (the default), Spherical, or Cylindrical.

* If Spherical is selected, enter the position of the center of the spherical geometry in the Center coordinate table.

For axisymmetric models, only the z coordinate is required since the geometry must be centered on the axis.

* If Cylindrical is selected, enter the position of a point on the cylinder axis in the Center coordinate table. For 3D

models, also enter a Center axis direction vector.

SCALING
Select a Coordinate stretching type—Polynomial (the default) or Rational. See PML Implementation for help on

making a decision.

Select an option from the Typical wavelength from list—Physics interface (the default) or User defined. If Physics
interface is selected, select one of the interfaces supporting PMLs from the Physics list. If User defined is sclected,

enter a value or expression for the Typical wavelength. The default is 1.

Note that the Physics interface setting has no effect in Eigenfrequency
studies. In that case, the typical wavelength is redefined to be equal to the
n PML width, as drawn in the geometry. The User defined option applies

unaltered.

Enter a value or expression for the PML scaling factor and the PML scaling curvature parameter which can be used to
tune the PMLs for wave fields with evanescent components or wavelengths deviating from the free-space

wavelength of plane waves. See further PML Implementation. The defaults are 1 for both.

If you have the Acoustics Module, see the models:
e Cylindrical Subwoofer: model library path
HH“ Acoustics_Module/Tutorial_Models/cylindrical_subwoofer

* Acoustic Scattering off an Ellipsoid: model library path

Acoustics_Module/Tutorial_Models/acoustic_scattering

If you have the RF Module, see the models:

i * Tutorial Models/Radar Cross Section (2D, cylindrical PML).
* Tutorial Models/RF Coil (3D, spherical PML with swept mesh).
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Known Issues When Modeling Using PMLs

When modeling with PMLs be aware of the following:

USE OF ONE SINGLE PERFECTLY MATCHED LAYER NODE

A separate Perfectly Matched Layer node must be used for each simply connected PML region. That is, to use one
and the same Perfectly Matched Layer node, all PML domains must be in contact with each other. Otherwise the
PMLs do not work properly.

ELEMENT QUALITY

The coordinate scaling resulting from PMLs also yields an equivalent scaling of the mesh that can effectively result
in a poor element quality. (The element quality displayed by the mesh statistics does not account for this effect.)
This typically happens when the geometrical thickness of the PML deviates much from one wavelength (local
wavelength rather than free space wavelength). The poor element quality causes poor convergence for iterative

solvers and makes the problem ill-conditioned in general.

For this reason, it is strongly recommended that you use swept meshing in the PML domains. The vector element
formulations (the ones using two or more components of a vector field variable) in the RF Module are particularly
sensitive to low element quality. The sweep direction should be selected the same as the direction of scaling. For

Cartesian PMLs and regions with more than one direction of scaling it is recommended to first sweep the mesh in
the domains with only one direction of scaling, then sweep the domains with scaling in two directions, and finish

by sweeping the mesh in the domains with PML scaling in all three directions.

COMPLICATED EXPRESSIONS

The expressions resulting from the stretching get quite complicated for spherical PMLs. This increases the time for
the assembly stage in the solution process. After the assembly, the computation time and memory consumption is
comparable to a problem without PMLs. The number of iterations for iterative solvers might increase if the PML

regions have a coarse mesh.

ERRONEOUS RESULTS
PML regions deviating significantly from the typical configurations shown in the beginning of this section can cause

the automatic calculation of the PML parameter to give erroneous results.

USE THE SAME MATERIAL PARAMETERS OR BOUNDARY CONDITIONS
The PML region is designed to model uniform regions extended toward infinity. Avoid using objects with different

material parameters or boundary conditions that influence the solution inside an PML region.

Infinite Element Implementation

Infinite elements apply a semi-infinite coordinate stretching in one, two, or three directions, depending on how the
infinite element domain connects to the physical domain. In each direction, the same form of stretching is used,
defined as a function of a dimensionless coordinate &, which varies linearly from 0 to 1 over the infinite element

layer. For an infinite element domain stretched in the direction of unit vector n, & is defined as

. -X-X

Aw
where x is the original, unscaled, coordinate vector, A, is the original thickness of the infinite element domain (as
drawn in the geometry), and x is a reference distance defined such that & = 0 whenever x lies on the boundary
between the infinite element and the physical domain. For a cylindrical or spherical infinite elements, for example,

X is its radius.
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The corresponding scaled coordinate vector X’, in which the equations are reformulated inside the infinite element

domains, is defined as
X' = X)+ n&f(&,)

where f(€) is a scalar stretching function, and X is the projection of the unscaled coordinate vector x onto the

surface & = 0:
Xq = x—ng;(n?x)+x0

The stretching function is defined as

f&) = y—_‘EEAp (5-1)

where A, is the, so called, pole distance and y is a number larger than one, computed as

where Ay is the scaled thickness of the infinite element domain.

The quantities ng, xg, and A, are computed automatically based on the sclected geometry type and an analysis of

the actual geometry. The scaled thickness A and the pole distance A, are user inputs.

There is no check that the geometry of the region is correct, so it is

n important to draw a proper geometry and select the corresponding region

type.

INTERPRETING INFINITE ELEMENT PARAMETERS
The infinite element stretching has two user-defined parameters which let you control the thickness of the
quasi-infinite region, as perceived by the physics interfaces, as well as how the stretching is distributed across the

domain.

Physical width The scaled width of the infinite element domain, Ay, is by default set to 1e3*dGeomChar, where the
constant dGeomChar is a characteristic geometry dimension. The domain is therefore by default scaled to be very
much larger than the original geometry, but not quite infinite in order to avoid numerical difficulties. In particular,

the finite distance to the far-away boundary allows prescribing standard boundary conditions effectively at infinity.

Pole distance The coordinate stretching function, Equation 5-1, used in the infinite element domain contains a

singularity when § = y. Since y > 1, this happens outside the infinite element domain. The pole distance, A, controls
just how far away this singularity is located. If Aj is small compared to the scaled width, A,, the coordinate stretching
will be very nonlinear, progressing from gentle close to the boundary with the physical domain to abrupt toward
to quasi-infinite boundary. Conversely, if the pole distance is large compared to the scaled width, the stretching will

be nearly constant across the domain.

The default pole distance is dGeomChar, which is small compared to the physical width. Therefore, the coordinate

stretching by default exhibits a nearly 1/r behavior, which is suitable for making optimal use of mesh resolution
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when the dependent variable also behaves as 1/r for large r, where r is the distance from any sources or

inhomogeneities.

By setting the physical width relatively small and the pole distance large,

it is often possible to use the infinite elements also for simulating a large

[

but finite domain.

Infinite Element Domain

An Infinite Element Domain node (I_'D.) applies a rational coordinate scaling to a layer of virtual domains surrounding
the physical region of interest. When the dependent variables vary slowly with radial distance from the center of the
physical domain, the finite elements can be stretched in the radial direction such that boundary conditions on the

outside of the infinite element layer are affectively applied at a very large distance from any region of interest.

To add an Infinite Element Domain to any Component, on the Definitions toolbar click Infinite Element Domain.

COORDINATE SYSTEM IDENTIFIER
The default Identifier is ie1. The identifier provides a namespace for variables created by the Infinite Element Domain
node. For example, the scaled x coordinate can typically be accessed in equations and postprocessing as ie1.x. See

the Equation View subnode for a complete list of available variables.

To display the Equation View node under all nodes creating variables, click
]
E the Show button and select Equation View. Sce also Equation View.

DOMAIN SELECTION

Select a set of domains conforming to the selected geometry type. See Standard Geometry Configurations.

GEOMETRY
Select a Type—Cartesian (the default), Spherical, or Cylindrical.

* If Spherical is selected, enter the position of the center of the spherical geometry in the Center coordinate table.
For axisymmetric models, only the z coordinate is required since the geometry must be centered on the axis.

* If Cylindrical is selected, enter the position of a point on the cylinder axis in the Center coordinate table. For 3D

models, also enter a Center axis direction vector.

SCALING
Enter expressions for the Physical width (SI unit: m) and the Pole distance (SI unit: m). The default values,
1e3*dGeomChar and dGeomChar, respectively, leads to an infinite element domain which is very large compared to

the geometry dimensions and with a nearly singular 1/r stretching.

Known Issues When Modeling Using Infinite Elements

Be aware of the following when modeling with infinite elements:

USE OF ONE SINGLE INFINITE ELEMENTS NODE
Use a separate Infinite Elements node for each isolated infinite element domain. That is, to use one and the same
Infinite Elements node, all infinite element domains must be in contact with each other. Otherwise the infinite

elements do not work properly.
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ELEMENT QUALITY
The coordinate scaling resulting from infinite elements also yields an equivalent stretching or scaling of the mesh
that effectively results in a poor element quality. (The element quality displayed by the mesh statistics does not

account for this effect.)

The poor element quality causes poor or slow convergence for iterative solvers and makes the problem
ill-conditioned in general. The vector element formulations (the ones using two or more components of a vector

field variable) in the AC/DC Module are particularly sensitive to low element quality.

For this reason, it is strongly recommended to use swept meshing in the infinite element domains. Select the sweep
direction to be the same as the direction of scaling. For Cartesian infinite elements in regions with more than one
direction of scaling it is recommended to first sweep the mesh in the domains with only one direction of scaling,

then sweep the domains with scaling in two directions, and finally sweep the mesh in the domains with infinite

element scaling in all three directions.

COMPLICATED EXPRESSIONS

The expressions resulting from the stretching get quite complicated for spherical infinite elements in 3D. This
increases the time for the assembly stage in the solution process. After the assembly, the computation time and
memory consumption is comparable to a problem without infinite elements. The number of iterations for iterative

solvers might increase if the infinite element regions have a coarse mesh.

ERRONEOUS RESULTS
Infinite element regions deviating significantly from the typical configurations shown in the beginning of this

section can cause the automatic calculation of the infinite element parameter to give erroneous results.

USE THE SAME MATERIAL PARAMETERS OR BOUNDARY CONDITIONS
The infinite element region is designed to model uniform regions extended toward infinity. Avoid using objects
with different material parameters or boundary conditions that influence the solution inside an infinite element

region.

References for PMLs and Infinite Element Domains

1. O.C. Zienkiewicz, C. Emson, and P. Bettess, “A Novel Boundary Infinite Element,” Int. J. for Numerical
Methods in Engineering, vol. 19, no. 3, pp. 393—404, 1983.

2.].P. Bérenger, “A Perfectly Matched Layer for the Absorption of Electromagnetic Waves,” J. Comput. Phys., vol.
114, pp. 185-200, 1994.

3. Jianming Jin, The Finite Element Method in Electromagnetics, 2nd ed., Wiley-IEEE Press, 2002.
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Visualization and Selection Tools

ComsoL Multiphysics® provides a number of tools to visualize and control how
you view models and select parts of the model geometry in the Graphics window

and the settings windows.
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Working with Geometric Entities

The topics in this section provide you with an introduction to the following;:

* About Geometric Entities defines the types of geometric entities in COMSOL, including information about

adjacent and overlapping objects in the Graphics window.
e The Graphics Window is the environment where the geometry is visualized and selected.

¢ About Selecting Geometric Entities is an important section that helps you to understand how to highlight, select,
or hide any part of the geometry using buttons, mouse clicks, keyboard shortcuts, or combinations of actions.
Many physics feature node settings windows have a common selection section, The Geometry Entity Selection

Sections, which also has several useful buttons available on the Settings Window Toolbar.

¢ The Selection List Window is a tool to help you to list all the specific geometric entities in the model and to

locate and select, for example, small parts of complex geometries.

¢ About Highlighted Geometric Entities in the Graphics Window describes the color scheme used to help you
visually determine what geometric entities are included or excluded in a model. This makes it easy to add or

remove domains, boundaries, edges, or points to the model.
¢ The section Selecting and Clearing Selection of Geometric Entities has a table with a list of the different ways to
select geometry using a variety of windows, mouse buttons, clicks, and keyboard shortcuts.

e The Graphics Window Toolbar Buttons includes a table with the different icons that display in the Model Builder
(based on space dimension). The rest of the section describes the tasks related to the toolbar—Zooming In and
Out in the Graphics Window, Changing Views in the Graphics Window, Moving Around and Rotating 3D

Geometry, Lighting, Transparency, and Wireframe Rendering, and Hiding and Showing Geometric Entities.

About Geometric Entities

Conceptually, a geometry is a collection of bounded geometric entities. Those entities are volumes, surfaces,
curves, or points. Geometric entities include domains, boundaries, edges (3D only), and points. For example, a 3D
cube consists of one domain with six boundaries. The six boundaries have 12 edges and the edges connect at eight
points (see Figure 6-1). This enables visualization of a cube by displaying one or more of these four types. For

instance, you can create a wireframe plot by rendering only the cube’s edges.

Geometric entities of the maximum dimension are called domains, while those of the next highest dimension are
called boundaries. The boundaries are sometimes referred to as faces in 3D and edgesin 2D. The vertices are also
called points.

Table 6-1 summarizes the terms used in COMSOL Multiphysics.

TABLE 6-1: NAMES OF GEOMETRIC ENTITIES IN DIFFERENT SPACE DIMENSIONS

ENTITY DIMENSION NAMEIN3D NAMEIN2D NAMEINID  NAME IN 0D
3D domain

2D boundary domain

ID edge boundary domain

0D vertex vertex boundary domain
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These rules apply to domains:

¢ The (interiors of the) domains are disjointed. However, this is only strictly true if the finalization method is to

form a union. When it is to form an assembly, domains can overlap (though that is normally considered a
modeling error).

Every geometric entity is bounded by entities of smaller dimension. In particular, a domain (in 3D, 2D, or 1D)

is bounded by boundaries, edges (in 3D), and vertices (in 3D and 2D). A boundary (in 3D or 2D) is bounded
by edges (in 3D) and vertices. An edge is bounded by vertices.

ADJACENT, OVERLAPPING, AND HIDDEN OBJECTS

Geometry objects are adjacent if they connect directly to each other. Hence all boundaries, edges, and points on
the cube are adjacent to the domain. An edge on the cube is adjacent to two boundaries and two points.

When you click a 3D geometry comprised of several objects, geometric entities of the same type might overlap and
hide each other at the point where you click. Overiapping objects, such as interior boundaries, are selected starting
with the closest geometric entity and ending with the entity the farthest away. Use the scroll wheel (mouse wheel)
to move the highlighting from the closest overlapping entity forward and back by rolling the wheel forward and
backward (if you use COMSOL on a computer with a touchpad instead of a mouse, use its equivalent to the wheel;
for example, moving two adjoining fingers up or down the touchpad). If you can move the mouse wheel in small
distinct increments, each such increment moves the selection to the next or previous entity that you can reach.
Alternatively, use the up arrow and down arrow keys to select the next or previous entity, respectively.

Two domains selected - Aboundary selected on Two edges selected on
a cube and a cone each domain

each boundary

Two points selected on each domain

Two points selected on boundary—with wireframe rendering

each domain boundary

T W,
- W,
. N
h N
|\ — 5_)'\
b, e
P \\K N

Figurve 6-1: A 3D geometry comprises domains, boundaries, edges, and points.
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* The Graphics Window
* About Selecting Geometric Entities

* About Highlighted Geometric Entities in the Graphics Window

The Graphics Window

The Graphics window (Figure 6-2) is a graphical view of the geometry, mesh, and results of the model. The window
has useful tools for changing the view and selecting multiple entities—geometry objects when creating the
geometry as well as domains, boundaries, edges, and points to define the physics or to select geometric entities for
fine-tuning the mesh or evaluating quantities in a certain part of the model, for example.

The toolbar at the top of the Graphics window has a set of tools for changing the visualization (for example, to
zoom in or out or to add transparency) and for making selections. The available tools are dynamic and change based

on the space dimension and what you are viewing in the graphics window at the time.

-~ 1

Q Q Ly @E | @8
t_plate=0.012, t_mount=0.015
Surface: Displacement field, Z component (um)

A 41,328

Yo

Figure 6-2: The Graphics window displaying o Surface plot for the Diagonal Mounting Detail of & Communication
Mast model. This image displays for Windows users. The Mac and Linux Graphics window looks slightly different but
Sfunctions the same and bas the same toolbay.

* Capturing and Copying Screen Shots
* About Geometric Entities
El * The Graphics Window Toolbar Buttons

e Named Selections
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Basic Selection Concepts

The following basic selection concepts are useful for picking geometric entities where you want to apply physics,
boundary conditions, or other parts of the model:

¢ To pick a geometric entity in the Graphics window and add it to the current node’s selection list, simply click it.
The geometric entity then appears in the selection list. Click again to deselect.

* You can also use the Selection List window to pick geometric entities, which you then add to the current selection
by right-clicking and selecting Add to Selection or clicking the corresponding toolbar button ( == . You can select
multiple entities from the selection lists using Ctrl-click or Shift-click.

e Itis good practice to add selection nodes with a selection of geometric entities that you can give a descriptive
name and that contains geometric entities that represent a specific part of the geometry (a ground plane or an
outlet, for example). You can then choose that selection node as a predefined selection from the Selection lists in
the physics nodes, for example.

¢ For adding physics nodes from the toolbars, it can be useful to use a preselection by setting the Active button to
off in the current settings window. You can then select geometric entities and click the toolbar button for the
physics that you want to add. That physics node, when added, then gets the selection that you have preselected.

You can choose to use the selection mechanisms and highlighting that was

available in earlier versions of COMSOL by selecting the Use classic

[

selections check box on the User interface page in the Preferences dialog
box (and restarting COMSOL).

About Highlighted Geometric Entities in the Graphics Window

COMSOL highlights geometric entities at different stages of selection. A geometric entity is highlighted in red,

blue, green, yellow, or with no highlight (gray) to indicate its status.

Another visual cue to help you work in the Graphics window is that the
geometry can have thicker edges (with OpenGL and Software rendering
only, not DirectX), or larger points to highlight the different geometric
entities selected. With the default graphics preference, to optimize for

[

quality (for graphics cards that support it), highlighted geometric entities
appear with a “glowing edge.” If required, change the default from The
Preferences Dialog Box under Graphics and Plot Windows>Visualization.

BLUE
A geometric entity highlighted in blue is included in the selection list for the specific node. See Figure 6-4 for an

example.

When assigning geometric entities to a node and you hover over that entity in the Graphics window, click once to
add it to a selection list. See Figure 6-5 for an example.

RED

When a geometric entity is selected in a selection list or on The Selection List Window, it is highlighted in red to

help you locate it on the Graphics window. See Figure 6-4 for an example.

When assigning geometric entities to a node, and you hover over that entity in the Graphics window, it displays in
red to indicate it has not been added to the selection. See Figure 6-5 for an example.
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GREEN

When you hover over a geometric entity in the Graphics window, it displays in green to indicate that it is included

in the selection list. See Figure 6-4 for an example.

GRAY (NO HIGHLIGHT)
If the geometric entity is gray (that is, not highlighted), it means it is not selected or included for that node and

geometric entity level. See Figure 6-5 for an example.

YELLOW
Next to the settings window’s selection list there is an Active button to toggle between turning ON and OFF

selections; that is, making the selections active for that selection list. For Windows users, the buttons are [an [
and [[FJarf] . For Mac and Linux users the buttons are ( (13 ) for ON, and ( (!} ) for OFF.

When the button is toggled to OFF, the selection mode is a preselection that will be used for a selection that you
add to the model from the toolbar, and the selection for the current node in the model tree is highlighted in yellow
in the Graphics window. See Figure 6-3.

Linear Elastic Material * | Graphics 1
Domain Selection @ Q 4 plEw B
Selection: |All domains k]
é L] + T
e |3 B - | |
ctive 5 | - L
; [_j&' o 200" i~
<> /
G | |
? -
100 ™

Cwverricde and Contribution

Equation T/ 0 J-\"_" Y
¥ H Lo \.-\-‘5.
Model Inputs + R 0
: . 5050
¥ Coordinate System Selection

Figure 6-3: When the Active button is OFF, the selection for the curvent node is bighlighted in yellow.

Hover over an entity in the Graphics window. When the selection is active, add or subtract it from the selection list

(see Figure 6-6) by observing how the colors cycle on and off:

COLOR WHEN CURRENT STATUS NEW COLOR NEW STATUS WHEN
HOVERED OVER WHEN CLICKED CLICKED
Green Included as a selection  Gray Not included as a
for the node. selection for the node.
Red Not included as a Blue Included as a selection
selection for the for the node.
node.
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Linear Elastic Material *| Graphics 1
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Domain Selection

Selection: | All domains =
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I Equation
[ Model Inputs 4

I Coordinate System Selection
I Linear Elastic Material

¥  Geometric Nonlinearity 'Messages|Progress Log .

Figure 6-4: Domain 2 is selected on the Linear Elastic Material settings window. Domain 2 is highlighted in ved in the
Graphics window to indicate where it is on the geometry (top image). Hover over a geometric entity in the Graphics
window and it displays in green (bottom image). The blue highlight indicates that these domains ave included as the
selection, in this case because it is a default node and the selection cannot be changed. This example uses the Diagonal
Mounting Detail of & Communication Mast model.
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Figure 6-5: You want to add a domain to the Body Load node to make the load act on that domain. When you hover
over a geometric entity in the Graphics window it displays in ved to indicate it has not been added to the selection list
(top). Click the domain to add it to the selection list on the settings window and it displays in blue to indicate it has
successfully been added (bottom). In both images, gray-coloved domains are not selected or included.

About Selecting Geometric Entities

Throughout COMSOL there are many lists of selected geometric entities, all based on the same principle—pick a
domain, boundary, edge, or point and use methods to add or remove these geometric entities to create selections
that define, for example, the parts of the geometry where a material or boundary condition is active. Such lists
appear in settings windows for defining equations and material properties, boundary conditions, sources, and other
parts of the model’s physics, or the Variables node (a= ) definitions for variables that are not defined in the entire
model.

All levels of geometry can be treated individually. You can add and remove 3D geometric entities (domains,
boundaries, edges, or points) to selection lists in different ways, including buttons on the Graphics toolbar (The
Graphics Window Toolbar Buttons), using The Selection List Window, clicking directly on the geometry, or
clicking buttons in the settings window. Table 6-2 lists the buttons that display on every settings window with a
geometric entity selection list as displayed in Figure 6-6.
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Domain Selection ——Geometric entity level

Selection: [AII domains - ] Selection list options
i D] 1 Selected geometric entity — +
g numbers. In this example, |__|E| s Selection
. All domains are included. -2 | toolbar butt
Active 1 f‘lj .EUj oolbar buttons
o
5 Active ON button. i
7 Toggle to turn OFF the
selection.

Boundary Selection

____This Selection cannot be
changed as this is for a

Selection: |All boundaries

lm ; l,:I ‘: + default node.
g =
. 4 fr. X Selected boundaries. In this
Active |5 (not applicable) F' Ll example, All boundaries
]

- are included and when
7 /boundaries are overridden
& (overridden) / or not applicable it is

3 {ovwerridden’ - indicated.

Figure 6-6: The selection list and toolbar on a physics node settings window. The geometric entity level for the top settings
window is domains. The bottom settings window is for a default boundary condition node where the selection cannot be
changed, although a boundary can be overridden.

Materia -4 Variables ~1

Geometric Entity Selection Geometric Entity Selection

Geometric entity level: Geometric entity level
Selection: All domains A

=

|_—‘E| - Active
Active ETj .?fl]

[

P T RS TTI AT

Figure 6-7: The Geometric entity level selection list and toolbar on a Material node settings window (left) and the
Variables settings window (vight).

In The Graphics Window the geometric entities are color highlighted as you make the selections, and you can lock
the selections by turning off the active selections or click the Select Node button (= in 3D) in the Graphics window

toolbar.

THE GEOMETRY ENTITY SELECTION SECTIONS
The name of the section where the list of selected geometric entities is managed depends on the geometric entity

level. For example, Figure 6-6 displays a Domain Selection section.
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Every geometric entity selection section also has an Active button to toggle between turning ON and OFF active
selections for that node. For Windows users, the buttons are [ay [ and [F7cer] - For Mac and Linux users the
buttons are ( (!} ) for ON, and ( {1} ) for OFF.

For physics nodes that are default nodes (see Physics Default Nodes) the selection defaults to all geometric entities
on the applicable level (all domains or all boundaries, for example, in Figure 6-6), and the Selection list is not active.
You can add other nodes that override the default nodes for some or all entities. Those entities are then marked

(overridden) in the selection list for the default node.

¢ Geometric Entity Selection: For Materials and Variables nodes, where you first select the level (domain, boundary,
and so on), from a Geometric entity level list. See Figure 6-7 for an example using the “Diagonal Mounting Detail

of a Communication Mast” model.

¢ Domain Selection: For nodes that define, for example, material models, sources, and body loads in domains. See

Figure 6-6 for an example.
¢ Boundary Selection: For nodes that define, for example, boundary conditions.

* Edge Selection: For nodes that define, for example, conditions and forces on edges. This is applicable to 3D

models only.

* Point Selection: For nodes that define, for example, point sources and point loads.
From the Selection list you can choose one of the following options:

* Manual (the default): Select the geometric entities directly in the Graphics window, using The Selection List

Window, or using the Paste Selection button. See below for more information about those selection methods.

If you start by setting the Geometric entity level to Domain, and then select

All domains, the Selection list displays all domains. If you make any changes

[

to this list (for example, remove a domain) the Selection list reverts to

Manual.

* All domains, All boundaries, All edges, All points: Depending on the geometric entity level, you can choose one of

these options to select all entities. See Figure 6-6 for example.

* Defined named selections: Selection nodes added in the geometry sequence or under Definitions (as well as
selections created from Boolean operations, for example) are available in the Selection lists for nodes that define
model properties for the same geometric entity level. You can rename such selection nodes to better reflect what
the selected entities represent. A named selection can consist of, for example, the domains where a volume force
acts, the boundaries where an inflow occurs, or points that are grounded. Named selections are useful for reusing
selections in a model and to clearly indicate what parts of geometry that the selected entities include or represent.

See Creating Named Selections.

In the lists of selected entities, (overridden) and (not applicable) can display next to the label (the number) of a
selected entity. See Figure 6-6 and Physics Node Status for more information about these status indicators. There
is also an Override and Contribution section in all physics nodes. It provides an overview of how the physics nodes

and their selections interact. See Physics Exclusive and Contributing Node Types.

Pair Selection

If the geometry is an assembly you have access to specific pair conditions (typically on boundaries) that you choose
from a Pairs submenu on the main physics nodes’ context menus. In the settings window for such pair nodes, a Pair
Selection section contains a list of the applicable pairs (typically identity pairs). The Boundary Selection section (or
another standard selection section) is then unavailable and shows the entity numbers for the boundaries, for

example, that the selected pairs include. You specify for which pairs the pair condition is applied by selecting on or
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more pairs from the Pairs list. See Identity and Contact Pairs.

See Table 6-3 for the many different ways to select geometric entities
using toolbar buttons, mouse click options, page settings, and keyboard

[

shortcuts.
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SETTINGS WINDOW TOOLBAR

TABLE 6-2: GEOMETRIC ENTITY SELECTION BUTTONS ON VARIOUS SETTINGS WINDOWS

BUTTON NAME DESCRIPTION

[on T Active ON Click the Active button ON to make the
Windows selection of geometric entities to the Selection
g
list active for that particular node.

1
O (Mac and
Linux)

[ETorF] Active OFF Click the Active button OFF to lock/deactivate
(Windows) the geometric entities in the Selection list for
that particular node. The selected entities in
the geometry are highlighted in yellow in the
Graphics window. See Figure 6-3 for an
example. The Graphics window is then available
for preselection of entities for a new node.

1
O (Mac and
Linux)

- Create Selection  Use this button to create selection nodes under
Definitions to represent various parts of the
geometry and simplify the process of assigning
materials, model equations, boundary
conditions, and model properties. See Creating
Named Selections. This button is also on The
Selection List Window.

|__'E| Copy Selection Use this button to copy the selection from the
list in the settings window to the clipboard. See
Copying and Pasting Selection Lists. This
button is also on The Selection List Window.

|_ﬁ"|:| Paste Selection Use this button if you have a list of geometric
entities in a file or document that you want to
type in and then paste into a selection list. If
you copy a selection from a document to the
clipboard, you can paste the selection directly
using Ctrl+V. An example is a list of geometric
entity numbers described as a step in a
modeling instruction. See Copying and Pasting
Selection Lists. This button is also on The
Selection List Window.

o) Add to Selection  Use this button to add a geometric entity to a
selection list. See Table 6-3. This button is also
on The Selection List Window.

— Remove from Use this button to remove a geometric entity
Selection from the Selection list. See Table 6-3. This
button is also on The Selection List Window.

& Clear Selection Use this button to clear a selection. Clearing
the selection also activates the selection for
that node.

[ Zoom Selected Use this button to zoom into the selected
geometric entities.

The Selection List Window

Use the Selection List window (see Figure 6-8) to make it easier to choose objects, for example, while working with
complex geometries and when you need to easily locate a geometric entity that is not easily viewed. The Selection

List is particularly useful when you know the geometric entity number to select; for example, when you are
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following step-by-step model instructions to build a model (in that case you can also copy and paste the selections
directly from the instructions).

To open the window, from the Home ribbon select More
Win Windows>Selection List (i ).

is

To open the window, select Windows>Selection List (" ).

Linux

Selection List v x

cEBED Y - @

I R T

Figure 6-8: The Selection List window and toolbar. Most of the toolbar buttons arve also on a node settings windows. In
this example, the numerical vepresentation for the domains is listed. See Table 6-2 for button information.

WORKING WITH THE SELECTION LIST WINDOW

The Selection List window displays all geometric entities of a certain type (boundaries, for example). COMSOL
Multiphysics determines the geometric entities listed based on where in the model you are working. This is different
from selection lists in settings windows, which contain lists of the selected entities only (see About Selecting
Geometric Entities, Figure 6-6).

Click any item to see it highlighted in The Graphics Window—except if the item is hidden, which is indicated in
the Selection List by (hidden)—and select items as described in Selecting and Clearing Selection of Geometric

Entities. For example, use the Selection List in these situations:

Materials, Physics, and Boundary Conditions: When working in windows with Selection or Geometric scope
sections (a Selection window under a Definitions node for example), or anywhere you assign materials, physics,
boundary conditions, and other Component settings. The Selection List displays the specific geometric entity level
selected (domain, boundary, edge, or point). See Figure 6-13 for an example.

Geometry: When in the Model Builder under the Geometry node—the geometry objects are displayed in the

Entities to select, for example, ext1 (extrusion), blk1 (solid), or conel (solid) (Figure 6-9). You might also
use it with a Chamfer or Fillet geometry feature when you want to locate specific points. To specify the selection
level, click the Select Points button in the Graphics toolbar and add the points to the Vertices to fillet or Vertices to
chamfer lists. See Creating Named Selections in the Geometry Sequence for details about creating selections based

on geometry sequences.

Meshing: When in the Model Builder under the Mesh node, the list also includes information on which entities are
meshed by adding (meshed) to the right of the meshed entities. If the Geometry has Mesh Construction entities,

the list also specifies if a construction entity has been removed; see Mesh Control Entities. This is indicated next to
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the entity in the list by (meshed and removed).

ection -4 Free Tetrahedra
[E1 Build Selected [E8 Build All

Explicit S¢
[E1 Build Selected [E8 Build All

~  Entities to Select ¥ Domain Selection

Entities to select: Selection:

[Corr 4 fin + [onpy| (4 = +
2 — 7 E‘El —

Active Active E:'E‘I '%:']
e

Figure 6-9: An example of an Explicit Selection settings window for a Geometry sequence (left) and a Free Tetrahedral
settings window for a Mesh node (right).

e Creating Named Selections
¢ Named Selections

* About Selecting Geometric Entities

Selecting and Clearing Selection of Geometric Entities

The sections About Selecting Geometric Entities and The Selection List Window give an overview of some of the
tools and windows available to highlight and select geometric entities. About Highlighted Geometric Entities in
the Graphics Window describes the different colors that display in the Graphics window to help you select
geometric entities to include in your model.

Table 6-3 contains the description of the different ways to complete the same task of selecting (or deselecting)

geometric entities.
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TABLE 6-3: DIFFERENT WAYS TO SELECT GEOMETRIC ENTITIES

TASK

ACTION

Select any level of
geometry:

Select all parts of the
geometry:

Clear the selection of all
parts of the geometry
not added to a selection
list:

Move, rotate, and then
select (3D only):

Lock the geometry
during selection:

Add to Selection sf=:

In The Graphics Window, click the geometric entity to add it
to an active selection list in the current node’s Settings window.

Open The Selection List Window and click entity numbers
(or names); then click the Add to Selection button ( == ) to add
it to an active selection list in the current node’s Settings
window.

In most settings windows’ selection sections, the option to
select All domains, All boundaries, All edges, or All points adds
all geometric entities of that type to the list of selected entities.
The selected items are highlighted in the Graphics window and
all entities are kept selected even if the geometry changes.

Open The Selection List Window, use the Shift or Ctrl keys
to select all the entity names (or numbers). You can also click
the main geometry node to select all entities that the node
includes. Then click the Add to Selection button ( =) to add it
to an active selection list in the current node’s Settings window.

In the Graphics window, click the Select All button ([ in 3D),
or click outside of the geometry or press Ctrl+A to select all
entities. For Windows users, a Select All button is available on a
customized Quick Access Toolbar. For Mac and Linux users,
from the main menu select Edit>Select All. This highlights and
selects all entities but does not confirm the selection or lock it
if the model changes.

In the Graphics window, click the Clear Selection button (.'E:I} ),
or click outside of the geometry or press Ctrl+D to clear all
selected entities. For Windows users, a Clear Selection button
is available on a customized Quick Access Toolbar. For Mac and
Linux users, from the main menu select Edit>Clear Selection.

Multiple mouse actions can be done together. For example, use
the mouse to rotate or move the object left and right to locate
the geometric entity to add to a selection list; then click to add
to the selection.

In the Graphics window, click the Select None button (\\).
Then no clicks in the graphics highlights or picks any geometric
entities, so you can move and rotate the geometry freely.

In the Graphics window, click a red highlighted entity to add it
and make it blue. Or select one or more geometric entities and
click the Add to Selection button.

In the Selection List window, select the entity names to add,
and click the Add to Selection button.

You can also paste selections from a file. See Copying and
Pasting Selection Lists for information.

For user-defined selections this action must be completed on
the selection page. See Create an Explicit Selection from the
Selection List Window for information.
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TABLE 6-3: DIFFERENT WAYS TO SELECT GEOMETRIC ENTITIES

TASK

ACTION

Select Box:
3D [ 2D (# |D =

Select Objects:

3D gy 2D ‘g ID
Select Domains:
iIDE2D@ D —

Select Boundaries:
3D g 2D ID —-

Select Edges [—:

Select Points:
3D12D

Select None:

3D & 2D \\ ID \\
Select All E-':_-';i

Edit (#:

To select multiple parts of the geometry, in the Graphics
window, click the Select Box button then click and hold the left
mouse button to draw a square over the geometry. It is like a
“rubberband” selecting all entities enclosed by this operation.
The selected geometric entities are added to the selection list.

In the Selection List window, use the Shift or Ctrl keys to select
the entity names (or numbers). Click the Add to Selection
button.

In the Graphics window, click the Select Objects button. Click
to select the geometry object and add it to the selection list.

In the Graphics window, click the Select Domains button. Click
to select the domains and add it to the selection list.

In the settings window, select Domain from a Geometry entity
level list and then click in the Graphics window. Only domains
are highlighted.

In the Graphics window, click the Select Boundaries button.
Click to select the boundary and add it to the selection list.

In the settings window, select Boundary from a geometry entity
level selection list and then click in the Graphics window. Only
boundaries are highlighted.

In the Graphics window, click the Select Edges button. Click to
select the edge and add it to the selection list.

In the settings window, select Edge from a geometry entity
level selection list and then click in the Graphics window. Only
edges are highlighted.

In the Graphics window, click the Select Points button. Click to
select the point and add it to the selection list.

In the settings window, select Point from a geometry entity
level selection list and then click in the Graphics window. Only
points are highlighted.

In the Graphics window, click the Select None button to turn off
all selections so that you can click in the Graphics window to
move or rotate the geometry, for example, without adding any
object or entity to a selection.

In the Graphics window, click the Select All button to select all
objects or entities.

Interactive editing of 2D geometry objects so that you can
click-and-drag to resize and move geometry objects. Alt-click a
2D geometry object to edit its underlying properties and drag
its control points, for example. Right-click to edit that
geometry editing mode. See Moving and Scaling 2D Objects
in the Graphics Window.

CHAPTER 6: VISUALIZATION AND SELECTION TOOLS



TABLE 6-3: DIFFERENT WAYS TO SELECT GEOMETRIC ENTITIES

TASK

ACTION

Remove from
Selection == :

Clear Selection ,"E:I":

In the Graphics window, highlight or select the geometric entity
and click the Remove from Selection button.

In the Graphics window, click to highlight and select the
geometric entity to remove. Any blue geometric entity turns
gray to indicate it is removed from the selection.

In the Selection List window, use the Shift or Ctrl keys to select
the entity names to remove. Click the Remove from Selection
button.

For user-defined selections this action must be completed on
the selection page. See Create an Explicit Selection from the
Selection List Window for information.

Click the Clear Selection button to clear all selections from the
selection list.

For user-defined selections this action must be completed on
the selection page. See Create an Explicit Selection from the
Selection List Window for information.

The Graphics Window Toolbar Buttons

Some of the toolbar buttons available on the Graphics window are different based on the space dimension of the

Component. The buttons also correspond to domain, boundary, edge, and point level nodes that display under the

physics, which are also based on the Component space dimension as shown in Table 6-4. The buttons in Table 6-5

are available in any space dimension.

In the tables there are links to the corresponding sections that contain instructions about how to do the listed tasks.

TABLE 6-4: GRAPHICS TOOLBAR BUTTONS BY SPACE DIMENSION

NAME

3D 2D AND 2D ID AND ID
AXISYMMETRIC  AXISYMMETRIC

Selecting and Clearing Selection of Geometric Entities

Select Boundaries
Select Box

Select Domains
Select Objects
Select Points
Select Edges
Select None

Select Edit

== = .
= [ ] —
| ] - —
B _ _
S \

&%

Changing Views in the Graphics Window

Go to XY View

Go to YZ View

Go to ZX View

XY —_ J—

[y
IE — —
[z

Lighting, Transparency, and Wireframe Rendering
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TABLE 6-4: GRAPHICS TOOLBAR BUTTONS BY SPACE DIMENSION

NAME 3D 2D AND 2D ID AND ID
AXISYMMETRIC  AXISYMMETRIC
Scene Light wh — —
Transparency = — —
Wireframe Rendering = — —

Drawing on a 2D Work Plane in 3D

Align with Work Plane* —

Work Plane Clipping* —

{l& —

*These buttons are available when using a Work Plane to define a 2D object

in 3D.

TABLE 6-5: GRAPHICS TOOLBAR BUTTONS AVAILABLE FOR ALL SPACE DIMENSIONS

BUTTON  NAME SEE ALSO

Y Select All (Ctrl+A)

,;'] Clear Selection (Ctrl+D)

¥ Select and Hide Hiding and Showing
Geometric Entities

View Unhidden

View Hidden Only

View All

_ Reset Hiding

& Zoom In Zooming In and Out in
the Graphics Window

&) Zoom Out

[ Zoom Selected

.
B < -
.

LN

Zoom Extents

Go to Default View

Image Snapshot

Print

Changing Views in the
Graphics Window
Capturing and Copying
Screen Shots

Printing from the
COMSOL Desktop
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ZOOMING IN AND OUT IN THE GRAPHICS WINDOW

BUTTON NAME

ACTION

] and Zoom In and

S Zoom Out
i Zoom Box
ez Zoom Selected

Zoom Extents

Click the Zoom In button to zoom in. Click the Zoom Out
button to zoom out.

3D only: Click the middle mouse button and drag it forward
and backward to zoom in and out of the object. The zoom is
centered where the first click is made in the Graphics window.

To zoom into a general area of the geometry, click the Zoom
Box button then click and drag to highlight a section of the
geometry to zoom into.

Click the Zoom Selected button to zoom into the selected
geometric entities. This button is also available in connection
with the selection lists for domains, boundaries, edges, and
points.

Click the Zoom Extents button to zoom out and fit the
complete geometry into the window.

CHANGING VIEWS IN THE GRAPHICS WINDOW

BUTTON NAME

ACTION

L Go to XY View,
|£ Go to YZ View,
. and Go to ZX
[ View (3D only)
v Go to Default

View
Display a

user-defined view:

Click the Go to XY View, Go to YZ View, and Go to ZX View
buttons to change the view to the xy-, yz-, or zx-plane. The
first click selects the plane view with a positive normal
direction. A second click on the same button switches to a
negative normal direction.

Click the Go to Default View button to change the view to
the default.

After creating a View under the Definitions node, click the
down arrow next to the Go to View button (»|.-) and select
a user-defined view from the list.

MOVING AROUND AND ROTATING

3D GEOMETRY

TASK ACTION AND RESULT OPERATION
ORDER
Rotate the geometry about the  In the Graphics window, left-click and left-click

axes

Move the visible frame on the
image plane in any direction

Zoom in and out around the
mouse position where the
action started

hold down the mouse button while
dragging it in any direction.

This rotates the scene around the axes
parallel to the screen X- and Y-axes
with origin in the scene rotation point.

In the Graphics window, right-click and  right-click
hold down the mouse button while
dragging it in any direction.

In the Graphics window, click and hold middle-click
down the middle mouse button and

drag the mouse forward or back to

zoom in and out.

WORKING WITH GEOMETRIC ENTITIES

325



TASK ACTION AND RESULT OPERATION
ORDER
Rotate about the X- and Y-axes  Press Ctrl and left-click in the Graphics ~ Ctrl+left-click

in the image plane (tilt and pan
the camera)

Move the camera in the plane
parallel to the image plane

Rotate the camera about the
axis

Move the scene in the plane
orthogonal to the axis between
the camera and the scene
rotation point

Move the camera into and away
from the object (dolly in/out)

Rotate the camera about its
axis between the camera and
the scene rotation point (roll
direction)

Move the camera along the axis
between the camera and the
scene’s rotation point

window. While holding down the key
and button, drag the mouse in any
direction.

This places the rotation coordinate
system in the camera and rotates
around the axes parallel to the screen
X- and Y-axes.

Press Ctrl and right-click in the Graphics
window. While holding down the key
and button, drag the mouse in any
direction.

Press Ctrl+Alt, then left-click in the
Graphics window. While holding down
the keys and button, drag the mouse in
any direction. If you have not rotated
the camera (using Ctrl+left-click), the
effect is the same as when using
Alt+left-click.

Press Alt, then right-click the mouse in
the Graphics window. While holding
down the key and button, drag the
mouse in any direction.

Press Ctrl and then click the middle
mouse button. While holding down
both the key and button, in the Graphics
window, drag the mouse in any
direction.

Press Alt, then left-click in the Graphics
window. While holding down the key
and button, drag the mouse in any
direction.

Press Alt, then middle-click in the
Graphics window. While holding down
the key and button, drag the mouse in
any direction.

Ctrl+right-click

Ctrl+Alt+left-c
lick

Alt+right-click

Ctrl+middle-cli
ck

Alt+left-click

Alt+middle-clic
k

LIGHTING, TRANSPARENCY, AND WIREFRAME RENDERING

The following are available for 3D models.

BUTTON NAME ACTION

wf Scene Light Click any plot under Results. In the Graphics window or any other
plot window, click the Scene Light button to turn it on. Click

again to turn scene light off. See Figure 6-10.

When creating a View, this action toggles the Scene light check
box on the View page.
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BUTTON NAME ACTION

| Transparency Click any plot under Results. In the Graphics window or any other
plot window, click the Transparency button to turn it on. Click
again to turn transparency off. See Figure 6-10.

When creating a View, this action toggles the Transparency check
box on the View page. See User-Defined Views.

= Wireframe Click any plot under Results. In the Graphics window, click the

Rendering Wireframe Rendering button to turn it on. Click again to turn the
wireframe off. See Figure 6-10.
When creating a View, this action toggles the Wireframe
rendering check box on the View page. See User-Defined Views.
See also Preferences Settings to set the level of graphic detail to
Wireframe and speed up the rendering of complex models or to
improve visual appearance.

Scene light on and Transparency off Scene light off

Transparency on Wireframe rendering on

Figure 6-10: Scene lLight, transparency, and wireframe vendeving examples.

HIDING AND SHOWING GEOMETRIC ENTITIES

Selecting an item in any Selection list highlights the corresponding geometric entities or objects in the Graphics
window for selection or deselection. Only the geometric entities you can see in the Graphics window are available
for selection; that is, hidden objects cannot be selected and selection methods vary based on the Component’s space
dimension.
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BUTTON NAME ACTION

o Select and Hide  In the Graphics window, toggle the Select and Hide button
(click to highlight and turn on and click again to turn off).
When turned on, click a geometric entity and it is added to the
selection list as being a hidden entity. See Figure 6-11.

When creating a View, right-click the View node and select Hide
Geometry Objects. Select a Geometric entity level from the list
to hide.

Also see Hide Geometry Objects and Hide Geometric
Entities when creating a View.

View Unhidden In the Graphics window, click the View Unhidden button to
display any domains, boundaries, edges, or points not hidden.

View Hidden In the Graphics window, click the View Hidden Only button to
Only display only hidden domains, boundaries, edges, or points.
View All In the Graphics window, click the View All button to display all
hidden and unhidden domains, boundaries, edges, or points.
- Reset All In the Graphics window, click the Reset Hiding button to reset

all hidden domains, boundaries, edges, or points to the default.

This removes any Hide Geometry Objects or Hide Geometric
Entities subnode added to a View node. See Hide Geometry
Objects and Hide Geometric Entities.

When the View Hidden Only button ([Z]), View Unhidden button ([&]), or
View All button () is clicked on the Graphics window toolbar it changes
the view accordingly. The selection list on the settings window details
what is hidden or shown based on the button clicked. See Figure 6-11
and Figure 6-12 for examples based on the original geometry shown in
About Highlighted Geometric Entities in the Graphics Window.

e

Linear Elastic Materia Y| Graphics
aaQae@| Lraxxzkz HhE=BER

Domain Selection

Selection: | All domains

1 s+
2 =
=3 | -
Active |4 (hidden) [
5 <.
G
7 (hidden)
Override and Contribution z
Equation y‘\I/r}{
Model Inputs +

Figure 6-11: An example of the domains that display in the Graphics window when the View unhidden button is clicked.
The selection list displays the detail that domains 4 and 7 ave hidden in the Graphics window. Compare to Figure 6-12.
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Selection: [AII domains V]
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—' |3 (hidden) BB -
Active |y E ﬁ‘!
5 (hidden) e
6 (hidden) i
7

I Owverride and Contribution z
I Equation y\L,}{
I Model Inputs *

Figure 6-12: An example of the domains that display in the Graphics window when the View unhidden only button is
clicked. The selection list displays the detail that domains 2, 3, 5, and 6 ave hidden in the Graphics window. Compare to
Figure 6-11.
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Named Selections

This section details how to create named selections to reuse throughout the model when assigning material

properties, boundary conditions, and other model settings.

You can create selection nodes under the Component node’s Definitions node to represent various parts of the
geometry and simplify the process of assigning materials, model equations, boundary conditions, and other model
properties. These user-defined selections can be reused during modeling and named using descriptive titles—for
example, Tube,Wall, or Fluid. Changes to the selection (for example, by adding or removing a boundary) updates

all nodes in the Component that use that particular selection.

Use the buttons listed in Table 6-2 to create, copy, and paste selections. When there is the possibility of overlapping
geometric entities, it is recommended that you use The Selection List Window to ensure the correct part of the

geometry is selected.

There are different types of selections—Explicit selections, selections by enclosing part of the geometry by a
bounding Ball, Box, or Cylinder, Boolean selections (Union, Intersection, Difference, and Complement), and
selections of Adjacent geometric entities. To add selection nodes, right-click a Definitions node and choose from the

Selections options as listed in Table 6-6.

You can also right-click the Geometry node and choose from Selections options similar to those in Table 6-6 for
defining selections based on the geometry objects in the geometry sequence. See Creating Named Selections in the

Geometry Sequence.

OPEN AN EXAMPLE MODEL WITH DEFINED EXPLICIT SELECTIONS
Figure 6-13 uses a COMSOL Multiphysics model library example, which includes several user-defined selections.
I Open The Model Libraries Window.

2 Navigate to the COMSOL Multiphysics>Structural Mechanics>mast_diagonal_mounting model file. Double-click to

open it.

3 Expand the Definitions node under Component 1. Several nodes display in the Model Builder. Click the nodes

shown in Figure 6-13 to examine the list of geometric entities displayed in the Explicit settings window.

In the selection settings windows, also click the Zoom Selected ([ )
g button to zoom in on the selected geometric entities.
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Figure 6-13: An example of an Explicit selection window for the Mount, mid level node. The Selection nodes under

Definitions arve venamed by the user.
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THE TYPES OF NAMED SELECTIONS

TABLE 6-6: NAMED SELECTIONS BY TYPE

ICON  TYPE DESCRIPTION
G Adjacent Use the Adjacent node to create the selection as the adjacent
geometric entities (boundaries, for example) to one of more
selections.
fm Ball Use the Ball node to create the selection by enclosing part of

the geometry by a bounding ball (sphere) to select geometric
entities that are partially or completely inside the ball.

f&] Box Use the Box node to create the selection by enclosing part of
the geometry by a bounding box to select geometric entities
that are partially or completely inside the box.

Cylinder Use the Cylinder node to create the selection by enclosing
part of the geometry by a bounding cylinder to select
geometric entities that are partially or completely inside the
cylinder.

—
| ¥

. Explicit Use an Explicit node to create the selection using the normal
selection tools for individual geometric entities (boundaries,
for example) on the geometric entity level chosen.

Union, Intersection, Difference, and Complement

Union Use the Union node to create the selection as the union
(addition) of two or more selections.

= Intersection Use the Intersection node to create the selection as the
intersection of two or more selections.

= Difference Use the Difference node to create the selection as the
difference between a set of one or more selections and
another set of one or more selections.

A Complement  Use the Complement node to create the selection as the
complement (inverse) of one or more selections.

* Grouping Nodes by Space Dimension and Type
El. * Creating Named Selections in the Geometry Sequence

* Working with Geometric Entities

Creating Named Selections

There are several ways to create named selections. Toolbar buttons are available on settings windows and The
Selection List Window (see Table 6-2) to help group the geometric entities into manageable and easily identifiable
selections that can be chosen from the Selection list on a settings window, for example.

¢ Create a Selection using the Definitions Node

* Create an Explicit Selection from a Settings Window

* Copying and Pasting Selection Lists

¢ Create an Explicit Selection from the Selection List Window

CREATE A SELECTION USING THE DEFINITIONS NODE

There are several types of selections that can be created. For each type, choose to add it from the

Definitions>Selections submenu. In the settings window that opens, define the selection for that particular selection
type. See The Types of Named Selections (Table 6-6) for a list and links to more information about the settings.
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CREATE AN EXPLICIT SELECTION FROM A SETTINGS WINDOW

I At any time during model creation, click a node that has the option to add a geometric entity to a selection, for

example, under the Materials node or for the Fixed Constraint node for a Selid Mechanics physics interface as in
Figure 6-14.

2 In the settings window that opens, select an option from the Selection list, for example, Manual or All boundaries.

3 Click the Create Selection button ( % ) and enter a Selection name in the Create Selection window, for example,
Fixed Constraint Boundaries. Click OK or press enter.

4 In the Model Builder the new Explicit node (now named Fixed Constraint boundaries)is added under
Definitions. After creating these named selections, the Selection list displays the name in the list as in Figure 6-15.

Model Builder ~ 4| Fixed Constraint -4

- =

- w= s

Boundary Selection

4 t_diagonal_mounting.rmph (root) .
Global Definitions Selection: [Manual v]
4 [ Component 1 (compl) | [8 L o+
= Definitions g =
)‘;\ Geometry 1 - 33 | __
52 Materials Active |42 E:'E‘I 'E\-'.’
4 55 Solid Mechanics (solid) &
7 Linear Elastic Material 1
o
o™ Freel
B Initial Values 1

mw Fixed Constraint1 I Owverride g
 Boundary Load 1 . X

A Mesh1 I Equatjgh
oo Study 1

{E Results '3 Create Selection / @

Selection name: | Fixed Constraint Boundaries

Cancel

Contribution

Figure 6-14: Creating o selection from the settings window for a Fixed Constraint node.

Prescribed Displacement !

Boundary Selection

Selection:

All boundaries
Fixed Constraint boundaries
Boundary Load

Figure 6-15: After creating these named selections, the Selection list displays the new name in the list, making it simple
to choose it when adding additional boundary conditions such as a Prescribed Displacement node.

CREATE AN EXPLICIT SELECTION FROM THE SELECTION LIST WINDOW

Continue using the same model for this example, which demonstrates how to identify specific boundaries to add
to a new Explicit selection:

I In the Model Builder, click the Component | node.
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2 Open The Selection List Window. Right-click and select Float to detach the window from the COMSOL

Desktop.
COMSOL displays the geometric entities in the Selection List based on
where in the model you are working. Other nodes can be clicked to
display the list of geometric entities. For example, the Materials, Solid
g Mechanics (in this example), Mesh, and Geometry nodes. Experiment in the

COMSOL Desktop by clicking on different nodes and observing the
changes in the Selection List and Graphics windows.

3 On the Graphics toolbar, click the Select Boundaries button (/g ). The Selection List displays a list of all boundaries
in the geometry. Click the Select Domains, Select Edges, or Select Points buttons in the Graphics window and

observe how the list and the geometry changes based on the geometric entity level.

4 In the Selection List window, click to select the boundaries you want to add to an Explicit selection:
- Click any individual boundary number in the list.
- Shift-click to select contiguous items in the list.

- Ctrl+click to select more than one boundary at a time.

To help you identify the boundary, the selected boundaries are highlighted in red in the Graphics window.

5 Once the boundaries are chosen, click the Create Selection button ( i ) and enter a Selection name in the Create

Selection window, for example, Tube boundaries. Click OK or press enter.

6 Go to the Model Builder. The new Explicit node (now named Tube boundaries) is added under Definitions.

Copying and Pasting Selection Lists

Another way to create selections (see Creating Named Selections) is to copy and paste existing lists of geometric
entities. If, for example, you have a list of geometric entities (boundaries, for example) in a file or document you
can copy it to the clipboard and then use Ctrl+V to directly paste that list into a selection list in a settings window.

An example of this is a list of geometric entity numbers described as a step in a modeling instruction.

You can also use the Copy Selection button (|__'E|) and Paste Selection button ( |_ﬂ'|:’|) if you have a list of geometric
entities that you want to paste into a selection list. These buttons are available on many settings windows as in
Figure 6-13 and Figure 6-14.

COPYING AND PASTING GEOMETRIC ENTITY INFORMATION INTO A SELECTION LIST

I Prepare or copy the information to insert into the selection list. For example, copy a list of numbers from a text
file or PDF file such as COMSOL model documentation (highlight and press Ctrl+C). Also copy a selection on
any settings window, (for example, the Fixed Constraint boundaries). Click the Copy Selection button (|__'E|) and

go to the next step.

2 On the window or page next to the selection list where you want to add a selection from file (or on the
clipboard), press Ctrl+V to paste the selection directly, or click the Paste Selection button ( |_E"|:|)

3 In the Paste Selection window, paste (press Ctrl+V) or enter the list of geometric entities into the Selection field.
Data in the list or entered in the field can include commas and spaces as separators (1, 3), ranges (10-34), and

words (and). Click OK to paste the selection into the selection list.

Adjacent

The Adjacent (5, ) selection outputs selections adjacent to specified geometric entities or selections. For example,

select all domains adjacent to some boundaries or all boundaries adjacent to some domains.
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The adjacent geometric entities can be of any type (domains, boundaries, edges, or points) regardless of the
geometric entity level for the input selections. To add this node, right-click the Definitions node and choose
Selections>Adjacent.

INPUT ENTITIES

Based on space dimension, select a Geometric entity level—Domain, Boundary, Edge (3D only), or Peint for the
selections to add or remove from the Input selections list and to create a selection of adjacent geometric entities.
Click the Add button ( == ) to open an Add dialog box that contains selections of the chosen geometric entity level
that appear earlier in the geometry sequence. Use the Move Up ( ), Move Down ( | ), and Delete (:=) buttons
to organize the list.

OUTPUT ENTITIES
In the Geometry entity level list, choose the type of output entitics—Adjacent domains, Adjacent boundaries, Adjacent
edges (3D only), or Adjacent points. If the output entities have a lower dimension that the input entities, there are

also two check boxes that you can use to select exterior and interior entities of the union of the input selections.

By default, only exterior entities are selected. For example, if the input selections are domains selections, and the
output is adjacent boundaries, the Exterior boundaries (sclected by default) and Interior boundaries check boxes

display.
* Creating Named Selections in the Geometry Sequence
'ﬂ * Adjacent Selection (Geometry Sequences)
Ball

Another way to select geometric entities is to define an enclosing Ball (") to select geometric entities that are
completely or partially inside the ball. To add this node, right-click the Definitions node and choose Selections>Ball.

GEOMETRIC ENTITY LEVEL

Select the Level for the geometric entitics —Domain, Boundary, Edge, or Point.

If Boundary (for 2D and 3D models) or Edge is selected, also select the Group by continuous tangent check box to
extend the selection to all adjacent faces or edges that have continuous tangents (an angle less than the value in the

Angular tolerance ficld) at their junctions (to select all faces that make up a continuous sheet, for example).

When the Group by continuous tangent check box is selected, set the tolerance on the continuity condition in the
Angular tolerance field as the maximum angle between two faces or edges that are considered as having continuous

tangents (a value between 0 and 180 degrees; the default value is 5 degrees).

See Output Entities for details about how the behavior depends on the condition for which the selection considers

the group of entities to be enclosed.

INPUT ENTITIES

The Entities list defaults to All, which bases the selection on all entities of the selected type.

Select From selections to base the selection on other defined selections. Then, in the Selections list, add the selections
for which you want to create a selection of geometric entities from those selections that are located within the ball,
box, or cylinder that you define for the resulting selection. Click the Add button ( == ) to open an Add dialog box
that contains selections of the chosen geometric entity level that appear earlier in the geometry sequence. Use the

Move Up ( } ), Move Down ( | ), and Delete ( buttons to organize the list.

=)
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BALL CENTER/BALL RADIUS
Position the center of the ball by entering the center position in the x, y, and (3D only) z fields (the unit is the
length unit for the geometry). Enter the radius for the ball (disk in 2D) in the Radius field. The default is 0.

OUTPUT ENTITIES

For the selections made under Input Entities, define the dimension of the ball and select the condition for the

geometric entities to be selected. Choose an option from the Include entity if list—Entity intersects ball (the default),

Entity inside ball, Some vertex inside ball, or All vertices inside ball.

If Entity intersects ball is kept as the default, it includes all geometric entities that intersect the enclosing ball, that

is, the selection includes all entities that are partially or completely inside the ball. If in addition the Group by
continuous tangent check box is selected for a boundary or edge under the Geometric Entity Level section, all

entities in each group are selected if any entity in the group intersects the ball.

¢ If Entity inside ball is chosen, it includes all geometric entities that are completely inside the enclosing ball. If in
addition the Group by continuous tangent check box is selected for a boundary or edge under the Geometric Entity

Level section, the entities in each group are selected only if all entities in the group are completely inside the ball.

¢ If Some vertex inside ball is chosen, it includes all geometric entities where at least some vertex is inside the
enclosing ball. If in addition the Group by continuous tangent check box is selected for a boundary or edge under
the Geometric Entity Level section, all entities in each group are selected if any entity in the group has at least

some vertex inside the ball.

* IfAll vertices inside ball is chosen, it includes all geometric entities where all vertices are inside the enclosing ball.
If the Group by continuous tangent check box is selected for a boundary or edge under the Geometric Entity Level
section, the entities in each group are selected only if all entities in the group have all vertices inside the ball. This
selection might differ slightly compared to when selecting Entity inside ball if the geometric entity is outside the

ball at some points between the vertices.

The Ball, Box, and Cylinder selections use the rendering mesh to

determine which entities fit the selection condition. You can control the

2!

detail for the rendering in the Preferences dialog box (select Graphics and

then use the Detail list under Visualization).

* Creating Named Selections in the Geometry Sequence

'& * Ball Selection (Geometry Sequences)

Box

Another way to select geometric entities is to define an enclosing Box ( @) to select geometric entities that are
completely or partially inside the box. To add this node, right-click the Definitions node and choose Selections>Box.

See Ball for the Geometric Entity Level and Input Entities settings.

BOX LIMITS

Define the dimensions of the box by entering the maximum and minimum values in all directions in the x minimum,
X maximum, y minimum, y maximum, and (for 3D) z minimum and z maximum fields. The unit is the length unit for
the geometry. The default is —Inf and Inf for the minimum and maximum values, respectively; that is, the box

encloses the entire geometry. Use —Inf or Inf in some of these settings to make the box only partially bounded.
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OUTPUT ENTITIES
For the selections made under Input Entities, define the dimension of the box and select the condition for the
geometric entities to be selected. Choose an option from the Include entity if list—Entity intersects box (the default),

Entity inside box, Some vertex inside box, or All vertices inside box.

See Ball for the settings. The only difference is that the settings are for a Box instead of a Ball.

* Creating Named Selections in the Geometry Sequence

'El * Box Selection (Geometry Sequences)

Cylinder

Another way to select geometric entities is to define an enclosing Cylinder ({7 ) to select geometric entities that are
completely or partially inside the cylinder. To add this node, right-click the Definitions node and choose
Selections>Cylinder.

See Ball for the Geometric Entity Level and Input Entities settings.

SIZE AND SHAPE

Define the dimensions of the cylinder by entering the radius and the positions of the upper and lower faces on the
cylinder axis in the Radius, Top distance, and Bottom distance ficlds. The unit is the length unit for the geometry.
The default is 0, Inf, and - Inf for these settings, respectively.

POSITION

Position the cylinder by entering the center position in the x, y, and (for 3D) z fields. The default is 0 for all
coordinates.

AXIS
Set the cylinder axis by choosing an Axis type—z-axis (the default), x-axis, y-axis, Cartesian, or Spherical. If Cartesian
is selected, enter coordinates for x, y, and z. If Spherical is selected, enter angles for theta and phi (unit: deg).

OUTPUT ENTITIES

For the selections made under Input Entities, define the dimension of the cylinder and select the condition for the
geometric entities to be selected. Choose an option from the Include entity if list—Entity intersects cylinder (the

default), Entity inside cylinder, Some vertex inside cylinder, or All vertices inside cylinder.

See Ball for the settings. The only difference is that the settings are for a Cylinder instead of a Ball.

* Creating Named Selections in the Geometry Sequence

El. * Ball Selection (Geometry Sequences)

Explicit

Use an Explicit node (" ) to create the selection using the selection tools for individual geometric entities
(boundaries, for example) on the chosen geometric entity level. To add this node, right-click the Definitions node

and choose Selections>Explicit.
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INPUT ENTITIES

Based on space dimension, select a Geometric entity level—Domain, Boundary, Edge, or Point for the geometric
entities to add or remove from the selection list.

Select and add geometric entities in the Graphics window, using other selection methods, or by selecting the All
domains, All boundaries, All edges, or All points check box. The selected items are highlighted in the Graphics window.
Selecting the check box for all geometric entities locks all entities of this type as selected even if the geometry

changes.

If Boundary (for 2D and 3D models) or Edge is selected, also select the Group by continuous tangent check box to
extend the selection to all adjacent faces or edges that have continuous tangents (an angle less than the value in the
Angular tolerance ficld) at their junctions to select all faces that make up a continuous sheet, for example. When the
Group by continuous tangent check box is selected, set the tolerance on the continuity condition in the Angular
tolerance ficld as the maximum angle between two faces or edges that are considered as having continuous tangents
(a value between 0 and 180 degrees; the default value is 5 degrees).

To deselect one or some of the faces or edges that make up the group with

g continuous tangents, first clear the Group by continuous tangent check box.

OUTPUT ENTITIES
Define the geometry objects that the selection contains. The options available and defaults depend on the selection

in the Geometric entity level list as well as the space dimension of the Component.
If Domain is the input the default output is the Selected domains. Select other options as required.

¢ Seclect Adjacent boundaries, Adjacent edges, or Adjacent points to use the boundaries, edges, or points next to the
selected domains as the selection output (available options depend on the space dimension of the Component).
This makes it possible to, for example, make a selection of all boundaries around a domain by first selecting the
domain.

¢ Depending on the selection output, choose to include Exterior boundaries (the default) or Interior boundaries;
Exterior edges (the default) or Interior edges; or Exterior points (the default) or Interior points. Click to select or
clear the check boxes as needed.

If Boundary or Edge are chosen as the input, the default output is the Selected boundaries or Selected edges,
respectively. As with the Domain input, select other options as required. The Point output is the same as the selection

input (that is, the selected points).

If a particular selection is used elsewhere in the model, including in other
n selections, it is not possible to change the output type, for example, from
domains to boundaries.

* Creating Named Selections in the Geometry Sequence

El. » Explicit Selection (Geometry Sequences)

Union, Intersection, Difference, and Complement

Boolean selections—Union (Ij ), Intersection (E ), Difference (E.I"' ), and Complement (T )—are useful to
combine two or more selections (union), create a selection of overlapping geometric entities (intersection), create

selection of entities that are in one selection but not in another (difference), and to create a selection as the
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complement (inverse) of one or more selections (all boundaries except the inflow boundaries, for example). The

complement can be convenient if a selection is needed that consists of all boundaries except one or a few. Then it
is easier to first create a selection (just the one boundary, for example) and then use a Complement node to create
its complement. All Boolean selection nodes’ settings windows have similar sections. To add this node, right-click

the Definitions node and choose an option from the Selections menu.

GEOMETRIC ENTITY LEVEL

Based on space dimension, select a Level—Domain, Boundary, Edge (3D only), or Point for the selections to add or

remove from the Selections to add (Selections to intersect, Selections to subtract, Selections to invert) list.

INPUT ENTITIES

Use the buttons in this section to move, add, or delete selections in the Selections to add (Union), Selections to
intersect (Intersection), or Selections to invert (Complement) lists. For the Difference sclection node also choose
Selections to subtract. Click the Add button ( = ) to open an Add dialog box that contains all existing selections for
the same geometric entity level. Use the Move Up ( 4 ), Move Down (| ), and Delete (. ) buttons to organize the

list.

=)

* Creating Named Selections in the Geometry Sequence

,& ¢ Union Selection, Intersection Selection, Difference Selection, and

Complement Selection (Geometry Sequences)

Creating Named Selections in the Geometry Sequence

You can also create selection nodes in the geometry sequence for user-defined named selections of all or a few of
the geometric entities at a specific geometric entity level based on one or more of the nodes above the selection
node in the geometry sequence. This way it is possible to make a selection that only includes a few of the geometric
entities from one or more geometry objects and also create selections based on entire geometry objects. Using
selections based on a geometry object makes it possible to track, for example, all boundaries in the final geometry
that belong to that geometric object, even if its original boundaries are intersected by other geometry objects
during a parametric sweep, for example. That is, the selection nodes in the Geometry branch can provide better
associativity when changing or updating the geometry than the corresponding selection nodes under Definitions.
See the following sections for details on the selection nodes in the geometry sequence, which you choose from the
Selections submenu in the Geometry node’s context menu.

* Working with Geometry Sequences

'El * Creating Named Selections

BUILDING SELECTION NODES

If the current node in the geometry sequence is before the node preceding the selection node, or after the selection
node, the selection is not visualized (because the selected object or entities might not be visible in this state). In
this case, the Build Preceding State button appears instead of the selection list (this also applies for nonexplicit
selections in some selection nodes if From selections is selected under Input Entities). To visualize a state where the
selection can be visualized, either click Build Preceding State or click the Build Selected button ( E ). To rebuild the

entire geometry, click the Build All Objects button ( [&& ).

CREATING SELECTIONS FROM GEOMETRIC PRIMITIVES AND OPERATIONS
For all geometric primitives in 3D, 2D, and 1D geometries—for example, blocks, spheres, squares, polygons, and

intervals—as well as for all geometry operations—for example, union, intersection, fillet, array, and mirror—you
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can create selections for each type of geometric entity that the resulting geometry objects consist of. The following
list shows the geometric entity types for geometry objects that are “solids”:

* In 3D: domains, boundaries, edges, and points
e In 2D: domains, boundaries, and points

e In 1D: domains and points

To create these selections, click the geometry node in the Model Builder and then select the Create selections check
box in the settings window’s Selections of Resulting Entities section. The selections become available with the name
of the geometry node (Block 1, for example) in all applicable selection lists in the settings windows for the physics
nodes, for example. There are no explicit Selection nodes for these selections. For example, for a 3D Component
model with a single Block node, the Selection list contains the selection Block I, which for a domain selection is the

single domain, and for a boundary selection consists of the six faces of the block.

CUMULATIVE SELECTIONS

A cumulative selection is a selection in the geometry sequence that is a union of contributions from several
selections. Cumulative selections are especially useful to construct a selection the has different definitions in
different branches of an If clause. You can also use them as an alternative to a Union Selection node. There is no

node in the model tree that corresponds to the cumulative selection.

For a selection geometry feature, you can let it contribute to an existing cumulative selection by choosing an
existing cumulative selection in the Contribute to list in the Cumulative Selection section. To let it contribute to a
new cumulative selection, click the New button. When a selection geometry feature contributes to a cumulative
selection, the Model Builder displays the name of the cumulative selection instead of the original name of the

selection geometry feature.

For a geometry feature that has a Selection of Resulting Entities section in its Settings window, you can similarly let
the created selections contribute to a cumulative selection by choosing an existing cumulative selection in the

Contribute to list, or by clicking the New button.

When a selection contributes to a cumulative selection, the original selection does not appear in lists where you
choose among selections—instead, the cumulative selection replaces it. To remove a contribution to a cumulative

selection, select None in the Contribute to list.

* Global Definitions and Geometry Subsequence

El. » Working with Geometry Sequences

TABLE 6-7: GEOMETRY NAMED SELECTIONS BY TYPE

ICON TYPE DESCRIPTION

- Adjacent Selection Use this node to create the selection as the adjacent geometric
entities (boundaries, for example) to one of more selections.
See Adjacent Selection (Geometry Sequences).

=  Ball Selection Use this node to create the selection by enclosing part of the

- geometry by a bounding ball (sphere) to select geometric
entities that are partially or completely inside the ball. See Ball
Selection (Geometry Sequences).

fa&] Box Selection Use this node to create the selection by enclosing part of the
geometry by a bounding box to select geometric entities that
are partially or completely inside the box. See Box Selection
(Geometry Sequences).
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TABLE 6-7: GEOMETRY NAMED SELECTIONS BY TYPE

ICON TYPE DESCRIPTION

{7]  Cylinder Selection Use this node to create the selection by enclosing part of the
geometry by a bounding cylinder to select geometric entities
that are partially or completely inside the cylinder. See
Cylinder Selection (Geometry Sequences).

= Explicit Selection ~ Use this node to create the selection using the normal
selection tools for individual geometric entities (boundaries,
for example) on the geometric entity level chosen. See Explicit
Selection (Geometry Sequences).

Union Selection, Intersection Selection, Difference Selection, and Complement
Selection (Geometry Sequences)

g Union Selection Use this node to create the selection as the union (addition) of
two or more selections.
% Intersection Use this node to create the selection as the intersection of
election 'wo or more selections.
Select t lecti
E Difference Use this node to create the selection as the difference between
Selection a set of one or more selections and another set of one or

more selections.

T Complement Use this node to create the selection as the complement
Selection (inverse) of one or more selections.

Adjacent Selection (Geometry Sequences)

The Adjacent Selection ( Tz ) node selects all entities of a given dimension that are adjacent to entities in a given set
of selections (having another dimension). For example, it can select all boundaries adjacent to a given domain

selection. To add this node, right-click the Geometry node and choose Selections>Adjacent Selection.

See Adjacent for the Input Entities and Output Entities settings, which are the same.

CUMULATIVE SELECTION

See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has
been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.
Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option

from any Contribute to list for a Geometry selection.

¢ Named Selections

'& * Adjacent

Ball Selection (Geometry Sequences)

Another way to select geometry objects or geometric entities is to use an enclosing Ball Selection (1) to select
objects or entities that are completely or partially inside the ball. To add this node, right-click the Geometry node
and choose Selections>Ball Selection.

See Ball for all settings. You can also choose Object as the Level under Geometric Entity Level.

CUMULATIVE SELECTION
See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has

been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.
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Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option
from any Contribute to list for a Geometry selection.

e Named Selections

'& * Ball, Box, and Cylinder

Box Selection (Geometry Sequences)

Another way to select geometry objects or geometric entities is to use an enclosing Box Selection ( E) to select
objects or entities that are completely or partially inside the box. To add this node, right-click the Geometry node
and choose Selections>Box Selection.

See Ball for the Geometric Entity Level, Input Entities and Output Entities scttings. See Box for the Box Limits settings.

¢ You can also choose Object as the Level under Geometric Entity Level.

* For the Output Entities settings, note that the settings are for a Box instead of a Ball.

CUMULATIVE SELECTION

See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has
been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.
Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option

from any Contribute to list for a Geometry selection.

¢ Named Selections

'El * Ball, Box, and Cylinder

Cylinder Selection (Geometry Sequences)

Another way to select geometry objects or geometric entities is to use an enclosing Cylinder Selection (“fF| ) to select
objects or entities that are completely or partially inside the cylinder. To add this node, right-click the Geometry
node and choose an option from the Selections menu.

See Ball for the Geometric Entity Level, Input Entities and Output Entities scttings. See Cylinder for the Size and Shape,
Position, and Axis settings.

* You can also choose Object as the Level under Geometric Entity Level.

e For the Output Entities settings, note that the settings are for a Cylinder instead of a Ball.

GEOMETRIC ENTITY LEVEL

Select the Level for the geometric entitics —Domain, Boundary, Edge, or Point.

CUMULATIVE SELECTION
See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has

been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.

342 | CHAPTER 6: VISUALIZATION AND SELECTION TOOLS



Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option

from any Contribute to list for a Geometry selection.

¢ Named Selections

El. e Cylinder

Explicit Selection (Geometry Sequences)

Use an Explicit Selection node (" ) to create the selection using the selection tools for individual geometry objects
or geometric entities (boundaries, for example). To add this node, right-click the Geometry node and choose

Selections>Explicit Selection.

ENTITIES TO SELECT
Based on space dimension, select a Geometric entity level—Object, Domain, Boundary, Edge, or Point for the geometric
objects or entities to add to the selection list.

Select and add geometric entities in the Graphics window or using other selection methods. The selected items are

highlighted in the Graphics window.

If Boundary (for 2D and 3D models) or Edge is sclected, also select the Group by continuous tangent check box to
extend the selection to all adjacent faces or edges that have continuous tangents (an angle less than the value in the
Angular tolerance ficld) at their junctions to select all faces that make up a continuous sheet, for example. When the
Group by continuous tangent check box is selected, set the tolerance on the continuity condition in the Angular
tolerance ficld as the maximum angle between two faces or edges that are considered as having continuous tangents

(a value between 0 and 180 degrees; the default value is 5 degrees).

If a particular selection is used elsewhere in the model, including in other
n selections, it is not possible to change the geometric entity level, for

example, from domains to boundaries.

To deselect one or some of the faces or edges that make up the group with
g continuous tangents, first clear the Group by continuous tangent check box.

e Named Selections

El. * Explicit

CUMULATIVE SELECTION

See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has
been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.
Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option

from any Contribute to list for a Geometry selection.
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Union Selection, Intersection Selection, Difference Selection, and Complement Selection

(Geometry Sequences)

Boolean selections—Union Selection (lg.l ), Intersection Selection ('E_'I ), Difference Selection (lg.l ), and Complement
Selection (T )—are useful to combine two or more selections (union), create a selection of overlapping geometric
entities (intersection), create selection of entities that are in one selection but not in another (difference), and to
create a selection as the complement (inverse) of one or more selections (all boundaries except the inflow
boundaries, for example). The complement can be convenient if a selection is needed that consists of all boundaries
except one or a few. Then it is easier to first create a selection (just the one boundary, for example) and then use a
Complement node to create its complement. All Boolean selection nodes’ settings windows have similar sections. To

add this node, right-click the Geometry node and choose an option from the Selections menu.

GEOMETRIC ENTITY LEVEL
Based on space dimension, select a Level—Object, Domain, Boundary, Edge (3D only), or Point for the selections to

add or remove from the Selections to add (Selections to intersect, Selections to subtract, Selections to invert) list.

INPUT ENTITIES

Use the buttons in this section to move, add, or delete selections in the Selections to add (Union), Selections to
intersect (Intersection), or Selections to invert (Complement) lists. For the Difference selection node also choose
Selections to subtract. Click the Add button ( = ) to open an Add dialog box that contains all existing selections for
the same geometric entity level. Use the Move Up ( 4 ), Move Down (| ), and Delete (. ) buttons to organize the
list.

CUMULATIVE SELECTION

See Cumulative Selections. From the Contribute to list, choose an option. If no previous Cumulative Selection has
been created, None is available from the list. To populate the list and to create a new Cumulative Selection, click New.
Enter a Name in the New Cumulative Selection window. Click OK or press enter. This is now available as an option

from any Contribute to list for a Geometry selection.

¢ Named Selections

'& * Union, Intersection, Difference, and Complement
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User-Defined Views

Views provide the camera setting, grid, rendering, arrows, lighting, and transparency in the Graphics window. You

can create and use several user-defined views to highlight and display the geometry in different ways.

By default a View node is added to all 2D ([xy), 2D axisymmetric ( [xy ), and 3D (-].») models.

For 2D and 2D axisymmetric models, an Axis ( [xy ) subnode is also added

where you can set the axis coordinates and manual spacing.

The View nodes (View (2D)) and subnodes have information about a view.
i For 2D and 2D axisymmetric models, it controls the settings to display or
|

hide geometry labels and direction arrows, and lock the axis.

For 3D models, a Camera subnode ( g, ) and three Directional Light
nodes (i), including default settings, are also added.

The View nodes (View (3D)) and their subnodes have information about
] a view. For 3D models the settings include (in addition to, for example,
settings for displaying geometry labels and direction arrows) transparency,

lighting sources, lighting attributes, and camera settings.

Also right-click the View node to add Hide Geometry Objects and Hide Geometric Entities nodes for any space
dimension.

Right-click Definitions ( = ) and select View to create additional View nodes and then experiment by switching views

to find the best way to illustrate a model. Views can be selected from the list of views (=].») on the Graphics toolbar.

To reset the View node settings and its subnodes to the defaults, right-click View and select Reset to Default ().

To display the Views node under Results (@I ), click the Show
button ("= ) and select Advanced Results Options. This is useful, for

[

example, when 2D axisymmetric revolved plots or 2D cut plane plots for
3D models are created.

View (2D)

For 2D and 2D axisymmetric models, the View node ( [x) controls the settings to display or hide geometry labels
and lock the axis. An Axis node is added by default.

Also right-click the View node to add Hide Geometry Objects and Hide Geometric Entities nodes. To add

additional View nodes, in the Model Builder, right-click Definitions and select View.

VIEW

Select the Show geometry labels check box to display the geometry object labels and the geometric entity labels
(numbering) in the Graphics window. The labels appear for geometry objects or geometric entities (domain,
boundary, edge, or point numbers), depending on what part of the model tree you display and the selection mode
you are using.

USER-DEFINED VIEWS | 345



Select the Show edge direction arrows check box to display the direction arrows on boundaries (edges) in the
Graphics window. The direction arrows indicate the directions in which the boundary parameterization’s value

increases.

Select the Lock axis check box to store the current axis limits so that the zoom tools can be temporarily used, for
example, but by revisiting the View node restore the axis limits to the values in the view at the time the Lock axis

check box is selected.

'& View (3D)

Axis

For 2D and 2D axisymmetric models, the View (2D) node has an Axis ( [#y) subnode where the axis coordinates

are set, manual spacing is defined, and the aspect ratio preserved.

AXIS

Enter x minimum, x maximum, y minimum, and y maximum values for the axis limits (r and z replace x and y in 2D
axial symmetry). The Preserve aspect ratio check box is selected by default to make the increments equal in the x-
and y-directions. Click to clear this check box to make the geometry fill the graphics window with unequal

increments. This can be useful when working with slender geometries.

GRID
Select the Manual spacing check box and enter x spacing and y spacing values to control the grid spacing manually. r
and z replace x and y in 2D axial symmetry. Enter Extra x and Extra y values directly or click the Range button ( L'rrj)

as required.

The default precision for the 2D grid axis labels is 4 digits. You can change

the precision in the Preferences dialog box, using the 2D axis field under

[

Precision on the Graphics page.

'El. View (3D)

View (3D)

The View node (=] ) for 3D models has many options to add light sources and define the light attributes. Other
functions include displaying or hiding geometry labels, transparency, wireframe rendering, a numbered grid, and

axis orientation in the Graphics window. See Figure 6-16.

e View (2D)
'El * About the 3D View Light Sources and Attributes
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View 1

¥ View

[¥] Wireframe rendering

Show geometry labels
Show edge direction arrows
Show grid

Show axis orientation

Lock camera

Q Q A E | L e

Geometry labels for
selected Fixed
Constraint node

Axis orientation Grid

Wireframe
rendering ON.

Figure 6-16: An example of the top of 3D View settings window with all View option check boxes selected. The Graphics
window shows what the check boxes vepresent. In this example, using the Diagonal Mounting Detail of o
Communication Mast model, the Fixed Constraint node is clicked in the Model Builder, which then displays the numbers
associated to the boundaries (8, 9, 33, and 42). Compare to the boundary numbers shown in Figure 6-14, which is for

the same node. The edge divection avrows are not displayed in this view.

The View node (»].») for 3D models has the following sections:

VIEW

Select the Wireframe rendering check box to view the edges of the object as solid lines. The Wireframe Rendering

button ( [=)) is turned on or off in the Graphics window at the same time.

Select the Show geometry labels check box to display the geometric object names and geometric entity labels

(numbers) in the Graphics window. The labels appear for geometry objects or geometric entities (domain,

boundary, edge, or point numbers), depending on what part of the model tree you display and the selection

mode you are using.

Select the Show edge direction arrows check box to display direction arrows on edges in the Graphics window. The

direction arrows indicate the directions for which the edge parameterization values increase.

By default the Show grid check box is selected and displays a numbered grid in the Graphics window around the
object. Click to clear the check box to hide the grid.

USER-DEFINED VIEWS

347



¢ By default the Show axis orientation check box is selected and the axis orientation indicator for the global
Cartesian coordinate directions is displayed in the lower-left corner of the Graphies window. Click to clear the

check box to hide the axis orientation indicator.
¢ Select the Lock camera check box to store the current camera settings so that the zoom tools can temporarily be

used, for example, but then revisiting the View node restores the camera settings to the values in the view at the

time the Lock camera check box was selected.

LIGHT

The Scene light sctting is a default that always displays and is based on the geometry. The Scene light, Diffuse light,
Specular light, and Ambient light check boxes are selected by default. To hide and disable all light sources, click to
clear the Scene light check box. The Scene Light button ( s ) is turned on or offin the Graphics window at the same

time.

¢ Click to clear the Diffuse light, Specular light, and Ambient light check boxes as required.

* Enter a value between 0 and 1 for the Ambient intensity (default value: 0.3) or use the slider to select a level.

Watch the changes in the Graphics window at the same time to help choose a level.

* Select a Color from the list—Custom, Black, Blue, Cyan, Gray, Green, Magenta, Red, White (default), or Yellow. The
color is only applied to ambient light. If you select Custom, click the Color button to choose a color from the

Custom color palette.

TRANSPARENCY

Select the Transparency check box to turn on transparency. The Transparency button ([7]) is activated in the
Graphics window at the same time. Enter a value between 0 and 1 in the Alpha field for the alpha blending, where
0 means a fully transparent color and 1 means a fully opaque color, or use the slider to select a transparency level.

Watch the changes in the Graphics window at the same time to help choose a level.

Camera

Use the Camera node ( g5, ) to orient the camera view in 3D models. In the Model Builder, under Definitions click to

expand the View node where you want to define the camera position.

CAMERA
From the Projection list, sclect Perspective (the default) or Orthegraphic (parallel) as required. The perspective
projection shows distant objects as smaller to provide a realistic 3D projection, whereas the orthographic projection

shows all objects using their actual size regardless of the distance.
Enter a Zoom angle (in degrees) or use the Zoom buttons on the Graphics toolbar.

By default, the Preserve aspect ratio check box is selected to make the increments equal in the x-, y-, and
z-directions. Clear this check box to make the geometry fill the graphics window with unequal increments. This

can be useful when working with slender geometries.

POSITION

In the Graphics window, left-click and hold the mouse to orient the geometry on the axes, or enter x, y, and z

coordinates.

TARGET
In the Graphics window, left-click and hold the mouse to orient the geometry on the axes. The corresponding
coordinates are displayed in the settings window under the Pesition, Target, and Up Vector sections, or enter X, Y,

and z coordinates for the camera target location.

The Position is the location of the camera and the Target default is 1 length unit in front of the camera position.
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UP VECTOR
In the Graphics window (or other plot windows), left-click and hold the mouse to orient the geometry on the axes,
or enter x, y, and z coordinates for the camera’s up vector, which determines which direction is up in the plot

window.

CENTER OF ROTATION
By default the values in the Center of Rotation section define the center of the geometry in the view. Explicitly
control the center of rotation by entering a center location in the x, y, and z fields and then click the Apply button

() at the top of the settings window.

VIEW OFFSET

Right-click the mouse and move the geometry left, right, up, or down as required. This shift operation moves the
currently visible frame on the image plane. The corresponding dimensionless values that display in the settings
window under View Offset are relative to the image width and height, respectively. For example, an offset of x = 0.5
moves the projection 0.5 screen widths to the left. Alternatively, enter x and y values for the view offset.

The value in the Orthographic scale ficld defines the size in scene length of the viewing block along the longest side
of the canvas. If the view’s camera setting uses orthotropic projection, zoom in or out by increasing or decreasing

the value of the orthographic scale. For a perspective projection this setting has no effect.

About the 3D View Light Sources and Attributes

Light sources are the Directional Light, Point Light, Spotlight, or Headlight nodes. Light attributes are the scene light
components, which include diffuse, specular, and ambient light (see Figure 6-17). Combined, these attribute and

source settings enable the software to render the 3D model to look realistic.

LIGHT ATTRIBUTES

Ambient light + Diffuse light + Specular light — Scene light

ehHeY "

Figure 6-17: Scene light is a combination of ambient, diffuse, and specular light attributes. The default Scene light color
is white and in this example the attributes display as diffevent shades of black and gray. The Scene light is further
enhanced using the various light source nodes.

Scene Light

For all geometry, scene light is applied by default and is a combination of the different light attributes. The light
intensity and ambient intensity levels are also attributes of the scene light. The diffuse, specular, and ambient light
attributes can be turned on or off by selecting or clearing the corresponding check boxes (see View (3D)). The

intensity levels are adjusted either with a slider or by entering a number between 0 and 1.

Think of Scene light as being comprised of ambient light, the base amount of light, plus specular light to add depth
to curves and diffuse light to soften the lighting and add contrast. See Figure 6-17 for examples of the attributes:

* Ambient light is the available light surrounding the geometry. By itself, ambient light makes a 3D object look like
a 2D object. The addition of diffuse and specular light adds the contrast and depth needed to define 3D

geometry.
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* Diffuse light is directional and spreads out over the object, like a flashlight shining on a sphere. This generally adds
contrast and depth of field to 3D objects.

* Specular light is directional and reflects off the surface of a sphere or curve in a geometry. It is based on the angle

between the viewer and the light source.

Apply the different sources of light (Directional Light, Point Light, Spotlight, or Headlight nodes) to further enhance
how the geometry displays.

LIGHT SOURCES

For 3D models, you can also add these light source nodes—Directional
Light (i ), Point Light ( E ), Spotlight (s ), and Headlight ( *)—
to adjust how the color and shading displays in the Graphics window.

| Each View can have a maximum of eight light sources (nodes) in any
combination. See Directional Light, Point Light, Spotlight, and
Headlight below.

Each light source has a unique light marker displayed in the Graphics window. Figure 6-19 shows three directional
light settings and markers displayed in the Graphics window. The light markers are placed at the user-defined x, y,
and z coordinates and are used to adjust the light and specular intensities on the object. You can show or hide the
markers and change the color. The color of the marker corresponds to the light hitting the object. A wireframe
around a light marker indicates that its node is selected in the Model Builder. When adjusting the light intensity,
the light marker changes in length as the corresponding intensity is changed on the object. When adjusting the
spread angle for a spotlight, the arrow increases and decreases in width as the angle value increases and decreases.

Figure 6-18: The light mavkers for each type of light source: (1) Headlight, (2) Point light, (3) Dirvection light, and (4)
Spotlight.

Directional Light

By default, a View contains three Directional Light (di ) nodes. Directional light represents light that falls from a
direction on all objects in the scene, like sunlight where all the light rays are parallel. Directional lights therefore
have no position. The direction of the light, the light and specular intensity levels, and the color can be adjusted as

required.

Figure 6-19 is an example of three Directional Light nodes where the color is changed and the light intensity adjusted
for Directional Light 3. The markers are labeled 1, 2, and 3 to correspond to the nodes. The Directional Light 3
node’s light intensity setting is changed from 0.24 to 1—the change in arrow size corresponds to the increase in
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light intensity. The wireframe around a light marker means that the corresponding node is selected in the Model
Builder. Adjust the direction of the light, the light and specular intensity levels, and the color as required.
4 m Component 1 (compl)
4 = Definitions
A= Boundary Systern 1 (sys1)
4 [[] view1
- Camnera
W Directional Light1
W Directional Light 2 f
W Directional Light 3 3a |

/) /

Figure 6-19: Examples of divectional light markers and the location of each divectional light. The mavkers and light can
be color coded to see which arveas need adjustment. The markers indicate which node is selected in the Model Builder (a
wireframe avound the arvow in 2 and 3a), and the level of light intensity applied (the size of the arrow; compare 3 and
3a).

DIRECTION

The x, y, and z coordinates define the direction in which the light falls on the objects in the scene. The arrow is a
visualization of that direction with a placement that is calculated automatically depending of the scene’s bounding
box. The arrow points in the direction of the light.

Change the color to something other than white to observe where the
[§ ﬁ ]
g

light hits the object.

SETTINGS

Adjust some of the settings such as the intensity and color of the directional light.

¢ Enter a Light Intensity or use the slider to select values. Watch the changes in the Graphics window at the same
time to help choose a level. When adjusting the light intensity, the light marker changes in length as the
corresponding intensity is changed on the object.

¢ Enter a Specular intensity (the intensity of the light that reflects off the surface of the geometry and used to define
spheres and curves). This setting is turned ON and OFF on the View page (the default is ON), and the levels
are adjusted for each Specular intensity using the field or the slider to select values between 0 and 1 (default value:
1). Watch the changes in the Graphics window at the same time to help choose a level. See Figure 6-17 for an

example of specular light.

* Seclect a Color—White (default), Custom, Black, Blue, Cyan, Green, Magenta, Red, or Yellow. If you select Custom,

click the Color button to choose a color from the Custom color palette.
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¢ By default, the Lock to camera coordinate system check box is selected to make the light rotate together with the
camera. Click to clear as required; the light then follows the geometry.

G}\. To lock the camera settings, see Camera.

e By default, the Show light marker is sclected. The light marker is associated to the type of light applied to the
object. See Figure 6-18 for examples. Click to clear the check box as required and remove the marker from the

Graphics window.

Point Light

The Point Light ( f;.‘ ) has a position and emits the light equally in all directions; it is like a light bulb. Point light
have therefore no direction. The position of the light, the light and specular intensity levels, and the color can be

adjusted as required. Figure 6-20 is an example of two Peint Light nodes added to the View and all other nodes
disabled.

1 Component 1 (compl)

4 = Definitions .
=/ Boundary Systern 1 (sys1)
4 [[] view1
= Camera
Directional Light 1
Directional Light 2
Directional Light 3
/ Point Light 4
Point Light 5
' Spotlight 6
' Spotlight 7
# Headlight 8

AABo® B &

Figure 6-20: An example of two Point Light nodes added to a View. All other light nodes are disabled to show only the
Point Light effects to the geometry. Point Light 5 is selected in the Model Builder as indicated by the wiveframe around
the light marker.

POSITION

Enter x, y, and z coordinates for the point light’s position.

SETTINGS
Adjust some of the settings such as the intensity and color of the point light.

* Enter a Light Intensity or use the slider to select values. Watch the changes in the Graphics window at the same
time to help choose a level. When adjusting the light intensity, the light marker changes in length as the
corresponding intensity is changed on the object.

¢ Enter a Specular intensity (the intensity of the light that reflects off the surface of the geometry and used to define
spheres and curves). This setting is turned on and off on the View page (the default is on), and the levels are
adjusted for each Specular intensity using the field or the slider to select values between 0 and 1 (default value:

1). Watch the changes in the Graphics window at the same time to help choose a level. See Figure 6-17 for an
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example of specular light.

¢ Seclect a Color—White (default), Custom, Black, Blue, Cyan, Green, Magenta, Red, or Yellow. If you sclect Custom,

click the Color button to choose a color from the Custom color palette.

* By default, the Lock to camera coordinate system check box is selected to make the light rotate together with the

camera. Click to clear as required; the light then follows the geometry..

Q To lock the camera settings, see Camera.

¢ By default, the Show light marker is selected. The light marker is associated to the type of light applied to the
object. See Figure 6-18 for examples. Click to clear the check box as required and remove the marker from the

Graphics window.

Spotlight

The Spotlight (mf ) acts like a flashlight and has both a position and a direction. Figure 6-21 is an example of two
Spotlight nodes added to a View with all other nodes disabled. The position and direction of the light, the light and
specular intensity levels, and the color can be adjusted as required. In addition, the spread angle can be adjusted as
shown in the figure. The width of the light marker corresponds to the spread angle.

\ v

~

Figure 6-21: Two Spotlight nodes displayed with all other nodes disabled showing wheve the Spotlight is focused. When
the spread angle is changed from 20 to 100 for Spotlight 7 (as indicated by the change in mavker width between 7 and
7n), a corrvesponding change is made to the model.

POSITION

Enter x, y, and z coordinates for the position of the spotlight.

DIRECTION
The x, y, and z coordinates define the direction in which the spotlight falls on the objects in the scene. The arrow
points in the direction of the light.

Change the color to something other than white to observe where the
light hits the object.

|ﬁ|
g
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SETTINGS

Adjust some of the settings such as the spread, intensity, and color of the spotlight.

Enter a Spread angle (in degrees). Also watch the changes in the Graphics window at the same time to help choose
an angle. When adjusting the spread angle, the arrow increases and decreases in width as the angle value increases

and decreases. The default is 20 degrees. See Figure 6-21 for an example.

Enter a Light Intensity or use the slider to select values. Watch the changes in the Graphics window at the same

time to help choose a level. The light marker’s length changes as the corresponding light intensity changes.

Enter a Specular intensity (the intensity of the light that reflects off the surface of the geometry and used to define
spheres and curves). You can turn specular light on and off'in the View node’s settings window (default: on), and
the levels are adjusted for each Specular intensity using the field or the slider to select values between 0 and 1
(default value: 1). Watch the changes in the Graphics window at the same time to help choose a level. See

Figure 6-17 for an example of specular light.

Select a Color—White (default), Custom, Black, Blue, Cyan, Green, Magenta, Red, or Yellow. If you select Custom,

click the Color button to choose a color from the Custom color palette.

By default, the Lock to camera coordinate system check box is selected to make the light rotate together with the

camera. Click to clear as required; the light then follows the geometry.

'El To lock the camera settings, see Camera.

By default, the Show light marker is sclected. The light marker is associated to the type of light applied to the
object. See Figure 6-18 for examples. Click to clear the check box as required and remove the marker from the

Graphics window.

Headlight

A headlight is a directional light that points to the scene from the camera position. The Headlight ( *.) is similar

to the Directional Light with the only difference being that it is always locked to the camera’s coordinate system and

a direction pointing from the camera is used. Figure 6-22 is an example of one Headlight node added to a View with

the Directional Light nodes enabled. The headlight’s position and direction cannot be changed; it is based on the

Directional Light node’s (or nodes’) x, y, and z coordinates. The light and specular intensity levels and the color can

be adjusted as required.
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Figure 6-22: An example of a blue Headlight source with three Divectional light sources set to white. If the geometry is
rotated, you can adjust and view the effects of the Headlight source on the geometry based on the shades of blue and white.

SETTINGS

Adjust the settings such as the intensity and color of the headlight.

Enter a Light Intensity or use the slider to select values. Watch the changes in the Graphics window at the same
time to help choose a level. When adjusting the light intensity, the light marker changes in length as the
corresponding intensity is changed on the object.

Enter a Specular intensity (the intensity of the light that reflects off the surface of the geometry and used to define
spheres and curves). This setting is turned ON and OFF on the View page (the default is ON), and the levels
are adjusted for each Specular intensity using the field or the slider to select values between 0 and 1 (default value:
1). Watch the changes in the Graphics window at the same time to help choose a level. See Figure 6-17 for an
example of specular light.

Select a Color—White (default), Custom, Black, Blue, Cyan, Green, Magenta, Red, or Yellow. If you select Custom,
click the Color button to choose a color from the Custom color palette.

By default, the Show light marker is selected. The light marker is associated to the type of light applied to the
object. See Figure 6-18 for examples. Click to clear the check box as required and remove the marker from the

Graphics window.

Hide Geometry Objects and Hide Geometric Entities

In the Model Builder, under Definitions, right-click any View node and sclect Hide Geometry Objects ( =z to hide a set

of geometry objects or some of their geometric entities—in the created or imported geometry. Right-click View and

select Hide Geometric Entities ( - ) to hide geometric entities (boundaries, for example)—in the analyzed (finalized)

geometry used for modeling—at a specific geometric entity level for any View.

The Hide Geometry Objects node hides geometry objects or parts of such
objects and affects the view in the Geometry branch only. The Hide

Geometric Entities node hides geometric entities (domains, boundaries,

[

edges, or points) in the finalized geometry and affects the view in the

Materials, physics, Mesh, studies, and Results branches.
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SELECTION

Hide a set of geometry objects at a specific Geometric entity level—Object (the default), Domain, Boundary, Edge (3D
only), or Peint. Then select the geometry objects or some of their geometric entities in the Graphics window. The
list under the Geometric entity level list contains the selected objects or entities to hide in the Geometry branch. For
example, for Hide Geometry Objects, hide a geometry objects, or hide a boundary of a 3D geometry object to make
it possible to view the inside of the object. Or, for Hide Geometric Entities, hide some domains that are not of interest
in the model, or some boundaries only on a specific domain to get a clearer view of some of the model. You can
include the hidden objects (entities) in a plot by selecting the Show hidden objects check box under Plot Settings in

the corresponding plot group’s settings window.

The Hide Geometric Entities settings window contains the following section:

GEOMETRIC ENTITY SELECTION

Hide a set of geometric entities at a specific Geometric entity level—Domain (the default), Boundary, Edge (3D only),
or Point. From the Selection list, select Manual (the default) or All domains, All boundaries, All edges (3D only), or All
points. If Manual is selected, go to the Graphics window and select the geometric entities that you want to hide. The
selected entities appear in the list under the Selection list. Use the Add to Selection ( == ), Remove from Selection

( =), Clear Selection ( "_-:‘ ), and Zoom Selected () buttons as required.
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Geometry Modeling and CAD Tools

The CAD tools in COMSOL Multiphysics® include many geometric primitives
and operations for modeling the geometry using solid modeling and boundary
modeling. This chapter covers geometry modeling in 1D, 2D, and 3D with
examples of solid modeling, boundary modeling, Boolean operations, and other
CAD tools. In addition, it shows how to use the tools for exploring geometric

properties, such as volumes and surfaces. There is also information about using
external CAD data.
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Creating a Geometry for Analysis

Overview of Geometry Modeling Concepts

In COMSOL Multiphysics you can use solid modeling or boundary modeling to create objects in 1D, 2D, and
3D. These can be combined in the same geometry (bybrid modeling).

¢ During solid modeling, a geometry is formed as a combination of solid objects using Boolean operations like
union, intersection, and difference. Objects formed by combining a collection of existing solids using Boolean

operations are known as composite solid objects.

* Boundary modeling is the process of defining a solid in terms of'its boundaries—for example, using lines to create
a solid hexagonal domain in 2D. You can combine such a solid with geometric primitives—common solid

modeling shapes like blocks, cones, spheres, rectangles, and circles, which are directly available in COMSOL.

In 3D, you can form 3D solid objects by defining 2D solids in work planes and then extrude and revolve these
into 3D solids. It is also possible to embed 2D objects into the 3D geometry.

You can also overlay additional nonsolid objects on top of solid objects to control the distribution of the mesh and
to improve analysis capabilities. For example, you can add a curve object to a geometry to control the element size
in the vicinity of this curve, or add a point to guarantee a mesh vertex in a specific location or to create a

time-dependent or parametric-value graph at that location in the geometry.

The settings for the nodes making up a geometry sequence can be changed at any time and the whole sequence
can be re-run. It is also possible to parameterize the geometry using one or more parameters that define properties
of'a geometric primitive, for example. COMSOL then takes the parameterization into account as part of the
geometry sequence for each step in a parametric sweep. You can also insert geometry sequences from other models

into your current sequence.

You can import 2D geometries from DXF files and 3D geometries from STL and VRML files.

See Import for details of how to import these CAD file formats.
Combining several objects where at least one is imported from an
STL/VRML file is not supported.

[

The CAD Import Module provides an interface for the import of CAD files in Parasolid, SAT (ACIS), Inventor,
Pro/E, SolidWorks, STEP, and IGES formats. In addition, the CATIA V5 Import Module provides an interface
for CATTA V5 files.

The optional LiveLink™ products offer bidirectional links to 3D CAD software. Using these, you can run
parametric geometry sweeps driven from the COMSOL environment but operating directly on the geometries in

the respective CAD package.

* Working with Geometry Sequences
'El. e Creating a Geometry Sequence

* Geometry in the COMSOL API Reference Manual

The Introduction to COMSOL Multiphysics includes a tutorial to learn
how to build the busbar geometry. See Appendix A—Building a
= Geometry or the printed copy included with COMSOL Multiphysics.
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Techniques for Creating Geometries

Several techniques can ensure that a geometry results in a good mesh and gives reasonable solution times for the

analysis. They include the use of symmetry and eliminating small details, gaps, holes, and singularities.

USING SYMMETRIES

Using symmetry is one of the most effective ways to reduce the size of a model. For axially symmetric geometries,
a 2D axisymmetric model is sufficient. You can easily visualize the results in a full 3D geometry using a Revolution
2D data set. Other common cases of symmetry are sector symmetry and symmetry and antisymmetry planes, which
can reduce the size of a 3D model.

MAKING THE GEOMETRY MATCH THE BOUNDARY CONDITIONS
Sometimes the modeling domain is unbounded or too large for successful analysis. For those cases a suitable

boundary condition can replace the exterior of the domain.

Itis important that the geometry is large enough to validate the boundary

n conditions.

For outflows in fluid-flow models, for example, the boundary should be perpendicular to the fully developed flow.
Inspections and modifications of the solved model might be necessary to verify the validity of the boundary
condition. Also, for some applications, infinite elements or perfectly matched layers (PMLs) are available for

modeling diffusion or wave propagation in unbounded domains.

AVOIDING EXCESSIVELY SMALL DETAILS, HOLES, AND GAPS

Many geometries, especially those designed using a CAD system, contain small holes, details, and gaps. These small
features can make the domain unbounded and must be removed before analysis. Small details and holes can lead to
large meshes or even failure during mesh generation. Make sure the snapping feature is activated to avoid small gaps

and mismatches between the geometry objects.

The CAD Import Module contains tools for automatic and interactive repair and defeaturing of 3D CAD data. For
a 2D or 3D model you can also remove small details and prepare the geometry for efficient meshing using virtual

geometry operations (see Virtual Geometry Operations).

AVOIDING SINGULARITIES AND DEGENERACIES IN THE GEOMETRY

A singularity in a geometry is a sharp corner or angle that can create problems during meshing and analysis. In
reality, a sharp reentrant corner leads to infinite stress values in a stress analysis of a perfectly elastic material. The
stress value for a sharp corner is finite in the stress analysis, but refinement of the mesh increases the stresses in the

corner without limit. To avoid a singularity, round sharp corners using fillets.

A degeneracy in the geometry can occur during solid modeling. For example, fillet areas that taper to a point and
the apex of'a cone can become degenerate points. These degeneracies might cause problems for the mesh generator
and during the analysis. A common degeneracy in the geometry occurs when a 3D solid is created (for example, a
cylinder) by rotation about an axis that touches the rotation area. It is then better to create the solid object by

extruding a cross section or to use geometric 3D primitives.

Associative Geometry and Selections of Geometry Objects

Associative geometry is a concept for the automatic updating of applied physical properties, such as boundary
conditions and equation coefficients, under geometric transformations. Thus, once you have defined the physical

properties of a model and return to the Geometry branch to modify the geometric model, COMSOL Multiphysics
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updates the physical properties according to the geometry modifications. The associative geometry functionality
utilizes geometry-mapping information between the groups of geometric entities (points, edges, boundaries, and

domains) in the finalized geometry and the corresponding groups in the geometric model.

This geometry mapping is not always without ambiguities. COMSOL makes some heuristic decisions when
mapping the physical properties between the finalized geometry (the object on which the physical properties are
imposed) and the geometric model. In some cases the resulting updated physical properties might not be the ones
that are expected.

User-defined named selection nodesin the geometry sequence are useful to improve associativity compared to other
selection nodes (see Creating Named Selections in the Geometry Sequence). You can refer to such selections
defined in following geometry nodes (for example, as input objects). This applies both to selections created by the

Create selections check box and selections created by selection nodes.

Choosing the Right Space Dimension

Most of the problems solved with COMSOL Multiphysics are three-dimensional (3D) in the real world. In many
cases, it is sufficient to solve a two-dimensional (2D) or one-dimensional (1D) problem that is close, or equivalent,
to the real problem. 2D models are easier to modify and generally solve much faster, so modeling mistakes are much

easier to find when working in 2D. Once the 2D model is verified, you are in a better position to build a 3D model.

Not all physics are available in all space dimensions. See the

documentation for the physics interfaces in COMSOL and its modules

[

for the supported space dimensions.

ID PROBLEMS

The following is a guide for some of the common approximations made
for 1D problems. Remember that modeling in 1D usually represents
- some 2D or 3D geometry under the assumption that nothing changes in

the other dimensions.

Cartesian Coordinates
In a 1D model you view a single straight line that represents the only space dimension where there is spatial (or

other) variation.

Axial Symmetry (Cylindrical Coordinates)
In an axially symmetric 1D model you view a straight line that represents the radial direction in an axially symmetric

geometry.

2D PROBLEMS

The following is a guide for some of the common approximations made
Q for 2D problems. Modeling in 2D often represents a 3D geometry under

the assumption that nothing changes in the third dimension.

Cartesian Coordinate Systems
In this case you view a cross section in the xy-plane of the actual 3D geometry. The geometry is mathematically
extended to infinity in both directions along the z-axis, assuming no variation along that axis. All the total flows in

and out of boundaries are per unit length along the z-axis. A simplified way of looking at this is to assume that the
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geometry is extruded one unit length from the cross section along the z-axis. The total flow out of each boundary

is then from the face created by the extruded boundary (a boundary in 2D is a line).
There are usually two approaches that lead to a 2D cross-sectional view of a problem:

* When there is no variation of the solution in one particular dimension.

¢ When there is a problem where the influence of the finite extension in the third dimension can be neglected.

In some applications there are special 2D assumptions, such as the plane strain and plane stress conditions for 2D
stress analysis in solid mechanics.

In addition to the unit-depth assumption, some physics interfaces (for solid mechanics and heat transfer, for
example) provide the thickness as a user-defined property in 2D models. For heat transfer, the thickness is used

when including out-of-plane heat transfer in the model.

Axial Symmetry (Cylindrical Coordinates)

e If the 3D geometry can be constructed by revolving a cross section about
i an axis, and no variations in any variable occur when going around the axis

of revolution, an axisymmetric physics interface can be used.

The spatial coordinates are called  and z, where r is the radius. The flow at the boundaries is given per unit length
along the third dimension. Because this dimension is a revolution, you have to multiply all flows with ar, where a

is the revolution angle (for example, 2= for a full turn). COMSOL provides this is an option during postprocessing.

'El Geometric Variables and Mesh Variables

3D PROBLEMS

R This section discusses 3D geometry modeling practices.

Although COMSOL fully supports arbitrary 3D geometries, it is important to simplify the problem. This is because
3D problems easily get large and require more computer power, memory, and time to solve. The extra time spent

on simplifying a problem is probably well spent when solving it.

Is it possible to solve the problem in 2D? Given that the necessary approximations are small, the solution is more

accurate in 2D because a much denser mesh can be used. See 2D Problems if this is applicable.

Are there symmetries in the geometry and model? Many problems have planes where the solution on either side
of the plane looks the same. A good way to check this is to flip the geometry around the plane, for example, by
turning it upside down around the horizontal plane. You can then remove the geometry below the plane if you do
not see any differences between the two cases regarding geometry, materials, and sources. Boundaries created by
the cross section between the geometry and this plane need a symmetry boundary condition, which is available in
all 3D physics.
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Do you know the dependence in one direction so it can be replaced by an analytical function? You can use this

approach either to convert 3D to 2D or to convert a layer to a boundary condition.

THE COORDINATE SYSTEMS AND THE SPACE DIMENSION

COMSOL uses a global Cartesian or cylindrical (axisymmetric) coordinate system. You select the geometry
dimension and coordinate system when creating a new model. The default variable names for the spatial coordinates
are x, ¥, and z for Cartesian coordinates and r, ¢, and z for cylindrical coordinates. These coordinate variables
(together with the variable ¢ for the time in time-dependent models) make up the independent variables in
COMSOL models.

The labels assigned to the coordinate system variables vary according to the space dimension:

¢ Models that are opened using the space dimensions 1D, 2D, and 3D use the Cartesian coordinate independent
variable labels x, ¥ (2D and 3D), and z (3D).

¢ In 2D axisymmetric geometries, the x-axis represents the r label, which is the radial coordinate, while the y-axis
represents the z label, the height coordinate.

e In 1D axisymmetric geometries, the default radial coordinate is labeled r, and represented by the x-axis.

For axisymmetric cases the geometry model must fall in the positive half plane (7 > 0).

* Creating a New Model
El. * Coordinate Systems

* Cylindrical System

The nodes under a physics in the Model Builder and Plot Groups and Plots use different icons and colors to help

visualize a model.

* Physics Nodes by Space Dimension

'El * Plot Groups and Plots

Removing Interior Boundaries

Removing interior boundaries is good practice if the interior boundary is an effect of the geometry modeling and
does not represent a border between different materials or between domains with different properties. When you
remove the interior boundaries, the resulting geometry consists of fewer domains and puts fewer constraints on the

mesh generation.

To remove interior boundaries, clear the Keep interior boundaries check box in a Boolean operations such as Union

or Compose.

It is sometimes useful to keep interior boundaries for controlling the mesh. In such cases, use virtual operations
such as Ignore Edges and Ignore Faces but keep the original interior boundaries for mesh control. The interior
boundaries are then not part of the geometry for defining physics but are present during meshing to define areas

where you want to use a finer mesh, for example. See Mesh Control Entities for more information.
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Working with Geometry Sequences

The Geometry Nodes

Once you have added a Component, The Geometry Node, representing the geometry sequence of the model
component, is added under the Component node. Initially, a geometry sequence only contains a Form Union node.

The Component’s geometry is created by adding nodes to the sequence and building them.

* To add features to a geometry sequence, use the buttons in The Geometry Toolbar or right-click The Geometry
Node in the Model Builder and then select one of the available options. Then see Geometric Primitives, Geometry
Operations, and Virtual Geometry and Mesh Control Operations for descriptions of the geometry features. The
tables in each section link to the individual feature settings window descriptions.

e Learn about Creating a Geometry Sequence where you can use the buttons on the toolbars, right-click the
Geometry node to add items from the context menu, copy and paste geometry features, insert an existing
geometry sequence from another MPH file, or import a geometry. Sometimes Exporting a Geometry is useful.

* Once a geometry sequence is in place, you need to understand about Editing and Building Geometry Nodes,
Measuring Geometry Objects, and The Form Union/Assembly Node—Uniting the Geometry.

* Creating a New Model
* The Component Node
@l » Working with Nodes in the Model Builder
* Global Definitions and Geometry Subsequence

* Creating Named Selections in the Geometry Sequence

If you add Work Plane nodes in a 3D geometry, a Plane Geometry Node appears under the Work Plane node, and
you can add 2D geometry objects and features under that node to create the 2D geometry sequence that defines

the work plane’s geometry.

The Geometry Toolbar

After a Component node is added to the model, the Geometry ribbon toolbar (Windows) or the Geometry contextual
toolbar (Mac and Linux) is made accessible (Geometry Toolbar). Click the Geometry toolbar to display the options.

Geometric Primitives and Geometry Operations for example, can be
added using these toolbars. You can also right-click The Geometry Node
in the Model Builder and select any one of the available options. You can
also use some drawing tools as listed in Geometry Drawing Toolbar

Buttons.
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Figure 7-1: Click the Geometry ribbon toolbar (Windows users, top) or Geometry contextual toolbar (Mac and Linux
users, bottom) to display the options of the Geometry toolbar. This example is the 3D toolbar. Only some of the available
buttons are shown in this image, and some features ave not available yet, which is indicated by a grayed out button or
icon. The contextual toolbar for cross platform users can also have a Novmal or Compact display mode. This changes the
number of geometry buttons availnble.

Options become available based on where in the geometry you are working. As in Figure 7-1, the Geometry toolbar
has some options grayed out because these are not yet available. As a geometry sequence is built, and you select
geometry objects in the Graphics window, the applicable options become available.

When one of the buttons is clicked, COMSOL performs the associated operation on the selected objects and creates
the resulting objects, often adding a node to the geometry sequence. If you want to modify the operation, you can
edit and rebuild this node. See About Highlighted Geometric Entities in the Graphics Window for details.

DRAWING GEOMETRIC PRIMITIVES

In 2D (and 1D) there are buttons for drawing Geometric Primitives by using the mouse. In 3D, the buttons are
available to create primitives, but you cannot draw these using the mouse. See Geometry Toolbar and Table 2-8
for a list of the buttons and links to the individual features.

MOVING AND SCALING 2D OBJECTS IN THE GRAPHICS WINDOW

For 2D geometries, you can click the Edit button ((#) in the Graphics window’s toolbar to enter an Edit selection
mode, where you can perform the following actions:
¢ Click to select; then click-and-drag to move a geometry object in the 2D geometry plane.

* Click to select; then click- and-drag using one of the small squares in the frame that surrounds the selected
objects to scale it. If the scaling is isotropic so that the geometry object retains its original shape and type, the

geometry object’s settings show the resulting size and position. If the scaling is anisotropic (stretching a square
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so that it becomes a rectangle, for example), a Scale node appears under the geometry objects’ nodes in the
geometry sequence, and it contains the corresponding anisotropic scale factors.

¢ Alt-click to enter a mode where you can edit the geometry object by clicking-and-dragging control points in the
Graphics window. Right-click to exit this mode; an Edit Object node then appears under the geometry objects’
nodes in the geometry sequence, and it contains the properties of the edited object. See Editing 2D Geometry
Objects below.

When you work in the Edit selection mode, there is no highlighting of objects when you hover over them with the
mouse. Click to select a single geometry object; ctrl-click to select multiple objects. Click outside of the geometry

object to deselect.

EDITING 2D GEOMETRY OBJECTS
Use the Edit Object ( # ) node to adjust the edges and vertices for a 2D geometry object or to add or delete edges
and vertices in the object. In the Model Builder, right-click a 2D Geometry and sclect Edit Object.

The Edit Object function can also be started using the Edit Object button ( #) in the Geometry toolbar:

I In the Model Builder click the Geometry node.
2 Sclect a single geometry object in the Graphics window.

3 Click the Edit Object button ( #*). The Graphics window displays handles for vertices and edge control points in
the selected object.

4 Use the mouse to drag vertices and control points to new locations. The image is updated in the Graphics window
to show the effect on the object being edited.

5 Right-click to exit the object editing mode and save the changes. A new Edit Object node is added in the Model
Builder. Alternatively, if the object being edited is an Edit Object feature, the changes are incorporated in the

existing feature and no new node is added in the Model Builder.
6 Click the left mouse button outside the object being edited to cancel the editing operation.
Another way to edit a geometry object, if you are in the Edit selection mode, is to hold down the Alt key and

left-click on the object in the Graphics window. This is equivalent to selecting the object and then using the Edit
Object toolbar button.

'El See Edit Object for details.

The Geometry Node

Under a Geometry node (4 ) you define and create the geometry sequence for the model component. The

Geometry node also contains some general settings for the geometry such as the length unit.

Adding a Component Geometry
To add a new Component, which includes a Geometry node, right-click the root node of the Model Builder, and
select Add Component (or use the Model Wizard to create a new sequence as described in Creating a New Model). A

Component node is added to the Model Builder containing a Geometry | (if it is the first Component) feature node
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with the start of a geometry sequence containing only a Form Union node (see Figure 7-1 for an example).

See Geometric Primitives, Geometry Operations and Virtual Geometry
and Mesh Control Operations for descriptions of the geometry features.
The tables in each section link to the individual feature settings window

descriptions.

To add features to a geometry sequence, use the buttons in The Geometry
Toolbar or right-click The Geometry Node in the Model Builder and then
select one of the available options.

To open the settings window for a geometry, click the Geometry node in the Model Builder and adjust the following
settings sections.

UNITS

Select the Scale values when changing units check box to scale the values for the geometric dimensions so that the
geometric objects keep their physical size. The default setting is to not scale the values when changing units; the
program then interprets the values for the geometric dimensions using the new units for length and angle. The
values themselves do not change.

From the Length unit list select the length unit to use in fields for lengths and for visualization of the geometry. You
can override the unit using the unit syntax to specify the length unit (for example, 13[mm]). When solving the
model, all lengths are converted to the base unit for length. If you change the unit, COMSOL Multiphysics
converts all pure numeric values in fields for lengths to the new unit, if you have selected the Scale values when

changing units check box (see above).

For information about available length units and prefixes, see Specifying
]
I_El Model Equation Settings.

Angular Unit

From the Angular unit list choose to use radians or degrees as the angular unit to use in fields for angles. You can
override the unit by entering, for example, 0.3[rad]. The program assumes that numeric inputs and outputs of
trigonometric functions are in radians. If you change the unit, all pure numeric values in fields for angles are

converted to the new unit, if you have selected the Scale values when changing units check box (see above).

ADVANCED

Geometry Representation (3D Only)

This list is only visible if you have a license for the CAD Import Module. The Geometry representation list controls
which kernel (geometric modeler) that COMSOL uses to represent and operate on the geometry objects: the CAD
Import Module’s kernel (Parasolid) or COMSOL’s own kernel.

* If you choose CAD Import Module kernel (requires the CAD Import Module), all objects and operations that
support the CAD Import Module’s kernel use it. For example, Work Plane, Extrude, and Revolve operations do

not support this kernel.

e If you choose COMSOL kernel, all objects are represented using COMSOL’s kernel.

When you change the Geometry representation sctting, all nodes that support the CAD Import Module’s kernel are
marked as edited with an asterisk (*) in the upper-right corner the node’s icon. To rebuild the geometry using the
new kernel, click the Build All button ( [& ).
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When you create a new model, its default geometry representation is controlled by the preference setting

Geometry>Geometry representation>In new models.

When you open an existing model, you normally use the geometry representation used in the model. To always get
the possibility to convert the geometry to the COMSOL kernel, change the preference setting Geometry>Geometry

representation>When opening an existing model to Convert to COMSOL kernel.

Default Relative Repair Tolerance

This is the default value that is used when you add a feature that has a Relative repair tolerance ficld (for example,
Boolean operations and conversions). Changing the Default relative repair tolerance does not affect the tolerances
in existing features. Adjust the Relative repair tolerance if you experience problems with a Boolean operation. The
absolute repair tolerance is the relative repair tolerance times the maximum coordinate of the input objects.

Geometric entities that have a distance less than the absolute repair tolerance are merged.

Automatic Rebuild

The Automatic rebuild check box controls if the geometry sequence is automatically rebuilt when clicking on a node
in the model tree outside the geometry sequence. The default value is controlled by the preference setting
Geometry>Automatic rebuild>Default in new geometries. Sclect the Automatic rebuild check box to always rebuild the

geometry, or clear it to prevent any automatic rebuilding of the geometry.

Plane Geometry Node

Under a Plane Geometry node ( '/ ) you define and create the geometry sequence for a work plane. The Plane

Geometry node also contains some settings for the visualization of the work plane’s geometry.

Click the Plane Geometry node to open the Work Plane Modal Toolbar.

VISUALIZATION
Select the Draw on work plane in 3D check box to create the work plane geometry on the work plane in a 3D view
(see Drawing on a 2D Work Plane in 3D). The default setting is to display the work plane in the Graphics window

as a separate 2D geometry.

Under In-plane visualization of 3D geometry, specify how to visualize 3D objects in the work plane (as blue curves

and points) by selecting one or more of the following check boxes (all of them are selected by default):

¢ Coincident entities (blue)—Show edges and points (in a pure blue color) that lie in the work plane.
* Intersection (cyan)—Show the intersection of 3D geometry and the work plane (in cyan).

* Projection (light blue)—Show the projection of all edges and points onto the work plane (in light blue).

Creating o Geometry Sequence

There are a variety of ways to add and build geometry nodes—use the buttons on the toolbars, right-click the
Geometry node to add items from the context menu, copy and paste geometry features, insert an existing geometry

sequence from another MPH file, or import a geometry.

The Introduction to COMSOL Multiphysics includes a tutorial to learn
- how to build the busbar geometry. See Appendix A—Building a
= Geometry or the printed copy included with COMSOL Multiphysics.

USE THE TOOLBARS AND CONTEXT MENUS
Use the buttons in The Geometry Toolbar. The buttons are available for almost all drawing primitives (in 2D /1D)

as well as operations and conversions acting on geometry objects.
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You can also select objects or geometric entities in the Graphics window and then click a button or choose a context
menu item. The selected objects/entities are then an input to the created geometry operation feature. To access all
the features from the context menu, right-click The Geometry Node in the Model Builder and then select one of

the available options.

However the geometry is added to the sequence, define the node properties in the settings window. In numerical
fields you can enter expressions that contain parameters defined in Parameters under Global Definitions in the Model
Tree to parameterize the geometry. Click the Build Selected button ( [& ) in the settings window to see the geometry
objects that result.

COPY AND PASTE GEOMETRY OBJECTS
When using the copy/paste functionality, the copy initially contains the same data as the copied node, but there is
no future connection between the two nodes. For example, if the original node is changed, it has no effect on the

second node that was copied. To keep a link between nodes, use the Transforms Copy feature instead.

With the standard copy and paste method, a copy of the geometry object (a rectangle or sphere, for example) is
inserted into the same geometry sequence, or another geometry sequence in the same Component, and is added
after the current feature of the selected geometry sequence. The copy feature can also be used for Work Plane

geometry sequences.

The copied object must be pasted under a Component with the same
n space dimension. For example, a Sphere can only be pasted into a 3D

Component model.

& Copying, Pasting, and Duplicating Nodes

INSERT A SEQUENCE

To insert a geometry sequence from an MPH-file:

¢ On the Geometry toolbar, click Insert Sequence (Eé]), or

* Right-click the Geometry node and select Insert Sequence (E'E]) from the context menu.

Then browse to a file name and click Open. The file is scanned for geometry sequences having the right space
dimension. If there is just one such sequence, its nodes are inserted into the geometry sequence after the current
node. If the file contains more than one such sequence, a dialog box opens. Select the geometry sequence from the
list of available sequences. Finally click OK. The nodes in the selected sequence are inserted into the geometry

sequence after the current node.

If the geometry sequence contains references to functions or parameters, those functions and parameters are also
inserted in the model under Global Definitions, or in case of nonglobal functions, under Definitions in the same

Component the geometry sequence is located.

Functions and parameters are inserted even if a function or parameter

with the same name already exists in the model. You have to manually

[

resolve any conflicts before the geometry sequence can be built.
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IMPORT A GEOMETRY

To import an existing geometry:

* On the Geometry toolbar, click Import ([T ), or

* Right-click the Geometry node and select Import ([ ) from the context menu.

Then in the Import settings window, click Browse. Navigate to the geometry file and double-click it. Then click

Import.

You could also Export an existing geometry from another model and then import it. See Exporting a Geometry

for information.

For example, in the COMSOL installation directory navigate to the folder
models/COMSOL_Multiphysics/Tutorial Models and double-click
virtualgeom_demo_2.mphbin.

ill The location of the file varies based on the installation. For example, if the
installation is on your hard drive, the file path might be similar to
C:\Program Files\COMSOL44\models.

e Import

El. * Exporting a Geometry

Editing and Building Geometry Nodes

THE CURRENT NODE IN GEOMETRY SEQUENCES

Once a geometry node is added, it is inserted in the sequence after the current node. To indicate the current node,
it displays with a quadratic frame around its icon. When you have added a node, it becomes the current node, but
COMSOL Multiphysics does not build it automatically. If you select a node and build it, this node becomes current.
The frame is green (D) to show that the current node is built. If the current node needs to be rebuilt the frame
is yellow (). See Dynamic Nodes in the Model Builder for examples that show these icon additions for visual

feedback about a node’s status.

Adding a Node at an Arbitrary Position
To add a node after an existing node, first select the existing node and then click Build Selected ( [ ), or right-click
the existing node and select Build Selected. The selected node then becomes current. Then add the new node.

To add a node before an existing node, first select the existing node, right-click the existing node and select Build
Preceding ( & ). Then add the node.

EDITING A NODE

To edit a node, select it in the model tree and make changes in the settings window. Nodes that you have edited
display with an asterisk (*) at the upper-right corner of their icons in the Model Builder window. Nodes that depend
on the edited node display with a yellow triangle at the lower-right corner of the node’s icon to indicate that they
need to be rebuilt. To see the result of your edits in the Graphics window, you need to build the node. You can do

this in two ways:

¢ Click the Build Selected button ( f& ) in the settings window, or right-click the node in the tree and select Build
Selected. This builds all nodes (if needed) from the first up to the selected node.
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Click the Build All Objects button ( [E ) in the settings window. This builds all nodes in the geometry sequence

above the Form Union/Assembly node (if needed).

Click the Build All button ( [E§ ) in the settings window or the toolbar, or right-click the Geometry node in the

tree and select Build All. This builds all nodes in the geometry sequence (if needed).

AUTOMATIC BUILDING OF GEOMETRY NODES

In some situations, COMSOL Multiphysics builds geometry nodes directly, such as when you:

Add a node, the software builds the current node (and all its preceding nodes) before showing the settings
window for the new node.

Generate a mesh or solve the model, the software builds the finalized geometry; that is, it builds all nodes if

needed.

Select a node that uses the finalized geometry, like physics and mesh nodes, the software builds the finalized

geometry if Automatic rebuild is sclected in the geometry node settings.

Open a CAD Defeaturing tools settings, the software builds the current node (and all its preceding nodes).

DELETE NODES

To delete selected nodes, right-click the nodes and select Delete ( % ) or press Del (the Delete key). Confirm the
deletion of nodes for it to take effect.

To delete a geometry right-click the Geometry node in the Model Builder and sclect Delete Sequence (';-_). You
cannot use the Undo command.

To delete geometry objects or entities, in the Model Builder, right-click Geometry and select Delete Entities ( E ).
Or select objects in the Graphics window, and click the Delete button ( % ) in the Graphics toolbar.

If you use the Delete button to delete objects, COMSOL Multiphysics deletes the selected objects that
correspond to primitive features by deleting their nodes from the geometry sequence. If you delete objects that
do not correspond to primitive features or if you delete geometric entities a Delete Entities node appears in the
sequence.

Undo is not possible for nodes that are built directly, such as geometry
n objects, meshes, solutions, and plots.

Exporting a Geometry

You can export geometry objects to a COMSOL binary file (.mphbin) or text file (.mphtxt).

Q 2D geometry objects can also be exported to a DXF file.

3D geometry objects can also be exported to an STL file. If you have a
R license for the CAD Import Module, 3D geometry objects can also be
exported to Parasolid files (.x_t, or .x_b) or ACIS files (.sat, or .sab).

To export an existing geometry to file:
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On the Geometry toolbar click Export ([[5 ), or

Right-click the Geometry node and select Export ([[ ) from the context menu.
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Then select a file type among the available formats in the File type list and enter a file name including the path in

the Filename field (or click Browse to specify the filename).

For STL file export you can select objects, domains, or boundaries to export. For the other file types you select the
objects to export by first clicking the Export selected objects button and then adding the objects to export to the
Selected object list, or click the Export result of Form Union/Assembly button to export the result of the Form

Union/Assembly operation.

For a geometry subsequence and for a Plane Geometry of a work plane,

the Export result of Form Union/Assembly option does not exist, so that

[

button and the Export selected objects button are not available. Instead,
just add objects to export to the Selected object list.

Click Export to export the selected geometry to the specified file. A confirmation message appears in The Messages

Window.

The .mphbin and .mphtxt formats do not contain unit information.
When the exported file is imported into a geometry with a different

length unit, you can use a Scale feature to scale the imported objects to

[

the correct size.

To export a geometry to use in an earlier version of COMSOL in the
g COMSOL format, select a version from the Compatible with version list.

e Also see Import for details of how to import CAD file formats.

'& e Creating a Geometry Sequence

Measuring Geometry Objects

To measure a set of geometric objects or entities selected in the Graphics window, click the Measure button ()
on the Geometry toolbar (this button is also available on the Mesh toolbar). The result appears in The Messages
Window:

* If objects are selected, the number of entities and objects is displayed.

¢ If domains are selected, the total volume/area/length and boundary area/length is displayed.

e Iffaces/edges are selected, the total area/length is displayed.

» Ifasingle vertex is selected, the coordinates are displayed.

e If two vertices are selected, the distance is displayed.

Another way to measure geometry objects, is to right-click the Geometry node and select Measure () from the

context menu. This opens the Measure window, which has the following contents:

The Measure window is a tool to measure geometry objects and entities. You can, for example, measure the volume,
area, or length of a selected domain, face, or edge. Also view the coordinates of a vertex, the distance between two
vertices, or the number of entities and the geometry representation (requires a license for the CAD Import Module)

of an object.
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GEOMETRY TYPE

From the Type of geometry list, select to measure geometry objects (the default) or the finalized geometry.

SELECTION
From the Geometric entity level list, sclect Object, Domain, Boundary, Edge, or Point. Then select some objects or
entities of the selected type to add to the list.

MEASUREMENTS

Under Measurements you find information about these objects or entities. For objects, this section contains the total
number of domains, boundaries, edges, and points, and the geometry representation. For domains, boundaries,
and edges, their total volume, area, or length appears. If you select a point, its coordinates are shown. If you select

two points, the distance is shown.

You can add a Mass Properties node to define variables for mass properties
g such as the total volume, total mass, and the center of mass.

The Form Union/Assembly Node—Uniting the Geometry

To unite the geometry, COMSOL Multiphysics evaluates the geometry sequence from the top down. The final
node in the geometry sequence (before any virtual operations, if present), the Form Union/Assembly node,
determines how to form the geometry that is used for meshing and analysis (possibly after also applying virtual
operations). There are two methods to form the geometry, which also determine the name of the node: Form Union
or Form Assembly ([}). There are some differences and aspects to consider when choosing a method:

* The default method is to form a #nion. The software then forms a union from all geometry objects that the
geometry sequence contains or creates. The union is divided into domains separated by boundaries according to
the participating geometry objects. You can mesh the entire geometry and model the physics by assigning
material properties, boundary conditions, and other data for the model. It is also possible but often not necessary
to specity boundary conditions on interior boundaries between domains in the geometry. By default, COMSOL
ensures continuity in the physics fields across interior boundaries. See also Removing Interior Boundaries below).

When forming a union for axisymmetric models, COMSOL removes all

parts of the geometry from the r<0 half plane.

[

e The alternative method is to form an assembly. The software then treats the geometry as a collection of parts,
where each geometry object represents a part. This means that you must use pairs to connect boundaries where
a field is continuous, but it also makes is possible to use special pair conditions for applications such as contact
modeling. By default, pairs are created automatically when forming an assembly. An assembly can also be useful
for meshing each part independently in, for example, thin geometries with high aspect ratios. Another case where
you need to use an assembly is when the geometry is too complex for forming a union, which might be the case

when importing an assembly geometry from CAD data.

The Form Union/Assembly node ([7)) ends each geometry sequence in 1D. In 2D and 3D, it is possible to add virtual
operation nodes and selection nodes after that node. In the Model Tree, its label is Form Union or Form Assembly
depending on its settings. By default, it unites all geometry objects into a single geometry object (this is the Form
Union variant). You cannot delete or disable the Form Union/Assembly node. When you leave the geometry sequence
to define materials or physics, the Messages window provides information about the method (forming a union or

an assembly) and about the number of geometric entities (domain, boundaries, and so on) in the geometry.
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FORM UNION/ASSEMBLY

The default method, Form a union, forms a union of all geometry objects. Select Form an assembly from the Action
list if you do not want the geometry objects to be united. The program then forms the geometry by collecting the
objects as parts in an assembly object. If you form an assembly, select the Create imprints check box to get imprints
of the parts of the assembly that touch each other. An imprint of a usually smaller part’s boundary on an adjacent
larger part’s boundary inserts points on the boundary in 2D and creates edges on the boundary in 3D. Creating
imprints can be useful when you need identical matching meshes on both parts’ boundaries or when you want to
split the larger boundary so that it contains a segment or area that matches the smaller boundary. Select the Create
pairs check box (selected by default) to generate pairs corresponding to the parts of the assembly that touch each
other. Select the Split disconnected pairs check box to generate one pair for each connected set of boundaries. Clear
the Split disconnected pairs check box to generate one pair for each pair of parts that touch each other. From the
Pair type list, sclect Identity pair (the default) to generate identity pairs, which makes it possible to connect the
physics fields across the assembly parts’ boundaries, or Contact pair to generate contact pairs. The contact pairs are
only useful for contact modeling in structural mechanics and require a license for the Structural Mechanics Module
or the MEMS Module.

Adjust the value in the Relative repair tolerance ficld (default value: 1-1076) if you experience problems with the
Form Union/Assembly operation. The absolute repair tolerance is the relative repair tolerance times the maximum
coordinate of all geometry objects. Geometric entities with a distance less than the absolute repair tolerance are
merged.

In 2D and 3D, virtual operation nodes and selection nodes can appear

]
|_E'| after the Form Union/Assembly node.

Using Geometry Subsequences

If you consider the geometry sequence as a computer program, a geometry subsequence corresponds to a
subroutine, function, method, or procedure in a programming language. In other words, a geometry subsequence
is a geometry sequence whose input is a set of arguments (having numerical values) and whose output is a set of

geometry objects.

You can call the subsequence (that is, create an instance of the subsequence) with new values of the arguments. You

can call it several times, and the calls can be nested.

CREATING A GEOMETRY SUBSEQUENCE
The geometry subsequences appear under Global Definitions in the Model Tree, so they are not attached to a
specific model component. To create a subsequence, right-click Global Definitions, and then select 3D, 2D, or ID from

the Geometry Subsequences submenu. Beneath the added geometry subsequence node there are two special nodes:

¢ Arguments. Enter the names of the arguments in the Name column. In the Expression column, enter their default
values as expressions in terms of numerical values. The corresponding values appear in the Value column.

Optionally, enter descriptions for the arguments in the Description column.

¢ Parameters. Enter the names of the local parameters in the Name column. In the Expression column, enter the
corresponding definitions; those definitions can depend on arguments and other local parameters. The
corresponding values appear in the Value column. Optionally, enter descriptions for the local parameters in the

Description column.

Within the subsequence you can use arguments and local parameters in expressions, just like you use global

parameters in an ordinary geometry sequence. There is no support for using global parameters within a
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subsequence. You add features to the subsequence as usual. There is also a View node with view settings below the
geometry feature nodes.

CALLING A GEOMETRY SUBSEQUENCE

In a geometry sequence or subsequence you can add a call to a geometry subsequence by right-clicking the
Geometry node and selecting Programming>Subsequence Call. This adds a Subsequence Call node ('-*3_-;_ ), whose
purpose is to build an instance of the subsequence with new values of its arguments. You can also change the

position and orientation of the resulting geometry objects. See Subsequence Call for details.

A Subsequence Call node can optionally call a local subsequence instead of a subsequence under Global Definitions.

In this case, the local subsequence appears beneath the Subsequence Call node.

There is no associativity for the output objects of a geometry
subsequence. That is, if you make a selection that consists of geometric
entities from these output objects, the selection becomes empty when you
rebuild the geometry after a change in the subsequence or in the

arguments. To overcome this problem, define the selections within the

[

subsequence. These selections also become available in the calling
sequence. You can also unite selections from several Subsequence Call

nodes using a cumulative selection; see Subsequence Call.

DEBUGGING A GEOMETRY SUBSEQUENCE

Sometimes you want to inspect what happens when you build a Subsequence Call. To do so, right-click the
Subsequence Call node, and select Step Into. This builds all preceding features and shows a copy of the called
subsequence beneath the Subsequence Call node. The copy is identical to the subsequence, except that the
arguments have different values. You can now build features in the copy. You can also try out modifications in the

copy. You can then apply the modifications in the subsequence.

When you build the Subsequence Call, you lose the changes you have

made in the copy. If you want to keep your changes, switch to using a

B

local sequence by selecting Local subsequence in the Subsequence list.

If an error occurs when you build the Subsequence Call, a copy of the called subsequence appears automatically so

that you can locate the error.
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Geometric Primitives

The geometric primitives provide building blocks of basic geometric shapes for creating geometries in 1D, 2D, and
3D. The features in Table 7-1 are also available as buttons on the The Geometry Toolbar, sometimes from the More
Primitives (<5 3D, 235 2D, or _~"1D) menu. You can combine and operate on all geometric primitives using

Boolean operations and other Geometry Operations.

TABLE 7-1: 1D, 2D, AND 3D GEOMETRY PRIMITIVES AND GEOMETRY TOOLBAR BUTTONS

ICON NAME SPACE ICON NAME SPACE
DIMENSION DIMENSION

S Bézier Polygon 2D, 3D - Interval ID

"-I-" Block 3D o Parametric 2D, 3D
Curve

0 Circle 2D 4 Parametric 3D
Surface

I Cone 3D . Point 1D, 2D, 3D

] Cylinder 3D ! Polygon 2D, 3D

I Eccentric Cone 3D B4 Pyramid 3D

(] Ellipse 2D | Rectangle 2D

=) Ellipsoid 3D & Sphere 3D

& Helix 3D [ Square 2D

() Hexahedron 3D iy Tetrahedron 3D

ey Interpolation 2D, 3D = Torus 3D

Curve

If you want to refer to the domains, boundaries, edges, or points (geometric entities) in the Component, COMSOL
can create selections for all geometric entities that a geometric primitive consists of. It is also possible to create

selections in the geometry nodes for the resulting geometry objects from such operations. See Creating Selections
From Geometric Primitives and Operations. For some geometric primitives (blocks and spheres, for example) you

can add layers for creating sandwich structures or, for example, layers of concentric spheres.

Bézier Polygon

A Bézier Polygon ( 7.7) consists of a sequence of connected line segments, quadratic Bézier curves (for example
circular arcs), and cubic Bézier curves. See About Rational Bézier Curves below for some information about Bézier

curves in general.
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To create a Bézier polygon, you can either:

* Right-click a 2D Geometry node and select Bézier Polygon (~.7). For a 3D model, on the Geometry toolbar, from
the More Primitives (<F ) menu, select Bézier Polygon (.7 ). Then enter the properties of the Bézier polygon in
the settings window, or

* Ona 2D Geometry toolbar, click the Draw Line button (_~*), Draw Quadratic ( /), and Draw Cubic ( *.") buttons

to draw in the Graphics window. Also see Drawing Geometric Primitives.

To draw a polygon consisting of line segments or Bézier curves, first click
one of the buttons. Then click the control points of the segments in the
Graphics window. Click one point for each linear segment, two points for
each quadratic segment, and three points for each cubic segment. If you
want to switch segment type, click one of the buttons and then click some
more control points. Close the polygon by right-clicking anywhere in the
Graphics window. Then, a solid Bézier polygon appears, and a
corresponding Bézier Polygon node appears in the geometry sequence. If
you want to modify the polygon (for instance, change from solid to curve)
you can edit the Bézier Polygon node by clicking it to display its settings

window.

When you have added a node or finished drawing the Bézier polygon in the Graphics window, you can use the
following sections to define it or fine tune it.

GENERAL
From the Type list, select Solid, Closed curve, or Open curve to specify if the Bézier polygon is a solid object (only
available in 2D) or a closed or open curve object. If you choose Solid or Closed curve, the software automatically

adds a line segment if needed to close the polygon.

When using the Geometry toolbar, the Draw Solid button ( /) is available
to toggle between drawing a solid object or an outline (or curve) instead

EI of selecting a Type. See Geometry Drawing Toolbar Buttons for other
drawing toolbar buttons.

POLYGON SEGMENTS

Define the Bézier polygon by adding curve segments to the list of segments. Choose linear segments, quadratic
segments, or cubic segments. Delete segments by selecting them and clicking Delete. To edit a segment, select it in
the list. When editing the last segment, click Close Curve to make the last control point coincide with the first control

point of the first segment.

Linear Segments
To add a linear segment, click Add Linear. Specify the start of the linear segment on the first row of coordinates

under Control points. Specify the end of the linear segment on the second row of coordinates.

Quadratic Segments
To add a quadratic segment, click Add Quadratic. Specify the coordinates of the three control points on rows under
Control points. Add the weights of the control points under Weights. The default weights—1, 1/(4/2) , and 1—

correspond to a circular arc if the control points are three corners of a square.
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Cubic Segments
To add a cubic segment, click Add Cubic. Specify the coordinates of the four control points on each row under
Control points. Add the weights of the four control points under Weights. Cubic segments with self-intersections

might look correct when displayed but are not handled correctly by other geometry and meshing operations.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, and
points) that the Bézier polygon consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

ABOUT RATIONAL BEZIER CURVES

A rational Bézier curve is a parameterized curve of the form

5ibﬂ%3€“)
b(t) = =2

> ,0<¢<1
z:wgfa)
1=0

where the functions

B(t) = (M)da-ep
are the Bernstein basis functions of degree p; b; = (x1, ..., x,,) are the control points of the n-dimensional space;
and w; are the weights, which should always be nonnegative numbers. The end-point interpolation property
corresponds to b(0) = bg and b(1) = b,,. Another uscful property of the rational Bézier curves is that the direction
of the tangent vector at £ = 0 and ¢ = 1 is determined by the vectors by —bg and by, —b,_j, respectively. That s, the
curve is always tangent to the line connecting the control points by and by and the line connecting b,,_; and by,.
When joining curves at end points, aligning the (nonzero) tangent vectors assures tangential continuity. This

technique produces visually smooth transitions between adjacent curves.

Quadratic Curves (Conic Sections)

Rational Bézier curves of degree 2 can represent all conic sections: circles, ellipses, parabolas, and hyperbolas.
Elliptical or circular curve segments are often called arcs. The conic sections are also called quadric curves or
quadrics. Because the parameter ¢ is constrained to be in the interval [0, 1], only a segment of the conic section is
represented. A 2nd degree curve consists of three control points and three weights. There is a simple rule for
classifying a 2nd degree curve if the end point weights are set to 1, only allowing the central weight wq to vary: if
wo=wg =1, then 0 <w; < 1 gives ellipses, wq = 1 gives parabolas, and wy > 1 gives hyperbolas. For a fixed control
polygon, at most one value of w; (among the ellipses generated by letting 0 < wy < 1) gives a circle segment. For

example, a quarter of a full circle is generated by a control polygon with a right angle and with a central weight of

1/.2.

Cubic Curves

Rational Bézier curves of degree 3 (cubic curves) have more dynamic properties than conic section curves. A cubic
curve has four control points and four weights, making it possible to create a self-intersecting control polygon or a
zigzag control polygon. A self-intersecting polygon can give rise to a self-intersecting curve (loop). Self-intersecting

curves and cusps are not supported.
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A zigzag control polygon generates an S-shaped curve containing a point of inflection where the tangent line lies
on both sides of the curve.

Block

To create a block (box), on the 3D Geometry toolbar, click Block (_'_:']::_'_ ). You can also right-click the Geometry node

to add this node from the context menu. Then enter the properties of the block using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the block is a solid object or a (hollow) surface object.

SIZE AND SHAPE
Define the edge lengths in the Width, Depth, and Height ficlds. With the default axis (representing the z-axis) and

no rotation, the width, depth, and height correspond to the dimensions in the x-, ¥-, and z-directions, respectively.

POSITION
Enter the position of the block using the x, y, and z fields. From the Base list, choose Center if the block is centered

about the position, or choose Corner if the block has one corner in this position.

AXIS

Specify the direction of the block’s third axis—that is, the direction of the edges corresponding to the height. From
the Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain an axis aligned with the specified coordinate
axis. Choose Cartesian to enter a direction vector in the x, y, and z fields. Choose Spherical to enter the direction

using the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE
Specify the rotational angle about the block’s third axis in the Rotation ficld. When this angle is zero (the default),

the block’s second axis is parallel to the xy-plane.

LAYERS

Layers can be used to create sandwich primitives by adding layers on one or more sides. Specify the thicknesses of
layers in the Layers table, and optionally a name for each layer. The outermost layer comes first. Select the check
boxes under Layer position to specify where to apply the layers (see the graphics to the right of the check boxes to
see the definitions of the left, right, front, back, bottom, and top sides of the block).

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the block consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).
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Circle

To create a circle or disk, you can either:

¢ Right-click the 2D Geometry node and add a Circle node to the sequence then define it in the settings window, or

* On the 2D Geometry toolbar, from the Circle ( () ) menu, select Circle (Corner) () ). Then draw the circle in
the Graphics window. Also see Drawing Geometric Primitives.

To draw a circle for a 2D model, click Circle or Circle (Corner). Then,
click the circle’s center (or one corner of the circle’s bounding box) in the
Graphics window. Drag the mouse to the desired position of a corner of
the circle’s bounding box. When you release the mouse button, a solid

circle appears, and a Circle node appears in the geometry sequence.

When you have added a node or finished drawing the circle in the Graphics window, you can use the following
section to define it or fine tune it.

OBJECT TYPE

From the Type list, select Solid or Curve to specify if the circle is a solid object (disk) or a curve object.

When using the geometry toolbar, the Draw Solid button ( /) is available
to toggle between drawing a solid object or an outline (or curve) instead

EI of selecting an Object Type. See Geometry Drawing Toolbar Buttons for
other drawing toolbar buttons.

SIZE AND SHAPE

Define the circle’s radius in the Radius field. Enter a sector angle (in degree) for a circle sector in the Sector angle
field. The default value is 360 degrees for a full circle.

POSITION

Enter the position of the circle using the x and y fields (r and z in 2D axial symmetry, xw and yw in work planes).
From the Base list, choose Center if the circle is centered about the position, or choose Corner if a surrounding box

has a corner at the position.

ROTATION ANGLE

Specify the counterclockwise rotational angle about the position in the Rotation field. The default angle is 0 degrees.

LAYERS
Layers can be used to create sandwich primitives by adding several concentric circles. You specify the thicknesses of

layers in the Layers table, and optionally a name for each layer. The outermost layer comes first.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, and
points) that the circle consists of. These selections are available in all applicable selection lists but do not appear as
separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative selection,
select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative selection

(see Cumulative Selections).
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Cone

To create a right circular cone or cone frustum (conical frustum, truncated cone), on the 3D Geometry toolbar,

click Cone (

I=). By adding a Cone feature you can create the part of a cone contained between two circular bases
without going through an apex. You can also right-click the Geoemetry node to add this node from the context

menu. Enter the properties of the cone using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the cone is a solid object or a (hollow) surface object.

SIZE AND SHAPE

Define the size and shape of the cone in the Bottom radius, Height, Specify top size using, and Semi-angle or Top radius
fields. From the Specify top size using list select Radius to specify the cone top size using the Top radius field. The
top radius must be a positive value or 0 for a cone with a sharp apex. From the Specify top size using list select Angle
(the default setting) to specify the cone top size using the Semi-angle field. The semi-angle is the angle a cone makes
with the vertical axis. For the default cone with a bottom radius and height of 1, the default semi-angle is roughly
26.565 degrees, which makes the radius of the second (top) basis 1,/2. For the default radius and height the
maximum semi-angle is 45 degrees (for a cone with a sharp apex). The maximum semi-angle depends on the values
for the radius and height. The semi-angle must be larger than —90 degrees. Setting the semi-angle to 0 makes the

cone into a cylinder.

POSITION

Enter the position of the cone using the x, y, and z fields. This is the center of the bottom circle.

AXIS

Specity the direction of the cone’s axis. From the Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain
an axis aligned with the specified coordinate axis. Choose Cartesian to enter a direction vector using the x, y, and z
fields. Choose Spherical to enter the direction using the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE
Specity the rotational angle about the axis in the Rotation field. When this angle is zero (the default), the second
axis of the cone’s local coordinate system is parallel to the xy-plane.

LAYERS

Layers can be used to create sandwich primitives by adding layers to one or more sides of the cone. You specify the
thicknesses of layers in the Layers table, and optionally a name for each layer. The outermost layer comes first. Select
the check boxes to specify where to apply the layers.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the cone consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Cylinder

To create a right circular cylinder, on the Geometry toolbar, click Cylinder ([T )). You can also right-click the

Geometry node to add this node from the context menu. Then enter the properties of the cylinder using the

following sections:
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OBJECT TYPE

From the Type list, select Solid or Surface to specify if the cylinder is a solid object or a (hollow) surface object.

SIZE AND SHAPE
Define the size and shape of the cylinder in the Radius and Height fields.

POSITION

Enter the position of the cylinder using the x, y, and z fields. This is the center of the bottom circle.

AXIS
Specify the direction of the cylinder’s axis. From the Axis type list, choose x-axis, y-axis, or z-axis (the default) to
obtain an axis aligned with the specified coordinate axis. Choose Cartesian to enter a direction vector using the x,

y, and z fields. Choose Spherical to enter the direction using the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE
Specify the rotational angle about the axis in the Rotation field. When this angle is zero (the default), the second
axis of the cylinder’s local coordinate system is parallel to the xy-plane.

LAYERS

Layers can be used to create sandwich primitives by adding layers on one or more sides. You specify the thicknesses
of layers in the Layers table, and optionally a name for each layer. The outermost layer comes first. Select the check
boxes to specify where to apply the layers.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the cylinder consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Eccentric Cone

To create an eccentric (oblique) cone or cone frustum with elliptic base, on the Geoemetry toolbar, from the More
Primitives (<3 ) menu, select Eccentric Cone (|]= ). You can also right-click the Geometry node to add this node from

the context menu. Then enter the properties of the eccentric cone using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the eccentric cone is a solid object or a (hollow) surface object.

SIZE AND SHAPE

Define the size and shape of the eccentric cone in the a-semiaxis, b-semiaxis, Height, Ratio, Top displacement 1, and
Top displacement 2 ficlds. The bottom of the cone is an ellipse with semiaxes given in the a-semiaxis and b-semiaxis
fields. The Height ficld determines the height of the cone frustum. The Ratio field controls the ratio between the
perimeters of the top and bottom ellipses. To get an oblique cone, use the Top displacement ficlds to specify the

displacement of the top ellipse’s center relative to the bottom ellipse’s center, in the cone’s local coordinate system.

POSITION

Enter the position of the eccentric cone using the x, y, and z fields. This is the center of the bottom ellipse.
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AXIS

Specify the direction of the third axis of the cone’s local coordinate system—that is, the normal to the base ellipse.
From the Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain an axis aligned with the specified
coordinate axis. Choose Cartesian to enter a direction vector using the x, y, and z fields. Choose Spherical to enter
the direction using the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE

Specify the rotational angle about the axis in the Rotation field. When this angle is zero (the default), the second
axis of the cone’s local coordinate system is parallel to the xy-plane.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the eccentric cone consists of. These selections are available in all applicable selection lists but do
not appear as separate selection nodes in the model tree. If you want to make the selections contribute to a
cumulative selection, select a cumulative selection from the Contribute to list, or click the New button to create a

new cumulative selection (see Cumulative Selections).

Ellipse

To create a ellipse, you can either:

¢ Right-click the Geometry node and add an Ellipse node to the sequence then define it in the settings window, or

* On the 2D Geometry toolbar, from the Circle ( (=} ) menu, select Ellipse ( ¢ ) or Ellipse (Corner)( ;=3 ). Then draw
the ellipse in the Graphics window. Also see Drawing Geometric Primitives.

To draw an ellipse for a 2D model, click Ellipse or Ellipse (Corner). Then,
click the ellipse’s center (or one corner of the ellipse’s bounding box) in
the Graphics window. Drag the mouse to the desired position of a corner
of the ellipse’s bounding box. When you release the mouse button, a solid

ellipse appears, and an Ellipse node appears in the geometry sequence.

When you have added a node or finished drawing the ellipse in the Graphics window, you can use the following
section to define it or fine tune it.

OBJECT TYPE

From the Type list, select Solid or Curve to specify if the ellipse is a solid object or a curve object.

When using the geometry toolbar, the Draw Solid button ( /T ) is available
to toggle between drawing a solid object or an outline (or curve) instead

EI of selecting an Object Type. See Geometry Drawing Toolbar Buttons for
other drawing toolbar buttons.

SIZE AND SHAPE

Define the ellipse’s semiaxes in the a-semiaxis and b-semiaxes ficlds. Enter a sector angle (in degree) for an ellipse
sector in the Sector angle ficld. The default value is 360 degrees for a full ellipse.
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POSITION
Enter the position of the ellipse using the x and y fields (r and z in 2D axial symmetry, xw and yw in work planes).
From the Base list, choose Center if the ellipse is centered about the position, or choose Corner if a surrounding box

has one corner at the position.

ROTATION ANGLE
Specify the counterclockwise rotational angle about the base point in the Rotation field. The default angle is 0

degrees.

LAYERS
Layers can be used to create sandwich primitives by adding several concentric ellipses. You specify the thicknesses

of layers in the Layers table, and optionally a name for each layer. The outermost layer comes first.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, edges, and points)
that the ellipse consists of. These selections are available in all applicable selection lists but do not appear as separate
selection nodes in the Model Tree. If you want to make the selections contribute to a cumulative selection, select
a cumulative selection from the Contribute to list, or click the New button to create a new cumulative selection (see

Cumulative Selections).

Ellipsoid

To create an ellipsoid, on the Geometry toolbar, from the More Primitives (3 ) menu, select Ellipsoid (5 ). You
can also right-click the Geometry node to add this node from the context menu. Then enter the properties of the

ellipsoid using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the ellipsoid is a solid object or a (hollow) surface object.

SIZE AND SHAPE

Define the semiaxes of the ellipsoid in the a-semiaxis, b-semiaxis, and c-semiaxis ficlds.

POSITION

Enter the position of the ellipsoid’s center using the x, y, and z fields.

AXIS

Specity the direction of the ellipsoid’s third axis—that is, the principal axis corresponding to c-semiaxis. From the
Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain an axis aligned with the specified coordinate axis.
Choose Cartesian to enter a direction vector in the x, y, and z fields. Choose Spherical to enter the direction using

the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE
Specify the rotational angle about the ellipsoid’s third axis in the Rotation ficld. When this angle is zero (the default),

the ellipsoid’s second axis is parallel to the xy-plane.

LAYERS
Layers can be used to create sandwich primitives by adding several concentric ellipsoids. You specify the thicknesses

of layers in the Layers table, and optionally a name for each layer. The outermost layer comes first.
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SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the ellipsoid consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Helix

To create a helix (coil) with a circular cross section, on the Geometry toolbar click Helix (£ ). You can also
right-click the Geometry node to add this node from the context menu. Then enter the properties of the helix using

the sections in the settings window.

To create a helix with a noncircular cross section, define the cross section
using a work plane. Define the helix centerpoint as a 3D curve using a
Helix node with a minor radius = 0 or a Parametric Curve node, and then
use a Sweep node to sweep the cross section from the work plane along

the curve to create the helix.

OBJECT TYPE
From the Type list, select Solid (the default) to create a solid helix, or select Surface to create a hollow helix that
consists of surfaces only.

SIZE AND SHAPE

This section contains a number of properties that determine the size and shape of the helix.
The Number of turns field contains a positive number. The default value is 3 turns.

There are two radii:

* The Major radius (SI unit: m) field is the radius from the center of the helix (the default is 1 m).

¢ The Minor radius field (SI unit: m) is the radius of the cross section (the default is 0.1 m). The Minor radius can
be zero, in which case a curve object is created. You can use this together with the Sweep feature to create helices

with noncircular cross sections.
There are two pitches:

¢ The Axial pitch field (SI unit: m) determines the axial distance between similar positions on two consecutive turns
of the helix (the default is 0.3 m).

* The Radial pitch ficld (SI unit: m) determines the radial distance between similar positions on two consecutive

turns of the helix (the default is 0, which means that each turn has the same radius).

Select Right handed or Left handed from the Chirality list. The chirality or handedness of the helix can be either right
handed (the default) or left handed. For a right handed helix, a clockwise screwing motion moves the helix away

from the observer; for a left handed helix, a clockwise screwing motion moves it toward the observer.
From the End caps list, select an option to create the end caps of the helix:

* Seclect Parallel to axis (the default) to create end caps that are parallel to the helix axis.
* Select Perpendicular to axis to create end caps that are perpendicular to the helix axis.

¢ Seclect Parallel to spine to create end caps that are parallel to the spine of the helix.

384 | CHAPTER 7: GEOMETRY MODELING AND CAD TOOLS



POSITION
This is the center position for the starting turn of the helix. Enter the coordinates in the x, y, and z fields. The default

position is the origin.

AXIS

Select the Axis type—x-axis, y-axis, z-axis, Cartesian, or Spherical.

* Select x-axis, y-axis, or z-axis (the default) to define the axis direction parallel to one of the coordinate axes.

¢ Select Cartesian to define the axis direction using Cartesian coordinates in the x, y, and z fields. The default axis
is in the z-direction (0, 0, 1).

¢ Seclect Spherical to define the axis direction using spherical coordinates 6 and ¢ (angles of inclination and
azimuth, respectively) in the theta and phi fields. The default angles are 0.

ROTATION ANGLE

Rotate the helix around its axis by entering an angle in the Rotation field. The default value is 0 degrees.

ADVANCED SETTINGS

By default, the Twist compensation check box is selected, which prevents the twisting that would otherwise occur
due to nonzero torsion for curves that do not belong to a fixed plane. Twist compensation rotates the base circle
during the sweep along the helix curve by an amount equal to the integral of the curve torsion.

Twist compensation affects the position of the vertices on the top side of

the helix. Clear the Twist compensation check box to turn it off. See

B

Figure 2-6 below.

Figure 7-2: The helix on the left has twist compensation (the defanlt). For the helix on the right, twist compensation has
been turned off.

From the Geometry representation list, sclect Spline (the default) to represent the helix using splines, or Bézier, to
represent the helix using Bézier curves. The difference is that using Bézier curves, the intersections between the

surfaces that form the helix are visible edges, whereas they are hidden when using splines.
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The values in the Relative tolerance ficld is a relative tolerance that controls the accuracy of the geometric
representation of the helix. The geometric representation is an approximation, which is necessary because it is not
possible to exactly represent a helix using NURBS (nonuniform rational basis splines). The default value is 1074
(or 0.01%).

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the helix consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Hexahedron

To create a hexahedron bounded by bilinear faces, on the Geometry toolbar, click More Primitives>Hexahedron
(1) You can also right-click the Geometry node to add this node from the context menu. Then enter the

properties of the hexahedron using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the hexahedron is a solid object or a (hollow) surface object.

VERTICES
Define the position, size, and shape of the hexahedron by specifying the coordinates of its vertices. Vertices 1—4 are

the vertices of the bottom face in clockwise order. Vertices 5-8 are the vertices of the top face in clockwise order.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the hexahedron consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Interpolation Curve

An interpolation curve consists of a curve that interpolates or approximates a sequence of points. To create an
interpolation curve, on the Geometry toolbar, from the More Primitives (3D & or 2D 2%%) menu, select
Interpolation Curve (2%%). You can also right-click the Geometry node to add this node from the context menu. Then

enter the properties of the interpolation curve using the following sections:

INTERPOLATION CURVE

From the Type list, sclect Solid, Closed curve, or Open curve to specify if the interpolation curve is a solid object (only
available in 2D) or a closed or open curve object. If Solid or Closed curve is selected, a point is automatically added
if needed to close the curve, and the curve has continuous first and second derivatives everywhere.

From the Data source list, select Table to specify the points to interpolate in a table in the settings window. This is

the default data source.

From the Data source list, select Vectors to specify the points to interpolate as vectors (lists) in the fields x, y, and
(3D only) z; r and z in 2D axial symmetry; xw and yw in work planes. Each field can contain a list of numbers or
expressions containing parameters, separated with commas or spaces. Click the Range button (| |) to use the Range

dialog box for specifying the vector of values for each coordinate.
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From the Data source list, select File to read the points to interpolate from a text file. Specify the file name in the
Filename field or click the Browse button. If Data format is Spreadsheet, the file must be a text file with the number
of columns equal to the dimension of the geometry sequence, and one row for each data point. The columns can
be separated by space, tab, comma, or semicolon characters. If Data format is Sectionwise, the file must be in the
sectionwise COMSOL postprocessing data format (see Sectionwise Data Format). Click the Import to Table button

to copy the file contents into the data point table and change the Data source to Table.

If Data source is File, changes in the file do not automatically cause the interpolation curve feature to be rebuilt. To

rebuild the feature after a change in the file, click the Rebuild with Current File button.

In the Relative tolerance ficld, enter the maximum allowed distance between the generated curve and the sequence
of points. The default value 0 implies that the curve interpolates all points. If the relative tolerance is larger than 0,

the curve does not necessarily interpolate all points, but the first and last points are interpolated.

Curves with self intersections might look correct when displayed but are not handled correctly by other geometry

and meshing operations. This applies also if two different parts of the curve touch, even if they do not intersect.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (all or some of the following
types: domains, boundaries, edges, and points) that the interpolation curve consists of. These selections are
available in all applicable selection lists but do not appear as separate selection nodes in the model tree. If you want
to make the selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list,

or click the New button to create a new cumulative selection (see Cumulative Selections).

Interval

To create one or several intervals, you can either:

¢ Right-click the Geometry node and add an Interval node to the sequence then define it in the settings window, or

* On the 1D Geometry toolbar, click Interval (_~"). Then draw the interval in the Graphics window. Also see

Drawing Geometric Primitives.

When you have added a node or finished drawing the interval in the Graphics window, you can use the following
section to define it or fine tune it.

INTERVAL
Enter the coordinates of the endpoints of the interval in the Left endpoint and Right endpoint ficlds. To get an object
consisting of a sequence of connected intervals, change Number of intervals from One to Many, and enter a

comma-separated list of coordinates in the Points field.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all domains and points that the interval
consists of. These selections are available in all applicable selection lists but do not appear as separate selection nodes
in the model tree. If you want to make the selections contribute to a cumulative selection, select a cumulative
selection from the Contribute to list, or click the New button to create a new cumulative selection (see Cumulative

Selections).

Parametric Curve

A parametric curve is a curve in 2D and 3D where you use a parameter to define the coordinates of the curve. For
example, the coordinates (s-cos(s), s-sin(s)) for a parameter s that runs from 0 to 107 defines a spiral in 2D. To

create a parametric curve, on the Geometry toolbar, from the More Primitives (3D &% or 2D 2%%) menu, select

GEOMETRIC PRIMITIVES | 387



Parametric Curve (- ). You can also right-click the Geometry node to add this node from the context menu. Then
enter the properties of the parametric curve using the following sections:

PARAMETER

Define the parameter name in the Name field (default name: s). Also define the interval for the parameter values in
the Minimum (default: 0) and Maximum (default: 1) fields.

EXPRESSIONS

Enter the expressions that define the functions of the parameter for each spatial coordinate in the x, y (r and z in
2D axial symmetry, xw and yw in work planes), and (3D only) z fields. To create the spiral described earlier with
the parameter s, type s*cos(s) in the x field and s*sin(s) in the y field.

Self-intersecting curves are not supported, except for closed curves (that

]
I_El is, when the start and end points coincide).

By default, the x, y (r and z in 2D axial symmetry, xw and yw in work planes), and (in 3D) z expressions define the
coordinates of points on the curve in the standard coordinate system. It is, however, possible to change this using
the settings in the Pesition, Axis (3D only), and Retation Angle sections. This is useful if you have created a parametric
curve with the right shape but want to move it to another position or orientation. These settings can be thought

of as defining a local coordinate system in which the parametric curve is defined.

Curves with self intersections might look correct when displayed but are not handled correctly by other geometry
and meshing operations. This applies also if two different parts of the curve touch, even if they do not intersect.

Simple closed curves are allowed though.

POSITION
Enter the position of the local coordinate system origin using the x, y (r and z in 2D axial symmetry, xw and yw in
work planes), and (3D only) z fields.

AXIS
In 3D, enter the axis that you want to rotate the local coordinate system about. The axis can be chosen parallel to
one of the coordinate axes or entered in Cartesian or spherical coordinates. The z-axis of the local coordinate system

is parallel to this axis.

ROTATION ANGLE
Enter the angle you want the local coordinate system to be rotated (default: 0 degrees). In 2D the local coordinate
system is rotated about its origin. In 3D, the local coordinate system is rotated about its z-axis, which is parallel to

the axis defined in the previous section.

ADVANCED SETTINGS

Internally, the software represents the parametric curve by a B-spline, which is computed to approximate the
mathematical curve defined by the x, y in 2D, r and z in 2D axial symmetry, xw and yw in work planes, and x, y, and
zin 3D expressions. The number of knot points in the spline increases automatically until the curve approximation
satisfies the tolerance specified in the Relative tolerance ficld or until it reaches the number of knots specified in the
Maximum number of knots field. The tolerance is measured relative to the space diagonal of the bounding box of

the parametric curve.

If the coordinate expressions contain user-defined functions, changes in those functions do not automatically cause
the parametric curve feature to be rebuilt. To rebuild the feature after a change in a user-defined function, click the
Rebuild with Updated Functions button.
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SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (boundaries or edges, and
points) that the parametric curve consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Parametric Surface

A parametric surface is a surface in 3D where you use two parameters to define the coordinates of the surface. For
example, the coordinates (s1-cos(sg), S1-5in(Sg), S9) for a parameter s; that runs from 0 to 7, and a parameter sy

that runs from -1 to 1 define a “twisted rectangle.” To create a parametric surface, on the Geometry toolbar, from
the More Primitives (< ) menu, select Parametric Surface (/7). You can also right-click the Geometry node to add

this node from the context menu. Then enter the properties of the parametric surface using the following sections:

PARAMETERS
Define the parameter names in the Name fields (default names: s1 and s2). Also define the intervals for the

parameter values in the Minimum (default: 0) and Maximum (default: 1) fields.

EXPRESSIONS

Enter the expressions that define the functions of the parameter for each spatial coordinate in the x, y, and z fields.
To create the twisted rectangle described earlier with the parameters s; and sg, type s1*cos(s2) in the x field,
s1*sin(s2) in the y field, and s2 in the z field.

By default, the x, y, and z expressions define the coordinates of points on the surface in the standard coordinate
system. It is, however, possible to change this using the settings in the Pesition, Axis, and Rotation Angle sections.
This is useful if you have created a parametric surface with the right shape but want to move it to another position
or orientation. These settings can be thought of as defining a local coordinate system in which the parametric

surface is defined.

Surfaces with self intersections might look correct when displayed but are not handled correctly by other geometry
and meshing operations. This applies also to surfaces where one edge touches the surface or another edge, and to
surfaces with singular points. If necessary, several parametric surfaces can be combined to overcome this limitation.
For example, constructing a cylindrical shell by typing cos(s1) in the x field, sin(s1) in the y field, and s2 in the
z field, where s1 runs from 0 to 27, and s2 runs from 0 to 1, is incorrect because two edges of the parametric

surface touch each other. Instead, use two parametric surfaces, with the same coordinate expressions, and where s1

runs from 0 to 7 in the first surface and from =« to 27 in the second one.

POSITION

Enter the position of the local coordinate system origin using the x, y, and z fields.

AXIS

Enter the axis that you want to rotate the local coordinate system about. The axis can be chosen parallel to one of
the coordinate axes or entered in Cartesian or spherical coordinates. The z-axis of the local coordinate system is
parallel to this axis.

ROTATION ANGLE
Enter the angle you want the local coordinate system to be rotated (default: 0 degrees). The local coordinate system
is rotated about its z-axis, which is parallel to the axis defined in the previous section.
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ADVANCED SETTINGS

Internally, the software represents the parametric surface by a B-spline, which is computed to approximate the
mathematical surface defined by the x, y, and z expressions. The number of knot points in the spline increases
automatically until the surface approximation satisfies the tolerance specified in the Relative tolerance field or until
it reaches the number of knots specified in the Maximum number of knots field. The tolerance is measured relative

to the space diagonal of the bounding box of the parametric surface.

If the coordinate expressions contain user-defined functions, changes in those functions do not automatically cause
the parametric surface feature to be rebuilt. To rebuild the feature after a change in a user-defined function, click
the Rebuild with Updated Functions button.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (boundaries—that is, the
parametric surfaces—, edges, and points) that the parametric surface consists of. These selections are available in all
applicable selection lists (as, for example, Parametric Surface |1 {geoml_psl_edg} for a selection that includes the
parametric surface’s edges) but do not appear as separate selection nodes. If you want to make the selections
contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the New button

to create a new cumulative selection (see Cumulative Selections).

Point

To create points, you can either:

* For all space dimensions, right-click the Geometry node and add a Point node to the sequence and then define it

in the settings window, or

¢ On the 1D Geometry toolbar, click Peint ( = ). On the 2D Geometry toolbar, from the More Primitives (27=)
menu, select Point ( = ). Then draw the point by clicking in the Graphics window. Also see Drawing Geometric
Primitives. On the 3D Geometry toolbar, from the More Primitives (<3 ) menu, you can also select Point ( = ),
which then adds a Peint node to the sequence. You can then define the point’s location in the Point node’s

settings window.

When you have added a node or finished drawing the point in the Graphics window, you can use the following

section to define it or fine tune it.

POINT
Define the position of the point by entering its coordinates in fields labeled x, y (2D and 3D), and z (3D); r and z
in 2D axial symmetry; xw and yw in work planes. To get several points, enter a list of coordinates in each of these

fields. Separate the coordinates with commas or blanks.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create a predefined selection for the point. This selection is available in all
selection lists for points but does not appear as a separate selection node in the model tree. If you want to make the
selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the

New button to create a new cumulative selection (see Cumulative Selections).

Polygon

A polygon consists of a sequence of connected line segments. To create a polygon, right-click a 2D Geometry node
and select Polygon ( /1). For a 3D model, on the Geometry toolbar, from the More Primitives (<J3 ) menu, select
Polygon ( /). You can also right-click the Geometry node to add this node from the context menu. Then enter the
properties of the polygon using the following sections:
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OBJECT TYPE

From the Type list, select Solid, Closed curve, or Open curve to specify if the polygon is a solid object (only available
in 2D) or a closed or open curve object. If you choose Solid or Closed curve, the program adds a line segment if
needed to close the polygon.

When using The Geometry Toolbar, the Draw Solid button ( /) is
available to toggle between drawing a solid object or an outline (or curve)
g instead of selecting an Object Type. See Geometry Drawing Toolbar

Buttons for other drawing toolbar buttons.

COORDINATES

From the Data source list, you can choose from three different data sources for the coordinates:

* Select Vectors (the default) to specify the coordinates of the vertices as vectors (lists) in the fields x, y, and z (3D
only); r and z in 2D axial symmetry; xw and yw in work planes. Each field can contain a list of numbers or
expressions containing parameters, separated with commas or spaces. Click the Range button (|, |) to use the
Range dialog box for specifying the vector of values for each coordinate.

* Select Table to specify the coordinates of the vertices in a table directly in the settings window.

* Select File to read vertex coordinate data from a text file where each row represents the x, y, and (in 3D) z
coordinates for a vertex in the polygon. Specify the filename in the Filename field, or click the Browse button. The
file must be a text file with the number of columns equal to the dimension of the geometry sequence and one
row for each data point. The columns can be separated by space, tab, comma, or semicolon characters. Click the
Import to Table button to copy the file contents into the data point table and change the Data source to Table.
Changes in the file do not automatically cause the polygon to be rebuilt. To rebuild the node after a change in
the file, click the Rebuild with Current File button.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (all or some of the following
types: domains, boundaries, edges, and points) that the polygon consists of. These selections are available in all
applicable selection lists but do not appear as separate selection nodes in the model tree. If you want to make the
selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the

New button to create a new cumulative selection (see Cumulative Selections).

Pyramid

To create a rectangular pyramid or pyramid frustum, on the Geometry toolbar, from the More Primitives (5 ) menu,
select Pyramid ([3d] ). You can also right-click the Geometry node to add this node from the context menu. Then

enter the properties of the pyramid using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the pyramid is a solid object or a (hollow) surface object.

SIZE AND SHAPE

Define the size and shape of the pyramid in the Base length 1, Base length 2, Height, Ratio, Top displacement I, and
Top displacement 2 ficlds. The Base length ficlds determine (default: 1) the side lengths of the bottom rectangle.
The Height field (default: 1) determines the height of the pyramid frustum. The Ratio field (default: 0.5) controls
the ratio of the perimeters of the top and bottom rectangles. To get an oblique pyramid, use the Top displacement
fields (default: 0) to specify the displacement of the top rectangle’s center relative to the bottom rectangle’s center,

in the pyramid’s local coordinate system.
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POSITION

Enter the position of the pyramid using the x, y, and z fields. This is the center of the bottom rectangle.

AXIS

Specify the direction of the third axis of the pyramid’s local coordinate system—that is, the normal to the base
rectangle. From the Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain an axis aligned with the
specified coordinate axis. Choose Cartesian to enter a direction vector using the x, y, and z fields. Choose Spherical

to enter the direction using the angles theta (polar, zenith) and phi (azimuth).

ROTATION ANGLE
Specify the rotational angle about the axis in the Rotation ficld. When this angle is zero (the default), the second

axis of the pyramid’s local coordinate system (corresponding to Base length 2) is parallel to the xy-plane.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the pyramid consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Rectangle

To create a rectangle, you can either:

¢ Right-click the Geometry node and add a Rectangle node to the sequence then define it in the settings window, or

* On the Geometry toolbar, from the Rectangle ([ ] ) menu, select Rectangle (Center) ([=] ). Then draw the
rectangle in the Graphics window. Also see Drawing Geometric Primitives.

To draw a rectangle for a 2D model, click Rectangle or Rectangle
(Center). Then, click one corner (or the center) of the rectangle in the
Graphics window. Drag the mouse to the desired position of a corner.
When you release the mouse button, a solid rectangle appears, and a

Rectangle node appears in the geometry sequence.

When you have added a node or finished drawing the rectangle in the Graphics window, you can use the following

section to define it or fine tune it.

OBJECT TYPE

From the Type list, select Solid or Curve to specify if the rectangle is a solid object or a curve object.

When using the geometry toolbar, the Draw Solid button ( /T ) is available
to toggle between drawing a solid object or an outline (or curve) instead

EI of selecting an Object Type. See Geometry Drawing Toolbar Buttons for
other drawing toolbar buttons.

SIZE
Define the size of the rectangle in the Width and Height fields.
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POSITION
Enter the position of the rectangle using the x and y fields (r and z in 2D axial symmetry, xw and yw in work planes).
From the Base list, choose Center if the rectangle is centered about the position, or choose Corner if the rectangle

has a corner at the position.

ROTATION ANGLE

Specify the counterclockwise rotational angle (default: 0 degrees) about the position the Rotation field.

LAYERS

Layers can be used to create sandwich primitives by adding layers on one or more sides. You specify the thicknesses
of layers in the Layers table, and optionally a name for each layer. The outermost layer comes first. Select the check
boxes to specify where to apply the layers.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, and
points) that the rectangle consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Sphere

To create a sphere or ball, on the Geometry toolbar click Sphere (=7 ). You can also right-click the Geometry node

to add this node from the context menu. Then enter the properties of the sphere using the following sections:

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the sphere is a solid object or a (hollow) surface object.

SIZE AND SHAPE
Define the radius of the sphere in the Radius field.

POSITION

Enter the position of the sphere’s center using the x, y, and z fields.

AXIS

Specify the direction of the third axis of the sphere’s local coordinate system. From the Axis type list, choose x-axis,
y-axis, or z-axis (the default) to obtain an axis aligned with the specified coordinate axis. Choose Cartesian to enter
a direction vector using the x, y, and z fields. Choose Spherical to enter the direction using the angles theta (polar,
zenith) and phi (azimuth).

ROTATION ANGLE
Specify the rotational angle about the axis in the Rotation ficld. When this angle is zero (the default), the second

axis of the sphere’s local coordinate system is parallel to the xy-plane.

LAYERS
Layers can be used to create sandwich primitives by adding several concentric spheres. You specify the thicknesses
and, optionally, names of each layer in the Layers table. The outermost layer comes first. The layers are positioned

inside the sphere’s radius.
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SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the sphere consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Square

To create a square, you can either:

¢ Right-click the Geometry node and add a Square node to the sequence then define it in the settings window, or

* On the Geometry toolbar, from the Rectangle ([ ] ) menu, sclect Square (D ) or Square (Center)([=] ). Then draw
the square in the Graphics window. Also see Drawing Geometric Primitives.

To draw a square, click Square or Square (Center). Then, click one corner
(or the center) of the square in the Graphics window. Drag the mouse to
the desired position of a corner. When you release the mouse button, a
solid square appears, and a Square node is added to the geometry

sequence.

When you have added a node or finished drawing the square in the Graphics window, you can use the following
section to define it or fine tune it.

OBJECT TYPE

From the Type list, select Solid or Curve to specify if the square is a solid object or a curve object.

When using the geometry toolbar, the Draw Solid button ( /7 ) is available
to toggle between drawing a solid object or an outline (or curve) instead
g of selecting an Object Type. See Geometry Drawing Toolbar Buttons for

other drawing toolbar buttons.

SIZE
Define the size of the square in the Side length ficld.

POSITION
Enter the position of the square using the x and y fields (r and z in 2D axial symmetry, xw and yw in work planes).
From the Base list, choose Center if the square is centered about the position, or choose Corner if the square has a

corner at the position.

ROTATION ANGLE

Specity the counterclockwise rotational angle about the position the Rotation ficld.

LAYERS

Layers can be used to create sandwich primitives by adding layers on one or more sides. You specify the thicknesses
of layers in the Layers table and optionally a name for each layer. The outermost layer comes first. Select the check

boxes to specify where to apply the layers.
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SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, and
points) that the square consists of. These selections are available in all applicable selection lists but do not appear as
separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative selection,
select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative selection

(see Cumulative Selections).

Tetrahedvon

To create a tetrahedron, on the Geometry toolbar, from the More Primitives (73 ) menu, select Tetrahedron

(A ).You can also right-click the Geometry node to add this node from the context menu.

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the tetrahedron is a solid object or a (hollow) surface object.

VERTICES
Define the position, size, and shape of the tetrahedron by specifying the coordinates of its vertices. Vertices 1-3 are

the vertices of the bottom face in clockwise order. Vertex 4 is the top vertex.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the tetrahedron consists of. These selections are available in all applicable selection lists but do not
appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Torus

To create a torus, on the Geometry toolbar, from the More Primitives (<F: ) menu, select Torus ({=1). You can also

right-click the Geometry node to add a Torus.

OBJECT TYPE

From the Type list, select Solid or Surface to specify if the torus is a solid object or a (hollow) surface object.

SIZE AND SHAPE

Define the size and shape of the torus in the Major radius, Minor radius, Revolution angle and Interior faces ficlds. The
Major radius (default: 1) field controls the distance from the center of the cross section to the center of the torus.
The Minor radius (default: 0.5) field controls the radius of the cross section. To get less than a full revolution (360
degrees, the default), use the Revolution angle ficld. Select the Interior faces check box to create cross-sectional faces

that partition the domain of a Solid torus.

POSITION

Enter the position of the torus’ center using the x, y, and z fields.

AXIS

Specify the direction of the third axis of the torus’ local coordinate system—that is, the normal to the plane of
directrix circle. From the Axis type list, choose x-axis, y-axis, or z-axis (the default) to obtain an axis aligned with
the specified coordinate axis. Choose Cartesian to enter a direction vector using the x, y, and z fields. Choose

Spherical to enter the direction using the angles theta (polar, zenith) and phi (azimuth).
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ROTATION ANGLE
Specify the rotational angle about the axis in the Rotation ficld. When this angle is zero, the second axis of the torus’

local coordinate system is parallel to the xy-plane.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the torus consists of. These selections are available in all applicable selection lists but do not appear
as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Composite Object (Backward Compatibility)

If you open a model created in the 3.5a version of COMSOL one Composite Object node (x“‘-.) appears for each

nonprimitive geometry object in the model. The Composite Object node contains the follow sections:

COMPOSITE OBJECT

If you save the model as a . java file, COMSOL uses the filename specified in the Filename ficld to determine the
path to a geometry file, containing the geometry object, that appears together with the . java file. The software
uses this geometry file when you run the resulting . java file. By default, the filename has the prefix SFILENAMES.
If the filename starts with this prefix, COMSOL stores the geometry file in the same directory as the . java file. It
is also possible to remove this prefix and specify the full path to the geometry file.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains, boundaries, edges,
and points) that the composite object consists of. These selections are available in all applicable selection lists but
do not appear as separate selection nodes in the model tree. If you want to make the selections contribute to a
cumulative selection, select a cumulative selection from the Contribute to list, or click the New button to create a

new cumulative selection (see Cumulative Selections).
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Geometry Operations

This section describes the available geometry operations (Work Plane Operations, Boolean Operations, Transform

Operations, Conversion Operations, Other Geometry Operations, and Programming). The features in Table 7-2,

Table 7-3, Table 7-4, Table 7-5, and Table 7-6,are also available as buttons on the The Geometry Toolbar.

@

See Virtual Geometry and Mesh Control Operations for examples of how

to use virtual geometry operations to remove a short edge and to ignore

and collapse edges to prepare the geometry for efficient meshing. You can

use several of these operations to also control the mesh.

WORK PLANE OPERATIONS

The following table lists operations available with work planes in 3D geometries:

TABLE 7-2: WORK PLANE RELATED OPERATIONS FOR 3D MODELS

ICON  NAME DESCRIPTION
= Cross Section  Create a 2D cross section from an intersection between
) a 3D geometry and a work plane.
8 Y P
[ Extrude Extrude planar objects into 3D.
-% Revolve Revolve planar objects into 3D.
F-4 Sweep To sweep one or several faces along a spine curve.

T
L

Work Plane

Create a work plane for drawing 2D objects that are
embedded in 3D.

BOOLEAN OPERATIONS

Use Boolean operations to create a composite geometry object by forming unions, set differences, and set

intersections—and combinations of those operations—of existing geometry objects.

The following Boolean operations are available in all space dimensions:

TABLE 7-3: BOOLEAN OPERATIONS

ICON NAME SPACE DESCRIPTION
DIMENSION

=2 Compose ID, 2D, 3D Compose geometry objects by specifying Boolean
operations using a set formula.

[h Difference ID, 2D, 3D  Select the objects to compose in the Graphics
window and click the Difference button to take the
selected object with the largest volume (area, length)
and subtract the others.

[=h Intersection 1D, 2D, 3D  Select the objects to intersect in the Graphics
window and click the Intersection button to create
an intersection of the selected objects.

%, Partition ID, 2D, 3D  Partition geometry objects using a work plane or

) other geometry objects (tool objects).
Union ID, 2D, 3D  Select the objects to unite in the Graphics window

and click the Union button to create a union of the
selected objects.
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TRANSFORM OPERATIONS

You can use the transforms to create rectangular and linear arrays of identical geometry objects and to move, rotate,
mirror, and scale geometry objects. Mirroring, moving, rotating, and scaling are affine transformations applied
to geometry objects. All transforms are available in all space dimensions, except Rotate, which is not applicable for

1D geometries.

TABLE 7-4: GEOMETRY TRANSFORM OPERATIONS

ICON NAME SPACE DESCRIPTION
DIMENSION
Array ID, 2D, 3D Create an array of geometry objects.
I__-.:'] Copy ID, 2D, 3D Copy geometry objects.
4 Mirror ID, 2D, 3D Mirror geometry objects in a plane (3D), a line
(2D), or a point (1D).

e Move ID, 2D, 3D Move geometry objects.

H Rotate 2D, 3D Rotate geometry objects about a centerpoint.
iV Scale ID, 2D, 3D Scale geometry objects about a centerpoint.

CONVERSION OPERATIONS
The geometry conversion operations make it possible to, for example, convert a 3D solid to a surface (boundary)

object for modeling a shell or other thin structure. You can perform the following geometry object conversions:

For 2D models:

* Convert a solid object into a curve or point object.
Q » Convert a curve object defining at least one closed domain into a solid
object.

» Convert a curve object into a point object.

For 3D models:

» Convert a solid object into a surface, curve, or point object.

* Convert a surface object defining at least one closed domain into a solid

.i object.

* Convert a surface object into a curve or point object.

» Convert a curve object into a point object.

TABLE 7-5: GEOMETRY CONVERSION OPERATIONS

ICON NAME SPACE DESCRIPTION
DIMENSION
= Convert to Curve 2D, 3D Select the objects to convert in the

Graphics window and click to unite them
and convert them to a curve object.

Convert to Point ID, 2D, 3D Select the objects to convert in the
Graphics window and click to unite them
and convert them to a point object.
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TABLE 7-5: GEOMETRY CONVERSION OPERATIONS

ICON NAME SPACE

DIMENSION

DESCRIPTION

— Convert to Solid 1D, 2D, 3D

Convert to Surface 3D

Convert to 3D

COMSOL

Split ID, 2D, 3D

Select the objects to convert in the
Graphics window and click to unite them
and convert them to a solid object.

Select the objects to convert in the
Graphics window and click to unite them
and convert them to a surface object.

Available with the CAD Import Module.
Select the objects to convert in the
Graphics window, and then click to
convert them to a COMSOL kernel
representation. See the CAD Import
Module User’s Guide.

Split one or several objects into their
entities.

OTHER GEOMETRY OPERATIONS

For 2D geometry objects, you can use geometry operations such as fillets and tangents to construct the geometry.

In all space dimensions you can delete geometry objects or geometric entities (domains, boundaries, edges, and

points).

The following table provides an overview of available general geometry operations:

TABLE 7-6: OTHER GEOMETRY OPERATIONS

ICON NAME SPACE

DIMENSION

DESCRIPTION

Chamfer 2D

7]

Fillet 2D

P Tangent 2D

E Delete Entities 1D, 2D, 3D

r 4 Edit Object 2D

ID, 2D, 3D

Import

=

Create chamfers at a set of corners of a 2D
geometry object.

Create fillets at a set of corners of a 2D
geometry object.

Create a tangent from an edge to another
edge or point in a 2D geometry.

To delete geometric entities (domains,
boundaries, edges, or points) from the
objects they belong to, or to delete entire
geometry objects, select the entities or
objects and click the Delete button. If you
delete objects corresponding to primitive
features, these nodes are removed from the
sequence. If you delete other objects or
geometric entities, a Delete Entities node is
added to the sequence. If instead you use
the Delete Entities context menu item, a
Delete Entities always displays.

To edit a 2D object using the settings
window, in the Model Builder, right-click the
Geometry node and select Edit Object from
the context menu. To edit a 2D object using
the Graphics window, select the object and
click the Edit Object button. See Editing
2D Geometry Objects.

Import geometry objects from a file or from
another geometry.
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PROGRAMMING
You can use If, Else If, Else, and End If nodes to create If statements that enable or disable other features depending
on values of logical conditions in terms of parameters. You can also use a Subsequence Call node to create an

instance of a geometry subsequence (see Using Geometry Subsequences) with changed values of its arguments.

TABLE 7-7: PROGRAMMING AND LOGICAL OPERATIONS

ICON NAME DESCRIPTION

;-_E If Begin an If statement. See If, Else If,
Else, End If.

?—E Else If Continue an If statement. See If] Else
If, Else, End If.

?—E Else Last alternative in an If statement. See
If, Else If, Else, End If.

?—E End If End an If statement. See If, Else If]
Else, End If.

Loy Subsequence Calll  Call a geometry subsequence.

Array

To create a rectangular or linear array of identical geometry objects, on the Geometry toolbar, click Array ( ::::: ). You

can also right-click the Geometry node to add this node from the Transforms submenu. Then enter the properties

of the array operation using the following sections:

INPUT
Select the geometry objects that you want to duplicate in the Graphics window. The objects appear in the Input
objects list. If the geometry sequence includes user-defined selections above the Array node, choose Manual to select

objects, or choose one of the selection nodes from the list next to Input objects.

Click the Active button to toggle between turning ON and OFF the Input objects selections.

SIZE
In 2D and 3D, you get a rectangular (in 2D) or three-dimensional (in 3D) array by default. Enter the number of
duplicates in each coordinate direction in the x size, y size, and z size ficlds; r size and z size in 2D axial symmetry;

xw size and yw size in work planes.

To create a linear array of objects in 2D or 3D, change Array type to Linear. Enter the number of duplicates in the
Size field.

In 1D, enter the number of duplicates in the Size field.

DISPLACEMENT

Set the displacement in each coordinate direction in the x, y, and z fields (not all fields are available in 1D and 2D).

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (all or some of domains,
boundaries, edges, and points) that the resulting geometric objects consist of. These selections are available in all
applicable selection lists but do not appear as separate selection nodes in the model tree. If you want to make the
selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the

New button to create a new cumulative selection (see Cumulative Selections).
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Chamfer

To chamfer corners in 2D geometry objects, on the Geometry toolbar click Chamfer (37]) You can also right-click
the Geometry node to add this node from the context menu. Then enter the properties of the chamfer operation

using the following sections:

POINTS

Select the points (vertices) that you want to chamfer in the Graphics window. They then appear in the Vertices to
chamfer list. If the geometry sequence includes user-defined selections above the Chamfer node, choose Manual to
select points, or choose one of the selection nodes from the list next to Vertices to chamfer.

Click the Active button to toggle between turning ON and OFF the Vertices to chamfer selections.

DISTANCE

In the Distance from vertex ficld, enter the distance from the vertex to the endpoints of the chamfer segment.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (all or some of domains,
boundaries, edges, and points) that the resulting geometric object consists of. These selections are available in all
applicable selection lists but do not appear as separate selection nodes in the model tree. If you want to make the
selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the

New button to create a new cumulative selection (see Cumulative Selections).

Compose

To create a composite geometry object from other geometry objects using Boolean operations given in a set
formula, on the Geometry toolbar, click Compose (2= ). You can also right-click the Geometry node to add this node
from the Boolean Operations submenu. Then enter the properties of the compose operation as a set formula using

the following section:

COMPOSE
Select the geometry objects that you want to compose in the Graphics window. The objects appear in the Input
objects list. If the geometry sequence includes user-defined selections above the Compose node, choose Manual to

select objects, or choose one of the selection nodes from the list next to Input objects.
Click the Active button to toggle between turning ON and OFF the Input objects selections.
Select the Keep input objects check box to use the selected solid geometry objects for further geometry operations.

In the Set formula ficld, enter a set formula involving the names of the selected geometry objects—for example,

ri+c1*(c2-r2)—to take the union of r1 and the object that is the result of the intersection between c1 and the
set difference where r2 is subtracted from c2. Use the binary operations +, *, and - for set union, set intersection,
and set difference, respectively. The precedence of the operators + and - are the same. The operator * has higher
precedence. You can override the precedence rules using parentheses. When you change the set formula, the Input

objects sclection is automatically updated.

To create a geometry object without interior boundaries, clear the Keep interior boundaries check box. This can be
useful to simplify a geometry where the interior boundaries do not separate domains with different physics or

materials, for example.

Adjust the Relative repair tolerance (default value: 10_6) if you experience problems with the compose operation.
The absolute repair tolerance is the relative repair tolerance times the maximum coordinate of the input objects.

The value is relative to the overall dimensions of the geometry. For example, if the dimensions are in meters, the
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default repair tolerance makes the geometry repair heal gaps that are smaller than a micrometer (10_6 m).
Geometric entities that have a distance less than the absolute repair tolerance are merged.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (all or some of domains,
boundaries, edges, and points) that the resulting composite geometric object consists of. These selections are
available in all applicable selection lists but do not appear as separate selection nodes in the model tree. If you want
to make the selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list,

or click the New button to create a new cumulative selection (see Cumulative Selections).

Convert to Curve

To unite and convert geometry objects to single a curve object, on the Geometry toolbar, Conversions menu, click
Convert to Curve (F=). You can also right-click the Geometry node to add this node from the Conversions submenu.

Then enter the properties of the convert operation using the following section:

INPUT
Select the geometry objects that you want to convert in the Graphics window. The objects appear in the Input

objects list.
Click the Active button to toggle between turning ON and OFF the Input objects selections.
Select the Keep input objects check box to use the selected geometry objects for further geometry operations.

Adjust the Relative repair tolerance if you experience problems with the convert operation. The absolute repair
tolerance is the relative repair tolerance times the maximum coordinate of the input objects. Geometric entities that

have a distance less than the absolute repair tolerance are merged.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (boundaries or edges, and
points) that the resulting curve object consists of. These selections are available in all applicable selection lists but
do not appear as separate selection nodes in the model tree. If you want to make the selections contribute to a
cumulative selection, select a cumulative selection from the Contribute to list, or click the New button to create a

new cumulative selection (see Cumulative Selections).

Convert to Point

To unite and convert geometry objects to single a point object, on the Geometry toolbar, Conversions menu, click
Convert to Point ([+=;). You can also right-click the Geometry node to add this node from the context menu. Then

enter the properties of the convert operation using the following section:

INPUT
Select the geometry objects that you want to convert in the Graphics window. The objects appear in the Input

objects list.
Click the Active button to toggle between turning ON and OFF the Input objects selections.
Select the Keep input objects check box to use the selected geometry objects for further geometry operations.

Adjust the Relative repair tolerance if you experience problems with the convert operation. The absolute repair
tolerance is the relative repair tolerance times the maximum coordinate of the input objects. Geometric entities that

have a distance less than the absolute repair tolerance are merged.
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SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create a predefined selection for the points that the resulting geometric
object consists of. This selection is available in all selection lists for points but does not appear as a separate selection
node in the model tree. If you want to make the selections contribute to a cumulative selection, select a cumulative
selection from the Contribute to list, or click the New button to create a new cumulative selection (see Cumulative

Selections).

Convert to Solid

To unite and convert geometry objects to single a solid object, on the Geometry toolbar, Conversions menu, click
Convert to Solid (&5 ). You can also right-click the Geometry node to add this node from the context menu. Then

enter the properties of the convert operation using the following section:

INPUT
Select the geometry objects that you want to convert in the Graphics window. The objects appear in the Input

objects list.
Click the Active button to toggle between turning ON and OFF the Input objects selections.
Select the Keep input objects check box to use the selected geometry objects for further geometry operations.

Adjust the Relative repair tolerance if you experience problems with the convert operation. The absolute repair
tolerance is the relative repair tolerance times the maximum coordinate of the input objects. Geometric entities that

have a distance less than the absolute repair tolerance are merged.

SELECTIONS OF RESULTING ENTITIES

Select the Create selections check box to create predefined selections for all entities (domains and all or some of
boundaries, edges, and points) that the resulting solid object consists of. These selections are available in all
applicable selection lists but do not appear as separate selection nodes in the model tree. If you want to make the
selections contribute to a cumulative selection, select a cumulative selection from the Contribute to list, or click the

New button to create a new cumulative selection (see Cumulative Selections).

Convert to Surface

To unite and convert geometry objects to single a surface object, on the Geometry toolbar, Conversions menu, click
Convert to Surface (). You can also right-click the Geometry node to add this node from the context menu. Then

enter the properties of the convert operation using the following section:

INPUT
Select the geometry objects that you want to convert in the Graphics window. The objects appear in the Input

objects list.
Click the Active button to toggle between turning ON and OFF the Input objects selections.
Select the Keep input objects check box to use the selected geometry objects for further geometry operations.

Adjust the Relative repair tolerance if you experience problems with the convert operation. The absolute repair
tolerance is the relative repair tolerance times the maximum coordinate of the input objects. Geometric entities that

have a distance less than the absolute repair tolerance are merged.

SELECTIONS OF RESULTING ENTITIES
Select the Create selections check box to create predefined selections for all entities (boundaries, edges, and points)
that the resulting surface object consists of. These selections are available in all applicable Selection lists but do not

appear as separate selection nodes in the model tree. If you want to make the selections contribute to a cumulative
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selection, select a cumulative selection from the Contribute to list, or click the New button to create a new cumulative

selection (see Cumulative Selections).

Copy

Use the Copy ([5]) node to make a displaced copy of one or several geometry objects. This method creates a node

in the model tree that contains a reference to other objects in the geometry sequence that are copied and keeps the

objects linked (unlike a simple copy and paste function).